
IX Support Tool Setting Manual

IX Series
IP network-compatible intercom

Software version: 5.0.0.0 or later

Important

• Before configuring and using the system, read "Setting Manual" and "Operation Manual" carefully.

• For the installation and connection of each device, refer to "Installation Manual."

• Begin installation after reading and understanding the procedures for system configuration.

• The setting data is required for after-sales service and other such services. Write the setting data to a CD-R or other media and
be sure to give it to the customer.

• The illustrations and images in this manual may vary from the actual ones.
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Introduction

This manual describes the IX Support Tool in detail.
The IX Series offers a separate manual for Installation, Settings, and Operations. Refer to the relevant manual.
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Introduction

1. Notational symbols in this manual

The following symbols identify important information concerning operational procedures.

• Terms displayed on master station and PC screens are indicated as [XXXX].
• Page reference are shown as "Title (→ page XX)," (→ page XX), or page XX.
• The illustrations and screen shots in this manual may vary from the actual ones.

Negligence could cause death or serious injury.

Negligence could result in injury to people or damage to property.

Indicates what should be known before operation. Please read and understand before 
proceeding.

Indicates tips and additional information for operation.

Warning

Caution

Important

Note
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2. Device type

The stations are shown as below.

Device Type Example Model Name

Master Stations IX-MV IX-MV

IX-MV7-* IX-MV7-HW, IX-MV7-W, IX-MV7-HB, IX-MV7-B

Video Stations IX-DV, IX-DVF(-*) IX-DV, IX-DVF, IX-DVF-P, IX-DVF-2RA, IX-DVF-
RA

IX-DA, IX-DF(-*) IX-DA, IX-DF, IX-DF-HID, IX-DF-RP10, IX-DF-
2RA

Audio Stations IX-SSA(-*) IX-SSA, IX-SSA-2RA, IX-SSA-RA

IX-SS-2G IX-SS-2G

IX-BA, IX-SS(-*) IX-BA, IX-SS, IX-SS-2RA, IX-SS-RA

IX-RS-* IX-RS-W, IX-RS-B

Others IXW-MA IXW-MA
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3. Product manuals

Read the "Installation Manual," "Setting Manual," and "Operation Manual" as needed. Have the person who installs or 
configures the product refer to the relevant manuals.

Installation Manual (comes with each station.)
Refer to when installing and connecting each station. (For installers)

Manuals can be downloaded from 
our web site. “https://
www.aiphone.net/product/support/.“ 
Refer to these manuals as 
necessary.

IX Support Tool Setting Manual (Electronic format (PDF file).)
Describes how to configure and maintain the system using IX Support Tool. (For system 
administrator)

Monitoring Software (IX Supervision Tool) Operation Manual (Electronic format 
(PDF file).)
Describes how to use the Monitoring Software. (For system administrator)

Operation Manual (Electronic format (PDF file).)
Describes how to use each station. (For user)

Web Setting Manual (Electronic format (PDF file).)
Describes how to set up each station for the Internet connection. (For system 
administrator)

Installation Manual (Electronic format (PDF file).)
Describes how to install each station. (For installer)

Installation Manual

https://www.aiphone.net/product/support/
https://www.aiphone.net/product/support/
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4. Station description

4.1 Master Station IX-MV7-*

■Part names

*1 Found by opening cover.

*2 Press and hold the reset button for at least 1 second (less than 5 seconds), then release to restart (reset).

1 Handset 10 microSD card slot*1

2 Camera 11 3.5 mm 4-pole mini jack

3 Privacy mask lever (top) 12 MAC address

4 Status indicator (orange/blue) 13 Camera angle adjustment lever

5 Speaker 14 Option connector terminal

6 Liquid crystal display (touch panel) 15 Low voltage cable connection terminal

7 Home button 16 Tabletop fastening screw hole

8 Microphone 17 LAN terminal

9 Reset button*1*2

1

2 3

8

4 12 13

14 15 16 175 6 7

9

10

11

2 3

8

4 12 13

14 15 16 175 6 7

9

10

11

Side Rear

Side Rear

Front

Front
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■ Indicators
: ON : OFF

 

Name Status (pattern) Description

Status 
indicator

Orange 
flashing

Normal flashing Booting

Fast flashing Device error, 
Startup error

Long OFF time flashing Communication 
failure,
Line supervision and 
device check error

Long irregular flashing Firmware
version updating

Long irregular flashing Initializing

Blue light Standby(Depends 
on setting)

Note

• For a status other than those noted here, refer to "Operation Manual."

• The default language for the master station's display is English.

0.75sec 0.75sec

0.25sec 0.25sec

0.5sec 4sec

１sec 0.25sec 0.25sec 0.25sec 0.25sec 0.25sec

１sec 0.25sec 0.25sec 0.25sec



14

Introduction

4.2 Master Station IX-MV

■Part names

*1 Press and hold the reset button for 1 - 4 seconds, then release to restart station.

1 Handset 13 SETTING button / Setting indicator (blue)

2 Hook switch 14 Select button

3 Speaker 15 ADJUST button

4 Keypad 16 Up/Down and L/R buttons

5 MONITOR button 17 Microphone

6 Color LCD monitor 18 Door Release button

7 Status indicator (orange/blue) 19 TALK button / Talk indicator (blue)

8 Speed Dial buttons (x 6) 20 OFF button

9 PRIVACY button / Privacy indicator (blue) 21 MAC address

10 TRANSFER button / Transfer indicator (orange) 22 Weak electrical current line connection terminal

11 LIST button / List indicator (blue) 23 LAN terminal

12 Reset button (beneath the name plate)*1

23
22

21
1
2
3

4

5

19
20

17

8
9
10

12
11

13
14
15
16

18

6 7

Back
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■ Indicators
: ON : OFF

 

Name Status (pattern) Description

Status 
indicator

Orange 
flashing

Normal flashing Booting

Fast flashing Device error

Long OFF time flashing Communication 
failure

Long irregular flashing Firmware
version updating

Long irregular flashing Initializing

Blue light Standby(Depends 
on setting)

Note

• For a status other than those noted here, refer to "Operation Manual."

• The display language is English by default.

0.75sec 0.75sec

0.25sec 0.25sec

0.5sec 4sec

１sec 0.25sec 0.25sec 0.25sec 0.25sec 0.25sec

１sec 0.25sec 0.25sec 0.25sec
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4.3 Handset Sub Station IX-RS-*

■Part names

*1 The volume can be adjusted for each of the following.
– Volume can be changed during an incoming call or in standby:

Ringtone... 0 (Off), 1 (Low) - 10 (High) (a tone is played each time it is adjusted)
– Volume can be changed during calls:

Handset Receive... 1 (Low) - 10 (High)
Hands-free Receive (also changes the paging reception and ringback tone volume)...1 (Low) - 10 (High)

*2 Press and hold the reset button for 1 - 4 seconds, then release to restart station.

1 Handset 8 Door Release button
Only displayed when configured.

2 Speaker 9 Call/TALK button
Can be used to call or answer depending on 
configuration. “Call Button Function (→page 224)”

3 Microphone 10 Ringtone/call volume*1

4 Status indicator (orange/blue) 11 MAC address

5 Call indicator (green)
LED lit during operation.

12 LAN terminal

6 Communication indicator (orange)
LED lit during operation.

13 Weak electrical current line connection terminal

7 Door release indicator (green)
LED lit during operation.

14 Reset button*2

1 4
5
6
7
8

9

10

11

12
13
14

2

3

Back
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■ Indicators
: ON : OFF

 

Name Status (pattern) Description

Status 
indicator

Orange 
flashing

Normal flashing Booting

Fast flashing Device error, 
Startup error

Long OFF time flashing Communication 
failure

Long irregular flashing Firmware
version updating

Long irregular flashing Initializing

Blue light Standby

Note

• For a status other than those noted here, refer to "Operation Manual."

0.75sec 0.75sec

0.25sec 0.25sec

0.5sec 4sec

１sec 0.25sec 0.25sec 0.25sec 0.25sec 0.25sec

１sec 0.25sec 0.25sec 0.25sec
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4.4 Video Door Station (IX-DA)/Audio Only Door Station (IX-BA)

■Part names

*1 Accessible when terminal cover is opened.

*2 Press and hold the reset button for 1 - 4 seconds, then release to restart station.

1 Call indicator (orange) 10 MAC address (beneath the panel)

2 Camera 11 Panel

3 Microphone 12 Main unit

4 Communication indicator (green) 13 Mounting frame

5 Speaker 14 MAC address

6 LED for night illumination 15 Camera angle adjustment lever (IX-DA only)

7 Call Button 16 Reset button*1*2

8 Status indicator (red) 17 LAN terminal*1

9 Drain holes (4) 18 Option connector*1

2
3

6

4

5

1

9

8
7

10

3

4

5

1

7

9

8

10

15

17
18

14

16

131211

IX-DA SideIX-BA Back
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■ Indicators
: ON : OFF

 

Name Status (pattern) Description

Status 
indicator

Red flashing Normal flashing Booting

Fast flashing Device error

Long OFF time flashing Communication 
failure

Long irregular flashing Firmware
version updating

Long irregular flashing Initializing

Red light Standby

Note

• For a status other than those noted here, refer to "Operation Manual."

0.75sec 0.75sec

0.25sec 0.25sec

0.5sec 4sec

１sec 0.25sec 0.25sec 0.25sec 0.25sec 0.25sec

１sec 0.25sec 0.25sec 0.25sec
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4.5 Video Door Station (IX-DV, IX-DVF(-*), IX-SSA(-*))

■Part Names

*1 Accessible when terminal cover is opened.

*2 Press and hold the reset button for 1 - 4 seconds, then release to restart station.

1 Status indicator (orange/blue) 10 Camera angle adjustment lever

2 Call indicator (green) 11 MAC address

3 Communication indicator (orange) 12 Terminal cover

4 Camera 13 Option connector terminal*1

5 Microphone 14 LAN2 terminal (PoE/PSE)*1

6 Door release indicator (green) 15 LAN1 terminal (PoE/PD)*1

7 LED for night illumination 16 Reset button*1*2

8 Speaker 17 microSD card slot*1

9 Call button
Surrounding area is lit up with blue light

18 microSD card release button*1

6
7

1

2
3
4
5

8

9

10

11
12

13
14
15
16
17
18

1

3
2

4
5
6
7

8

9

10

11

12

13
14
15
16
17
18

IX-DV

Front Back

IX-DVF

Front Back
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*1 Accessible when terminal cover is opened.

*2 Press and hold the reset button for 1 - 4 seconds, then release to restart station.

1 Status indicator (orange/blue) 11 Urgent call button

2 Call indicator (green) 12 Camera angle adjustment lever

3 Communication indicator (orange) 13 MAC address

4 Camera 14 Terminal cover

5 Microphone 15 Option connector terminal*1

6 Door release indicator (green) 16 LAN2 terminal (PoE/PSE)*1

7 LED for night illumination 17 LAN1 terminal (PoE/PD)*1

8 Speaker 18 Reset button*1*2

9 Call button
Surrounding area is lit up with blue light

19 microSD card slot*1

10 Braille 20 microSD card release button*1

1

2

3

6

8

10

5

4

7

9

11

12

13

1415

18
20

16
17
19

1

2

3

6

8

5

4

7

11

10

15

18
20

12

13

14
16

17
19

IX-DVF-2RA

Front Back

IX-DVF-RA

Front Back
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*1 Accessible when terminal cover is opened.

*2 Press and hold the reset button for 1 - 4 seconds, then release to restart station.

1 Status indicator (orange/blue) 12 Hearing aid (T mode) compatible microphone

2 Call indicator (green) 13 Camera angle adjustment lever

3 Communication indicator (orange) 14 MAC address

4 Camera 15 Terminal cover

5 Microphone 16 Option connector terminal*1

6 Door release indicator (green) 17 LAN2 terminal (PoE/PSE)*1

7 LED for night illumination 18 LAN1 terminal (PoE/PD)*1

8 Speaker 19 Reset button*1*2

9 Call button
Surrounding area is lit up with blue light

20 microSD card slot*1

10 HID reader 21 microSD card release button*1

11 Nameplate (with backlight) 22 Hearing aid unit

1

2

3

6

8

5

4

7

9

10

16

19
21

13

14

15
17
18
20

1

2

3

6

8

11

5

4

7

12

9

16

19
21

13

14

15
17

18
20

22

IX-DVF-P

Front Back

IX-DVF-L

Front Back
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*1 Accessible when terminal cover is opened.

*2 Press and hold the reset button for 1 - 4 seconds, then release to restart station.

1 Status indicator (orange/blue) 10 MAC address

2 Call indicator (green) 11 Terminal cover

3 Communication indicator (orange) 12 Option connector terminal*1

4 Microphone 13 LAN2 terminal (PoE/PSE)*1

5 Door release indicator (green) 14 LAN1 terminal (PoE/PD)*1

6 Speaker 15 Reset button*1*2

7 Call button
Surrounding area is lit up with blue light.

16 microSD card slot*1

8 Braille 17 microSD card release button*1

9 Urgent call button

1

2

3

5

6

4

7

12

15
17

10

11
13
14
16

1

2

3

5

6

8

4

7

9

12

15
17

10

11
13
14
16

1

2

3

5

6

8

9

4

12

15
17

10

11
13
14
16

IX-SSA

Front Back

IX-SSA-2RA

Front Back

IX-SSA-RA

Front Back



24

Introduction

■ Indicators
: ON, : OFF

 

Name Status (pattern) Description

Status 
indicator

Orange 
flashing

Normal flashing Booting

Fast flashing Device error, 
Startup error

Long OFF time flashing Communication 
failure

Long initial light ON flashing Firmware
version updating

Long initial light ON flashing Mounting/
unmounting 
microSD card

Long initial light ON flashing Initializing

Blue light Standby

Note

• For a status other than those noted here, refer to "Operation Manual."

0.75sec 0.75sec

0.25sec 0.25sec

0.5sec 4sec

１sec 0.25sec 0.25sec 0.25sec 0.25sec 0.25sec

2sec 0.25sec 0.25sec 0.25sec

１sec 0.25sec 0.25sec 0.25sec
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4.6 Door Station (IX-SS-2G)

■Part names

*1 Found by opening terminal cover.

*2 Press and hold the reset button for 1 - 4 seconds, then release to restart station.

■ Indicators
: ON : OFF

 

1 Speaker 7 MAC address

2 Microphone 8 LAN terminal*1

3 Call Button 9 Reset button*1*2

4 Status indicator (orange/blue) 10 Low voltage cable connection terminal*1

5 Communication indicator (orange) 11 Terminal cover

6 Call indicator (green)

Name Status (pattern) Description

Status 
indicator

Orange 
flashing

Normal flashing Booting

Fast flashing Device error, 
Startup error

Long OFF time flashing Communication 
failure

Long irregular flashing Firmware
version updating

Long irregular flashing Initializing

Blue light Standby

Note

• For a status other than those noted here, refer to "Operation Manual."

1

2

3

4
5

6

7
8
9

11
10

Back

0.75sec 0.75sec

0.25sec 0.25sec

0.5sec 4sec

１sec 0.25sec 0.25sec 0.25sec 0.25sec 0.25sec

１sec 0.25sec 0.25sec 0.25sec
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4.7 I/O Adaptor (IXW-MA)

■Part names

*1 The panel must be removed to access it.

*2 Press and hold the reset button for 1 - 4 seconds, then release to restart station.

■ Indicators
: ON : OFF

 

1 MAC address*1 4 Status indicator (orange/blue)*1

2 Panel 5 Option connector terminal

3 Reset button*1*2 6 LAN terminal

Name Status (pattern) Description

Status 
indicator

Orange 
flashing

Normal flashing Booting

Fast flashing Device error, 
Startup error

Long OFF time flashing Communication 
failure

Long irregular flashing Firmware
version updating

Long irregular flashing Initializing

Blue light Standby

3

2

4

1 5

6

Back

0.75sec 0.75sec

0.25sec 0.25sec

0.5sec 4sec

１sec 0.25sec 0.25sec 0.25sec 0.25sec 0.25sec

１sec 0.25sec 0.25sec 0.25sec
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5. Configuring the system

After installing and connecting all stations, the system will need to be fully configured before it will be operational.
IX system can be configured in one of the two methods below. Choose one method. Using the "IX Support Tool" (1) is 
recommended.
(1) Configure the system using the "IX Support Tool" application

– Install the application on a PC and use to create the configuration for all stations.
– Search for IX stations on the network; assign and upload configuration data for the system.

(2) Configure each station through a Web browser (WEB Settings Access)
– Access each station through a Web browser and enter setting data.
– When using the Web browser method, each station must be configured separately.

Important

• Once the system has been configured through a browser, the settings cannot be transferred to the IX Support Tool. Using the 
IX Support Tool is the recommended method to manage settings.

• If web browser configuration is used to change the "Identification" “Number♦ (→page 170)”, "ID and Password" “Administrator 
ID♦ (→page 175)” and “Administrator Password♦ (→page 175)”, "IPv4 Address" “IP Address♦ (→page 182)”, IPv6 Address" 
“IP Address♦ (→page 183)”, "Address Book" “Station List (→page 209)”, and "Call Settings" “Called Stations (Door/Sub 
Stations) (except IX-MV7-*, IX-MV, and IXW-MA) (→page 225)” after configured using the IX Support Tool, it will not be 
applied to the IX Support Tool settings.

• Save the settings after configuring the system.
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6. Flowcharts for configuring the system

When configuring the system using IX Support Tool, follow the flowchart that fits the application.
Save the settings after configuring the system. Otherwise, it may become impossible to restore the settings after 
maintenance or after-sales servicing.
Flowcharts are for configuration using IX Support Tool.
To configure a station through a Web browser, refer to "Web Setting Manual" for each station.

• “Creating new data (→page 30)”

For Static IPv4 Address • “Change the settings (For static IPv4 address) (→page 32)”

• “Add a station (For static IPv4 address) (→page 34)”

• “Delete a station (For static IPv4 address) (→page 35)”

• “Replace a station (For static IPv4 address) (→page 36)”

• “Creating new data (→page 37)”

For IPv4 Address with DHCP • “Change the settings (For IPv4 address with DHCP) 
(→page 39)”

• “Add a station (For IPv4 address with DHCP) (→page 41)”

• “Delete a station (For IPv4 address with DHCP) (→page 43)”

• “Replace a station (due to malfunction, etc.) (For IPv4 address 
with DHCP) (→page 44)”

• “Creating new data (→page 46)”

For Static IPv6 Address • “Change the settings (For static IPv6 address) (→page 48)”

• “Add a station (For static IPv6 address) (→page 50)”

• “Delete a station (For static IPv6 address) (→page 52)”

• “Replace a station (due to malfunction, etc.) (For static IPv6 
address) (→page 53)”
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• “Creating new data (→page 55)”

For stateless IPv6 Address • “Change the settings (For stateless IPv6 address) 
(→page 57)”

• “Add a station (For stateless IPv6 address) (→page 59)”

• “Delete a station (For stateless IPv6 address) (→page 61)”

• “Replace a station (due to malfunction, etc.) (For stateless 
IPv6 address) (→page 62)”

• “Creating new data (→page 64)”

For IPv6 Address with DHCP • “Change the settings (For IPv6 address with DHCP) 
(→page 66)”

• “Add a station (For IPv6 address with DHCP) (→page 68)”

• “Delete a station (For IPv6 address with DHCP) (→page 70)”

• “Replace a station (due to malfunction, etc.) (For IPv6 address 
with DHCP) (→page 71)”



30

Introduction

6.1 For static IPv4 Address

6.1.1 Creating new data

Use flowchart to create new configuration, e.g., when installing a new system.

Important

• Save the setting file after configuring the system. Refer to “Exporting the IX Support Tool System Configuration (→page 150)”.
If the settings are not saved, it may be impossible to restore them after maintenance or after-sales servicing.

1. Set the language.
“Language (→page 158)”

2. Perform the "Create New System" procedure
“Create new system/import setting data (→page 123)”
If using the Wizard function to create a new system, refer to “Use the Wizard function to easily set up the system and make 
it operational (→page 125)” for further instructions and continue from Step 8.

3. Configure using "Table View"
Follow the instructions for each setting item and perform setup.“System Settings (Table View) (→page 169)”

4. Install all stations.
Note the MAC addresses of all the stations.

5. Associate the created setting data to the station.
“Association Settings (→page 160)”

6. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

7. Set the time for all stations.
“Time (→page 177)”
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8. Set the display language for each station (IX-MV7-*, IX-MV).
Refer to each station's Operation Manual.

9. Complete
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6.1.2 Change the settings (For static IPv4 address)

Use this flowchart when changing the settings.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. Perform setup.
Follow the instructions for each setting item and perform setup.
“System Settings (Table View) (→page 169)”“System Settings (Station View) (→page 374)”

Were any of the following changed? "Number," "Name," "Location," "IP Address," "Location 
Registry," "Camera Name"

YES NO

Was "IP Address" changed from among these options? 4. Upload the setting data to 
the station whose settings 
were changed.
“Upload Settings To Station 
(→page 145)”

YES NO

4. Because the setting data 
for the station whose IP 
address was changed is no 
longer associated, re-
associate the data.
“Association Settings (→page 160)”
The station will be restarted, and the 
changed IP Address will be reflected in 
the station.

4. Upload the setting data to 
all stations.
“Upload Settings To Station 
(→page 145)”

5. Complete
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5. Upload the setting data to 
all stations.
“Upload Settings To Station 
(→page 145)”

5. Complete

6. Complete
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6.1.3 Add a station (For static IPv4 address)

Use flowchart to add a station.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. Add the setting data.
“System Settings (Table View) (→page 169)”
First, add the station data to “Station Information (→page 170)”.

4. Install the additional station.

5. Associate the setting data with the additional station.
“Association Settings (→page 160)”

6. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

7. Set the time for the additional station.
“Time (→page 177)”

8. Set the display language for the additional station (IX-MV7-*, IX-MV only).
Refer to the Operation Manual for each station.

9. Complete
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6.1.4 Delete a station (For static IPv4 address)

Use flowchart to delete a station.

Important

• If a page is placed without deleting the station from the system, the operation may be delayed.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. Delete the data of the station to be deleted.
“Remove Station (→page 173)”

4. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

5. Complete
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6.1.5 Replace a station (For static IPv4 address)

Use flowchart to replace a station.

1. Set the language.
“Language (→page 158)”

Can the setting data of the station to be replaced be retrieved?
YES NO

2. Retrieve the setting data from the station to 
be replaced.
“Download Settings From Station (→page 143)”

2. Replace the station.
Note the MAC address of the station to be replaced.

3. Replace the station.
Note the MAC address of the station to be replaced.

3. Replace the setting data.
*If the settings were changed with the station, they cannot be 
reflected.
“Station Replacement (→page 162)”

4. Replace the setting data.
“Station Replacement (→page 162)”

4. Set the display language for the replaced 
station (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.

5. Set the display language for the replaced 
station (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.

5. Complete

6. Complete



37

Introduction

6.2 For IPv4 address with DHCP

6.2.1 Creating new data

Use flowchart to create new configuration, e.g., when installing a new system.

Important

• Due to the architecture of the IX system, DHCP configuration is only recommended for network environments utilizing 
managed (static) IP address leasing.

• Save the setting file after configuring the system. Refer to “Exporting the IX Support Tool System Configuration (→page 150)”.
If the settings file is not saved, it may be impossible to restore if post-installation service or maintenance is required.

1. Set up the DHCP server.

2. Set the language.
“Language (→page 158)”

3. "Create New System"
“Create new system/import setting data (→page 123)”
If using the Wizard function to create a new system, refer to “Use the Wizard function to easily set up the system and make 
it operational (→page 125)” for further instructions and continue from Step 9.

4. Configure using "Table View"
Follow the instructions for each setting item and perform setup.“System Settings (Table View) (→page 169)”

5. Install all stations.
Note the MAC addresses of all the stations.

6. Associate the created setting data to the station.
“Association Settings (→page 160)”
Each station is restarted and the IP address assigned by DHCP server will be assigned.
If a DHCP address cannot be assigned, it will default to "192.168.1.160."
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7. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

8. Set the time for all stations.
“Time (→page 177)”

9. Set the display language for each station (IX-MV7-*, IX-MV).
Refer to each station's Operation Manual.

10. Complete
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6.2.2 Change the settings (For IPv4 address with DHCP)

Use this flowchart when changing the settings.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. Perform setup.
Follow the instructions for each setting item and perform setup.
“System Settings (Table View) (→page 169)”“System Settings (Station View) (→page 374)”

Were any of the following changed? "Number," "Name," "Location," "IP Address," "Location 
Registry," "Camera Name"

YES NO

Was "IP Address" changed from among these options? 4. Upload the setting data to 
the station whose settings 
were changed.
“Upload Settings To Station 
(→page 145)”

YES NO

4. Because the setting data 
for the station whose IP 
address was changed is no 
longer associated, re-
associate the data.
“Association Settings (→page 160)”
The station will be restarted, and the 
changed IP Address will be reflected in 
the station.

4. Upload the setting data to 
all stations.
“Upload Settings To Station 
(→page 145)”

5. Complete
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5. Upload the setting data to 
all stations.
“Upload Settings To Station 
(→page 145)”

5. Complete

6. Complete
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6.2.3 Add a station (For IPv4 address with DHCP)

Use flowchart to add a station.

1. Configure so that the IP address for the station to be added to the DHCP server is assigned 
as a static address.
For information on DHCP server setting methods, refer to the DHCP server manual.

2. Set the language.
“Language (→page 158)”

3. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

4. Add the setting data.
“System Settings (Table View) (→page 169)”
First, add the station data to “Station Information (→page 170)”.

5. Install the additional station.

6. Associate the setting data with the additional station.
“Association Settings (→page 160)”
The station is restarted and the IP address assigned by DHCP server will be assigned.
If a DHCP address cannot be assigned, it will default to "192.168.1.160."

7. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”
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8. Set the time for the additional station.
“Time (→page 177)”

9. Set the display language for the additional station (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.

10. Complete
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6.2.4 Delete a station (For IPv4 address with DHCP)

Use flowchart to delete a station.

Important

• If a page is placed without deleting the station from the system, the operation may be delayed.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. From the setting data, delete the data of the station to be deleted.
“Remove Station (→page 173)”

4. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

5. Complete
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6.2.5 Replace a station (due to malfunction, etc.) (For IPv4 address with DHCP)

Use flowchart to replace a station.

Can the setting data of the station to be replaced be retrieved?
YES NO

1. Retrieve the setting data from the station to 
be replaced.
“Download Settings From Station (→page 143)”

1. Replace the station.
Note the MAC address of the station to be replaced.

2. Configure so that the IP address for the new station to be installed on the DHCP server is 
carried over from the old station.
For information on DHCP server setting methods, refer to the DHCP server manual.

3. Set the language.
“Language (→page 158)”

4. Replace the station.
Note the MAC address of the station to be replaced.

4. Replace the setting data.
*If the settings were changed with the station, they cannot be 
reflected.
“Station Replacement (→page 162)”
The station is restarted and the IP address set by DHCP 
server will be assigned. If the IP address assignment fails, it 
will default to "192.168.1.160." If this happens, cycle power 
to the station, and then the IP Address will be reassigned.

5. Replace the setting data.
“Station Replacement (→page 162)”
The station is restarted and the IP address assigned by 
DHCP server will be assigned.
If a DHCP address cannot be assigned, it will default to 
"192.168.1.160."

5. Set the display language of the replaced 
station (IX-MV7-*, IX-MV).
Refer to each station's Operation Manual.
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6. Set the display language of the replaced 
station (IX-MV7-*, IX-MV).
Refer to each station's Operation Manual.

6. Complete

7. Complete
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6.3 For static IPv6 Addres

6.3.1 Creating new data

Use flowchart to create new configuration, e.g., when installing a new system.

Important

• Save the setting file after configuring the system. Refer to “Exporting the IX Support Tool System Configuration (→page 150)”.
If the settings are not saved, it may be impossible to restore them after maintenance or after-sales servicing.

1. Set the language.
“Language (→page 158)”

2. Perform "Create New System."
“Create new system/import setting data (→page 123)”
If using the Wizard function to create a new system, refer to “Use the Wizard function to easily set up the system and make 
it operational (→page 125)” for further instructions and continue from Step 9.

3. Perform setup using "Table View."
Follow the instructions for each setting item and perform setup.“System Settings (Table View) (→page 169)”

4. Install all stations.
Note the MAC addresses of all the stations.

5. Associate the created setting data to the station.
“Association Settings (→page 160)”

6. Set the communication method for the IX Support Tool to "IPv6."
“IX Support Tool Settings (→page 156)”
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7. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

8. Set the time for all stations.
“Time (→page 177)”

9. Set the display language for all stations (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.

10. Complete
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6.3.2 Change the settings (For static IPv6 address)

Use this flowchart when changing the settings.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. Perform setup.
Follow the instructions for each setting item and perform setup.
“System Settings (Table View) (→page 169)”“System Settings (Station View) (→page 374)”

Were any of the following changed? "Number," "Name," "Location," "IP Address," "Location 
Registry," "Camera Name"

YES NO

Was "IP Address" changed from among these options? 4. Upload the setting data to 
the station whose settings 
were changed.
“Upload Settings To Station 
(→page 145)”

YES NO

4. Because the setting data 
for the station whose IP 
address was changed is no 
longer associated, re-
associate the data.
“Association Settings (→page 160)”
The station will be restarted, and the 
changed IP Address will be reflected in 
the station.

4. Upload the setting data to 
all stations.
“Upload Settings To Station 
(→page 145)”

5. Complete
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5. Upload the setting data to 
all stations.
“Upload Settings To Station 
(→page 145)”

5. Complete

6. Complete
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6.3.3 Add a station (For static IPv6 address)

Use flowchart to add a station.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. Set the communication method for the IX Support Tool to "IPv4."
“IX Support Tool Settings (→page 156)”

4. Add the setting data.
“System Settings (Table View) (→page 169)”
First, add the station data to “Station Information (→page 170)”.

5. Install the additional station.
Note the MAC addresses of all the stations.

6. Associate the setting data with the additional station.
“Association Settings (→page 160)”

7. Set the communication method for the IX Support Tool to "IPv6."
“IX Support Tool Settings (→page 156)”

8. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”
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9. Set the time for the additional station.
“Time (→page 177)”

10. Set the display language for the additional station (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.

11. Complete
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6.3.4 Delete a station (For static IPv6 address)

Use flowchart to delete a station.

Important

• If a page is placed without deleting the station from the system, the operation may be delayed.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. From the setting data, delete the data of the station to be deleted.
“Remove Station (→page 173)”

4. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

5. Complete
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6.3.5 Replace a station (due to malfunction, etc.) (For static IPv6 address)

Use flowchart to replace a station.

1. Set the language.
“Language (→page 158)”

Can the setting data of the station to be replaced be retrieved?
YES NO

2. Retrieve the setting data from the station to 
be replaced.
“Download Settings From Station (→page 143)”

2. Replace the station.
Note the MAC address of the station to be replaced.

3. Replace the station.
Note the MAC address of the station to be replaced.

3. Change "Static / DHCP" to "Static IPv6" for 
the newly installed station and configure an 
appropriate "IPv6 Address."
To configure a station through a Web browser, refer to the 
Web Setting Manual for each station.

4. Change "Static / DHCP" to "Static IPv6" for 
the newly installed station and configure an 
appropriate "IPv6 Address."
To configure a station through a Web browser, refer to the 
Web Setting Manual for each station.

4. Replace the setting data.
*If the settings were changed with the station, they cannot be 
reflected.
“Station Replacement (→page 162)”

5. Replace the setting data.
“Station Replacement (→page 162)”

5. Set the display language for the replaced 
station (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.
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6. Set the display language for the replaced 
station (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.

6. Complete

7. Complete
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6.4 For stateless IPv6 address

6.4.1 Creating new data

Use flowchart to create new configuration, e.g., when installing a new system.

Important

• Save the setting file after configuring the system. Refer to “Exporting the IX Support Tool System Configuration (→page 150)”.
If the settings are not saved, it may be impossible to restore them after maintenance or after-sales servicing.

1. Install a device (router, etc.) that can transmit Router Advertisement (RA) (that can perform 
stateless auto-configuration).
Do not change the device so that it cannot transmit Router Advertisement (RA). For how to set up, refer to the manual of the 
device.

2. Set the language.
“Language (→page 158)”

3. Perform "Create New System."
“Create new system/import setting data (→page 123)”
If using the Wizard function to create a new system, refer to “Use the Wizard function to easily set up the system and make 
it operational (→page 125)” for further instructions and continue from Step 10.

4. Perform setup using "Table View."
Follow the instructions for each setting item and perform setup.“System Settings (Table View) (→page 169)”

5. Install all stations.
Note the MAC addresses of all the stations.
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6. Associate the created setting data to the station.
“Association Settings (→page 160)”
Each station is restarted and IPv6 Address will be automatically configured.
If IP Address fails to be automatically configured, it will become "FDC2::7000." If this happens, cycle power to the station, 
and then the IP Address will be automatically reconfigured.

7. Set the communication method for the IX Support Tool to "IPv6."
“IX Support Tool Settings (→page 156)”

8. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

9. Set the time for all stations.
“Time (→page 177)”

10. Set the display language for all stations (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.

11. Complete
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6.4.2 Change the settings (For stateless IPv6 address)

Use this flowchart when changing the settings.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. Perform setup.
Follow the instructions for each setting item and perform setup.
“System Settings (Table View) (→page 169)”“System Settings (Station View) (→page 374)”

Were any of the following changed? "Number," "Name," "Location," "IP Address," "Location 
Registry," "Camera Name"

YES NO

Was "IP Address" changed from among these options? 4. Upload the setting data to 
the station whose settings 
were changed.
“Upload Settings To Station 
(→page 145)”

YES NO

4. Because the setting data 
for the station whose IP 
address was changed is no 
longer associated, re-
associate the data.
“Association Settings (→page 160)”
The station will be restarted, and the 
changed IP Address will be reflected in 
the station.

4. Upload the setting data to 
all stations.
“Upload Settings To Station 
(→page 145)”

5. Complete
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5. Upload the setting data to 
all stations.
“Upload Settings To Station 
(→page 145)”

5. Complete

6. Complete
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6.4.3 Add a station (For stateless IPv6 address)

Use flowchart to add a station.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. Add the setting data.
“System Settings (Table View) (→page 169)”
First, add the station data to “Station Information (→page 170)”.

4. Install the additional station.

5. Set the communication method for the IX Support Tool to "IPv4."
“IX Support Tool Settings (→page 156)”

6. Associate the setting data with the additional station.
“Association Settings (→page 160)”
The station is restarted and IPv6 Address will be automatically configured.
If IP Address fails to be automatically configured, it will become "FDC2::7000." If this happens, cycle power to the station, 
and then the IP Address will be automatically reconfigured.

7. Set the communication method for the IX Support Tool to "IPv6."
“IX Support Tool Settings (→page 156)”
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8. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

9. Set the time for the additional station.
“Time (→page 177)”

10. Set the display language for the additional station (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.

11. Complete
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6.4.4 Delete a station (For stateless IPv6 address)

Use flowchart to delete a station.

Important

• If a page is placed without deleting the station from the system, the operation may be delayed.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. From the setting data, delete the data of the station to be deleted.
“Remove Station (→page 173)”

4. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

5. Complete
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6.4.5 Replace a station (due to malfunction, etc.) (For stateless IPv6 address)

Use flowchart to replace a station.

1. Set the language.
“Language (→page 158)”

Can the setting data of the station to be replaced be retrieved?
YES NO

2. Retrieve the setting data from the station to 
be replaced.
“Download Settings From Station (→page 143)”

2. Replace the station.
Note the MAC address of the station to be replaced.

3. Replace the station.
Note the MAC address of the station to be replaced.

3. Change "Static / DHCP" to "Static IPv6" for 
the newly installed station and configure an 
appropriate "IPv6 Address."
To configure a station through a Web browser, refer to the 
Web Setting Manual for each station.

4. Change "Static / DHCP" to "Static IPv6" for 
the newly installed station and configure an 
appropriate "IPv6 Address."
To configure a station through a Web browser, refer to the 
Web Setting Manual for each station.

4. Replace the setting data.
*If the settings were changed with the station, they cannot be 
reflected.
“Station Replacement (→page 162)”
The station is restarted and IPv6 Address will be 
automatically configured.
If IP Address fails to be automatically configured, it will 
become "FDC2::7000." If this happens, cycle power to the 
station, and then the IP Address will be automatically 
reconfigured.
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5. Replace the setting data.
“Station Replacement (→page 162)”
The station is restarted and IPv6 Address will be 
automatically configured.
If IP Address fails to be automatically configured, it will 
become "FDC2::7000." If this happens, cycle power to the 
station, and then the IP Address will be automatically 
reconfigured.

5. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

6. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

6. Set the display language for the replaced 
station (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.

7. Set the display language for the replaced 
station (IX-MV7-*, IX-MV).
Refer to the Operation Manual for each station.

7. Complete

8. Complete
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6.5 For IPv6 address with DHCP

6.5.1 Creating new data

Use flowchart to create new configuration, e.g., when installing a new system.

Important

• Save the setting file after configuring the system. Refer to “Exporting the IX Support Tool System Configuration (→page 150)”.
If the settings are not saved, it may be impossible to restore them after maintenance or after-sales servicing.

1. Set up the DHCP server.
Configure so that a static IP address is assigned to the station by the DHCP server.
DUID of the station is "00030001 + MAC address."
For information on DHCP server setting methods, refer to the DHCP server manual.

2. Set the language.
“Language (→page 158)”

3. "Create New System"
“Create new system/import setting data (→page 123)”
If using the Wizard function to create a new system, refer to “Use the Wizard function to easily set up the system and make 
it operational (→page 125)” for further instructions and continue from Step 10.

4. Configure using "Table View"
Follow the instructions for each setting item and perform setup.“System Settings (Table View) (→page 169)”

5. Install all stations.
Note the MAC addresses of all the stations.
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6. Associate the created setting data to the station.
“Association Settings (→page 160)”
The station is restarted and the IPv6 Address assigned by DHCP server beforehand will be assigned.
If a DHCP address cannot be assigned, it will default to "FDC2::7000."

7. Choose "IPv6" for the communication method of IX Support Tool.
“IX Support Tool Settings (→page 156)”

8. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

9. Set the time for all stations.
“Time (→page 177)”

10. Set the display language for each station (IX-MV7-*, IX-MV).
Refer to each station's Operation Manual.

11. Complete
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6.5.2 Change the settings (For IPv6 address with DHCP)

Use this flowchart when changing the settings.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. Perform setup.
Follow the instructions for each setting item and perform setup.
“System Settings (Table View) (→page 169)”“System Settings (Station View) (→page 374)”

Did you change the "Number," "Name," "Location," "IP Address," "Location Registry," or " 
Camera Name?"

YES NO

Was "IP Address" changed from among these options? 4. Upload the setting data to 
the station whose settings 
were changed.
“Upload Settings To Station 
(→page 145)”

YES NO

4. Cancel the association for 
the setting data for the station 
whose IP address was 
changed, then re-associate 
the data.
“Association Settings (→page 160)”
The station will be restarted, and the 
changed "IP Address" will be reflected 
in the station.

4. Upload the setting data to 
all stations.
“Upload Settings To Station 
(→page 145)”

5. Complete
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5. Upload the setting data to 
all stations.
“Upload Settings To Station 
(→page 145)”

5. Complete

6. Complete
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6.5.3 Add a station (For IPv6 address with DHCP)

Use flowchart to add a station.

1. Configure so that the IP address for the station to be added to the DHCP server is assigned 
as a static address.
For information on DHCP server setting methods, refer to the DHCP server manual.

2. Set the language.
“Language (→page 158)”

3. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

4. Add the setting data.
“System Settings (Table View) (→page 169)”
First, add the station data to “Station Information (→page 170)”.

5. Install the additional station.

6. Choose "IPv4" for the communication method of IX Support Tool.
“IX Support Tool Settings (→page 156)”

7. Associate the setting data with the additional station.
“Association Settings (→page 160)”
The station is restarted and the IPv6 Address assigned by DHCP server beforehand will be assigned.
If a DHCP address cannot be assigned, it will default to "FDC2::7000."
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8. Choose "IPv6" for the communication method of IX Support Tool.
“IX Support Tool Settings (→page 156)”

9. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

10. Set the time for the additional station.
“Time (→page 177)”

11. Set the display language of the station to add (IX-MV7-*, IX-MV).
Refer to each station's Operation Manual.

12. Complete
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6.5.4 Delete a station (For IPv6 address with DHCP)

Use flowchart to delete a station.

Important

• If a page is placed without deleting the station from the system, the operation may be delayed.

1. Set the language.
“Language (→page 158)”

2. Retrieve the setting data for all the stations.
“Download Settings From Station (→page 143)”

3. From the setting data, delete the data of the station to be deleted.
“Remove Station (→page 173)”

4. Upload the setting data to all stations.
“Upload Settings To Station (→page 145)”

5. Complete
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6.5.5 Replace a station (due to malfunction, etc.) (For IPv6 address with DHCP)

Use flowchart to replace a station.

Can the setting data of the station to be replaced be retrieved?
YES NO

1. Retrieve the setting data from the station to 
be replaced.
“Download Settings From Station (→page 143)”

1. Replace the station.
Note the MAC address of the station to be replaced.

2. Configure so that the IP address for the new station to be installed on the DHCP server is 
carried over from the old station.
For information on DHCP server setting methods, refer to the DHCP server manual.

3. Set the language.
“Language (→page 158)”

4. Replace the station.
Note the MAC address of the station to be replaced.

4. Change "Static / DHCP" to "Static IPv6" for 
the newly installed station and configure an 
appropriate "IPv6 Address."
To configure a station through a Web browser, refer to Web 
Setting Manual for each station.

5. Change "Static / DHCP" to "Static IPv6" for 
the newly installed station and configure an 
appropriate "IPv6 Address."
To configure a station through a Web browser, refer to Web 
Setting Manual for each station.

5. Replace the setting data.
*If the settings were changed with the station, they cannot be 
reflected.
“Station Replacement (→page 162)”
The station is restarted and the IPv6 Address assigned by 
DHCP server beforehand will be assigned.
If a DHCP address cannot be assigned, it will default to 
"FDC2::7000."
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6. Replace the setting data.
“Station Replacement (→page 162)”
The station is restarted and the IPv6 Address assigned by 
DHCP server beforehand will be assigned.
If a DHCP address cannot be assigned, it will default to 
"FDC2::7000."

6. Set the display language of the replaced 
station (IX-MV7-*, IX-MV).
Refer to each station's Operation Manual.

7. Set the display language of the replaced 
station (IX-MV7-*, IX-MV).
Refer to each station's Operation Manual.

7. Complete

8. Complete



Startup and
Configuration
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1. System requirements

PC requirements for using the IX Support Tool.

Operating System Windows 7 Professional, Windows 7 Enterprise, Windows 7 Ultimate
Windows 8, Windows 8 pro, Windows 8 Enterprise
Windows 8.1, Windows 8.1 pro, Windows 8.1 Enterprise
Windows 10 Home, Windows 10 pro, Windows 10 Enterprise
Windows 10 Education

CPU 32 bit (x86) processor or 64 bit (x64) processor of 1 GHz or higher

Memory 4 GB RAM or higher

Resolution 1280x768 or greater
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2. Installing IX Support Tool

1. Access our Web site at https://www.aiphone.net/product/support/ and download the IX Support Tool 
to your PC.

2. Extract the downloaded file.
Double-click "setup.exe" in the extracted folder and install IX Support Tool.
• If .NET Framework4.5 is not installed yet, install .NET Framework4.5 first. Install this, following the 

instructions on the screen.

3. Click [Next].

4. Choose the location to install the IX Support Tool and the user who will use the IX Supervision Tool, 
then click [Next].

https://www.aiphone.net/product/support/
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5. Click [Next].

6. Click [Close].

• IX Support Tool is now installed.

Important

• If using a PC with user privileges, select "All Users."
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3. Login and registration of the station

1. Double-click the "AIPHONE IX SupportTool" shortcut created on the desktop or 
"AIPHONE_IX_SupportTool.exe" in the folder specified during installation.
By default, it will be installed in "Computer > Local Disk(C) > Program Files > AIPHONE_IX_SupportTool."

2. Enter "ID" and "Password" and click [Login].
• The setting data configured during the previous login session will be shown.
• If logging into the IX Support Tool for the first time, proceed to Step 3.

• The default ID and Password are "admin."

3. When first logging into IX Support Tool, the "New System" screen is displayed.
Refer to “Create new system/import setting data (→page 123)” and proceed with the setup.
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Once "New System" configuration is complete, setting data is automatically generated and the Settings (Table 
View) screen is displayed.

“Restore System Settings (→page 164)” “Reading in data created by another IX Support Tool (→page 139)”

Wizard function
selection

System settings
Number of Stations 
settings

Select the automatic
door release setting
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4. How to configure

When logging into the IX Support Tool, the following setting window will be shown. Each station can be configured 
from this window.
• Depending on PC and OS being used, the window may be slightly different.
• After setup, refer to the Operation Manual for each station and confirm operation.

4.1 Settings window

Settings screen sample

Table View(→page 169)
Configure all the stations in the system from the Settings window.

Setting switching: Click to switch to Settings (Station View).

Menu bar: Allows user to create new setting data, save the settings, 

etc.(→page 122)

Notes: Displays notes.

Update: Click this button to update the station settings.

Setting menu: Show all items that can be configured. Click the title to be 

configured to display the appropriate Settings screen.

Title bar: Displays the system name and title when editing 

settings.

Settings screen: The Settings screen for the currently 

selected title is displayed.
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Station View(→page 374)
Station settings can be configured for each station in the system.

Note

• Settings which cannot be modified will be grayed out.

Setting switching: Click to switch to Settings (Table 

View).

Menu bar: Allows user to create new setting data, save 

the settings, etc.(→page 122)

Select Station to Edit: 
Allows user to change the 
station to be edited.

Copy Settings: Copies the settings 
currently being edited to another 
station.(→page 83)

Update: Click this button to update the station settings.

Setting menu: Show all items that can be configured. Click the title to be configured to 

display the appropriate Settings screen.

Settings screen: The Settings screen for the 

currently selected title is displayed.

Displays station information while editing settings.

Title bar: Displays the system name and title when 

editing settings.
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4.2 How to configure

1. Click the title to be configured.
• The Settings window for that particular title will be shown.

2. Enter setting values for each entry.
• The selected field will turn orange. (Settings (Table View) only)
• When changing the settings, the field will turn pink. (Settings (Table View) only)
• Some titles allow copy and paste.

• Select an entry field and press the F1 key to display a Detailed Explanation (Settings (Table View) only).

3. When you are done configuring on this screen, click [Update] to save the settings.
• To cancel all settings, click another title in the Setting menu.
• If there is an error when clicking [Update], the error message will be shown and the settings will not be 

allowed to be saved.
The field will be shown in red if there is an error. (Settings (Table View) only)

Important

• Be sure to input the settings for entries in red. Upon use, leave the unnecessary items at their default values.

Move to related item: This allows you to move to the Settings screen for related entries.
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• If another title is selected without clicking [Save], the system will prompt whether to save the settings. Click 
[Yes] to save the settings; click [No] to continue without saving.

• Click [Cancel] to return to the original screen.

4. Perform Steps 1 - 3 for other titles as well. 
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4.3 Copy settings (Settings (Station View))

Copy the settings marked with "♠" in Settings (Station View). The copied settings can be applied either to all station 
types or to all stations of the same type.

How to copy the settings

1. Click the title of the entry to copy and display the Settings screen.

2. Select "Copy to all stations" or "Copy to stations by Type."

3. Select the items to be copied from "Settings."

4. Click [Copy].
• The "♠" entries will be copied.

2

3

4
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Important

• Please copy the setting items below after copying “Custom Sound Registry (except IXW-MA) (→page 416)”.

– "Call Origination" - “Ringback Tone (except IX-MV) ♠ (→page 423)”

– "Call Origination" - “Busy Tone (except IX-MV)♠ (→page 429)”

– "Call Origination" - “Error Tone (Call Failed) (except IX-MV7-* and IX-MV)♠ (→page 430)”

– "Incoming Call" - “Ringtone (→page 432)”

– "Incoming Call" - “Call Button (for IX-MV7-* and IX-MV) (→page 433)”

– "Incoming Call" - “Option Input (for IX-MV7-* and IX-MV) (→page 434)”

– "Relay Output" - “Door Release (→page 445)”

– "Relay Output" - “Relay Control (start) (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*)) (→page 445)”

– "Relay Output" - “Relay Control (end) (except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*)) (→page 446)”

– "Option Input Page" - “Message File Name (→page 454)”

– "Network Camera Integration" - “Event Tone (for IX-MV)♠ (→page 460)”

– "Paging Settings" - “Paging Pretone (→page 461)”

– "Communication Audio Messages" - "Start Communication" - “Message (→page 489)”

– "Communication Audio Messages" - "Code Received" - “Message (→page 490)”

– "Chime" - "Weekly Schedule" - “Chime (→page 492)”

– "Chime" - "Daily Schedule" - “Chime (→page 494)”

– "Speed Dials / Favorites" - "Group Message Page" - “Message (→page 522)”

– "Speed Dials / Favorites" - "All Message Page" - “Message (→page 523)”

– "Volume / Tone" - “Communication Timeout Notification (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠ 
(→page 529)”

– "Volume / Tone" - “Communication End Pretone (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠ (→page 530)”

– "Volume / Tone" - “Call Queue Notification (for IX-MV7-*)♠ (→page 530)”

– "Volume / Tone" - “Paging Pretone (for IX-MV7-* and IX-MV) ♠ (→page 531)”

– "Volume / Tone" - “Auto Answer Tone (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠ (→page 531)”

– "Volume / Tone" - “On Hold (for IX-MV7-*)♠ (→page 532)”

– "Volume / Tone" - “Key Received (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))♠ (→page 532)”

– "Volume / Tone" - “Error (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠ (→page 533)”

– "Communication" - “Communication Start Tone (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠ 
(→page 535)”

– "Monitor" - “Monitored Notification (except IX-MV7-* and IX-MV) ♠ (→page 537)”



85

Startup and Configuration

5. System settings list

The following items can be configured using IX Support Tool.
The symbols indicate the following:
♦: Be sure to input the settings. Upon use, leave the unnecessary items at their default values.
♠: The setting item information can be copied.
• The following list is the summary of IX Support Tool. The contents, how they are displayed, and the order of entries 

may vary from the actual ones.
• Download and back up the setting file (Table View: (→page 371), Station View: (→page 548)) in case after-sales 

service is required, and store it in a safe place where it will not be lost.
If a backup has not been performed, it may not be possible to recover the data during after-sales service.

■Table View

Setting items Reference 
pages

Station Information

Identification - - Number♦ 170

Name 171

Location (except for IXW-
MA)

171

Add Station - - 172

Remove Station - - 173

Location Registry (except 
for IXW-MA)

- - 174

ID and Password - - Administrator ID♦ 175

Administrator Password♦ 175

User ID♦ 175

User Password♦ 175

ONVIF ID (IX-DV, IX-DVF(-
*), IX-DA, IX-DF(-*) only) ♦

176

ONVIF Password (IX-DV, 
IX-DVF(-*), or IX-DA, IX-
DF(-*) only) ♦

176

RTSP ID (IX-DV, IX-DVF(-
*), IX-SSA(-*), IX-SS-2G, 
IX-RS-* only) ♦

176

RTSP Password  (IX-DV, 
IX-DVF(-*), IX-SSA(-*), IX-
SS-2G, IX-RS-* only) ♦

176

Time Time Zone - Select time zone 177

Daylight Savings Time - Enable automatic daylight 
savings time

177

Manual Date / Time Setup - - 178

Expanded System 
(not used)

- - - 179
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Network Settings

IP Address - - Hostname (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

180

IP Version 180

Static / DHCP 181

IPv4 Address - IP Address♦ 182

Subnet Mask♦ 182

Default Gateway 182

IPv6 Address - IP Address♦ 183

Default Gateway 183

Batch IP Address 
Configuration

- - 183

DNS Primary Server - IPv4 185

IPv6 185

Secondary Server - IPv4 185

IPv6 185

SIP (except for IXW-
MA)

SIP Connections - SIP Signaling Port♦ 186

User Agent (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

186

SIP Server (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

Primary Server ID 186

Password 187

IPv4 Address 187

IPv6 Address 187

Port♦ 187

Secondary Server ID 187

Password 187

IPv4 Address 187

IPv6 Address 188

Port♦ 188

Tertiary Server ID 188

Password 188

IPv4 Address 188

IPv6 Address 188

Port♦ 188

Miscellaneous - Register Transmission 
Interval [sec] (except for IX-
MV, IX-DA, IX-DF(-*), IX-
BA, IX-SS(-*)) ♦

189

Setting items Reference 
pages
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DTMF digit interval timeout 
[sec] (except for IX-MV, IX-
DA, IX-DF(-*), IX-BA, IX-
SS(-*)) ♦

189

Call health check timer 
[sec]♦

189

Multicast Address
(IX-MV7-*, IX-MV, IX-
DV, IX-DVF(-*), IX-
DA, IX-DF(-*) only)

- - IPv4 190

IPv6 190

Batch Multicast Address 
Configuration

- - 191

Video (IX-MV7-*, IX-
MV, IX-DV, IX-DVF(-
*), IX-DA, IX-DF(-*) 
only)

Video Encoder 1 - Video Codec (IX-DA, IX-
DF(-*) only)

192

Resolution (IX-DV, IX-
DVF(-*), IX-DA, IX-DF(-*) 
only)

192

Frame Rate [fps] (IX-DV, 
IX-DVF(-*), or IX-DA, IX-
DF(-*) only)

193

Select Profile [H.264 / AVC] 
(IX-DV, IX-DVF(-*), or IX-
DA, IX-DF(-*) only)

193

I-picture interval [H.264/
AVC] (IX-DV, IX-DVF(-*), or 
IX-DA, IX-DF(-*) only) ♦

193

Bit rate [kbps] [H.264 / 
AVC] (IX-DV, IX-DVF(-*), or 
IX-DA, IX-DF(-*) only)

193

Select Quality [Motion-
JPEG] (IX-DA, IX-DF(-*) 
only)

194

RTP Start Port♦ 194

RTP End Port♦ 194

Video Encoder 2 - Second Video Encoder (IX-
DV, IX-DVF(-*), or IX-DA, 
IX-DF(-*) only)

195

Video Codec (IX-DV, IX-
DVF(-*), IX-DA, IX-DF(-*) 
only)

195

Resolution (IX-DV, IX-
DVF(-*), IX-DA, IX-DF(-*) 
only)

195

Frame Rate [fps] (IX-DV, 
IX-DVF(-*), or IX-DA, IX-
DF(-*) only)

195

Select Profile [H.264 / AVC] 
(IX-DV, IX-DVF(-*), or IX-
DA, IX-DF(-*) only)

196

Setting items Reference 
pages
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I-picture interval [H.264/
AVC] (IX-DV, IX-DVF(-*), or 
IX-DA, IX-DF(-*) only) ♦

196

Bit rate [kbps] [H.264 / 
AVC] (IX-DV, IX-DVF(-*), or 
IX-DA, IX-DF(-*) only)

196

Select Quality [Motion-
JPEG] (IX-DV, IX-DVF(-*), 
IX-DA, IX-DF(-*) only)

196

RTP Start Port♦ 196

RTP End Port♦ 196

Master Station Video 
Setting (IX-MV7-* only)

- Video Streaming 197

Frame Rate [fps] 197

Select Profile 197

I-picture interval♦ 197

Bit rate [kbps] 197

Audio (except for 
IXW-MA)

- - Audio Codec 200

Audio RTP Transmission 
Interval [msec]

201

RTP Idle Detection Time 
[sec]♦

202

Audio 1 RTP Start Port♦ 202

Audio 1 RTP End Port♦ 202

Audio 2 RTP Start Port♦ 202

Audio 2 RTP End Port♦ 202

Audio Buffer - Packets Buffered at Audio 
Start

202

Maximum Packets Buffered 203

Packet Priority - - TOS Value (Audio) (except 
for IXW-MA) ♦

204

TOS Value (Video) (IX-
MV7-*, IX-DV, IX-DVF(-*), 
IX-DA, IX-DF(-*) only)

204

TOS Value (SIP) (except for 
IXW-MA) ♦

204

VLAN Setting 204

VLAN ID♦ 205

VLAN Priority 205

NTP Enable NTP - - 206

Synchronization Interval 
[hour]♦

- - 206

Primary Server Address IPv4 206

IPv6 207

Port♦ - 207

Setting items Reference 
pages
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Secondary Server Address IPv4 207

IPv6 207

Port♦ - 207

System Information

Location Registry - - - 208

Address Book (IX-
MV7-* and IX-MV 
only)

Open Station List - - 209

Open Network Camera List - - 212

Open Network Camera 
Registry

Camera Name♦ 214

Hostname 214

IP Address (IPv4) 214

IP Address (IPv6) 214

ID♦ 214

Password♦ 214

Group (for Master) 
(IX-MV7-* and IX-MV 
only)

Create Group - - 218

Custom Sound 
Registry

- - - 221

Call Settings

Station Information 
(IX-RS-*, IX-DV, IX-
DVF(-*), IX-SSA(-*), 
or IX-SS-2G only)

- - Call Button Function 224

Called Stations 
(Master Stations) (IX-
MV7-* and IX-MV 
only)

- - Call Destination Settings 
are unnecessary, Master 
Station can call any station 
in Address Book.

-

Called Stations 
(Door/Sub Stations) 
(except for IX-MV7-*, 
IX-MV, or IXW-MA)

- - - 225

Setting items Reference 
pages
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Call Origination 
(except for IXW-MA)

Call Origination Advanced 
Settings

- Call Method (except for IX-
MV7-*, IX-MV, IX-DA, IX-
DF(-*), or IX-BA, IX-SS(-*))

228

Ringback Tone (except for 
IX-MV)

229

Call Timeout (except for 
[Call Button] - IX-MV) ♦

229

Ringback Tone Count 
[time(s)]  (except for IX-MV)

230

Call Destination ([Option 
Input 1 - 4] - IX-MV7-* and 
IX-MV only)

230

Standard Mode Settings 
(except for IX-MV7-* and 
IX-MV)

230

Destination Dwell 1 - 8 
(except for IX-MV7-*, IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

230

Destination Dwell Time 
(except for IX-MV7-*, IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*)) ♦

231

Weekly Schedule (except 
for IX-MV7-*, IX-MV, IX-DA, 
IX-DF(-*), or IX-BA, IX-SS(-
*))

Start Time 232

End Time 232

Call Destination 232

Priority 233

Daily Schedule (except for 
IX-MV7-*, IX-MV, IX-DA, 
IX-DF(-*), or IX-BA, IX-SS(-
*))

Start Time 234

End Time 234

Call Destination 234

Priority 235

Tone Settings - Busy Tone (except for IX-
MV)

235

Error Tone (Call Failed) 
(except for IX-MV7-* and 
IX-MV)

236

Call Restart Function 
(except for IX-MV7-*, IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

Call Restart Function 236
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Incoming Call (except 
for IX-DA, IX-DF(-*), 
IX-BA, IX-SS(-*), or 
IXW-MA)

Call Answer Settings - Auto Answer 237

Ringtone - Ringtone (except for IX-
MV7-*, IX-MV)

238

Ringback Tone Count 
(except for IX-MV7-*)

238

Call Button (IX-MV7-* and 
IX-MV only)

239

Option Input (IX-MV7-* and 
IX-MV only)

239

Call Button Ringtone Count 
[time(s)] (IX-MV7-* only)

240

Option Input Ringtone 
Count [time(s)] (IX-MV7-* 
only)

240

VoIP Phone (except for IX-
MV)

- VoIP Phone Call Priority 240

Option Input/Relay Output Settings

Option Input Option Input Advanced 
Settings

Name (except for IX-MV, 
IX-DA, IX-DF(-*), IX-BA, IX-
SS(-*), or IXW-MA)

- 241

Function - 242

Type - 242

Detection Time Detection Time Range 242

Detection Time♦ 242

API API 1 243

API 2 243

Relay Output Relay Output Advanced 
Settings

Name (except for IX-MV, 
IX-DA, IX-DF(-*), IX-BA, IX-
SS(-*), or IXW-MA)

- 244

Function - 245

Option Relay Control - 246

Output Time Range Output Time Range 247

Output Time♦ 248

Door Release Authorization 
(except for IXW-MA)

- 248
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Sound Settings (except for 
IX-MV and IXW-MA)

Door Release 249

Relay Control (start) 
(except for IX-DA, IX-DF(-*) 
and IX-BA, IX-SS(-*))

249

Relay Control (end) (except 
for IX-DA, IX-DF(-*) and IX-
BA, IX-SS(-*))

250

Weekly Schedule (except 
for IX-MV, IX-DA, IX-DF(-*), 
or IX-BA, IX-SS(-*))

Start Time 251

End Time 251

Daily Schedule (except for 
IX-MV, IX-DA, IX-DF(-*), or 
IX-BA, IX-SS(-*))

Start Time 252

End Time 253

Authentication Key - Option Relay Control 
Authentication Key (except 
for IX-MV, IX-DA, IX-DF(-*), 
or IX-BA, IX-SS(-*))

253

Paging Settings

Paging Origination 
(IX-MV7-* and IX-MV 
only)

- - Paging Timeout [sec]♦ 254

Paging Wait Timer [sec] 
(IX-MV7-* only) ♦

254

Urgent Page Response (IX-
MV7-* only)

255

Lock Paging (IX-MV7-* 
only)

255

All Page (IX-MV-* 
and IX-MV only)

- - - 256

Option Input Page 
(IX-MV7-* only)

- - Destination 257

Group Number 257

Priority 257

Message File Name 258

Play Count [time(s)] 258
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Function Settings

Door Release (IX-
MV7-* and IX-MV 
only)

Door Release Assignment - Contact Assignment 259

Authentication Key 260

Network Camera 
Integration (IX-MV7-* 
and IX-MV only)

Profile Setting - Profile 262

Event Registration - Event 262

Function (IX-MV7-* only) 262

Event Tone (IX-MV7-* only) 263

ID (IX-MV7-* only) 263

Password (IX-MV7-* only) 263

Call Origination (IX-MV7-* 
only)

264

Call Destination (IX-MV7-* 
only)

264

Priority (IX-MV7-* only) 264

Event Tone (IX-MV only) - - 264

Play count of Event Tone - - 264

Paging Settings 
(except for IX-MV7-*, 
IX-MV, or IXW-MA)

- - Paging Pretone 267

Bathroom Call (IXW-
MA only) (not used)

- - - 268

Email Server Settings - SMTP Server 269

SMTP Port♦ 269

SMTP Encryption 270

Authentication Settings - SMTP Authentication 271

Mode 271

ID 271

Password 271

Email Addresses - Destination 1 271

Destination 2 271

Destination 3 272

Source Address 272
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Email Event Trigger - Outgoing Normal Call 
(except for IXW-MA)

272

Incoming Normal Call 
(except for IX-MV, IX-DA, 
IX-DF(-*), IX-BA, IX-SS(-*), 
or IXW-MA)

272

Outgoing Priority Call 
(except for IXW-MA)

272

Incoming Priority Call 
(except for IX-MV, IX-DA, 
IX-DF(-*), IX-BA, IX-SS(-*), 
or IXW-MA)

272

Outgoing Urgent Call 
(except for IXW-MA)

272

Incoming Urgent Call 
(except for IX-MV, IX-DA, 
IX-DF(-*), IX-BA, IX-SS(-*), 
or IXW-MA)

273

Door Release Activated (IX-
MV7-*, IX-MV, or IX-RS-* 
only)

273

Call Failed (except for IXW-
MA)

273

Latch Reset (IX-RS-*, IX-
DV, IX-DVF(-*), IX-SSA(-*), 
IX-SS-2G only)

273

Error 273

Station Restarted 273

SD Card Error (IX-MV7-*, 
IX-DV, IX-DVF(-*), IX-SSA(-
*) only)

273

Recording Memory Full (IX-
MV7-*, IX-DV, IX-DVF(-*), 
IX-SSA(-*) only)

274

Line Supervision (Passed) 
(IX-MV7-* only)

274

Line Supervision (Failed) 
(IX-MV7-* only)

274

Device Check (Passed) (IX-
MV7-* only)

274

Device Check (Failed) (IX-
MV7-* only)

274

Subject 274

Periodic Log Transmission - Periodic Log Transmission 275

Periodic Log Transmit Time 275

Periodic Log Transmit 
Interval

275

Periodic Log Transmission 
Subject

276
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Send Test Email (except for 
IX-MV, IX-DA, IX-DF(-*), or 
IX-BA, IX-SS(-*))

- - 277

Additional Settings (IX-DV, 
IX-DVF(-*), IX-DA, IX-DF(-
*) only)

- Attach Image 278

Image Filename 278

CGI Integration - - CGI Functionality 279

SIF Integration SIF Functionality - - 280

SIP URI Format (except for 
IX-MV, IX-DA, IX-DF(-*), or 
IX-BA, IX-SS(-*))

- - 280

SIF Settings (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

- Program Type 281

IPv4 281

IPv6 281

Destination Port 281

SSL 281

Connection 281

Transmission Trigger 
(except for IX-MV, IX-DA, 
IX-DF(-*), or IX-BA, IX-SS(-
*))

- Begin Outgoing Call 
(except for IXW-MA)

282

Begin Communication 
(Source) (except for IXW-
MA)

282

Door Release Indication 
(IX-MV7-* and IX-RS-* 
only)

282

End Communication 
(except for IXW-MA)

282

Change contact 282

Unit error 283

Begin broadcast (IX-MV7-* 
only)

283

End broadcast (IX-MV7-* 
only)

283

Begin Transfer (IX-MV7-* 
only)

283

End Transfer (IX-MV7-* 
only)

283

Periodical Transmission 283

Initialization Notice 283

End Outgoing Call (except 
for IXW-MA)

284

Begin Incoming Call 
(except for IXW-MA)

284
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End Incoming Call (except 
for IXW-MA)

284

Latch Reset (except for IX-
MV7-* and IXW-MA)

284

Change Call Destination 
(except for IXW-MA)

284

Call Failure (except for 
IXW-MA)

284

Begin Incoming Transfer 
Call (IX-MV7-* only)

284

Begin On Hold (IX-MV7-* 
only)

285

End On Hold (IX-MV7-* 
only)

285

Begin Incoming Page 
(except for IXW-MA)

285

End Incoming Page (except 
for IXW-MA)

285

Paging Failure (IX-MV7-* 
only)

285

Begin Monitoring (IX-MV7-* 
only)

285

End Monitoring (IX-MV7-* 
only)

285

Monitoring Failure (IX-MV7-
* only)

286

Begin Monitored (except for 
IX-MV7-* and IXW-MA)

286

End Monitored (except for 
IX-MV7-* and IXW-MA)

286

Begin Communication 
(Destination) (except for 
IXW-MA)

286

Begin Privacy (IX-MV7-* 
only)

286

End Privacy (IX-MV7-* 
only)

286

Keypad Input (IX-MV7-* 
only)

286

Speed Dial Input (IX-MV7-* 
only)

287

Begin Record (IX-MV7-*, 
IX-DV, IX-DVF(-*), IX-SSA(-
*) only)

287

End Record (IX-MV7-*, IX-
DV, IX-DVF(-*), IX-SSA(-*) 
only)

287

Recording Memory Full (IX-
MV7-*, IX-DV, IX-DVF(-*), 
IX-SSA(-*) only)

287
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Passed Line Supervision 
(IX-MV7-* only)

287

Failed Line Supervision (IX-
MV7-* only)

287

Passed Device Check (IX-
MV7-* only)

288

Failed Device Check (IX-
MV7-* only)

288

SD Card Error (IX-MV7-*, 
IX-DV, IX-DVF(-*), IX-SSA(-
*) only)

288

SIP Registration Failure 
(except for IXW-MA)

288

Network Camera Event (IX-
MV7-* only)

288

Periodical Transmission 
(except for IX-MV, IX-DA, 
IX-DF(-*), or IX-BA, IX-SS(-
*))

Periodical Transmission 
Interval

Range 290

Interval♦ 290

Upload SIF File - - 291

Download SIF File - - 293

Record (IX-MV7-*, 
IX-DV, IX-DVF(-*), 
IX-SSA(-*) only)

Record Mode (IX-DV, IX-
DVF(-*), IX-SSA(-*) only)

- - 295

Record Event - Incoming Call (IX-MV7-* 
only)

297

Communication (Master) 
(IX-MV7-* only)

297

Monitor (IX-MV7-* only) 297

Outgoing Call (IX-DV, IX-
DVF(-*), IX-SSA(-*) only)

297

Communication (Door) (IX-
DV, IX-DVF(-*), IX-SSA(-*) 
only)

297

Monitored (IX-DV, IX-DVF(-
*), IX-SSA(-*) only)

297

Schedule (IX-DV, IX-DVF(-
*), IX-SSA(-*) only)

298

Recorded Device (IX-MV7-* 
only)

- - 298

Prevent Overwrite - - 298

Video Recording File 
Length

- - 298

Event Recording Timer (IX-
MV7-* only)

- - 299

Manual Recording (IX-MV7-
* only)

- - 299
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Audio Recording (IX-MV7-*,  
or IX-DV, IX-DVF(-*) only)

- - 299

Weekly Schedule (IX-DV, 
IX-DVF(-*), or IX-SSA(-*) 
only)

- Start Time 300

End Time 300

Communication 
Audio Messages (IX-
RS-*, IX-DV, IX-
DVF(-*), IX-SSA(-*), 
or IX-SS-2G  only)

Start Communication - Message 302

Code Received - Code 303

Message 303

Chime (except for IX-
MV, IX-DA, IX-DF(-*), 
IX-BA, IX-SS(-*), or 
IXW-MA)

Weekly Schedule - Start Time 304

Chime 305

Daily Schedule - Start Time 307

Chime 307

CSR - - - 308

SSL Certificate - - - 309

IEEE 802.1X (except 
for IX-MV, IX-DA, IX-
DF(-*), or IX-BA, IX-
SS(-*))

- - IEEE 802.1X 313

EAP 313

EAP User Name 314

EAP Password 314

Display Mode (IX-
MV7-* only)

Master UI Mode - - 317

Standard Mode Home Screen 318

Receptionist Mode Color Scheme - 320

Screen Layout - 321

Company Information Name 323

Text Size♦ 323

Bold 323

Text Color 323

Greeting Information Greeting 323

Text Size♦ 323

Bold 323

Text Color 324

Images Company Image 324

Greeting Image 324

Receptionist Image 325
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Button Function Button 1 325

Button 2 325

Button 3 325

Button 4 326

Button Name for Group Call 326

Button Name for Select By 
Name

326

Button Name for Select By 
List

326

Button Name for Enter 
Number

326

Group Call Destination - 326

Reject Incoming Call - 326

Bathroom Link (not 
used)

- - - 327

Transfer Settings

Absent Transfer (IX-
MV7-* and IX-MV 
only)

- - Absent Transfer 328

Transfer Destination List 328

Re-Transfer Destination 
(IX-MV7-* only)

329

Delay Transfer (IX-
MV7-* and IX-MV 
only)

- - Delay Transfer 330

Delay Time [sec]♦ 330

Transfer Destination List 330

Re-Transfer Destination 
(IX-MV7-* only)

331

Schedule Transfer 
(IX-MV7-* and IX-MV 
only)

- - Schedule Transfer 332

Weekly Schedule - Transfer Destination List 333

Re-Transfer Destination 
(IX-MV7-* only)

333

Start Time 333

End Time 333

Daily Schedule (IX-MV7-* 
only)

- Transfer Destination List 335

Re-Transfer Destination 336

Start Time 336

End Time 336

Lock Transfer (IX-
MV7-* only)

- - - 337
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Station Settings

Speed Dials / 
Favorites (IX-MV7-* 
and IX-MV only)

Advanced Speed Dial 
Button Settings

Speed Dial Name (IX-MV7-
* only)

- 338

Function - 339

Individual Call Number 339

Priority 339

Group Call Group Number 339

Priority 340

Group Page Group Number 340

Priority 340

All Page Priority 340

Group Message Page (IX-
MV7-* only)

Group Number 340

Message 341

Priority 341

Play Count [time(s)] 341

All Message Page (IX-MV7-
* only)

Message 342

Priority 342

Play Count [time(s)] 342

Monitor (IX-MV7-* only) Number 342

Network Camera Monitor 
(IX-MV7-* only)

Network Camera 343

Option Relay Control (IX-
MV7-* only)

Total 343

Output Time Range 343

Output Time♦ 344

TLS 344

Option Relay Control Key 344

Lock (IX-MV7-* only) - 344

Privacy (IX-MV7-* 
and IX-MV only)

- - Privacy 345
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Volume / Tone 
(except for IXW-MA)

Volume - Handset Transmit (IX-MV7-
*, IX-RS-*, or IX-MV only)

346

Handset Receive (IX-MV7-
*, IX-RS-*, or IX-MV only)

346

Hands-free Transmit (IX-
MV7-*, IX-RS-*, or IX-MV 
only)

346

Hands-free Receive (IX-
MV7-*, IX-RS-*, or IX-MV 
only)

347

Headset Jack Transmit (IX-
MV7-* only)

347

Headset Jack Receive (IX-
MV7-* only)

347

Transmit (except for IX-
MV7-*, IX-RS-*, or IX-MV)

347

Receive (except for IX-
MV7-*, IX-RS-*, or IX-MV)

347

External Input (not used) 347

External Output (IX-RS-* 
only)

347

VoIP Phone Volume 
Adjustment (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

347

Ringtone 348

Paging (IX-DV, IX-DVF(-*), 
and IX-SSA(-*) only)

348

Button Feedback (IX-MV7-* 
and IX-MV only)

348

Tone - Communication Timeout 
Notification (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

349

Communication End 
Pretone (except for IX-MV, 
IX-DA, IX-DF(-*), or IX-BA, 
IX-SS(-*))

350

Call Queue Notification (IX-
MV7-* only)

350

Paging Pretone (IX-MV7-* 
and IX-MV only)

351

Auto Answer Tone (except 
for IX-MV, IX-DA, IX-DF(-*), 
or IX-BA, IX-SS(-*))

351

On Hold (IX-MV7-* only) 352

Key Received (except for 
IX-MV, IX-DA, IX-DF(-*), IX-
BA, IX-SS(-*))

352
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Error (except for IX-MV7-*, 
IX-MV, IX-DA, IX-DF(-*), or 
IX-BA, IX-SS(-*))

353

Mic Select (not used) - - 353

Headset Specification (IX-
MV7-* only)

- - 353

Audio Output (for Master) 
(IX-MV7-* only)

- - 353

Audio Output (for Door) 
(except for IX-MV7-*, IX-
SS-2G, or IX-MV)

- - 354

Communication 
(except for IXW-MA)

- - Talk Timeout [sec]♦ 355

Communication Start Tone 
(except for IX-MV7-*, IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

356

Force Touch-to-Talk (IX-
MV7-* and IX-MV only)

356

Monitor (except for 
IXW-MA, IX-DA, IX-
DF(-*), or IX-BA, IX-
SS(-*))

Monitor Timeout [sec] (IX-
MV7-* and IX-MV only) ♦

- - 357

Scan Monitor (IX-MV7-* 
only)

- Type 358

Number 358

Camera Settings 358

Open Camera List 358

Prevent Being Monitored 
(except for IX-MV7-* and 
IX-MV)

- - 358

Monitored Notification Tone 
(except for IX-MV7-* and 
IX-MV)

- - 359

Monitored LED Notification 
(except for IX-MV7-* and 
IX-MV)

- - 360

Master Station 
Display (IX-MV7-* 
and IX-MV only)

- - Brightness 361

Primary Video Source (IX-
MV7-* only)

361

Aspect Ratio (IX-MV7-* 
only)

361

Time Format (IX-MV only) 361

Standby LED State 362

Keypad (IX-MV7-* only) 362
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Camera (IX-DV, IX-
DVF(-*), or IX-DA, IX-
DF(-*) only)

Adjustment - Backlight Compensation 363

Low Light Sensitivity 363

Color Settings (IX-DA, IX-
DF(-*) only)

- Brightness♦ 364

Contrast♦ 364

Color♦ 364

White LED - Call / Communication 364

Monitored 364

Door Release 
Assignment (IX-RS-* 
only)

- - Contact Assignment 365

Authentication Key 365

Door Release by IX-RS 366

Line Supervision (IX-
MV7-* only)

Line Supervision Interval - Test Interval 367

Weekly 367

Line Supervision Schedule 367

Device Check Interval - Test Interval 368

Weekly 368

Device Check Schedule 368

Maintenance

Firmware Update - - - 369

Initialization - - - 370

Settings File Backup - - - 371

syslog (except for IX-
MV, IX-DA, IX-DF(-*), 
or IX-BA, IX-SS(-*))

- - IPv4 Address 373

IPv6 Address 373

Port♦ 373
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■Station View

Setting items Reference 
pages

Station Information

Identification - - Number♦ 375

Name 375

Location (except for IXW-
MA)

375

ID and Password - - Administrator ID♦♠ 376

Administrator Password♦♠ 376

User ID♦♠ 376

User Password♦♠ 376

ONVIF ID (IX-DV, IX-DVF(-
*), IX-DA, IX-DF(-*) only) ♦♠

376

ONVIF Password (IX-
EA(U), IX-DV, IX-DVF(-*), 
and IX-DA, IX-DF(-*) only) 
♦♠

176

RTSP ID (IX-DV, IX-DVF(-
*), IX-SSA(-*), IX-SS-2G, 
IX-RS-* only) ♦♠

377

RTSP Password  (IX-DV, 
IX-DVF(-*), IX-SSA(-*), IX-
SS-2G, IX-RS-* only) ♦♠

377

Time Time Zone - Select time zone♠ 378

Daylight Savings Time - Enable automatic daylight 
savings time♠

378

Date and Time - - 378

Expanded System
(not used)

- - - 380

Network Settings

IP Address - - Hostname (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

381

Static / DHCP♠ 381

IPv4 Address - IP Address♦ 382

Subnet Mask♦♠ 382

Default Gateway♠ 382

IPv6 Address - IP Address♦ 382

Default Gateway♠ 383

DNS Primary Server♠ - IPv4 384

IPv6 384

Secondary Server♠ - IPv4 384

IPv6 384
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SIP (except for IXW-
MA)

SIP Connections - SIP Signaling Port♦♠ 385

User Agent (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

385

SIP Server (except for IX-
MV, IX-DA, IX-DF(-*), IX-
BA, IX-SS(-*), or IXW-MA)

Primary Server ID♠ 386

Password♠ 386

IPv4 Address♠ 386

IPv6 Address♠ 386

Port♦♠ 386

Secondary Server ID♠ 386

Password♠ 386

IPv4 Address♠ 387

IPv6 Address♠ 387

Port♦♠ 387

Tertiary Server ID♠ 387

Password♠ 387

IPv4 Address♠ 387

IPv6 Address♠ 387

Port♦♠ 388

Miscellaneous - Register Transmission 
Interval [sec] (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*)) ♦♠

388

DTMF digit interval timeout 
[sec] (except for IX-MV, IX-
DA, IX-DF(-*), or IX-BA, IX-
SS(-*)) ♦♠

388

Call health check timer♦♠ 388

Multicast Address 
(IX-MV7-*, IX-MV, IX-
DV, IX-DVF(-*), IX-
DA, IX-DF(-*) only)

- - For Call / Paging (IX-MV7-* 
and IX-MV only)

389

For Call (IX-DV, IX-DVF(-*), 
IX-DA, IX-DF(-*) only)

389

Video (IX-MV7-*, IX-
MV, IX-DV, IX-DVF(-
*), IX-DA, IX-DF(-*) 
only)

Video Encoder 1 - Video Codec (IX-DA, IX-
DF(-*) only) ♠

390

Resolution (IX-DV, IX-
DVF(-*), IX-DA, IX-DF(-*) 
only) ♠

391

Frame Rate [fps] (IX-DV, 
IX-DVF(-*), or IX-DA, IX-
DF(-*) only) ♠

391
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Select Profile [H.264 / AVC] 
(IX-DV, IX-DVF(-*), or IX-
DA, IX-DF(-*) only)

391

I-picture interval [H.264/
AVC] (IX-DV, IX-DVF(-*), or 
IX-DA, IX-DF(-*) only) ♦

391

Bit rate [kbps] [H.264 / 
AVC] (IX-DV, IX-DVF(-*), or 
IX-DA, IX-DF(-*) only) ♠

391

Select Quality [Motion-
JPEG] (IX-DA, IX-DF(-*) 
only) ♠

392

RTP Start Port♦ 392

RTP End Port♦ 392

Video Encoder 2 - Second Video Encoder (IX-
DV, IX-DVF(-*), or IX-DA, 
IX-DF(-*) only) ♠

393

Video Codec (IX-DV, IX-
DVF(-*), IX-DA, IX-DF(-*) 
only) ♠

393

Resolution (IX-DV, IX-
DVF(-*), IX-DA, IX-DF(-*) 
only) ♠

393

Frame Rate [fps] (IX-DV, 
IX-DVF(-*), or IX-DA, IX-
DF(-*) only) ♠

393

Select Profile [H.264 / AVC] 
(IX-DV, IX-DVF(-*), or IX-
DA, IX-DF(-*) only)

394

I-picture interval [H.264/
AVC] (IX-DV, IX-DVF(-*), or 
IX-DA, IX-DF(-*) only) ♦

394

Bit rate [kbps] [H.264 / 
AVC] (IX-DV, IX-DVF(-*), or 
IX-DA, IX-DF(-*) only) ♠

394

Select Quality [Motion-
JPEG] (IX-DV, IX-DVF(-*), 
IX-DA, IX-DF(-*) only) ♠

394

RTP Start Port♦ 394

RTP End Port♦ 394

Master Station Video 
Setting (IX-MV7-* only)

- Video Streaming 395

Frame Rate [fps]♠ 395

Select Profile 395

I-picture interval♦ 395

Bit Rate [kbps]♠ 395

Using a 3rd party product to 
monitor video/audio from 
IX-DV, IX-DVF(-*), IX-DA, 
IX-DF(-*)

- - 397

Setting items Reference 
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Audio (except for 
IXW-MA)

- - Audio Codec♠ 398

Audio RTP Transmission 
Interval [msec]♠

399

RTP Idle Detection Time 
[sec]♦♠

400

Audio 1 RTP Start Port♦ 400

Audio 1 RTP End Port♦ 400

Audio 2 RTP Start Port♦ 400

Audio 2 RTP End Port♦ 400

Audio Buffer - Packets Buffered at Audio 
Start♠

401

Maximum Packets 
Buffered♠

401

Packet Priority - - TOS Value (Audio) (except 
for IXW-MA) ♦♠

402

TOS Value (Video) (IX-
MV7-*, IX-DV, IX-DVF(-*), 
IX-DA, IX-DF(-*) only) ♦♠

402

TOS Value (SIP) (except for 
IXW-MA) ♦♠

402

VLAN Setting♠ 402

VLAN ID♦♠ 403

VLAN Priority♠ 403

NTP Enable NTP♠ - - 404

Synchronization Interval 
[hour]♦♠

- - 404

Primary Server Address♠ IPv4 404

IPv6 405

Port♦♠ - 405

Secondary Server Address♠ IPv4 405

IPv6 404

Port♦ ♠ - 405

System Information

Location (IX-MV7-* 
and IX-MV only)

- - - 406

Address Book (IX-
MV7-* and IX-MV 
only)

Station List - - 406

VoIP Phone Registration - 408

Network Camera List - Camera Name♦ 409

Hostname 410

IP Address (IPv4) 410

IP Address (IPv6) 410

ID♦ 410

Password♦ 410

Setting items Reference 
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PTZ Operation 410

Audio Monitoring 411

Group (for Master) 
(IX-MV7-* and IX-MV 
only)

- - - 414

Custom Sound 
Registry (except for 
IXW-MA)

- - - 416

Call Settings

Station Information 
(IX-RS-*, IX-DV, IX-
DVF(-*), IX-SSA(-*), 
or IX-SS-2G only)

- - Call Button Function 418

Called Stations 
(Master Stations) (IX-
MV7-* and IX-MV 
only)

- - Call Destination Settings 
are unnecessary, Master 
Station can call any station 
in Address Book.

Called Stations 
(Door/Sub Stations) 
(except for IX-MV7-*, 
IX-MV, or IXW-MA)

- - Number 420

Protocol (except for IX-DA, 
IX-DF(-*) and IX-BA, IX-
SS(-*))

420

VoIP Phone Registration - - 421

Call Origination 
(except for IXW-MA)

Call Origination Advanced 
Settings

- Call Method (except for IX-
MV7-*, IX-MV, IX-DA, IX-
DF(-*), or IX-BA, IX-SS(-*))

422

Ringback Tone (except for 
IX-MV) ♠

423

Call Timeout (except for IX-
MV - "Call Button") ♦♠

423

Ringback Tone Count 
(except for IX-MV - "Call 
Button") ♠

424

Call Destination (IX-MV7-* 
or IX-MV - "Option Input 1 - 
4" only)

424

Standard Mode Settings 
(except for IX-MV7-* and 
IX-MV)

424

Destination by Time Delay 
Settings (except for IX-
MV7-*, IX-MV, IX-DA, IX-
DF(-*), or IX-BA, IX-SS(-*))

424

Destination Dwell Time[sec] 
(except for IX-MV7-*, IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*)) ♦

425
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Schedule Settings (Weekly 
Schedule) (except for IX-
MV7-*, IX-MV, IX-DA, IX-
DF(-*), or IX-BA, IX-SS(-*))

Start Time 426

End Time 426

Call Destination 426

Priority 426

Schedule Settings (Daily 
Schedule) (except for IX-
MV7-*, IX-MV, IX-DA, IX-
DF(-*), or IX-BA, IX-SS(-*))

Start Time 427

End Time 427

Call Destination 428

Priority 428

Tone Settings - Busy Tone (except for IX-
MV) ♠

429

Error Tone (Call Failed) 
(other than IX-MV7-* or IX-
MV) ♠

430

Call Restart Function - Call Restart Function 
(except for IX-MV7-*, IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

430

Incoming Call (except 
for IX-DA, IX-DF(-*), 
IX-BA, IX-SS(-*), or 
IXW-MA)

Call Answer Settings - Auto Answer♠ 431

Ringtone - Ringtone (other than IX-
MV7-*, IX-MV) ♠

430

Ringback Tone Count 
(other than IX-MV7-*) ♠

433

Call Button (IX-MV7-* and 
IX-MV only)

433

Option Input (IX-MV7-* and 
IX-MV only)

434

Call Button Ringtone Count 
[time(s)] (IX-MV7-* only) ♠

434

Option Input Ringtone 
Count [time(s)] (IX-MV7-* 
only) ♠

434

VoIP Phone (except for IX-
MV)

- VoIP Phone Call Priority 435

Option Input/Relay Output Settings

Option Input Option Input Advanced 
Settings

Name (except for IX-MV, 
IX-DA, IX-DF(-*), IX-BA, IX-
SS(-*), or IXW-MA)

- 436

Function - 437

Type - 437
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Detection Time Range Detection Time Range 437

Detection Time♦ 437

API (except for IX-MV, IX-
DA, IX-DF(-*), or IX-BA, IX-
SS(-*))

API 1 438

API 2 438

Relay Output Relay Output Advanced 
Settings

Name (except for IX-MV, 
IX-DA, IX-DF(-*), IX-BA, IX-
SS(-*), or IXW-MA)

- 440

Function - 440

Option Relay Control 
(except for IX-MV, IX-DA, 
IX-DF(-*), or IX-BA, IX-SS(-
*))

- 442

Output Time Range Output Time Range 443

Output Time [msec / sec]♦ 443

Door Release Authorization 
(except for IXW-MA)

- 443

Sound Settings (except for 
IX-MV and IXW-MA)

Door Release 445

Relay Control (start) 
(except for IX-DA, IX-DF(-*) 
and IX-BA, IX-SS(-*))

445

Relay Control (end) (except 
for IX-DA, IX-DF(-*) and IX-
BA, IX-SS(-*))

446

Schedule Settings (Weekly 
Schedule) (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

Start Time 447

End Time 447

Schedule Settings (Daily 
Schedule) (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

Start Time 449

End Time 449

Option Relay Control 
Authentication Key (except 
for IX-MV, IX-DA, IX-DF(-*), 
or IX-BA, IX-SS(-*))

- - 449

Paging Settings

Paging Origination 
(IX-MV7-* and IX-MV 
only)

- - Paging Timeout [sec]♦ ♠ 450

Paging Wait Timer [sec] 
(IX-MV7-* only) ♦ ♠

450

Urgent Page Response (IX-
MV7-* only)

450

Lock Paging (IX-MV7-* 
only)

451
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All Page (IX-MV7-* 
and IX-MV only)

- - - 452

Option Input Page 
(IX-MV7-* only)

- - Destination 453

Group Number 453

Priority 453

Message File Name 454

Play Count [time(s)] 454

Function Settings

Door Release (IX-
MV7-* and IX-MV 
only)

Door Release Assignment - Contact Assignment 455

Authentication Key 455

Network Camera 
Integration (IX-MV7-* 
and IX-MV only)

Profile Setting - Profile 456

Event Registration - Event 458

Function (IX-MV7-* only) 458

Event Tone (IX-MV7-* only) 459

ID (IX-MV7-* only) 459

Password (IX-MV7-* only) 459

Call Origination (IX-MV7-* 
only)

459

Call Destination (IX-MV7-* 
only)

460

Priority (IX-MV7-* only) 460

Event Tone (IX-MV only) ♠ 460

Play count of Event Tone♠ 460

Paging Settings 
(except for IX-MV7-*, 
IX-MV, or IXW-MA)

Paging Pretone Setting - Paging Pretone 461

Bathroom Call (IXW-
MA only) (not used)

- - - 462

Email Server Settings - SMTP Server♠ 463

SMTP Port♦♠ 463

SMTP Encryption♠ 463

Authentication Settings - SMTP Authentication♠ 464

Mode♠ 464

ID♠ 464

Password♠ 464

Email Addresses - Destination 1♠ 465

Destination 2♠ 465

Destination 3♠ 465

Source Address♠ 465
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Email Event Trigger - Outgoing Normal Call 
(except for IXW-MA)

466

Incoming Normal Call 
(except for IX-MV, IX-DA, 
IX-DF(-*), IX-BA, IX-SS(-*), 
or IXW-MA)

466

Outgoing Priority Call 
(except for IXW-MA)

467

Incoming Priority Call 
(except for IX-MV, IX-DA, 
IX-DF(-*), IX-BA, IX-SS(-*), 
or IXW-MA)

467

Outgoing Urgent Call 
(except for IXW-MA)

467

Incoming Urgent Call 
(except for IX-MV, IX-DA, 
IX-DF(-*), IX-BA, IX-SS(-*), 
or IXW-MA)

467

Door Release Activated (IX-
MV7-*, IX-MV, or IX-RS-* 
only)

467

Call Failed (except for IXW-
MA)

467

Latch Reset (IX-RS-*, IX-
DV, IX-DVF(-*), IX-SSA(-*), 
IX-SS-2G only)

467

Error 468

Station Restarted 468

SD Card Error (IX-MV7-*, 
IX-DV, IX-DVF(-*), IX-SSA(-
*) only)

468

Recording Memory Full (IX-
MV7-*, IX-DV, IX-DVF(-*), 
IX-SSA(-*) only)

468

Line Supervision (Passed) 
(IX-MV7-* only)

468

Line Supervision (Failed) 
(IX-MV7-* only)

468

Device Check (Passed) (IX-
MV7-* only)

469

Device Check (Failed) (IX-
MV7-* only)

469

Subject♠ 469

Periodic Log Transmission - Periodic Log Transmission 469

Periodic Log Transmit Time 469

Periodic Log Transmit 
Interval

470

Periodic Log Transmission 
Subject

470

Send Test Email - - 471
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Additional Settings (IX-DV, 
IX-DVF(-*), IX-DA, IX-DF(-
*) only)

- Attach Image♠ 472

Image Filename♠ 472

CGI Integration - - CGI Functionality 473

SIF Integration SIF Functionality - - 474

SIP URI Format (except for 
IX-MV, IX-DA, IX-DF(-*), or 
IX-BA, IX-SS(-*)) ♠

- - 474

SIF Settings (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

- Program Type♠ 475

IPv4♠ 475

IPv6♠ 475

Destination Port♠ 475

SSL♠ 476

Connection♠ 476

Transmission Trigger 
(except for IX-MV, IX-DA, 
IX-DF(-*), or IX-BA, IX-SS(-
*))

- Begin Outgoing Call 
(except for IXW-MA)

477

Begin Communication 
(Source) (except for IXW-
MA)

477

Door Release Indication 
(IX-MV7-* and IX-RS-* 
only)

477

End Communication 
(except for IXW-MA)

477

Change contact 477

Unit Error 478

Begin broadcast (IX-MV7-* 
only)

478

End broadcast (IX-MV7-* 
only)

478

Begin Transfer (IX-MV7-* 
only)

478

End Transfer (IX-MV7-* 
only)

478

Periodical Transmission 478

Initialization Notice 478

End Outgoing Call (except 
for IXW-MA)

479

Begin Incoming Call 
(except for IXW-MA)

479

End Incoming Call (except 
for IXW-MA)

479
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Latch Reset (except for IX-
MV7-* and IXW-MA)

479

Change Call Destination 
(except for IXW-MA)

479

Call Failure (except for 
IXW-MA)

479

Begin Incoming Transfer 
Call (IX-MV7-* only)

479

Begin On Hold (IX-MV7-* 
only)

480

End On Hold (IX-MV7-* 
only)

480

Begin Incoming Page 
(except for IXW-MA)

480

End Incoming Page (except 
for IXW-MA)

480

Paging Failure (IX-MV7-* 
only)

480

Begin Monitoring (IX-MV7-* 
only)

480

End Monitoring (IX-MV7-* 
only)

480

Monitoring Failure (IX-MV7-
* only)

481

Begin Monitored (except for 
IX-MV7-* and IXW-MA)

481

End Monitored (except for 
IX-MV7-* and IXW-MA)

481

Begin Communication 
(Destination) (except for 
IXW-MA)

481

Begin Privacy (IX-MV7-* 
only)

481

End Privacy (IX-MV7-* 
only)

481

Keypad Input (IX-MV7-* 
only)

481

Speed Dial Input (IX-MV7-* 
only)

482

Begin Record (IX-MV7-*, 
IX-DV, IX-DVF(-*), IX-SSA(-
*) only)

482

End Record (IX-MV7-*, IX-
DV, IX-DVF(-*), IX-SSA(-*) 
only)

482

Recording Memory Full (IX-
MV7-*, IX-DV, IX-DVF(-*), 
IX-SSA(-*) only)

482
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Passed Line Supervision 
(IX-MV7-* only)

482

Failed Line Supervision (IX-
MV7-* only)

482

Passed Device Check (IX-
MV7-* only)

482

Failed Device Check (IX-
MV7-* only)

483

SD Card Error (IX-MV7-*, 
IX-DV, IX-DVF(-*), IX-SSA(-
*) only)

483

SIP Registration Failure 
(except for IXW-MA)

483

Network Camera Event (IX-
MV7-* only)

483

Periodical Transmission 
(except for IX-MV, IX-DA, 
IX-DF(-*), or IX-BA, IX-SS(-
*))

- Periodical Transmission 
Interval♦

483

SIF File Management - SIF Communication 
Settings (sif.ini)

484

SIF Parameter Settings 
(sif_conf.ini)

484

Record (IX-MV7-*, 
IX-DV, IX-DVF(-*), 
IX-SSA(-*) only)

- - Record Mode (IX-DV, IX-
DVF(-*), IX-SSA(-*) only) ♠

485

Record Event 486

Recorded Device (IX-MV7-* 
only)

486

Prevent Overwrite♠ 486

Video Recording File 
Length♠

486

Event Recording Timer (IX-
MV7-* only) ♠

487

Manual Recording (IX-MV7-
* only) ♠

487

Audio Recording (IX-MV7-*, 
IX-DV, IX-DVF(-*) only) ♠

487

Schedule Settings (IX-DV, 
IX-DVF(-*), or IX-SSA(-*) 
only)

Weekly Schedule Start Time 488

End Time 488

Communication 
Audio Messages (IX-
RS-*, IX-DV, IX-
DVF(-*), IX-SSA(-*), 
or IX-SS-2G  only)

Start Communication - Message 489

Code Received - Code 490

Message 490
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Chime (except for IX-
MV, IX-DA, IX-DF(-*), 
IX-BA, IX-SS(-*), or 
IXW-MA)

Weekly Schedule - Start Time 491

Chime 492

Daily Schedule - Start Time 494

Chime 494

CSR - - Country 495

State/County/Region 495

City/Locality 496

Organization 496

Organizational Unit 496

Common Name 496

SSL Certificate - - - 497

IEEE 802.1X (except 
for IX-MV, IX-DA, IX-
DF(-*), or IX-BA, IX-
SS(-*))

- - IEEE 802.1X 498

EAP♠ 498

EAP User Name♠ 498

EAP Password♠ 498

Display Mode (IX-
MV7-* only)

Master UI Mode - - 500

Standard Mode - Home Screen 501

Receptionist Mode Color Scheme - 502

Screen Layout - 503

Company Information Name 505

Text Size♦ 505

Bold 505

Text Color 505

Greeting Information Greeting 506

Text Size♦ 506

Bold 506

Text Color 506
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Images Company Image 507

Greeting Image 507

Receptionist Image 507

Button Function Button 1 508

Button 2 508

Button 3 508

Button 4 508

Button Name for Group Call 509

Button Name for Select By 
Name

509

Button Name for Select By 
List

509

Button Name for Enter 
Number

509

Group Call Destination - 509

Reject Incoming Call - 509

Bathroom Link (not 
used)

- - - 510

Transfer Settings

Absent Transfer (IX-
MV7-* and IX-MV 
only)

- - Absent Transfer 511

Transfer Destination List 
(IX-MV7-* only)

512

Transfer Destination (IX-MV 
only)

512

Re-Transfer Destination 
(IX-MV7-* only)

512

Delay Transfer (IX-
MV7-* and IX-MV 
only)

- - Delay Transfer 513

Delay Time [sec]♦ 514

Transfer Destination List 
(IX-MV7-* only)

514

Transfer Destination (IX-MV 
only)

514

Re-Transfer Destination 
(IX-MV7-* only)

514

Schedule Transfer 
(IX-MV7-* and IX-MV 
only)

- - Schedule Transfer 515

Weekly Schedule - Transfer Destination 516

Re-Transfer Destination 
(IX-MV7-* only)

516

Start Time 516

End Time 516
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Daily Schedule (IX-MV7-* 
only)

- Transfer Destination 517

Re-Transfer Destination 518

Start Time 518

End Time 518

Lock Transfer (IX-
MV7-* only)

- - Lock 518

Station Settings

Speed Dials / 
Favorites (IX-MV7-* 
and IX-MV only)

Advanced Speed Dial 
Button Settings

Speed Dial Name (IX-MV7-
* only)

- 520

Function - 520

Individual Call Number 520

Priority 520

Group Call Group Number 521

Priority 521

Group Page Group Number 521

Priority 521

All Page Priority 521

Group Message Page (IX-
MV7-* only)

Group Number 521

Message 522

Priority 522

Play Count [time(s)] 522

All Message Page (IX-MV7-
* only)

Message 523

Priority 523

Play Count [time(s)] 523

Monitor (IX-MV7-* only) Number 523

Network Camera Monitor 
(IX-MV7-* only)

Network Camera 524

Scan Monitor (IX-MV7-* 
only)

- 524

Option Relay Control (IX-
MV7-* only)

Open 524

Output Time 524

TLS 524

Option Relay Control Key 525

Lock (IX-MV7-* only) - 525

Privacy (IX-MV7-* 
and IX-MV only)

- - Privacy♠ 526
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Volume / Tone 
(except for IXW-MA)

Volume - Handset Transmit (IX-MV7-
*, IX-RS-*, or IX-MV only)

527

Handset Receive (IX-MV7-
*, IX-RS-*, or IX-MV only)

527

Hands-free Transmit (IX-
MV7-*, IX-RS-*, or IX-MV 
only)

527

Hands-free Receive (IX-
MV7-*, IX-RS-*, or IX-MV 
only)

527

Headset Jack Transmit (IX-
MV7-* only)

527

Headset Jack Receive (IX-
MV7-* only)

528

Transmit (except for IX-
MV7-*, IX-RS-*, or IX-MV)

528

Receive (except for IX-
MV7-*, IX-RS-*, IX-MV, or 
IX-DV, IX-DVF(-*))

528

Receive (IX-DV, IX-DVF(-*) 
only)

528

External Input (not used) 528

External Output (IX-RS-* 
only)

528

VoIP Phone Volume 
Adjustment (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*))

528

Ringtone 528

Paging (IX-DV, IX-DVF(-*), 
and IX-SSA(-*) only)

529

Button Feedback (IX-MV7-* 
and IX-MV only)

529

Tone - Communication Timeout 
Notification (except for IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*)) ♠

529

Communication End 
Pretone (except for IX-MV, 
IX-DA, IX-DF(-*), or IX-BA, 
IX-SS(-*)) ♠

530

Call Queue Notification (IX-
MV7-* only) ♠

530

Paging Pretone (IX-MV7-* 
and IX-MV only) ♠

531

Auto Answer Tone (except 
for IX-MV, IX-DA, IX-DF(-*),  
IX-BA, IX-SS(-*)) ♠

531

On Hold (IX-MV7-* only) ♠ 532
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Key Received (except for 
IX-MV, IX-DA, IX-DF(-*), or 
IX-BA, IX-SS(-*)) ♠

532

Error (except for IX-MV7-*, 
IX-MV, IX-DA, IX-DF(-*), or 
IX-BA, IX-SS(-*))

533

Mic Select (not used) 533

Headset Specification (IX-
MV7-* only)

533

Audio Output (for Master) 
(IX-MV7-* only)

533

Audio Output (for Door) 
(except for IX-MV7-*, IX-
SS-2G, or IX-MV)

534

Communication 
(except for IXW-MA)

- - Talk Timeout [sec]♦ ♠ 535

Communication Start Tone 
(except for IX-MV7-*, IX-
MV, IX-DA, IX-DF(-*), or IX-
BA, IX-SS(-*)) ♠

535

Force Touch-to-Talk (IX-
MV7-* and IX-MV only)

535

Monitor (except for 
IXW-MA, IX-DA, IX-
DF(-*), or IX-BA, IX-
SS(-*))

Monitor Timeout [sec] (IX-
MV7-* and IX-MV only) ♦♠

- - 536

Scan Monitor (IX-MV7-* 
only)

- Type 536

Number 536

Network Camera Number 537

Dwell Time 537

Prevent Being Monitored 
(except for IX-MV7-* and 
IX-MV)

- - 537

Monitored Notification Tone 
(other than IX-MV7-* or IX-
MV) ♠

- - 537

Monitored LED Notification 
(except for IX-MV7-* and 
IX-MV)

- - 538
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Master Station 
Display (IX-MV7-* 
and IX-MV only)

- - Brightness 539

Primary Video Source (IX-
MV7-* only)

539

Aspect Ratio 539

Time Format (IX-MV only) ♠ 539

Standby LED State♠ 539

Keypad (IX-MV7-* only) 540

Camera (IX-DV, IX-
DVF(-*), or IX-DA, IX-
DF(-*) only)

Adjustment - Backlight Compensation♠ 541

Low Light Sensitivity♠ 541

Color Settings (IX-DA, IX-
DF(-*) only)

- Brightness♦ 541

Contrast♦ 541

Color♦ 542

White LED - Call / Communication♠ 542

Monitored♠ 542

Door Release 
Assignment (IX-RS-* 
only)

- - Contact Assignment 543

Authentication Key 543

Door Release by IX-RS - 544

Line Supervision (IX-
MV7-* only)

- - Line Supervision Interval 545

Line Supervision Schedule 545

Device Check Interval 545

Device Check Schedule 545

Maintenance

Firmware Update - - - 546

Initialization - - - 547

Settings File Backup Setting File Download - - 548

Setting File Upload - - 550

syslog (except for IX-
MV, IX-DA, IX-DF(-*), 
or IX-BA, IX-SS(-*))

- - IPv4 Address 552

IPv6 Address 552

Port♦ 552
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Important

• Depending on the language for the display on the station (IX-MV7-* or IX-MV), the content of the settings may appear incorrectly.

• The symbols indicate the following:
♦: Be sure to input the settings. Upon use, leave the unnecessary items at their default values.
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1. File

1.1 Create new system/import setting data

Creates new system setting data.
The below three methods can be used to create a new system depending on your objective.
• Perform detailed setup for all functions. → “Create new system settings data (without using the Wizard function) 

(→page 124)”
• Set call/door release/paging/monitoring functions only. → “Use the Wizard function to easily set up the system and 

make it operational (→page 125)”
• Import setting data from another IX Support Tool or setting data created before Ver4.0.0.0. “Reading in data 

created by another IX Support Tool (→page 139)”

Select "File" > "Create New System" to display the "New System" screen.

“Restore System Settings (→page 164)”

IX Support Tool Settings

“Reading in data created by another IX Support Tool (→page 139)”

1

3

4

2

5
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1.1.1 Create new system settings data (without using the Wizard function)

1. Configure the system settings.

■System Name♦

■ IP Version

■ Installer Information♦

■Owner Information♦

■Notes♦

2. Enter the number of stations in the "IX Support Tool Settings."

3. Select "Wizard Programing" > "No."
If using the Wizard function, refer to “Use the Wizard function to easily set up the system and make it 
operational (→page 125)”.

4. Select "Automatically configure door release for all stations?."
• When Door Release Settings do not exist or when Door Release Settings for each door will be configured 

individually, set to "No."

5. Click [Apply].
• Setting data will be automatically generated and the Settings (Table View) screen will be displayed. Refer to 

“System Settings (Table View) (→page 169)” when performing the settings.
• Click [Cancel] to terminate the process without creating a new system.

Description Enter the name of the system to be created.

Settings 1 - 64 alphanumeric characters

Default values ̶

Description Choose the protocol for IX Support Tool.

Settings • IPv4
• IPv6

Default values IPv4

Description Enter the installer information.
The set installer information is displayed in station information/notes in IX-MV7-* - "Station 
Information" - "CONTACT INFORMATION."

Settings 4 rows (1-64 alphanumeric characters per row)

Default values ̶

Description Enter the owner information.

Settings 1-64 alphanumeric characters

Default values ̶

Description Enter the notes.

Settings 1-64 alphanumeric characters

Default values ̶
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1.1.2 Use the Wizard function to easily set up the system and make it operational

Before configuring, connect the programming PC and all stations to the same network.
The Wizard allows setup for the call, door release, paging, and monitoring functions. If using other functions, refer to 
“System Settings (Table View) (→page 169)”.

1. Configure the system settings.
For entries, refer to Step 1 of “Create new system settings data (without using the Wizard function) 
(→page 124)”.

2. Enter the number of stations in the "IX Support Tool Settings."

3. Select "Wizard Programing" > "Yes."

4. Select "Automatically configure door release for all stations?."
• When Door Release Settings do not exist or when Door Release Settings for each door will be configured 

individually, set to "No."

5. Click [Next].
Auto-generation of the setting data and a station search will be performed and the "System Configuration" 
screen will be displayed. (The search may take several minutes.)
• The stations without power and the stations in the process of initialization will not be subject to search.
• Search up to 9999 stations at a time.
• Click [Station Search] to search again.
• You cannot search for terminals using a different IP version. Select the IP version of the terminal to search in 

"Station Search Protocol." (Set the PC to same communication type.)
• You cannot search for stations on other segments. Refer to Step 9.
• The following setting items will be set automatically.

– IP Address
– Subnet Mask
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6. Edit "Station Settings List."
Edit if stations are added or deleted.
“How to edit the Station Settings List (→page 129)”

7. Set "Advanced Settings."
Set these when you need to change the station name, IP address, and so on.
“How to configure Advanced Settings (→page 130)”

8. Associate setting files and stations.
Select the setting file to associate from "Station Settings List."
• A setting file that has already been associated cannot be selected.
• Click [Associate Automatically] to automatically associate all setting files with stations.

6

Station Search Protocol
Select the IP version of the 
station to search.

7

System Management
This allows for the addition or 
deletion of stations on the 
Station Settings List.

Advanced Settings

10

9

8

Station Setting List
A list of the generated setting 
files will be shown.

Station List
The searched stations will be 
shown.

Associated Station List
The settings that have been 
associated will be shown.

Perform association again.
Removes association.

Setting files and stations are 
automatically associated.

Search again for stations.
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9. Select the station with which the setting file selected at Step 8 will be associated from "Station List."
• A station that has already been associated cannot be selected.
• Select "Enter station MAC address" to specify a station by entering the MAC address.
• To associate a station on another segment, select "Enter station MAC address" then "Different Networks," 

and then enter the MAC address to specify the station.

10. Click [Apply].
• The settings that have been associated will be shown in "Associated Stations List."
• The station will be restarted and the IP Address and Name will be updated. If a station on another segment 

was associated in Step 9, it will not be updated. Update the IP Address and Name using a Web browser.

11. Repeat steps 8 - 10 and associate all stations.
• To dissociate, select the content to remove from "Associated Stations List" (multiple selections allowed), and 

then click [Remove Association].

12. Click [Next].
The "Setting File Upload" screen is displayed.
• Click [Cancel] to terminate the process without creating a new system.

13. Select the station from which to upload the setting file from "Station List." (Multiple selections 
allowed)
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].
• Stations for which there are no Association Settings cannot be selected.

14. Set the date and time.
Enter the time for each station. Time is used for incoming calls, outgoing calls, and the system log.
“How to configure the date and time manually (→page 139)”

Important

• If “Static / DHCP (→page 181)” was set to "DHCP," "Stateless," or "DHCPv6" at Step 5, the IP address set beforehand by the 
DHCP server will be assigned.
If the IP address assignment fails, the IP address will default to "192.168.1.160" if it is IPv4 and "FDC2::7000" if it is IPv6. If this 
happens, cycle power to the station to, and then the IP Address will be reassigned by the DHCP server. Afterwards, perform 
association again.

15 1814

13
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15. Click [Start Upload].

16. Click [OK].
• Click [Cancel] to return to the "Setting File Upload" screen without uploading.

17. Click [OK].
• The result is displayed in "Station List" > "Status."

In Process: The setting file is in the process of uploading.
Success: Upload is completed.
Failed: Upload failed.

18. Click [Next].
The "Export Settings" screen is displayed.
• Click [Cancel] to terminate the process without creating a new system.

19. Output the system configuration file that was set.
Click [Export].

20. Specify the save directory and click [OK].
• A folder with the name specified in "System Name" in Step 1 will be created in the specified directory, and 

the system configuration file will be saved inside.

21. Click [Apply].
• The Wizard function is complete.

19
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1.1.2.1 How to edit the Station Settings List
This is an explanation for Step 6 of “Use the Wizard function to easily set up the system and make it operational 
(→page 125)”.

How to add a station
On the "System Configuration" screen, click [Add New Station] to display the "Add New Station" screen.

1. Enter the station type and the number of the stations to be added.

2. Click [Add].

3. Click [OK].
• Click [Cancel] to end the process for adding a new station.

1

2

3
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How to remove a station
On the "System Configuration" screen, click [Station Removal] to display the "Station Removal" screen.

1. Select the station to delete from "Station List." (Multiple selections allowed)

2. Click [Delete].
• Click [Cancel] to cancel deletion.

3. Click [Yes].
• Click [No] to return to the "Station Removal" screen.

1.1.2.2 How to configure Advanced Settings

This is an explanation for Step 7 of “Use the Wizard function to easily set up the system and make it operational 
(→page 125)”.

1

2
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How to register a new address book (IX-MV7-* and IX-MV only)
Default value: All stations to be registered to Address Book
Click [Address Book] to display the "Address Book" screen.

1. Search for the stations for which the Address Book will be set up from the "list of IX-MV7-* and IX-MV 
in setting data."

2. Search for stations to be registered from "List of stations that can be registered to Address Book."

3. Click [Select] in the cell that corresponds to Steps 1 and 2.
• Register
✔: Register the selected station to the Address Book.
SIP: Register the station with which to communicate over a SIP server.

By default, "✔ (register)" is set for all stations.

4. After configuration is complete, click [OK].
• Click [Cancel] to complete Address Book registration.

List of IX-MV7-* and IX-MV in setting data List of stations that can be registered to Address Book

12

3

4

Move row
Up to 50 station number rows can be displayed at a 
time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.

Move column
Up to 50 station number lines can be displayed at a 
time. Switch the display as follows.
[Previous]: Display the previous 50 columns.
[Next]: Display the next 50 columns.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered column.
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How to configure Station Details
Click [Station Details] to display the "Station Details" screen.

1. Change setting of each item.

2. After configuration is complete, click [OK].
• Click [Cancel] to stop configuring station details.

■Number♦
Description Set Number. Set it such that there is no overlap with other stations.

The set station number will be shown to the recipient when a call is made or when the station is 
paged. It is also used to search a station by station number for IX-MV7-* and IX-MV.

Settings 3-5 digits

Default values Set in order starting from 0001.

Remarks When configuration is complete, the stations are sorted by station number.

1

1

2

“How to register a location 
(→page 135)”

Move row
Up to 50 station number rows can be displayed 
at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.



133

Menu bar

■Name

■Location (except for IXW-MA)

■Hostname (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

■ IP Version

■Static / DHCP

Description Enter the station name.
The set station name will be shown to the recipient when a call is originated.

Settings 1-24 alphanumeric characters

Default values IX-MV7-*, IX-MV: Master Station (number); IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*): Video Door 
Station (number);IX-SSA(-*), IX-SS-2G, IX-BA, IX-SS(-*): Audio Door Station (number); IX-RS-*: 
Handset Sub Station (number); IXW-MA: I/O Adaptor (number)

Remarks When updated with no entry, the station numbers are automatically copied in this field.

Description Select the station's Location.
The set Location will be shown to the recipient when a call is originated.

Settings Select one from the Location registered in “How to register a location (→page 135)”.

Default values ̶

Description Set the station's hostname. Set this to access a station by hostname that was registered in “How 
to register a new address book (IX-MV7-* and IX-MV only) (→page 131)”, “Called Stations 
(Door/Sub Stations) (except IX-MV7-*, IX-MV, and IXW-MA) (→page 225)”.

When setting the hostname, configure “DNS (→page 185)”.

Settings 1-64 alphanumeric characters

Default values ̶

Description Select the station's communication type.

Settings • IPv4
• IPv6

Default values IPv4

Important

• IPv4 and IPv6 cannot be mixed in the same system.

Description Select the addressing method for the IP version selected in "IP Version."

Settings When selecting IPv4:
• Static
• DHCP

When selecting IPv6:
• Static
• Stateless
• DHCPv6

Default values IPv4
• Static
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■ IP Address (IPv4)♦

■Subnet Mask (IPv4) ♦

■Default Gateway (IPv4)

■ IP Address (IPv6)♦

■Default Gateway (IPv6)

Important

• If "DHCP" is selected for iPv4, configure so that a static IP address is assigned to the stations by the DHCP server.

• If "Stateless" is selected for iPv6, do not change the prefix of the device that can transmit Router Advertisement (RA).

• If "DHCPv6" is selected for iPv6, configure so that a static IP address is assigned to the stations by the DHCP server. DUID of 
the station is "00030001 + the MAC address."

• When setting up a product from another manufacturer, such as a DHCP server, refer to its manual.

• If "Static / DHCP" is set to "DHCP," settings will not be applied to the station even if the "IP Address," "Subnet Mask," and 
"Default Gateway" are set.

Description Set the IP address of the station.
Set a unique IP address for each station.

Settings 1.0.0.1 - 223.255.255.254

Default values A series of numbers proceeding in the manner of 192.168.1.10, 192.168.1.11... is set.

Description Set the subnet mask for the station.

Settings 128.0.0.0 - 255.255.255.255

Default values 255.255.255.0

Description Set the default gateway of the network to which the station belongs.

Settings 1.0.0.1 - 223.255.255.254

Default values ̶

Important

• If "Static / DHCP" is set to "Stateless" or "DHCPv6," settings will not be applied to the station even if "IP Address" and "Default 
Gateway" are set.

Description Set the IP address of the station.
Set a unique IP address for each station.

Settings 2000::0 - 3FFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or FD00::0 - 
FDFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values ̶

Description Set the default gateway of the network to which the station belongs.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values ̶
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How to register a location

1. Enter the location in "Location List." For IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*), enter 
locations within the 001 - 050 range.
• Location: 1-24 alphanumeric characters

2. Click [OK].
• Click [Cancel] to end the process without registration.

Click [Location Registry] to display the "Location Registry" screen.

Up to 100 locations can be registered. However, only locations set between 001 and 050 can be used with IX-MV, IX-DA, IX-DF(-
*), and IX-BA, IX-SS(-*).

1

2
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How to configure door release
Configure the door release authentication key.
To release the electrical lock connected with a destination station after performing a door release operation during 
communication or monitoring, it is necessary to authenticate the destination station's authentication key and door 
release key.

Click [Door Release] to display the "Door Release" screen.

1. Set "Authentication Key."

2. Click [OK].
• Click [Cancel] to stop configuring electrical lock door release.

List of IX-MV7-* and IX-MV in setting data

1

2

Destination station and authentication key

Move row
Up to 50 station number rows can be displayed at 
a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.

Move column
Up to 50 station number lines can be displayed at 
a time. Switch the display as follows.
[Previous]: Display the previous 50 columns.
[Next]: Display the next 50 columns.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered 
column.
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■Authentication Key

How to perform Batch IP Address Configuration
Click [Batch IP Address Configuration] to display the "Batch IP Address Configuration" screen.

1. In "IPv4 Address" or "IPv6 Address," enter the start IP address that is to be automatically assigned.

2. For IPv4, enter "Subnet Mask."
• With the subnet mask, set the range for assignment. The network addresses in the range and the broadcast 

addresses cannot be assigned.

Description Set the door release key for releasing the door connected to the destination station when a door 
release operation is performed. Door release is possible when it matches the Door Release 
Authorization of the destination station.

Settings • IX-MV7-*: 1-20 digits
• IX-MV: 1-4 digits

If it matches the destination station's Door Release Authorization, "✔" will be displayed for 
"Match Result."

Default values Configured with the same characters as the Door Release Authorization.

Note

• The initial values for the Door Release Authorization and Authentication Key vary depending on the station type set in "File" > 
"Create New System" > "IX Support Tool Settings."

– IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) not configured: 20 digits

– IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) configured: 4 digits

• If the destination station's Door Release Authorization is four characters or longer, the Authentication Key for IX-MV will 
release the door if the first four digits match.

• If “Contact Assignment (→page 259)” is "Originating Station," "Authentication Key" will be "-" and "Match Result" will be "×."

1

2

3

4
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3. Select the station to automatically assign an IP address from "Station List." (Multiple selections 
allowed)
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].

4. Click [OK].
• Click [Cancel] to end the automatic assignment.

5. Click [OK]. The IP Addresses will be automatically assigned, and the subnet mask will be entered.
• Click [Cancel] to return to the "Batch IP Address Configuration" window.
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1.1.2.3 How to configure the date and time manually
This is an explanation for Step 14 of “Use the Wizard function to easily set up the system and make it operational 
(→page 125)”.
On the "Setting File Upload" screen, click [Manual Date / Time Setup] to display the "Manual Date / Time Setup" 
screen.

1. Enter (select) "Year," "Month," "Day," "Hour," "Minute," and "Second."
• Click [Sync with PC] to synchronize the time with the PC.

2. Click [Apply].

3. Click [OK].

4. Click "[Back]" to return to the "Setting File Upload" screen.

1.1.3 Reading in data created by another IX Support Tool

On the "New System" screen, click [Import System Configuration] to display the "Import System Configuration" 
screen.

1

2

1
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1. Click [Browse].
• If the other IX Support Tool is older than Ver. 4.0.0.0, place a check next to "Import system configuration 

from older IX Support Tool (Ver. 4.0.0.0)."

2. Select the folder where the setting file is saved and click [OK].

3. Click [Next].
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1.2 Select Existing System

View or edit existing system setting data.
Click "File" > "Select Existing System." The "System Selection" screen will be shown.

1. Select the system name of the setting data to be edited.

2. Click [OK].
• In the Setting window, the selected setting data will be shown.
• Click [Cancel] to terminate the process without selecting a system.

1.3 Delete Existing System

Delete created setting data.
Select "File" > "Delete Existing System" to display the "Delete System" screen.

1. Select the system name of the setting data to be deleted.

2. Click [OK].
• Delete the selected setting data.
• Click [Cancel] to terminate the process without deleting a system.

1

2
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3. Click [OK].
• Click [Cancel] to return to the "Delete System" screen.

1.4 Update Settings

The edited setting data overwrites the existing one. This feature is identical to [Update] at the top right in the Settings 
screen.
Select "File" > "Update Settings."

1. Click [OK].
• The edited setting data overwrites the existing one.
• Click [Cancel] to quit without overwriting setting data.

2. Click [OK].
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1.5 Download Settings From Station

Obtain (download) settings from a station.
If “Association Settings (→page 160)” is not performed in advance, downloading is not possible.

Click "File" > "Download Settings From Station." The "Setting File Download" screen will be shown.

How to download settings

1. Select the station from which to download the setting file from "Station List." (Multiple selections 
allowed)
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].
• Stations for which “Association Settings (→page 160)” has not been performed cannot be selected.

2. Download the file.
[Settings]: Download only the setting file.
[Sounds]: Download the setting file and audio file for a custom tone.
[Image] (IX-MV7-* only): Download the setting file and image file for the image on the reception screen.
[Schedule] (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), or IXW-MA): Download schedule setting files 
(for transfer, etc.). Schedules for IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) are downloaded from [Settings].

Important

• When first configuring through a Web browser or after performing configuration using the IX Support Tool, when "Identification" 
“Number♦ (→page 170)”, "ID and Password" “ID♦ (→page 156)” and “Password♦ (→page 157)”,"IPv4 Address" “IP Address♦ 
(→page 182)”, "IPv6 Address" “IP Address♦ (→page 183)”, "Address Book" “Station List (→page 209)”, or "Call Settings" 
“Called Stations (Door/Sub Stations) (except IX-MV7-*, IX-MV, and IXW-MA) (→page 225)” is changed through a Web 
browser, the setting file cannot be obtained. In this case, obtain the setting file through a browser.

1

2
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3. Click [OK].
• Click [Cancel] to return to the "Setting File Download" screen without downloading.

4. Click [OK].
• The file download result is displayed in "Station List" - "Status."

In Process: The file is in the process of downloading.
Success: Download is completed.
Failed: Download failed.
Unavailable: This is displayed when a file that cannot be uploaded to a station is selected to download in 
Step 2.

• Downloaded files are saved as follows in "AIPOHONE_IX_SupportTool" - "SystemData" within the folder 
specified during installation.
– Setting file: "NewIXSystem(Set System Name).db"
– Sound file: Saved as a WAV file inside "(Set System Name)" - "Setting (Hidden Folder)" - "(Station 

Number)"
– Image file: Saved as a PNG file inside "(Set System Name)" - "Setting (Hidden Folder)" - "(Station 

Number)"
– Schedule file: Saved inside "(Set System Name)" - "Setting (Hidden Folder)" - "(Station Number)" as 

"SCHED_CHIME.txt," "SCHED_GROUP.txt," "SCHED_OUTPUT.txt," "SCHED_TRANSFER.txt," or 
"SCHED_REC.txt" (the saved content differs depending on the station).



145

Menu bar

1.6 Upload Settings To Station

Upload settings created using IX Support Tool onto the station.
If “Association Settings (→page 160)” is not performed in advance, uploading is not possible.
Click "File" > "Upload Settings To Station." The "Setting File Upload" screen will be shown.

Important

If a custom sound/image was added, be sure to upload each file by selecting "Sounds" / "Image" when uploading.
The following will occur if only the setting file is uploaded.

• The default tone will play when the operation in which the custom tone was set is performed.

• The image will not be displayed in receptionist mode.

• "Download Settings From Station" will fail.

• "Upload Settings To Station" will fail.

1

2
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How to upload settings

1. Select the station from which to upload the setting file from "Station List." (Multiple selections 
allowed)
• To select or unselect stations in a batch, choose the type and click [Select] or [Unselect].
• Stations for which “Association Settings (→page 160)” has not been performed cannot be selected.

2. Upload the file.
[Settings]: Upload only the setting file.
[Sounds]: Upload the setting file and audio file for a custom tone.
[Image] (IX-MV7-* only): Upload the setting file and image file for the image on the reception screen.
[Schedule] (except for IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), or IXW-MA): Select and upload the schedule 
setting file (transfer, etc.). Refer to “How to upload schedules (→page 147)”. Schedules for IX-MV, IX-DA, IX-
DF(-*), and IX-BA, IX-SS(-*) are uploaded from [Settings].

3. If [Settings], [Sounds], or [Image] was clicked in Step 2, click [OK].
• Click [Cancel] to return to the "Setting File Upload" screen without uploading.

4. Click [OK].
• The file upload result is displayed in "Station List" - "Status."

In Process: The file is in the process of uploading.
Success: Upload is completed.
Failed: Upload failed.
Unavailable: This is displayed when a file that cannot be uploaded was selected in Step 2.
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How to upload schedules
In Step 2 of “How to upload settings (→page 146)”, if [Schedule] is clicked, the following screen is displayed.

1. Select the station from which to upload the schedule file, from the station list. (Multiple selections 
allowed)
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].

2. Select the type of schedule file to upload. (Multiple selections allowed)
• The schedule files that can be selected vary by station.

3. Click [Start Upload].

4. Click [OK].
• Click [Cancel] to return to the "Upload Schedules" screen without uploading.

1 2

3
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1.7 Upload SSL certificate

Apply the SSL certificate or IEEE802.1X certificate data to the station.
If “Association Settings (→page 160)” is not performed in advance, uploading is not possible. Select "File" > "Upload 
SSL Certificate" to display the "Certification Update/Delete" screen.

1. Select the type of certificate to be uploaded.
• If "SSL Certificate" is selected, configure the file to upload in “SSL Certificate (→page 309)”.
• If "IEEE802.1X Certificate" is selected, select the file to be uploaded and click [Open].

2. Select the station for which to upload the file from "Station List" (multiple selections allowed).
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].

3. Click [Upload].
• Click [Delete] to delete the uploaded file.

4. Click [OK].
• Click [Cancel] to return to the "Certification Update/Delete" screen without uploading.
• The file upload result is displayed in "Station List" - "Status."

In Process: The file is in the process of uploading.
Success: Upload is completed.
Failed: Upload failed.
Unavailable: This is displayed when a file that cannot be uploaded was selected in Step 1.

1

2

3
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1.8 Import Setting File

A setting file can be modified using a text editor and imported into IX Support Tool.
Click "File" > "Import Setting File." The "Import Setting File" screen will be shown.

How to import a setting file

1. Click [Browse…], select the setting file data (txt file), and then click [Open].
• Setting file data is the txt file output via “Exporting the IX Support Tool System Configuration (→page 150)” 

(file name: config-station number-output date and time.txt)

2. Select the station from which to upload the setting file from "Station List."

3. Click [Apply].

4. Click [OK].
• Click [Cancel] to return to the "Import Setting File" screen without importing.
• If the file to be imported is mismatched with the original file, the file will not be imported.
• The file should be uploaded or downloaded before importing.
• The result is displayed in "Station List" > "Status."

In Process: The Setting File is in the process of importing.
Success: Import is completed.
Failed: Import failed. Try importing again.

1

3
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1.9 Exporting the IX Support Tool System Configuration

Backup setting files created in IX Support Tool.
If the settings are lost, it may be impossible to restore them after maintenance or after-sales servicing.
Select "File" > "IX Support Tool Export System Configuration" to display the "Export Settings" screen.

1. Click [Export].

2. Select the folder where the setting file is saved and click [OK].
• A folder with the name specified in "System Name" will be created in the specified directory, and the system 

configuration file will be saved inside as a hidden file.
Copy each "System Name" and store the setting data.

• Click [Cancel] to return to the "Export Settings" screen without saving the setting file.

3. Click [Finish].

1

3
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1.10 Export To Line Supervision Software

To use registered station information with the IX Supervision Tool, output the file in Address Book format.
Click "File" > "Export To Line Supervision Software." The following screen will be shown.

1. Click [Browse] and select the folder where the setting file will be saved.

2. Click [Export].

3. Click [OK].
• The setting file will be saved as "SettingAddressList.txt."
• Information for stations without configured IP addresses will not be output.

1.11 Exit

Select "File" > "Exit" to close the IX Support Tool.

1

2



152

Menu bar

2. Edit

You can switch between "Table View" and "Station View" or create shortcuts to settings in "Table View" and can edit 
setting data.

2.1 Table View

All stations in the system can be configured using the table.
On the "Station View" window, selecting "Edit" > "Table View" will display the "Table View" window.

For each item in "Table View," refer to “System Settings (Table View) (→page 169)”.

2.2 Station View

Configure each station in the system individually.
On the "Table View" window, selecting "Edit" > "Station View" will display the "Station View" window.

For each item in Station View, refer to “System Settings (Station View) (→page 374)”.

"Station View" window "Table View" window

"Table View" window "Station View" window
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2.3 Master Station Address Book

Click "Edit" > "Master Station Address Book." The following screen will be shown.

For "Master Station Address Book," refer to “Station List (→page 209)”.

2.4 Creating VoIP Phone Address Books

Click "Edit" - "VoIP Phone List." The following screen will be shown.

For "VoIP Phone List," refer to “VoIP Phone Registration (→page 227)”.

2.5 Register Network Camera

Click "Edit" > "Register Network Camera." The following screen will be shown.
For "Register Network Camera," refer to “Open Network Camera List (→page 212)”.
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2.6 Network Camera Integration

Click "Edit" - "Network Camera Integration." The following screen will be shown.

For "Network Camera Integration," refer to “Network Camera Integration (for IX-MV7-* and IX-MV) (→page 261)”.

2.7 Master Station Group Settings

Click "Edit" > "Master Station Group Settings." The following screen will be shown.

For "Master Station Group Settings," refer to “Group (for Master) (for IX-MV7-* and IX-MV) (→page 217)”.
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2.8 Door Station Group Settings

Click "Edit" > "Door Station Group Setting." The following screen will be shown.

For "Door Station Group Settings," refer to “Called Stations (Door/Sub Stations) (except IX-MV7-*, IX-MV, and IXW-
MA) (→page 225)”.

2.9 Location Registry

Select "Edit" > "Location Registry" to display the "Location Registry" window.

For "Location Registry," refer to “Register location (except IXW-MA) (→page 174)”.
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2.10 Manual Date / Time Setup

Select "Edit" > "Manual Date / Time Setup" to display the "Manual Date / Time Setup" window.

For "Manual Date / Time Setup," refer to “Manual Date / Time Setup (→page 178)”.

2.11 IX Support Tool Settings

Select "Edit" > "IX Support Tool Settings" to display the "IX Support Tool Settings" window.

How to configure IX Support Tool

1. Configure each item.

2. Click [OK].
• Click [Cancel] to quite without registering.

■ ID♦
Description Set an ID to log in IX Support Tool.

Settings 1-32 alphanumeric characters

Default values admin

1

2
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■Password♦

■System Name♦

■ IP Version

■ Installer Information♦

■Owner Information♦

■Notes♦

Description Set a password to log in IX Support Tool.

Settings 1-32 alphanumeric characters

Default values admin

Description Change the system name.
When changing the system name, the name of the folder where the setting data is stored will be 
changed as well.

Settings 1-64 alphanumeric characters

Default values The system name of the setting data being edited will be shown.

Description Choose the protocol for IX Support Tool.

Settings • IPv4
• IPv6

Default values IPv4

Description Enter the installer information.
The set installer information is displayed in station information/notes in IX-MV7-* - "Station 
Information" - "CONTACT INFORMATION."

Settings 4 rows (1-64 alphanumeric characters per row)

Default values ̶

Description Enter the owner information.

Settings 1-64 alphanumeric characters

Default values ̶

Description Enter the notes.

Settings 1-64 alphanumeric characters

Default values ̶
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3. Language

Set the language of following items.
• The display content of the IX Support Tool.
• The input text language of settings item. (Station Name, Address book, etc.)
• The content of the email message and system log.

Important

• Configure each station through a Web browser individually, to set a different language for each station.

• If the language (configured on the station main unit) displayed on the screen for IX-MV7-* or IX-MV is different from the 
language set in "Language," the characters may appear incorrectly. To avoid this, enter information in the setting data using 
alphabetical characters only.
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4. Tools

4.1 Station Search

Search the stations in IX System connected in the network to show the list.

1. Connect the PC to a network on the same segment as the system.
• Set it to the same protocol as the system. For information on protocol settings, refer to “IX Support Tool 

Settings (→page 156)”.

2. Click "Tools" > "Station Search" to display the searched stations in the "Station Search" screen. 
(Searching may take several minutes.)
• The stations without power and the stations in the process of initialization will not be subject to search.
• Search up to 9999 stations at a time.
• You cannot search for stations on other segments.
• Click [Search] to restart the search.
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4.2 Association Settings

The data created with IX Support Tool is to be assigned to each station.
Associate the settings when creating the setting data.
Some items cannot be configured without association.

1. Connect the PC to a network on the same segment as the system.
• Set it to the same protocol as the system. For information on protocol settings, refer to “IX Support Tool 

Settings (→page 156)”.

2. Select "Tools" > "Association Settings" to perform a station search, and the "Association Settings" 
window will be displayed. (The search may take several minutes)
• The stations without power and the stations in the process of initialization will not be subject to search.
• Search up to 9999 stations at a time.
• Click [Station Search] to restart the search.
• You cannot search for stations on other segments. Refer to Step 9.

Station Setting List
A list of the setting files that 
have been created will be 
shown.

Station List
The searched stations will be 
shown.

Associated Stations List
The settings that have been 
associated will be shown.

Perform association again.

3

4

5 Search again for stations.

Removes association.
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3. Select the file to associate from "Station Settings List."
• A setting file that has already been associated cannot be selected.
• A setting file without a configured IP address cannot be selected.

4. Select the station with which the setting file selected at Step 3 will be associated from "Station List."
• A station that has already been associated cannot be selected.
• Select "Enter station MAC address" to specify a station by entering the MAC address.
• To associate a station on another segment, select "Enter station MAC address" and "Different Networks," 

and then enter the MAC address to specify the station.

5. Click [Apply].
• Associated content is displayed on the "Associated Stations List."

When setting a new IP address or changing an old address, the station will be restarted and the IP address 
and station name will be updated. If a station on another segment was associated in Step 4, it will not be 
updated. Update the IP address and station name through a Web browser.

6. Repeat steps 3 - 5 and associate all stations.
• To dissociate, select the content to remove from "Associated Stations List" (multiple selections allowed), and 

then click [Remove Association].
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4.3 Station Replacement

Use this feature to replace a station. The station can only be replaced with one of the same station type.

1. Connect the PC to a network on the same segment as the system.
• Set it to the same protocol as the system. For information on protocol settings, refer to “IX Support Tool 

Settings (→page 156)”.

2. Replace the station.

3. Select "Tools" > "Station Replacement" to perform a station search, and the "Station Replacement" 
window will be displayed. (The search may take several minutes)
• The stations without power and the stations in the process of initialization will not be subject to search.
• Search up to 9999 stations at a time.
• Click [Search] to restart the search.
• Stations can not be found using search if stations are on different network segments.

4. Select the station to replace from "Station List."
• Stations that are not associated cannot be selected.

5. Select the newly installed station from "Station List."

Note

• To replace a station on another segment, select "Tools" - "Association Settings" to remove the association with the 
malfunctioning station and then associate the newly installed station.

The MAC address for the 
associated stations will be 
displayed. If there are no 
associations, there will be no 
display.

6

5

4
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6. Click [Apply].
• The setting data will be uploaded to the newly installed station.

7. Click [OK].
• Click [Cancel] to return to "Station Replacement" window without uploading.

8. Click [OK].
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4.4 Restore System Settings

If the setting file is lost, the setting file can be restored.
Select "Tools" > "Restore System Settings" or "Create New System" (→page 78), (→page 123), and then click 
[Restore Setting file]" to display the "Restore System Settings" screen.

1. Connect the PC to the network to which the station is connected.

2. Enter the system name which the setting file to be restored.
• System name: 1-64 alphanumeric characters

3. Choose the internet protocol version for the system.
• Set the PC to the same communication type.

4. Click [Station Search] to perform a search and show stations in "Station List." (The search may take 
several minutes)
• The stations without power and the stations in the process of initialization will not be subject to search.
• Search up to 9999 stations at a time.
• Cannot search for stations on other network.

5. Select the station from which to restore the setting file. (Multiple selections allowed)
• If the station number is duplicated or does not exist, the setting file will not be restored.
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].

6. Enter the "ID (Administrator)" and "Password (Administrator)" for the station selected in Step 5.
• If "ID (Administrator)" or "Password (Administrator)" are wrong, the setting file will not be restored.
• The default values of "ID (Administrator)" and "Password (Administrator)" are "admin."

7. Click [Apply].

7

65

4

3

2
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8. Click [OK].
• Click [Cancel] to return to the "Restore System Settings" window.

9. Click [OK].
• The result is displayed in "Station List" > "Status."

Restoring: The setting file is in the process of restoring.
Success: Restore successful.
Failed: Restore failed.

• Restored setting files are saved as follows in "AIPHONE_IX_SupportTool" - "SystemData" within the folder 
specified when installing IX Support Tool.
– Setting file: "NewIXSystem(Set System Name).db"
– Sound file: Saved as a WAV file in "(Set System Name)" - "Setting (Hidden Folder)" - "(Station Number)"
– Image file: Saved as a PNG file in "(Set System Name)" - "Setting (Hidden Folder)" - "(Station Number)"
– Schedule file: Saved in "(Set System Name)" - "Setting (Hidden Folder)" - "(Station Number)" as 

"SCHED_CHIME.txt," "SCHED_GROUP.txt," "SCHED_OUTPUT.txt,"
"SCHED_TRANSFER.txt," or "SCHED_REC.txt" (the saved content differs depending on the station; 
included in the setting file for IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)).

• The items that could not be restored are displayed as shown below.
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4.5 System Configuration

The process from associating a newly created setting file to uploading the setting file can be configured here.
Select "Tools" - "System Configuration." The "System Configuration" screen will be shown.

The procedure for "System Configuration" is the same from step 5 in “Use the Wizard function to easily set up the 
system and make it operational (→page 125)”.
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5. Help

5.1 Update Firmware

Select "Help" > "Update Firmware" to display the "Update Firmware" window.

For "Update Firmware," refer to “Firmware Update (→page 546)”.
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5.2 About

Select "Help" > "About" to display the "Version Information" window.

Click [Close] to close the "Version Information" window.

The Installer Information, Owner Information, and Notes entered 
in “IX Support Tool Settings (→page 156)” will be displayed.

The current version of the IX Support Tool.



System Settings (Table
View)

Important

• Depending on the language settings of the station (IX-MV7-* or IX-MV), the content of the settings may differ from this manual.

• The symbols indicate the following:
♦: Be sure to input the settings. Leave any of these unused settings at their default values.
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1. Station Information

1.1 Identification

Configure the station number, station name, and location of the station to register in the system.
Up to 500 stations can be registered.

■Number♦

Important

• Always configure “Language (→page 158)” before setting "Identification."

• Enter the language configured in “Language (→page 158)”. However, if the language displayed on the screen for IX-MV7-* or 
IX-MV (configured on the station main unit) is different from that set in “Language (→page 158)”, the characters on the station 
screen may appear incorrectly. To avoid this, enter information in the setting data using alphabetical characters only.

• Results when searching by station will be listed in order of station number.

Description Set an unique number for each station. The station number will be displayed on the  screen of 
the destination during call, page, etc.
This is also used to search stations by station number for IX-MV7-* and IX-MV.

Settings 3-5 digits

Default values Start from 0001.

“Remove Station (→page 173)”

“Register location (except IXW-MA) (→page 174)”

Move row
Up to 50 station number rows can be 
displayed at a time. Switch the display 
as follows.
[Previous]: Display the previous 50 
rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number 
and click [Display] to move the cursor 
to the entered row.

“Add a Station (→page 172)”
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■Name

■Location (except IXW-MA)

Description Set the station name.
The station name will be displayed on the  screen of the destination during call, page, etc.
This is also used to search stations by station name for IX-MV7-* and IX-MV.

Settings 1-24 alphanumeric characters

Default values IX-MV7-*, IX-MV: Master Station (number); IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*): Video Door 
Station (number); IX-SSA(-*), IX-SS-2G, IX-BA, IX-SS(-*): Audio Door Station (number); IX-RS-
*: Handset Sub Station (number);IXW-MA: I/O Adaptor (number)

Remarks If left blank, station name will be the same as station number.

Description Select the Location of the station.
The location will be displayed on the  screen of the destination during call, page, etc.

Settings Select one from the Location registered in “Register location (except IXW-MA) (→page 174)”.

Default values -
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1.1.1 Add a Station

Add a Station to setting data.
Click [Add New Station] to display the "Add New Station" screen.

■How to add a station

1. Enter the station type and the number of the stations to be added.

2. Click [Add].

3. Click [OK].
• Click [Cancel] to end the process for adding a new station.
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1.1.2 Remove Station

Delete a station from the settings.
Click ["Remove Station"] , the "Station Removal" window will be shown.

How to delete a station

1. Select the station(s) to be deleted.

2. Click [Delete].
• Click [Cancel] to end the Station Removal.

3. Click [Yes] to delete the station.

• Click [No] to cancel the deletion and return to the "Station Removal" window.

4. Click [OK].

1

2
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1.1.3 Register location (except IXW-MA)

Click [Location Registry] , the "Location Registry" window will be shown.
Up to 100 locations can be registered. However, only locations set between 001 and 050 can be used with IX-MV, IX-
DA, IX-DF(-*), and IX-BA, IX-SS(-*).

How to register a location

1. Enter the location in "Location List." For IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*), enter 
locations within range of 001-050.
• Location: 1 - 24 alphanumeric characters

2. Click [Update].

3. Click [OK].

1
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1.2 ID and Password

Set the ID and password for logging in via a web browser, and the ID and password for ONVIF/RTSP authentication.

■Administrator ID♦

■Administrator Password♦

■User ID♦

■User Password♦

Description Set the ID of the administrator account for logging in to the Web System Setting Server.
For IX-MV7-*, configure the administrator ID used to access the station's Settings screen.

Settings 1-32 alphanumeric characters

Default values admin

Description Set the Password of the administrator account for logging in to the Web System Setting Server.
For IX-MV7-*, configure the administrator password used to access the station's Settings screen.

Settings 1-32 alphanumeric characters

Default values admin

Description Set the ID of the user account for logging in to the Web System Setting Server.

Settings 1-32 alphanumeric characters

Default values user

Description Set the Password of the user account for logging in to the Web System Setting Server.

Settings 1-32 alphanumeric characters

Default values user

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■ONVIF ID (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♦

■ONVIF Password (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♦

■RTSP ID (for IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-*)♦

■RTSP Password  (for IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-*)♦

Description Set the ID to access this station from 3rd party products using ONVIF.
The setting values for IX-DA, IX-DF(-*) cannot be changed from their default values (they are not 
shown in the Settings screen).

Settings 1-32 alphanumeric characters

Default values aiphone

Description Set the Password to access this station from 3rd party products using ONVIF.
The setting values for IX-DA, IX-DF(-*) cannot be changed from their default values (they are not 
shown in the Settings screen).

Settings 1-32 alphanumeric characters

Default values aiphone

Description Set the ID to access this station from 3rd party products using RTSP.

Settings 1-32 alphanumeric characters

Default values aiphone

Description Set the Password to access this station from 3rd party products using RTSP.

Settings 1-32 alphanumeric characters

Default values aiphone

Note

• The "Administrator ID" and "User ID" cannot be identical.

• The ONVIF port number is "10080" and the RTSP port number is "554."

• To view video from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) using a 3rd party product, refer to “Using a 3rd party product to monitor 
video/audio from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) (→page 199)”.

• The ONVIF ID and ONVIF password for IX-DA, IX-DF(-*) can be changed on a 3rd party product. If changed on a 3rd party 
product, the Settings screen will not show the changes.

• The "Administrator Password," "User Password," "ONVIF Password," and "RTSP Password " are displayed as "*****" on the 
screen.
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1.3 Time

Set the date and time for each station.

1.3.1 Time Zone

■Select time zone

1.3.2 Daylight Savings Time

■Enable automatic daylight savings time

Description Set the Time Zone.

Settings Select from 99 regions

Default values When a new system is created, the following settings will be set to these defaults depending on 
the language selected.
Japanese: (GMT+09:00) Osaka, Sapporo, Tokyo
English: (GMT-08:00) Pacific Standard Time (US), Tijuana
French: (GMT+01:00) Brussels, Madrid, Copenhagen, Paris
Spanish: (GMT+01:00) Brussels, Madrid, Copenhagen, Paris
Dutch: (GMT+01:00) Amsterdam, Berlin, Bern, Rome, Stockholm
Traditional Chinese: (GMT+08:00) Taipei
Simplified Chinese: (GMT+08:00) Beijing, Chongqing, Hong Kong, Urumqi

Description The daylight saving time is set automatically according by region selected in "Select time zone."

Settings • Yes
• No

Default values No

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

“Manual Date / Time Setup (→page 178)”
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1.3.3 Manual Date / Time Setup

Enter the time for each station. Time is used for incoming calls, outgoing calls, and the system log.

Click [Manual Date / Time Setup] , the  "Manual Date / Time Setup" window will be shown.

How to configure the date and time

1. Select "Year," "Month," "Day," "Hour," "Minute," and "Second."
• Click [Sync with PC] to synchronize with PC.

2. Click [Apply].
• If "Association Settings" has not been configured, the following screen will be shown.

Click [OK] and use “Association Settings (→page 160)”.

• If the PC cannot communicate with the system, the following screen will be shown.
Click [OK], and then ensure the PC can communicate with the system.

3. Click [OK].

Important

• The time cannot be set unless the “Association Settings (→page 160)” is performed and the PC is connected to the same 
network as the station.

1

2
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1.4 Expanded System

■Expanded System
Description Not used.
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2. Network Settings

2.1 IP Address

Configure the hostname, IP address, subnet mask, and default gateway for each station.

■Hostname (except IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*))

■ IP Version

Important

• When a setting related to the IP address is updated on a station, it will restart. In some cases, it may take up to 10 minutes for 
the station to start up.

Description Set the Hostname for each station. Hostname can be used to access to the stations that is 
registered in “Address Book (for IX-MV7-* and IX-MV) (→page 208)” and “Called Stations (Door/
Sub Stations) (except IX-MV7-*, IX-MV, and IXW-MA) (→page 225)”.

Go to “DNS (→page 185)” to set Hostname.

Settings 1-64 alphanumeric characters

Default values -

Note

• Communication from IX Support Tool to the stations use the IP address.

Description Select the Protocol.

Settings • IPv4
• IPv6

Default values IPv4

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

“Batch IP Address Configuration (→page 183)”
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■Static / DHCP

Important

• IPv4 and IPv6 cannot be mixed in the same system.

Description Select Static or DHCP for the selected IP version in "IP Version."

Settings For IPv4
• Static
• DHCP

For IPv6
• Static
• Stateless
• DHCPv6

Default values • Static

Important

• When selecting "DHCP" for IPv4, configure the system so that the DHCP server assigns a Static IP Address to each station.

• When selecting "Stateless" for IPv6, do not change the prefix of the device so that it can transmit RA.

• When selecting "DHCPv6" for IPv6, configure the system so that the DHCP server assigns a Static IP Address to each station. 
DUID of the station is "00030001 + MAC address."

• When setting up a product from another manufacturer, such as a DHCP server, refer to its manual.
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2.1.1 IPv4 Address

■ IP Address♦

■Subnet Mask♦

■Default Gateway

Important

• If “Static / DHCP (→page 181)” is set to "DHCP," settings will not be applied to the station even if the "IP Address," "Subnet 
Mask," and "Default Gateway" are set.

Description Set the IP Address.
The IP Address should be unique.

Settings 1.0.0.1 - 223.255.255.254

Default values -

Description Set the Subnet Mask.

Settings 128.0.0.0 - 255.255.255.255

Default values -

Description Set the Default Gateway.

Settings 1.0.0.1 - 223.255.255.254

Default values -
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2.1.2 IPv6 Address

■ IP Address♦

■Default Gateway

2.1.3 Batch IP Address Configuration

Click ["Batch IP Address Configuration"] , the "Batch IP Address Configuration" window will be shown.

How to perform Batch IP Address Configuration

1. Enter the starting address that is to be automatically assigned to "IPv4 Address" or "IPv6 Address."

2. For IPv4, enter "Subnet Mask."
• With the subnet mask, set the range for assignment. The network addresses in the range and the broadcast 

addresses cannot be assigned.

3. Select the station to which the IP address in "Station List" is to be automatically assigned.
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].

Important

• If "Static / DHCP" is set to "Stateless" or "DHCPv6," settings will not be applied to the station even if "IP Address" and "Default 
Gateway" are set.

Description Set the IP Address.
The IP Address should be unique.

Settings 2000::0 - 3FFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or FD00::0 - 
FDFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -

Description Set the Default Gateway.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -

1

2

3

4
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4. Click [OK].

5. Click [OK]. the Batch IP Addresses will be automatically assigned, and the subnet mask will be 
entered.
• Click [Cancel] , the screen will go back to "Batch IP Address Configuration" window.
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2.2 DNS

When IPv4 or IPv6 is configured by hostname for each entry, or when using the email function configured in “Email 
(→page 269)” for IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*) a DNS server must be configured for name 
resolution.

2.2.1 Primary Server

■ IPv4

■ IPv6

2.2.2 Secondary Server

■ IPv4

■ IPv6

Description Set the IPv4 address for DNS Primary Server.

Settings 1.0.0.1 - 223.255.255.254

Default values -

Description Set the IPv6 address for DNS Primary Server.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -

Description Set the IPv4 address for DNS Secondary Server.

Settings 1.0.0.1 - 223.255.255.254

Default values -

Description Set the IPv6 address for DNS Secondary Server.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.



186

System Settings (Table View)

2.3 SIP (except IXW-MA)

Configure SIP settings.

2.3.1 SIP Connections

■SIP Signaling Port♦

■User Agent (except IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*))

2.3.2 SIP Server (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*))

Configure integration with 3rd party SIP based PBX systems. Please contact your local Aiphone distribution for more 
information.

2.3.2.1 Primary Server

■ ID

Description Set the Port Number for SIP.
Set the same port number for each station to communicate.

Settings 1 - 65535

Default values 5060

Description Set the User Agent.

Settings 1-36 alphanumeric characters

Default values ̶

Description Configure the user ID for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

Jump to related item
Moves to the selected item within the same Settings screen.
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■Password

■ IPv4 Address

■ IPv6 Address

■Port♦

2.3.2.2 Secondary Server

■ ID

■Password

■ IPv4 Address

Description Configure the user password for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Note

• The "Password" is displayed as "*****" in the Settings screen.

Description Configure the IPv4 address of the SIP server.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -

Description Configure the IPv6 address of the SIP server.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -

Description Configure the Port Number to communicate with the SIP server.

Settings 1 - 65535

Default values 5060

Description Configure the user ID for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Description Configure the user password for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Note

• The "Password" is displayed as "*****" in the Settings screen.

Description Configure the IPv4 address of the SIP server.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -
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■ IPv6 Address

■Port♦

2.3.2.3 Tertiary Server

■ ID

■Password

■ IPv4 Address

■ IPv6 Address

■Port♦

Description Set the IPv6 address of the SIP server.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -

Description Set the Port Number to communicate with the SIP server.

Settings 1-65535

Default values 5060

Description Configure the user ID for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Description Configure the user password for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Note

• The "Password" is displayed as "*****" in the Settings screen.

Description Set the IPv4 address of the SIP server.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -

Description Set the IPv6 address of the SIP server.

Settings ::FF:0-FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname(1-64 alphanumeric 
characters)

Default values -

Description Set the Port Number to communicate with the SIP server.

Settings 1-65535

Default values 5060
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2.3.3 Miscellaneous

■Register Transmission Interval [sec] (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-
SS(-*)) ♦

■DTMF digit interval timeout [sec] (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*)) 
♦

■Call health check timer [sec]♦

Description Configure the Transmission Interval to send Register to the SIP server.

Settings 10-14400 sec

Default values 3600 sec

Description Configure the time to timeout signal reception, when a DTMF signal is not received from the 
VoIP Phone for a continuous period of time.

Settings 1-10 sec

Default values 5 sec

Important

• Configure the IP-PBX and VoIP phone DTMF with outbound.

Description Set the timer to transmit re-INVITE while calling and monitoring.

Settings • Do not transmit re-INVITE: Do not detect communication errors.
• 80-3600 sec: Select to set between 80-3600 sec (by 1 sec).

Default values 90 sec
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2.4 Multicast Address (For IX-MV7-*, IX-MV, IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

This must be configured if multicast is enabled in “Group (for Master) (for IX-MV7-* and IX-MV) (→page 217)”, “All 

Page (for IX-MV7-* and IX-MV) (→page 256)”, and “Called Stations (Door/Sub Stations) (except IX-MV7-*, IX-MV, 
and IXW-MA) (→page 225)”.

■ IPv4

■ IPv6

Note

• A multicast address must be configured to utilize All Page.

Description Set the IPv4 Multicast Address. The Multicast Address should be unique.

Settings 224.0.0.0 - 239.255.255.255

Default values -

Description Set the IPv6 Multicast Address. The Multicast Address should be unique.

Settings FF10::0 - FF1F:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -

“Batch Multicast Address Configuration (→page 191)”

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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2.4.1 Batch Multicast Address Configuration

Click [Batch Multicast Address Configuration] , the "Batch Multicast Address Configuration" window will be shown.

How to perform Batch Multicast Address Configuration

1. Enter the starting multicast address that is to be automatically assigned to "IPv4" or "IPv6."

2. Select the station(s) to which the multicast address in "Station List" is to be automatically assigned.
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].

3. Click [OK].

4. Click [OK], the multicast addresses will be automatically assigned.
• Click [Cancel], the screen goes back to "Batch Multicast Address Configuration" window.

1

2

3
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2.5 Video (for IX-MV7-*, IX-MV, IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

Configure video settings.

2.5.1 Video Encoder 1

Configure video settings when placing a call between stations, during communication, or when calling a VoIP phone. 
Configure video settings for IX-MV7-* in “Master Station Video Setting (for IX-MV7-*) (→page 197)”.

■Video Codec (for IX-DA, IX-DF(-*))

■Resolution (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

Description Select Video Codec.

Settings • H.264 / AVC
• Motion-JPEG

Default values H.264 / AVC

Note

• For IX-DV, IX-DVF(-*), "Video Codec" is set to "H.264 / AVC" and cannot be changed.

Description Select the video resolution of Video Encoder 1.

Settings • 320×240 (QVGA)
• 640×480 (VGA)

Default values IX-DV, IX-DVF(-*): 640×480 (VGA)
IX-DA, IX-DF(-*): 320×240 (QVGA)

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

Move to Related Settings
Moves to the selected item within the same Settings screen.
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■Frame Rate [fps] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■Select Profile [H.264 / AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■ I-picture interval [H.264/AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♦

■Bit rate [kbps] [H.264 / AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

Description Set the Frame Rate [fps] of Video Encoder 1.

Settings 1, 2 (for IX-DV, IX-DVF(-*)), 3, 5, 7.5, 10, 15, 20, 30 fps
For IX-DA and IX-DF(-*), when the frame rate is set to 7.5, 10, 15, 20 or 30 fps, the frame Rate 
will be 5 fps after approx. 10 min of an outgoing call.

Default values IX-DV, IX-DVF(-*): 10fps
IX-DA, IX-DF(-*): 15 fps

Note

• The frame rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.

Description Select the H.264/AVC Profile of Video Encoder 1.

Settings • Baseline
• Main
• High

Default values Main

Description Set the interval to send H.264/AVC I-picture of Video Encoder 1.

Settings 1 - 100

Default values IX-DV, IX-DVF(-*): 10
IX-DA, IX-DF(-*): 15

Description Set the H.264/AVC Bit Rate of Video Encoder 1.

Settings 32 (for IX-DV, IX-DVF(-*)), 64, 128, 256, 384, 512, 768, 1024, 2048 kbps

Default values 1024 kbps

Note

• The bit rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.
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■Select Quality [Motion-JPEG] (for IX-DA, IX-DF(-*))

■RTP Start Port♦

■RTP End Port♦

Description Select the Quality of Motion-JPEG of Video Encoder 1.

Settings 1 (low) - 10 (high)

Default values 6

Description Set the range of port numbers to transmit and receive RTP for Video Encoder 1.
Set the difference to 90 or greater in the range of (RTP Start Port) - (RTP End Port).

Settings 1 - 65534

Default values 30000

Description Set the range of port numbers to transmit and receive RTP for Video Encoder 1.
Set the difference to 90 or greater in the range of (RTP Start Port) - (RTP End Port).

Settings 1 - 65535

Default values 31000
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2.5.2 Video Encoder 2

Set when transmitting video using ONVIF.
To view video from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) with a 3rd party product, refer to “Using a 3rd party product to 
monitor video/audio from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) (→page 199)”.

■Second Video Encoder (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■Video Codec (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■Resolution (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■Frame Rate [fps] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

Important

• These settings may be changed by ONVIF-compliant 3rd party products, if utilized. Refer to the manual of the 3rd party 
product to be used.

Description Select Enable / Disable for Second Video Encoder.
Set to "Enable" to send the video using ONVIF.

Settings • Enable
• Disable

Default values Enable

Description Select the Video Codec of Video Encoder 2.

Settings • H.264 / AVC
• Motion-JPEG

Default values H.264 / AVC

Description Select the video resolution of Video Encoder 2.

Settings • 320x240(QVGA)
• 640x480(VGA)
• 800x480(WVGA) (For IX-DV, IX-DVF(-*))
• 1280x720(HD) (For IX-DV, IX-DVF(-*))
• 1280x960(SXVGA) (For IX-DV, IX-DVF(-*))

Default values IX-DV, IX-DVF(-*): 1280x720(HD)
IX-DA, IX-DF(-*): 320x240(QVGA)

Description Set the Frame Rate [fps] of Video Encoder 2.

Settings 1, 2 (for IX-DV, IX-DVF(-*)), 3, 5, 7.5, 10, 15, 20, 30 fps
For IX-DA and IX-DF(-*), when the frame rate is set to 7.5, 10, 15, 20 or 30 fps, the frame Rate 
will be 5 fps after approx. 10 min of an outgoing call.

Default values IX-DV, IX-DVF(-*): 10 fps
IX-DA, IX-DF(-*): 15 fps

Note

• The frame rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.
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■Select Profile [H.264 / AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■ I-picture interval [H.264/AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♦

■Bit rate [kbps] [H.264 / AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■Select Quality [Motion-JPEG] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■RTP Start Port♦

■RTP End Port♦

Description Select the H.264/AVC Profile of Video Encoder 2.

Settings • Baseline
• Main
• High

Default values Main

Description Set the interval to send H.264/AVC I-picture of Video Encoder 2.

Settings 1 - 100

Default values IX-DV, IX-DVF(-*): 10
IX-DA, IX-DF(-*): 15

Description Set the H.264/AVC Bit Rate of Video Encoder 2.

Settings 32 (for IX-DV, IX-DVF(-*)), 64, 128, 256, 384, 512, 768, 1024, 2048, 4096 (for IX-DV, IX-DVF(-
*)), 8192 (for IX-DV, IX-DVF(-*)) kbps

Default values IX-DV, IX-DVF(-*): 2048 kbps
IX-DA, IX-DF(-*): 1024 kbps

Note

• The bit rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.

Description Select the Quality of Motion-JPEG of Video Encoder 2.

Settings 1 (low) - 10 (high)

Default values 6

Description Set the range of port numbers to transmit and receive RTP for Video Encoder 2.
Set the difference to 10 or greater in the range of (RTP Start Port) - (RTP End Port).

Settings 1 - 65534

Default values 32000

Description Set the range of port numbers to transmit and receive RTP for Video Encoder 2.
Set the difference to 10 or greater in the range of (RTP Start Port) - (RTP End Port).

Settings 1 - 65535

Default values 33000
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2.5.3 Master Station Video Setting (for IX-MV7-*)

Configure video settings for the IX-MV7-* camera.

■Video Streaming

■Frame Rate [fps]

■Select Profile

■ I-picture interval♦

■Bit rate [kbps]

Important

• When sending video to an VoIP Phone, configure to the same video settings as the VoIP Phone.

• Video is not sent when making an outgoing call to a VoIP Phone.

Description Select Enable / Disable for Video Streaming of IX-MV7-*. Video cannot be distributed to 3rd 
party products not compatible with ONVIF or to IX-MV.  The Video Codec is H.264 / AVC.

Settings • Enable
• Disable

Default values Enable

Description Set the Frame Rate [fps].

Settings 0.5, 1, 2, 3, 5, 7.5, 10, 15, 20, 30 fps

Default values 15 fps

Note

• The frame rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.

Description Set the profile for Video Streaming.

Settings • Baseline
• Main
• High

Default values Main

Description Select the interval to send I-picture for Video Streaming.

Settings 1 - 100

Default values 15

Description Select the bit rate [kbps].

Settings 32, 64, 128, 256, 384, 512, 768, 1024, 2048 kbps

Default values 1024 kbps
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Note

• The bit rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.
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2.5.4 Using a 3rd party product to monitor video/audio from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)

IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) support ONVIF Profile S and RTSP.
Video and audio of  IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) can be monitored from a 3rd party product.

Configuring IX-DV, IX-DVF(-*), and IX-DA so that video can be viewed on a 3rd party product.

1. Select "Enable" for “Second Video Encoder (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) (→page 195)”.

2. Configure video and audio settings.
• Configure video in “Video Encoder 2 (→page 195)”, and audio in “Audio 2 RTP Start Port♦ (→page 202)” and 

“Audio 2 RTP End Port♦ (→page 202)”.

3. Register IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) with a third party product. Enter the following as 
necessary.
• For IX-DV, IX-DVF(-*)

– ONVIF ID: Configure in “ONVIF ID (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♦ (→page 176)”.
– ONVIF Password: Configure in “ONVIF Password (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♦ 

(→page 176)”.
– ONVIF Port: 10080
– RTSP ID: Configure in “RTSP ID (for IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-*)♦ (→page 176)”.
– RTSP Password : Configure in “RTSP Password  (for IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-*)♦ 

(→page 176)”.
– RTSP Port: 554

• For IX-DA, IX-DF(-*)
– ONVIF ID: aiphone
– ONVIF Password: aiphone
– ONVIF Port: 10080
– RTSP ID: aiphone
– RTSP Password : aiphone
– RTSP Port: 554

• For how to register, refer to the instruction manual of the third party product to be registered.

Important

• Video from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) camera cannot be viewed simultaneously by more than two 3rd party products.

• Audio will not be distributed if “Audio Codec (→page 200)” is set to "G.722."

Important

• Configure “Video Encoder 2 (→page 195)” according to the specification of the product.

Important

• "ONVIF ID" and "ONVIF Password" can be changed on the 3rd party product.

• If changed on a third party product, IX-DA, IX-DF(-*) will not show the changes on IX Support Tool.
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2.6 Audio (except IXW-MA)

Configure the settings for audio.

■Audio Codec
Description Select the Audio Codec.

Settings • G.711 (μ-Law)
• G.711 (A-Law)
• G.722 (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*))

Default values G.711 (μ-Law)

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■Audio RTP Transmission Interval [msec]

Important

• When changing from "G.711" to "G.722" or from "G.722" to "G.711," the station will restart when the change is applied. In 
some cases, it may take around 10 minutes to restart the station.

• Stations with different audio codecs (G.711 and G.722) selected cannot ring, call, monitor, or page each other.

• When changing "G.711" to "G.722" and "G.722" to "G.711," change the custom tones used for the following subcategories to 
audio files with appropriate audio sample rates.“Custom Sound Registry (except IXW-MA) (→page 221)”

– "Call Origination" - “Ringback Tone (except IX-MV) (→page 229)”

– "Call Origination" - “Busy Tone (except IX-MV) (→page 235)”

– "Call Origination" - “Error Tone (Call Failed) (except IX-MV7-* and IX-MV) (→page 236)”

– "Incoming Call" - “Ringtone (→page 238)”

– "Incoming Call" - “Call Button (for IX-MV7-* and IX-MV) (→page 239)”

– "Incoming Call" - “Option Input (for IX-MV7-* and IX-MV) (→page 239)”

– "Relay Output" - “Door Release (→page 249)”

– "Relay Output" - “Relay Control (start) (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*)) (→page 249)”

– "Relay Output" - “Relay Control (end) (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*)) (→page 250)”

– "Option Input Page" - “Message File Name (→page 258)”

– "Network Camera Integration" - “Event Tone (for IX-MV7-*) (→page 263)”

– "Network Camera Integration" - “Event Tone (for IX-MV) (→page 264)”

– "Paging Settings" - “Paging Pretone (→page 267)”

– "Communication Audio Messages" - "Start Communication" - “Message (→page 302)”

– "Communication Audio Messages" - "Code Received" - “Message (→page 303)”

– "Chime" - "Weekly Schedule" - “Chime (→page 305)”

– "Chime" - "Daily Schedule" - “Chime (→page 307)”

– "Speed Dials / Favorites" - "Group Message Page" - “How to configure Group Message Page (for IX-MV7-*) (→page 340)”

– "Speed Dials / Favorites" - "All Message Page" - “How to configure All Message Page (for IX-MV7-*) (→page 342)”

– "Volume / Tone" - “Communication Timeout Notification (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) 
(→page 349)”

– "Volume / Tone" - “Communication End Pretone (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 350)”

– "Volume / Tone" - “Call Queue Notification (for IX-MV7-*) (→page 350)”

– "Volume / Tone" - “Paging Pretone (for IX-MV7-* and IX-MV) (→page 351)”

– "Volume / Tone" - “Auto Answer Tone (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 351)”

– "Volume / Tone" - “On Hold (for IX-MV7-*) (→page 352)”

– "Volume / Tone" - “Key Received (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*)) (→page 352)”

– "Volume / Tone" - “Error (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 353)”

– "Communication" - “Communication Start Tone (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) 
(→page 356)”

– "Monitor" - “Monitored Notification (except IX-MV7-* and IX-MV)  (→page 359)”

Description Set the Audio RTP Transmission Interval.

Settings 20, 40, 60, 80, 100 msec

Default values 20 msec
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■RTP Idle Detection Time [sec]♦

■Audio 1 RTP Start Port♦

■Audio 1 RTP End Port♦

■Audio 2 RTP Start Port♦

■Audio 2 RTP End Port♦

2.6.1 Audio Buffer

■Packets Buffered at Audio Start

Description Set the time to detect RTP idle state for Audio.
When Audio RTP is not received during communication, monitoring, or receiving a page, 
connection will be disconnected after the set time.

Settings 10 - 180 sec (by 1 sec)

Default values 10 sec

Description Set the range of port numbers to transmit and receive Audio RTP,  such as communication 
between IX systems.
Set the difference to 210 or greater in the range of (Audio 1 RTP Start Port) - (Audio 1 RTP End 
Port).

Settings 1 - 65534

Default values 20000

Description Set the range of port numbers to transmit and receive Audio RTP,  such as communication 
between IX systems.
Set the difference to 210 or greater in the range of (Audio 1 RTP Start Port) - (Audio 1 RTP End 
Port).

Settings 1 - 65535

Default values 21000

Description Set the range of port numbers to transmit and receive Audio RTP using ONVIF.
Set the difference to 10 or greater in the range of (Audio 2 RTP Start Port) - (Audio 2 RTP End 
Port).

Settings 1 - 65534

Default values 22000

Description Set the range of port numbers to transmit and receive Audio RTP using ONVIF.
Set the difference to 10 or greater in the range of (Audio 2 RTP Start Port) - (Audio 2 RTP End 
Port).

Settings 1 - 65535

Default values 23000

Description Set the number of packets to accumulate before playing audio.

Settings 0 - 4

Default values 1
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■Maximum Packets Buffered
Description Set the maximum number of packets that can be accumulated.

If a packet is received beyond the set value, it is removed from the oldest packet.
It should be greater than the number of  “Packets Buffered at Audio Start (→page 202)”.

Settings 2 - 10

Default values 3
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2.7 Packet Priority

Configure the Packet Priority and VLAN for audio, video, and SIP packets.

■TOS Value (Audio) (except IXW-MA) ♦

■TOS Value (Video) (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))♦

■TOS Value (SIP) (except IXW-MA) ♦

■VLAN Setting

Important

• When a setting related to VLAN is updated at a station, it will restart. In some cases, it may take around 10 minutes for the 
station to start up.

Description Set the Packet Priority (TOS Value) for Audio.

Settings 0x00 - 0xFF

Default values 0x00

Description Set the Packet Priority (TOS Value) for Video.

Settings 0x00 - 0xFF

Default values 0x00

Description Set the Packet Priority (TOS Value) for SIP.

Settings 0x00 - 0xFF

Default values 0x00

Description Select Enable / Disable for tagged VLAN.

Settings • Enable
• Disable

Default values Disable

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■VLAN ID♦

■VLAN Priority

Important

• When "VLAN Setting" is set to "Enable" and uploaded to the station, ensure that the switches, PCs, and stations are all 
configured for VLAN operation.

Description Set the VLAN ID.

Settings 1 - 4094

Default values 1

Description Set the VLAN priority.

Settings 0 (low) - 7 (high)

Default values 0
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2.8 NTP

Configure NTP settings.

2.8.1 Enable NTP

2.8.2 Synchronization Interval [hour]♦

2.8.3 Primary Server

■Address IPv4

Description Select Yes / No Use to synchronize the time with an NTP server.
If this is set to "Yes," be sure to configure the other subcategories in “NTP (→page 206)”.

Settings • Yes
• No Use

Default values No Use

Description Set the interval to synchronize with the NTP server.

Settings 1-255 hours (by 1 hour)

Default values 24 hour

Description Set the IPv4 address for NTP Primary Server.
Go to “DNS (→page 185)” to set hostname.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■Address IPv6

■Port♦

2.8.4 Secondary Server

■Address IPv4

■Address IPv6

■Port♦

Description Set the IPv6 address for NTP Primary Server.
Go to “DNS (→page 185)” to set hostname.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -

Description Set the port number for NTP. 

Settings 1 - 65535

Default values 123

Description Set the IPv4 address for NTP Secondary Server.
Go to “DNS (→page 185)” to set hostname.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -

Description Set the IPv6 address for NTP Secondary Server.
Go to “DNS (→page 185)” to set hostname.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -

Description Set the port number for NTP. 

Settings 1 - 65535

Default values 123
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3. System Information

3.1 Location Registry (for IX-MV7-* and IX-MV)

Register a location.
For how to register a location, refer to “Register location (except IXW-MA) (→page 174)”.

3.2 Address Book (for IX-MV7-* and IX-MV)

Configure the IX-MV7-* and IX-MV Address Book.
Calling, paging, monitoring, line monitoring, and malfunction monitoring can be performed for any station registered in 
the Address Book. Network cameras can be monitored and outgoing calls can be made to VoIP phones.

Important

• Always configure “Language (→page 158)” before setting "Address Book."

• Enter the language configured in “Language (→page 158)”. However, if the language (configured on the station main unit) 
displayed on the screen for IX-MV7-* or IX-MV is different from that set in “Language (→page 158)”, the characters on the 
station screen may appear incorrectly. To avoid this, enter information in the setting data using alphabetical characters only.

“Station List (→page 209)”

“Open Network Camera List (→page 212)”
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3.2.1 Station List

Register the stations in the Address Book.
Click [Open Station List]. The following window will be shown.

Important

• Stations where “IP Address (→page 180)” is not configured cannot be registered to the Address Book.

• To access stations registered to the Address Book by hostname, configure "IP Address" - “Hostname (except IX-MV, IX-DA, 
IX-DF(-*), or IX-BA, IX-SS(-*)) (→page 180)” and “DNS (→page 185)”.

• Results when searching by station will be listed in order of station number.

If a network camera has not been registered in “Open Network 
Camera List (→page 212)”, this will not be shown.

Move row
Up to 50 station number rows can be displayed at a 
time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.

VoIP Phone Registration(→page 211)
Register the VoIP phone in the Address Book.

3

1

2

List of IX-MV7-*, IX-MV in the Settings data

Move column
Up to 50 station number lines can be displayed at a time. Switch the display 
as follows.
[Previous]: Display the previous 50 columns.
[Next]: Display the next 50 columns.
[Display]: Enter the station number and click [Display] to move the cursor 
to the entered column.

List of stations that can be 
registered to the Address Book
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How to create Station List

1. VoIP phones are registered in “VoIP Phone Registration (→page 227)”.

2. Identify the station to be configured using "List of IX-MV7-* and IX-MV in the Settings data."

3. Identify the station to be registered in the Address Book using "List of stations that can be registered 
to the Address Book."

4. Click cells ("Select" and "Network Camera") that correspond to Steps 1 and 2.
• Select: Register stations in which "✔" has been selected to the Address Book. For IX stations, stations for 

which "SIP" was selected will be registered to the Address Book as VoIP phones.
By default, "✔ (register)" is set for all.

• Network Camera (for IX-MV7-*): Click [Network camera selection] and then select the network camera to 
associate. Network cameras configured in “Open Network Camera List (→page 212)” can be selected. The 
number of the selected network camera will be displayed.
If a network camera is associated with a station, the video from the network camera will be displayed when 
placing a call, during a communication, or when monitoring.

5. When done, click [Update].

6. Click [OK].
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3.2.1.1 VoIP Phone Registration

Register the VoIP phone to the Address Book. When registering a VoIP phone, be sure to also configure “SIP (except 
IXW-MA) (→page 186)”.
On the "Address Book" screen, click [VoIP Phone Registration]. The following window will be shown.

How to perform VoIP Phone Registration

1. In the "Station List," enter the "Number♦," "Name," and "Location."
• Number: 3-32 digits
• Name: 1-24 alphanumeric characters
• Location: Select a location registered in “Register location (except IXW-MA) (→page 174)”.

2. Click [Update].
• Click [Cancel] to close the "Address Book" screen without registering a VoIP phone.
• The registered VoIP phone will be displayed at the end of the Address Book.

1

2

“Register location (except IXW-MA) (→page 174)”
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3.2.2 Open Network Camera List

IX-MV7-* and IX-MV support the ONVIF interface standard "ONVIF profile S."
Video and audio of 3rd party network camera can be monitored on the IX-MV7-*, IX-MV screen.
Register the network camera in the Address Book. Up to 500 network cameras can be registered.
Configure “Network Camera Integration (for IX-MV7-* and IX-MV) (→page 261)” to configure event notification-
related settings for the network camera.
Click [Open Network Camera List]. The following window will be shown.

Move row
Up to 50 station number rows can be 
displayed at a time. Switch the display as 
follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and 
click [Display] to move the cursor to the 
entered row.

List of network cameras that can be registered to the 
Address Book

“Network Camera Registry (→page 213)”

List of IX-MV7-* and IX-MV in Settings data If no network camera is registered, this will not be shown.

1

2

3
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How to create Network Camera List

1. Register the network camera in “Network Camera Registry (→page 213)”.

2. Identify the station to be configured using "List of IX-MV7-* and IX-MV in Settings data."

3. Identify the network camera to be registered in the Address Book using "List of network cameras that 
can be registered to the Address Book."

4. Click the cells ("Select," "PTZ Operation," and "Audio Monitoring") that correspond to Steps 2 and 3.
• Select: Register network cameras with "✔" selected to the Address Book.

All items are "blank (unregistered)" by default.
• PTZ Operation (for IX-MV7-*): Configure whether to allow network camera PTZ operation from the station.

All items are set to "Yes" by default.
• Audio Monitoring (for IX-MV7-*): Configure whether to allow monitoring of network camera audio from the 

station.
All items are set to "Enable" by default.

5. When done, click [Update].

6. Click [OK].

3.2.2.1 Network Camera Registry

Click [Open Network Camera Registry]. The following screen will be shown.

Note

• "PTZ Operation" and "Audio Monitoring" are set to "Enable" for IX-MV and cannot be changed.

Important

• Network camera registration is configured via “Association Settings (→page 160)” on at least one IX-MV7-* or IX-MV station, 
and cannot be configured if the PC cannot communicate with the system (this is because, when registering a network camera, 
the network camera is searched through IX-MV7-* or IX-MV).

“How to register a new network camera (→page 215)”

Select the network camera(s) to be deleted (multiple selections allowed), and click to delete.

If no network camera is registered, this will not be shown.
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■Camera Name♦

■Hostname

■ IP Address (IPv4)

■ IP Address (IPv6)

■ ID♦

■Password♦

Note

• When searching on the station, the numbers will be displayed in the order they were registered.

Description Set the Network Camera Name.

Settings 1-24 alphanumeric characters

Default values -

Description Set the hostname.
Go to “DNS (→page 185)” to set Hostname.

Settings 1-64 alphanumeric characters

Default values -

Description Set the IPv4 address for Network camera.

Settings 1.0.0.1 - 223.255.255.254

Default values -

Description Set the IPv6 address for Network camera.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -

Description Enter ID of the network camera.

Settings 1-32 alphanumeric characters

Default values -

Description Enter Password of the network camera.

Settings 1-32 alphanumeric characters

Default values -

Note

• "Password" is displayed as "*****" in the Settings screen.
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How to register a new network camera
Registration cannot be performed if the PC is not connected to the same network as the network camera.
Click [Add Camera] to search for a network camera (searching may take several minutes).
When searching is done, the "Network Camera Selection" screen will be shown, and the network cameras connected 
in the network will be shown in the "Network Camera Search List."

1. To search by specifying an IP address, select "Manual Network Camera Configuration," and enter 
the "IP Address♦," "ID♦," and "Password ♦" of the network camera.

2. To select from the Network Camera Search List, select "Select from Network Camera Search List." 
Select the network camera(s) to register from the "Network Camera Search List" (multiple selections 
allowed), and then enter the "Hostname," "ID♦," and "Password♦."
When entering the Hostname, configure “DNS (→page 185)”.
To search again, click [Search]. It is also possible change the search time.

3. Click [Get Network Camera Information].
(Obtaining the video profile may take several minutes.)
When video profiles are successfully obtained, they will be shown in "Network Camera Information."

4. Choose the video profile(s) to be registered from the list (multiple selections allowed).

If the video profile cannot be obtained, nothing will be shown.

1

2

3

4

5
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5. Click [Register] to register a network camera.

6. When done, click [Update].

7. Click [OK].
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3.3 Group (for Master) (for IX-MV7-* and IX-MV)

Configure the group for groups calls, group pages, and contact input calls.
Up to 50 groups per station (50 stations per group) can be registered.
Stations other than IXW-MA can be registered to groups.

Important

• Always configure “Language (→page 158)” before setting "Group (for Master)."

• Enter the language configured in “Language (→page 158)”. However, if the language (configured on the station main unit) 
displayed on the screen for IX-MV7-* or IX-MV is different from that set in “Language (→page 158)”, the characters on the 
station screen may appear incorrectly. To avoid this, enter information in the setting data using alphabetical characters only.

• Only a single VoIP Phone can be registered to each group.

• All pages, groups pages, message pages, and external input pages cannot be sent to VoIP Phones.

• Stations “IP Address (→page 180)” has not been configured and that have not been registered in “Address Book (for IX-MV7-
* and IX-MV) (→page 208)” cannot be registered to groups.

• Groups calls and calls by Option Input cannot be made to IX-DA, IX-DF(-*), IX-BA, IX-SS(-*).

• Groups calls and calls by Option Input cannot be made from IX-MV to IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-*.

• Results when searching by station will be listed in order of group number.

Move row
Up to 50 station number rows can be displayed at 
a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.

Move column
Up to 50 station number lines can be displayed at a time. 
Switch the display as follows.
[Previous]: Display the previous 50 columns.
[Next]: Display the next 50 columns.
[Display]: Enter the station number and click [Display] to 
move the cursor to the entered column.
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3.3.1 Configuring a Group

How to configure individual settings
Configure the group to register in each station.

1. Select the group to be configured from "Display Settings."
The Settings screen for the selected group will be shown on the screen.

2. Enter the following information in "Group Information."
• Group Number: 01 - 99

Group numbers must be unique.
• Group Name: 1 - 24 alphanumeric characters

3. Identify the station to be configured using "List of IX-MV7-* and IX-MV in Settings data."

4. Identify the station to be registered from the "list of stations that can be registered to group."

5. Click the cells that correspond to Steps 3 and 4. Select an audio protocol and video protocol setting 
value for each, and register to a group.
The number of registered stations will be shown in "Total."
Audio Protocol
• Blank: Select to not register to a group.
• U: Belongs to group. Paging audio is transmitted in unicast.
• M: Belongs to group. Paging audio is transmitted in multicast.

Video Protocol (only when IX-MV7-* is both the station to configure and register)
• Blank: Video will be transmitted as multicast.
• U: Video will be transmitted as unicast during group calls. Unicast can be used to send video to up to 20 

stations.
• M: Video will be transmitted as multicast during group calls.

1

2

3

4

5

List of stations that can be 
registered to group

List of IX-MV7-* and IX-MV in Settings data Group Information

“How to Create Group from Location(s) (→page 219)”
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The Video Protocol pull-down menu is shown when the Audio Protocol setting is selected.
All items are blank by default.

6. When done, click [Update].

7. Click [OK].

How to Create Group from Location(s)
Groups are automatically created for each location.
Click [Create Group from Location(s)]. The following window will be shown.

1. Select the location(s) for which a group is to be created.

2. Select "Group Number♦."
• 01 - 99

Select a unique value.

Important

• If "M" is selected or "blank" is selected for the Video Protocol, be sure to configure “Multicast Address (For IX-MV7-*, IX-MV, 
IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) (→page 190)”.

• For VoIP phones or stations in which "SIP" was selected in “Station List (→page 209)” or “Called Stations (Door/Sub Stations) 
(except IX-MV7-*, IX-MV, and IXW-MA) (→page 225)”, "M" cannot be selected.

Note

• When making a group call, the Audio Protocol will be set to "U" and cannot be changed.

1 2

3

The locations registered in “Register location (except IXW-MA) (→page 174)” will be 
shown.
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3. Click [OK].
A group will be registered for all configured Location in the selected location and group number. The location is 
shown in the group name.
• Click [Cancel] to return to the "Group" screen without creating a group.

4. Click [OK].

Important

• Registration cannot be performed by selecting only a single station.

• Video Protocol and Audio Protocol settings are all set to "U" by default. To change them to "M," they must be changed 
individually.

• Performing Steps 1 and 4 again will overwrite with new settings.

• A group cannot be created from a location with 50 or more stations registered.
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3.4 Custom Sound Registry (except IXW-MA)

Register audio files to be used for ringback tones, ringtones, message paging, etc.
The numbers of audio files that can be registered to each station are as follows.

Supported file format
• File Type: .wav
• Sample Size: 16 bits
• Sample Rate: 8 kHz (if “Audio Codec (→page 200)” is "G.711 (μ-Law)" or "G.711 (A-Law)"), 16 kHz (if “Audio 

Codec (→page 200)” is "G.722")
• Channel: 1 (monaural)
• File Name: 1-82 alphanumeric characters (without file extensions)

For IX-MV7-*, enter either a letter or number as the first character. Audio files for message paging will be searched 
by a letter or number when paging. 

Station Type Information that can be saved to the station

IX-MV7-* Max. 100 files (with 200 seconds and 8 Mbytes per file)

IX-MV Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-DA, IX-DF(-*) Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-DV, IX-DVF(-*) Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-SSA(-*) Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-SS-2G Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-BA, IX-SS(-*) Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-RS-* Max. 100 files (total length of within 200 seconds and 8 Mbytes)

Note

• If using a file for a ringback tone, ringtone, or network camera event tone, add a period of silence in the .wav file if the tone is 
to be intermittent.

• Sample files of custom tones are provided on our website (https://www.aiphone.net/product/) for download and use as audio 
sources.

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

“How to register multiple custom tones at once (→page 223)”

https://www.aiphone.net/product/
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How to register an audio file

1. Click [Browse] at the end of the row for the station in which the file is to be registered.

2. Select the audio file to register, and click [Open].

3. Information on the selected audio file will be shown.
• Name: Shows the file name of the audio file. Up to  24 alphanumeric characters will be shown.

The name will be shown as the setting value when configuring the ringback tone etc.
If the file name of the audio file exceeds the character limit above, it will only partially be shown.

• File attachment: The audio file reference destination is shown.

4. When done, click [Update].

5. Click [OK].

How to delete a custom tone

1. Check the [Delete] box of the audio file to delete.

2. Click [Update].

3. Click [OK].

Note

• "Name" can be deleted from the Settings screen by selecting “Upload Settings To Station (→page 145)” - "Sounds" to upload 
the setting file,  and then deleting the audio file from the station.
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How to register multiple custom tones at once
Audio files can be registered to multiple stations at once.
Click "Custom Sound Registration." The following screen will be shown.

1. Click [Browse], select the audio file to register, and then click [Open].

2. Enter the number of the custom tone to register the audio file.
• 1 - 100

3. Select the station(s) to register the audio file from "Station List" (multiple selections allowed).
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].

4. Click [Add].
• Click [Cancel] to quit without registering multiple files.

5. Information on the added audio file will be shown.
• Name: Shows the file name of the audio file. Up to 24 alphanumeric characters will be shown.

The Name will be shown when configuring the ringback tone etc.
If the file name of the audio file exceeds the character limit above, it will only partially be shown.

• Browse for .wav file: The audio file reference destination is shown.

6. When done, click [Update].

7. Click [OK].

1

2

3

4
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4. Call Settings

4.1 Station Information (for IX-RS-*, IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G)

Configure the call button function.

■Call Button Function

4.2 Called Stations (Master Stations) (for IX-MV7-* and IX-MV)

A call destination does not have to be set up. Any intercom station registered in “Address Book (for IX-MV7-* and IX-
MV) (→page 208)” can be called.

Description Select the Call Button Function when call button is pressed (for IX-RS-*: Call/Talk button).

Settings • Call: Outgoing call
• Call, Cancel Call, End Communication: Out going call, Cancel outgoing call, End 

Communication
• Call, Answer Call, End Communication: Outgoing call, Answer call or page, End 

communication

Default values Call

Note

• Contact input calls and communication switched from a contact input call cannot be ended by pressing the call button (IX-RS-
*: Call button).

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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4.3 Called Stations (Door/Sub Stations) (except IX-MV7-*, IX-MV, and IXW-MA)

Configure the group to call when a call is made using the call button or via contact input.
• Stations other than IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*): Up to 20 stations can be configured in a single group, 

and up to 10 groups can be configured.
• IX-DA, IX-DF(-*), IX-BA, IX-SS(-*) (for placing a Call Button call): Up to 20 stations can be configured in a single 

group, and only a single group can be configured.
• IX-DA, IX-DF(-*), IX-BA, IX-SS(-*) (for placing a Option Input call): Up to 20 stations can be configured in a single 

group, and up to nine groups can be configured.
Any station other than IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), IXW-MA can be registered as a call recipient.

Important

• An IX-RS, IX-DA, IX-DF(-*) or IX-BA, IX-SS(-*) must be registered under Called Stations (Door/Sub Stations) to use Door 
Release while in communication with IX-DA, IX-DF(-*) or IX-BA, IX-SS(-*). An IX-RS cannot place a call to IX-DA, IX-DF(-*) or 
IX-BA, IX-SS(-*) even IX-DA, IX-DF(-*) or IX-BA, IX-SS(-*) is under Called Stations (Door/Sub Stations.)

List of stations that can 
be registered to group

List of IX-RS-*, IX-DV, IX-DVF(-*), IX-SSA(-*), IX-DA, IX-DF(-*), IX-BA, IX-SS(-*) in setting data

VoIP Phone 
Registration(→page 211)
Register the VoIP phone as 
a call recipient.

Move row
Up to 50 station number rows can be 
displayed at a time. Switch the display as 
follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered 
row.

Move column
Up to 50 station number lines can be 
displayed at a time. Switch the display as 
follows.
[Previous]: Display the previous 50 columns.
[Next]: Display the next 50 columns.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered 
column.

2

3

4

1
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How to configure destinations (Door/Sub Stations)

1. Select the group to configure from "Display Settings."
• The Settings screen for the selected group will be displayed.
• Use the following groups when configuring IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*) destinations.

– Groups used to place a call by operating the call button: "Group number 10"
– Groups used to place a call by Option Input: "Group number 01 - 09"

2. Search for a station to configure from the "list of IX-RS-*, IX-DV, IX-DVF(-*), IX-SSA(-*), IX-DA, IX-
DF(-*), IX-BA, IX-SS(-*) in setting data."

3. Search for the station to be registered from the "list of stations that can be registered to group."

4. Click the cells that correspond to Steps 2 and 3. Select the settings and register the station to the 
group.
• The number of registered stations will be shown in "Total."

– Blank: The selected station will not be registered.
– U: The station will be registered in the call destination. An outgoing call is transmitted as unicast.
– M: Station will be registered in the call destination. Video is transmitted as multicast for an outgoing call.

Station must be IX-DV, IX-DVF(-*), IX-DA, or IX-DF(-*), and the call destination must be IX-MV7-* or IX-
MV.

– SIP: Select this to call an IX station as a VoIP phone.
• For group number 01 for stations other than IX-DA, IX-DF(-*), IX-BA or IX-SS(-*) and group number 10 for 

IX-DA, IX-DF(-*), IX-BA, or IX-SS(-*), all IX-MV7-* or IX-MV stations in the "list of stations that can be 
registered to group" with station numbers in order from 1 to 20 will be set to "U".

5. When done, click [Update].

6. Click [OK].

Important

• Stations in which “IP Address (→page 180)” is not configured cannot be registered as destinations.

• If the station registered to the call destination is anything other than IX-MV7-* or IX-MV, one of the following must be 
configured to receive incoming calls.

– Set to "Call, Answer Call, End Communication" in “Call Button Function (→page 224)”.

– Set to "Answer Call / Page" in "Option Input" - “Function (→page 242)”.

• Do not register the same station multiple times within a group.

• Only one VoIP phone can be registered to each group.

Important

• If "M" is selected, be sure to configure “Multicast Address (For IX-MV7-*, IX-MV, IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) 
(→page 190)”.
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4.3.1 VoIP Phone Registration

Register the VoIP phone in Called Stations (Door/Sub Stations). When registering a VoIP phone, be sure to configure 
“SIP (except IXW-MA) (→page 186)”.
On the "Called Stations (Door/Sub Stations)" screen, click [VoIP Phone Registration]. The following window will be 
shown.

How to perform VoIP Phone Registration

1. In the "Station List," enter the "Number♦," "Name," and "Location."
• Number: 3-32 digits
• Name: 1-24 alphanumeric characters
• Location: Select a location registered in “Register location (except IXW-MA) (→page 174)”.

2. Click [Update].
• Click [Cancel] to close the "VoIP Phone Registration" screen without registering a VoIP phone.
• The registered VoIP phone will be displayed at the end of the Address Book.

1

2

“Register location (except IXW-MA) (→page 174)”
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4.4 Call Origination (except IXW-MA)

Configure outgoing call settings.
Select the call method to configure in [Display Settings].

4.4.1 Call Origination Advanced Settings

■Call Method (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Description Select the Call Method to change call destinations automatically by time delay or schedule.

Settings • Standard Destination: Do not change call destination automatically.
IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*) are fixed to "Standard Destination" and cannot be 
changed.

• Change Destination by Time Delay: Change destination group from “Destination Dwell 1 - 8 
(except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), IX-BA, or IX-SS(-*)) (→page 230)” after 
“Destination Dwell Time (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*))♦ 
(→page 231)”. Up to 8 groups can be used.

• Change Destination by Schedule: Change destination group by “Weekly Schedule (except IX-
MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 232)” and “Daily Schedule 
(except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 234)”.

Default values Standard Destination

Move row
Up to 50 station number rows can be 
displayed at a time. Switch the display 
as follows.
[Previous]: Display the previous 50 
rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number 
and click [Display] to move the cursor 
to the entered row.

Display Settings
Displays settings for the selected outgoing call method.
[Call Button] (except IX-MV): Displays settings related to outgoing calls linked that 
placed by the call button or the bathroom link.
[Option Input 1 - 6]: Displays settings related to outgoing calls when "Call" is selected for 
"Option Input" - “Function (→page 242)”.

“Weekly Schedule (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and 
IX-BA, IX-SS(-*)) (→page 232)”

“Daily Schedule (except IX-
MV7-*, IX-MV, IX-DA, IX-DF(-
*), and IX-BA, IX-SS(-*)) 
(→page 234)”

Move to Related 
Settings
Moves to the 
selected item within 
the same Settings 
screen.
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■Ringback Tone (except IX-MV)

■Call Timeout (except [Call Button] - IX-MV)♦

Description Select the sound to be played by the station when placing a call.
For IX-MV7-*, this will also sound when monitoring.

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Call Button
• IX-MV7-*: Call Pattern 4
• Except IX-MV7-*: Call Pattern 1

Option Input 1
• IX-MV7-*: Call Pattern 4
• Except IX-MV7-*: Call Pattern 2

Option Input 2
• IX-MV7-*: Call Pattern 4
• IX-DV, IX-DVF(-*), IX-SSA(-*): Call Pattern 3

Option Input 3
• IX-MV7-*: Call Pattern 4
• IX-DV, IX-DVF(-*), IX-SSA(-*): Call Pattern 4

Option Input 4
• IX-MV7-*: Call Pattern 4
• IX-DV, IX-DVF(-*), IX-SSA(-*): Call Pattern 5

Option Input 5
• IX-DV, IX-DVF(-*), IX-SSA(-*): Call Pattern 6

Option Input 6
• IX-DV, IX-DVF(-*), IX-SSA(-*): Tremolo Sound

Description Configure the Call Timeout for outgoing call.

Settings • Infinite: Keep calling until call is answered
• 10-600sec: Select to set between 10-600 sec (by 1 sec)

Default values 60sec

Note

• For [Call Button], the outgoing call time for IX-MV is set on the station.
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■Ringback Tone Count [time(s)] (except [Call Button] IX-MV)

■Call Destination ([Option Input 1-4] - for IX-MV7-* and IX-MV)

■Standard Mode Settings (except IX-MV7-* and IX-MV)

■Destination Dwell 1 - 8 (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), IX-BA, or IX-SS(-*))

Description Set the play count of ringback tone for outgoing call.

Settings • Infinite: The ring back tone continues to play for the amount of time set in “Call Timeout 
(except [Call Button] - IX-MV)♦ (→page 229)”.

• 1 - 20 times

Default values Infinite

Note

• For [Call Button], the ringtone count for IX-MV is set on the station.

Description Configure the call destination group and call priority.
Enter the group number directly, or click [Open] to select a group.

Settings • Group Number: 01 - 99. Select from groups registered in “Group (for Master) (for IX-MV7-* 
and IX-MV) (→page 217)”.

• Priority: Normal/Priority/Urgent

Default values • Group Number: -
• Priority: Normal

Description Select the destination group when "Standard Destination" is selected in “Call Method (except IX-
MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 228)”.

Settings • Call Destination: 01 - 10. Select from groups registered in “Called Stations (Door/Sub Stations) 
(except IX-MV7-*, IX-MV, and IXW-MA) (→page 225)”.
The call group number for IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*) is fixed to "10" and cannot be 
changed for [Call Button], or can be selected from "01 - 09" for [Option Input 1].

• Priority: Normal/Priority/Urgent

Default values Call Button
• Call Destination: 01 (10 for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Priority: Normal

Contact input 1 - 5 call
• Call Destination: - (01 for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Priority: Normal

Option Input 6
• Call Destination: 01
• Priority: Urgent

Description Configure the call priority for the call group to switch when “Call Method (except IX-MV7-*, IX-
MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 228)” is set to "Change Destination by Time 
Delay." Up to 8 groups can be configured, and it will switch between groups in order by the time 
configured in "Destination Dwell Time."

Settings • Call Destination: 01 - 10. Select from groups registered in “Called Stations (Door/Sub Stations) 
(except IX-MV7-*, IX-MV, and IXW-MA) (→page 225)”.

• Priority: Normal/Priority/Urgent

Default values • Call Destination: -
• Priority: Normal
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■Destination Dwell Time (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*))♦
Description Configure the delay time to change the call destination when "Change Destination by Time 

Delay" is selected in “Call Method (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-
SS(-*)) (→page 228)”.

Settings 10-600sec / 1 sec step

Default values 30 sec
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4.4.1.1 Weekly Schedule (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))
Configure when “Call Method (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 228)” is set 
to "Change Destination by Schedule."
Configure the switch time for the call destination, the call destination group, and the call priority each day from Sunday 
to Saturday. 12 schedules can be set for each day.

■Start Time

■End Time

■Call Destination

Description Configure the time to start changing the call destination.

Settings 00:00 - 23:59

Default values -

Description Configure the time to stop changing the call destination. If this is set earlier than "Start Time," the 
end time will be for the following day.

Settings 00:00 - 23:59

Default values -

Description Configure the call destination to change within the schedule.

Settings 01 - 10. Select from groups registered in “Called Stations (Door/Sub Stations) (except IX-MV7-*, 
IX-MV, and IXW-MA) (→page 225)”.

Default values -

Weekly Schedule
Select the day and schedule range to configure. The Settings screen 
is shown.
“How to configure schedule display (→page 233)”

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■Priority

How to configure schedule display
Configure the day and schedule range shown on the Settings screen for the weekly schedule.
The display can be filtered to show only the day and schedule to configure.
Click Schedule View Adjustment. The following screen will be shown.

1. Select the day(s) to display from "Day" (multiple selections allowed).
• To select or unselect all days at once, click [Select] or [Unselect].
• By default, all days are shown.

2. Select the range of schedules to display (1 - 12) that can be configured for each day of the week.
• By default, the range of 1 - 3 is shown.

3. Click [OK].
• Click [Cancel] to return to the previous menu..

Description Configure the priority of calls.

Settings • Normal
• Priority
• Urgent

Default values -

1

2

3
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4.4.1.2 Daily Schedule (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))
Configure when “Call Method (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 228)” is set 
to "Change Destination by Schedule."
Configure the switch time for the destination, the call group, and the call priority in units of one day. A schedule one 
year from the set day can be configured. 12 schedules can be set for each day.

■Start Time

■End Time

■Call Destination

Description Configure the time to start changing the call destination.

Settings 00:00 - 23:59

Default values -

Description Set the time to stop changing the call destination. If this is set earlier than "Start Time," the end 
time will be for the following day.

Settings 00:00 - 23:59

Default values -

Description Set the call destination to change within the schedule.

Settings 01 - 10. Select from groups registered in “Called Stations (Door/Sub Stations) (except IX-MV7-*, 
IX-MV, and IXW-MA) (→page 225)”.

Default values -

Daily Schedule
Select the date and schedule range to configure. The Settings screen will be 
shown.

1. Select the date from the drop down menu.

2. Select the range of schedules to display (1 - 12) that 
can be configured for each day.
• By default, the range of 1 - 3 is shown.

3. Click [Change to Daily Schedule Display].

Move row
Up to 50 station number rows can be displayed at 
a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.
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■Priority

4.4.2 Tone Settings

Configure the busy tone and error tone when making an outgoing call.

■Busy Tone (except IX-MV)

Description Set the priority of calls.

Settings • Normal
• Priority
• Urgent

Default values -

Description Select the sound to be played when call destination station is busy.

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
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■Error Tone (Call Failed) (except IX-MV7-* and IX-MV)

4.4.3 Call Restart Function (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*))

■Call Restart Function

Description Select the sound to be played when outgoing call has failed.

Settings • None (except for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (IX-DA, IX-DF(-*), IX-BA, IX-SS(-*) are Busy Tone)
• On Hold
• Operation Sound
• Error (IX-DA, IX-DF(-*), IX-BA, IX-SS(-*) are Error Tone)
• Pre Tone 1 (except for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2 (except for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3 (except for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone (except for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification (except for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone (except for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Error (IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*) are Error Tone)

Description Select Enable/Disable for Call Restart Function.
Call Restart Function: When the station is reset during an outgoing call, the outgoing call will be 
resumed automatically up to 2 times.

Settings • Enable
• Disable

Default values Disable
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4.5 Incoming Call (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

Configure incoming call settings.

4.5.1 Call Answer Settings

■Auto Answer
Description Select ON / OFF to automatically answer the individual call.

Auto Answer: when receiving an individual call, answer automatically. When transferring a call, it 
must be answered manually.

Settings • OFF: No Auto Answer.
• ON: Auto Answer.

Default values • IX-MV7-*, IX-MV, IX-RS-*: OFF
• IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G: ON

Important

• For IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, if Auto Answer is set to "OFF," be sure to configure one of the following. If not 
configured, calls will not be received.

– Set to "Call, Answer Call, End Communication" in “Call Button Function (→page 224)”.

– Set to "Answer Call / Page" in "Option Input" - “Function (→page 242)”.

Note

• For IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*), Auto Answer is set to "ON and cannot be changed."

Move row
Up to 50 station number rows can be displayed at a time. 
Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to 
move the cursor to the entered row.

Move column
Up to 50 station number lines can be displayed at a time. 
Switch the display as follows.
[Previous]: Display the previous 50 columns.
[Next]: Display the next 50 columns.
[Display]: Enter the station number and click [Display] to 
move the cursor to the entered column.
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4.5.2 Ringtone

■Ringtone (except IX-MV7-*, IX-MV)

■Ringback Tone Count [time(s)] (except IX-MV7-*)

Description Select the ringtone to be played for incoming call.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Call Pattern 3

Description Set the paly count of ringtone for incoming call.

Settings • Infinite: Keep ringing until the call is answered or canceled.
• 1 - 20 times

Default values Infinite
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■Call Button (for IX-MV7-* and IX-MV)

■Option Input (for IX-MV7-* and IX-MV)

Description Select the ringtone for incoming call. Ringtone can be set per each source station.
IX-MV7-*: Ringtone can be set per priority.
IX-MV: Same for all priority. Set ringtone to "Normal" priority.

Settings • None (IX-MV7-* only)
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (IX-MV: Busy Tone)
• On Hold
• Operation Sound
• Error (IX-MV: Error Tone)
• Pre Tone 1 (IX-MV7-* only)
• Pre Tone 2 (IX-MV7-* only)
• Pre Tone 3 (IX-MV7-* only)
• Communication End Pretone (IX-MV7-* only)
• Call Queue Notification (IX-MV7-* only)
• Waiting Reply Tone (IX-MV7-* only)
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Call Pattern 1

Description Select the ringtone for incoming call by Option Input. The ringtone can be set per each source 
station.
IX-MV7-*: The ringtone can be set per priority.
IX-MV: Same for all priorities. Set the ringtone to "Normal" priority.

Settings • None (IX-MV7-* only)
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (IX-MV: Busy Tone)
• On Hold
• Operation Sound
• Error (IX-MV: Error Tone)
• Pre Tone 1 (IX-MV7-* only)
• Pre Tone 2 (IX-MV7-* only)
• Pre Tone 3 (IX-MV7-* only)
• Communication End Pretone (IX-MV7-* only)
• Call Queue Notification (IX-MV7-* only)
• Waiting Reply Tone (IX-MV7-* only)
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Call Pattern 2
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■Call Button Ringtone Count [time(s)] (for IX-MV7-*)

■Option Input Ringtone Count [time(s)] (for IX-MV7-*)

4.5.3 VoIP Phone (except IX-MV)

■VoIP Phone Call Priority

Description Set the play count of ringback tone for incoming call from call button.

Settings • Infinite: Keep ringing until the call is answered or canceled.
• 1 - 20 times

Default values Infinite

Description Set the play count of ringback tone for incoming call from the option input.

Settings • Infinite: Keep ringing until the call is answered or canceled.
• 1 - 20 times

Default values Infinite

Description Select the call priority from VoIP phones.

Settings • Normal
• Priority
• Urgent

Default values Normal



241

System Settings (Table View)

5. Option Input/Relay Output Settings

5.1 Option Input

Configure the input terminal settings for each station. The number of input terminals varies by station.
Select the contact input number to configure in [Display Settings].

5.1.1 Option Input Advanced Settings

5.1.1.1 Name (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

Description Set the Name of the Option Input.

Settings 1-24 alphanumeric characters

Default values -

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

Display Settings
Displays setting content for the selected contact input number.
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5.1.1.2 Function

5.1.1.3 Type

5.1.1.4 Detection Time

■Detection Time Range

■Detection Time♦

Description Configure the contact input functions. The functions that can be selected differ depending on the 
station.

Settings • No Function
• Call (except IXW-MA): Call to destination. Be sure to also configure "Option Input 1 - 6" in “Call 

Origination (except IXW-MA) (→page 228)”.
• Answer Call / Page (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), IXW-MA): Answer 

incoming call or page.
• Paging (for IX-MV7-*): Page to destination. Be sure to also configure “Option Input Page (for 

IX-MV7-*) (→page 257)”.

• Message Page (for IX-MV7-*): Send message to destination. Be sure to also configure “Option 
Input Page (for IX-MV7-*) (→page 257)”.

• External Input Page (for IX-MV7-*): Page using an external sound source. Only one input 
terminal may be configured. Be sure to also configure “Option Input Page (for IX-MV7-*) 
(→page 257)”.

• Turn LCD On (for IX-MV7-*): Turn LCD backlight of IX-MV7-* on.
• Relay Latch Reset (for IX-RS-*, IX-DV, IX-DVF(-*), IX-SS-2G): Reset latch relay output using 

the option input.
Be sure to select "Latch Output" in "Relay Output" - “Function (→page 245)”.

• Bathroom Indicator Reset (for IXW-MA): Not used.
• API (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*)): Send CGI command set by “API 1 

(→page 243)” and “API 2 (→page 243)”.

Default values No Function

Description Set the detection method of the contact input.

Settings • Make
• Break

Default values Make

Description Select the Detection Time Range for Option Input.

Settings • 0 (Immediate): Detect at input less than 200 msec.
• 200 - 2000 [msec]
• 3 - 600 [sec]

Default values 0 (Immediate)

Note

• The Detection Time Range for IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*) is "200 - 2000 [msec]" and cannot be changed.

Description Configure the contact input search time within the range set in "Detection Time Range."

Settings The settings will be configured as follows according to the information set in "Detection Time 
Range."
• If set to 0 (Immediate): Configuration unnecessary.
• If set to 200 - 2000 [msec]: Configure from 200 - 2000 msec (by 100 msec).
• If set to 3 - 600 [sec]: Configure from 3 - 600 sec (by 1 sec).

Default values -
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5.1.1.5 API (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

■API 1

■API 2

Description Enter the CGI command sent when "API" is selected in “Function (→page 242)”.

Settings 1-128 alphanumeric characters

Default values -

Description Enter the CGI command sent when "API" is selected in “Function (→page 242)”.

Settings 1-128 alphanumeric characters

Default values -
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5.2 Relay Output

Configure the output terminal settings for each station. The number of output terminals varies by station.
Select the relay output number to configure in [Display Settings].

5.2.1 Relay Output Advanced Settings

5.2.1.1 Name (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

Important

• The four relay output methods are shown below. Redundant configuration is possible for each output terminal. If multiple 
commands occur during a single relay output, the last command will take priority.

– Function selected in “Function (→page 245)”

– “Option Relay Control (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*)) (→page 246)”

– “Weekly Schedule (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 250)”, “Daily Schedule (except IX-MV, 
IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 252)”

– “CGI (→page 279)”

Description Set the name of the Relay Output.

Settings 1-24 alphanumeric characters

Default values -

Move row
Up to 50 station number rows can be 
displayed at a time. Switch the 
display as follows.
[Previous]: Display the previous 50 
rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number 
and click [Display] to move the 
cursor to the entered row.

Display Settings
Displays setting content for the selected contact output number.

“Weekly Schedule (except IX-MV, IX-DA, IX-DF(-*), and IX-
BA, IX-SS(-*)) (→page 250)”

“Daily Schedule (except IX-MV, 
IX-DA, IX-DF(-*), and IX-BA, 
IX-SS(-*)) (→page 252)”

Move to Related 
Settings
Moves to the selected 
item within the same 
Settings screen.
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5.2.1.2 Function

How to configure Status Output
If “Function (→page 245)” is set to "Status Output," select the operating state for when the relay output occurs. This 
can be selected for each operation priority (multiple selections allowed).
The operating states that can be selected vary by station type.

Description Select the function of the Relay Output. Different function can be selected depending on the 
station type.

Settings • No Function
• Status Output (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), IXW-MA): Relay Output 

during the status. The details setting can be set  in “How to configure Status Output 
(→page 245)”.

• External Audio Output (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*), IX-SSA(-*), IX-BA, IX-SS(-*)): 
Contact is output to control the paging amplifier while audio is output from the paging amplifier 
terminal. Relay output during Line audio output. This operates when "Volume / Tone" - “Audio 
Output (for Door) (except IX-MV7-*, IX-SS-2G, and IX-MV) (→page 354)” is set to something 
other than "Built-in Speaker for Communication and Paging."

• Door Release (except IXW-MA): Relay output when door release is activated or, entering the 
authentication key using keypad of the station or the VoIP Phone. Configure the output time in 
“Output Time♦ (→page 248)”.

• Latch Output (for IX-RS-*, IX-DV, IX-DVF(-*), IX-FA, IX-SS-2G): Latch relay output by event 
trigger. Continue to output until latch reset trigger input. Ignore set “Output Time♦ 
(→page 248)”. Configuration can be set in "How to configure Latch Output".

• Contact Input Call / Communication State (for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*)): Relay 
output during the contact input call and communication until reset.

• Bathroom Indicator (for IXW-MA): Not used.
• Contact Change SIF Event (for IXW-MA): Relay output when Contact Change SIF Event is 

received from another station. Output Time is the same as Option Input Detection Time or 
Relay Output Time of the SIF command originating station. Set in "SIF" - "Transmission 
Trigger" - “Change contact (→page 282)”.

Default values Relay Output 1
• Except IXW-MA: Door Release
• IXW-MA: No Function

Relay Output 2 - 10
• No Function

Note

• If "Automatically configure door release for all stations?" is set to "No" in “Create new system/import setting data 
(→page 123)”, the default value for "Relay Output 1 (except IXW-MA)" will be "No Function."

Note

• For "Outgoing Page" and "Incoming Page," relay output is performed even during message paging and external input paging.

• For "Monitored," relay output is performed even during scan monitoring.
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How to configure Latch Output
If “Function (→page 245)” is set to "Latch Output," select the operating state for when the relay output occurs. This 
can be selected for each operation priority (multiple selections allowed).
Choose from two restoration methods for relay output.
• Option Input (default value): Reset Latch Output by the Option Input.
• End Communication: Reset Latch Output by ending communication or the option input.

All items are set to "Option Input" by default.
To reset by Option Input, be sure to configure "Relay Latch Reset" in "Option Input" - “Function (→page 242)”.

How to configure Contact Change SIF Event
If “Function (→page 245)” is set to "Contact Change SIF Event", select the station for interlocking with Contact 
Change SIF Event of Relay Output 1.

■Number

5.2.1.3 Option Relay Control (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*))

Description Set SIF Origination Station Number. Enter the station number or select station from the list.

Settings 3-32 digits

Default values -

Description Select Enable/Disable for Option Relay Control when using the speed dial of  IX-MV7-* to control 
the output.
If set to "Enable," contact will be output according to the "Speed Dials / Favorites" - “How to 
configure Option Relay Control (for IX-MV7-*) (→page 343)” setting.
If "How to configure optional relay" - “TLS (→page 344)” was set to "Enable" for the station that 
be controlled, also configure “Option Relay Control Authentication Key (except IX-MV, IX-DA, IX-
DF(-*), IX-BA and IX-SS(-*)) (→page 253)”.
For IXW-MA, this can be controlled as an optional relay if set to "Enable," only when “Function 
(→page 245)” is set to "No Function."

Settings • Enable
• Disable

Default values Disable
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5.2.1.4 Output Time Range

■Output Time Range
Description Select the Output Time Range for relay output if “Function (→page 245)” is set to "Door 

Release" or if the output terminal is controlled via “CGI (→page 279)”.

Settings • 0 (Momentary) (for IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)): Outputs while an output 
command is received. However, this is set to 10 sec and cannot be changed if a relay output 
command is received via CGI.

• 200-2000 [msec]
• 3 - 600 [sec] (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))
• 3-300 [sec] (for IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Default values 200-2000 [msec]
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■Output Time♦

5.2.1.5 Door Release Authorization (except IXW-MA)

Important

• If set to "0 (Momentary)," the operation when the door on the other station is released will be as follows.
IX-MV7-* or IX-RS-*: When the Door Release button is pressed or the Authentication Key is input by the keypad, a relay output 
command is sent and the output command ends immediately. The output command will not continue even if the Door Release 
button is held.
IX-MV: The relay output command continues while the Door Release button is pressed, and ends once it is released.

Description Set the Output Time within the range selected in “Output Time Range (→page 247)”.

Settings Select the Output Time Range for relay output.
• If set to 0 (Momentary): Configuration unnecessary.
• If set to 200-2000 [msec]: Configure from 200 - 2000 msec (by 200 msec).
• If set to 3 - 600 [sec]: Configure from 3 - 600 sec (by 1 sec).
• If set to 3-300 [sec]: Configure from 3 - 300 sec (by 1 sec).

Default values 400 [msec]

Description Set the Authentication Key when "Door Release" is selected in “Function (→page 245)” for 
releasing the door that is connected to the station. When the "Authentication Key" is confirmed, 
the relay output will be activated. Configure "Door Release Settings" - “Authentication Key 
(→page 260)”." This will also be the authentication key used to release the door using the 
numerical keypad on IX-MV7-* or VoIP Phone.

Settings • Except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*): 1-20 digits
• IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*): 1-4 digits

Default values This will vary depending on the setting value configured in “Create new system/import setting 
data (→page 123)” - "IX Support Tool Settings."

– IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) not configured: 20 random digits
– IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) configured: 4 random digits

Important

• Configure the Authentication Key using 1 to 4 digits to release when using the IX-MV.

• Configure a different Authentication Key for each output terminal. (The same key cannot be used.)

• Configure an Authentication Key that is different from the Authentication Key configured in "Communication Audio Messages" 
- “Door Release Authorization (except IXW-MA) (→page 248)” and “Option Relay Control Authentication Key (except IX-MV, 
IX-DA, IX-DF(-*), IX-BA and IX-SS(-*)) (→page 253)”. If the setting is the same, multiple functions might operate.

• To release the door using the numerical keypad, enter "**Door Release Authorization*" on the IX-MV7-* or VoIP Phone 
numerical keypad (if the Authentication Key is "0000" enter "**0000*").
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5.2.1.6 Sound Settings (except IX-MV and IXW-MA)

■Door Release

■Relay Control (start) (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))

Description Select the Door Release sounds to be played.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Operation Sound

Description Select the sound to be played when Option Relay is activated.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None
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■Relay Control (end) (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))

5.2.1.7 Weekly Schedule (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))
Configure the time to perform relay output for each day of the week, from Sunday to Saturday. 12 schedules can be 
set for each day.

Description Select the sound to be played when Option Relay is deactivated.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None

Weekly Schedule
Select the day and schedule range to configure. The Settings screen will be 
shown.
“How to configure schedule display (→page 233)”

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■Start Time

■End Time

How to configure schedule display
Configure the day and schedule range shown on the Settings screen for the weekly schedule.
The display can be filtered to show only the day and schedule to configure.
Click Schedule View Adjustment. The following screen will be shown.

1. Select the day(s) to display from "Day" (multiple selections allowed).
• To select or unselect all days at once, click [Select] or [Unselect].
• By default, all days are shown.

2. Select the range of schedules to display (1 - 12) that can be configured for each day of the week.
• By default, the range of 1 - 3 is shown.

Important

• Regardless of the configuration in “Function (→page 245)”, the relay will continue to output during the time period set in the 
schedule. However, if a door release operation or other command occurs during the relay output, the last command will be 
given priority, and the relay output will stop even if it is still within the time set in the schedule.

Description Set the time to start the relay output.

Settings 00:00 - 23:59

Default values -

Description Set the time to end the relay output.
If set earlier than "Start Time," the end time will be the time the following day.

Settings 00:00 - 23:59

Default values -

1

2

3
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3. Click [OK].
• Click [Cancel] to return to the schedule display.

5.2.1.8 Daily Schedule (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))
Configure the time at which relay output will be performed, in units of one day. A schedule one year from the set day 
can be configured. 12 schedules can be set for each day.

■Start Time

Important

• Regardless of the setting in “Function (→page 245)”, the relay will continue to output during the time period set in the 
schedule. However, if a door release operation or other command occurs during relay output, the latest command will be given 
priority, and relay output will stop even if it is still within the time set in the schedule.

Description Set the time to start the relay output.

Settings 00:00 - 23:59

Default values -

Daily Schedule
Select the date and schedule range to configure. The Settings screen will be 
shown.

1. Select the date from the drop down menu.

2. Select the range of schedules to display (1 - 12) that 
can be configured for each day.
• By default, the range of 1 - 3 is shown.

3. Click [Change to Daily Schedule Display].

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■End Time

5.2.2 Authentication Key

■Option Relay Control Authentication Key (except IX-MV, IX-DA, IX-DF(-*), IX-BA and IX-
SS(-*))

Description Set the time to end the relay output.
If set earlier than "Start Time," the end time will be the time the following day.

Settings 00:00 - 23:59

Default values -

Description If “Option Relay Control (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*)) (→page 246)” is 
set to "Enable" and "Speed Dials / Favorites" - “TLS (→page 344)” is set to "Enable" on the 
requesting station, configure the key used to decrypt encrypted communication.
If this matches the "Option Relay Control Key" of the station performing the operation, the Relay 
Output can be controlled.
To use this, be sure to configure "Speed Dials / Favorites" - “Option Relay Control Key 
(→page 344)”.

Settings 1-20 digits

Default values -

Note

• Only one Option Relay Control Authentication Key can be set for each station. It will be shared with multiple Relay Output.
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6. Paging Settings

6.1 Paging Origination (for IX-MV7-* and IX-MV)

Configure settings related to outgoing paging.

■Paging Timeout [sec]♦

■Paging Wait Timer [sec] (for IX-MV7-*)♦

Important

• All pages, groups pages, message pages, and external input pages cannot be sent to VoIP Phone.

Description Set the time for outgoing paging duration.

Settings 10-600sec / 1 sec step

Default values 30 sec

Description Set the time to wait for a response from all destination stations when outgoing paging is 
activated. Paging starts after this time without a response form all destination.

Settings 1-20sec (by 1 sec)

Default values 10 sec

Important

• A page may not be sent to a station if a response is received after "Paging Wait Timer [sec]" elapses. If multiple stations 
receive pages, configure a longer paging wait timer.

Note

• The paging wait time for IX-MV is set to "10 sec" and cannot be changed.

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■Urgent Page Response (for IX-MV7-*)

■Lock Paging (for IX-MV7-*)

Description Select Enable / Disable for the paging destination station can answer the urgent page.

Settings • Enable
• Disable

Default values Disable

Important

• If the station being called is IX-MV, end operations can be performed even if urgent paging rejecting is set to "Enable."

Description Select Enable / Disable to lock paging function.

Settings • Enable: Page button will be hidden
• Disable

Default values Disable

Note

• Configure the pretone when a page is received in "Volume / Tone" - “Paging Pretone (for IX-MV7-* and IX-MV) (→page 351)”.
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6.2 All Page (for IX-MV7-* and IX-MV)

When paging all stations, the default setting is set to multicast. When unicast is required, configure the following 
settings.

How to configure All Page

1. Identify the station to be configured using "List of IX-MV7-* and IX-MV in the setting data."

2. Search for stations to transmit via unicast from the "List of stations in Address Book."

3. Place a check in the cells corresponding to Steps 1 and 2.
• Unchecked: Multicast transmission
• Checked: Unicast transmission
• By default, all are set to "Unchecked" (multicast transmission).

4. When done, click [Update].

5. Click [OK].

Important

• Unicast can reach up to 50 stations. If you need to page more than 50 stations are to be paged at once, use multicast.

• When paging stations in multicast, configure “Multicast Address (For IX-MV7-*, IX-MV, IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) 
(→page 190)”.

Move row
Up to 50 station number rows can be displayed at a time. 
Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to 
move the cursor to the entered row.

Move column
Up to 50 station number lines can be displayed at a time. Switch 
the display as follows.
[Previous]: Display the previous 50 columns.
[Next]: Display the next 50 columns.
[Display]: Enter the station number and click [Display] to move 
the cursor to the entered column.

List of IX-MV7-* and IX-MV in the Settings data

Address Book Station List

1

2
3
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6.3 Option Input Page (for IX-MV7-*)

Configure contact input paging.
Configure if "Paging," "Message Page," and "External Input Page" are selected in "Option Input" - “Function 
(→page 242)”.

■Destination

■Group Number

■Priority

Description Set the destination group for paging.

Settings • All Page: Page all stations that are registered in the address book.
• Group: Page the group that is set in "Group Number."

Default values All Page

Description Set the destination group for paging.
Enter the group number, or click [Open] to select group.

Settings 01 - 99. Select from groups registered in “Group (for Master) (for IX-MV7-* and IX-MV) 
(→page 217)”.

Default values -

Description Set the priority for paging.

Settings • Normal
• Urgent

Default values Normal

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

Display Settings
Displays setting content for the selected Option Input number.
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■Message File Name

■Play Count [time(s)]

Description Select the message to be sent for message paging. Available when "Message Page" is selected 
in "Option Input" - “Function (→page 242)”.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None

Description Set the play count for message paging.

Settings 1 - 20 times

Default values 1 time
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7. Function Settings

7.1 Door Release (for IX-MV7-* and IX-MV)

7.1.1 Door Release Assignment

Configure the connected station and the authentication key to release the door during a call.
For IX-RS-* settings, refer to “Door Release Assignment (for IX-RS-*) (→page 365)”.

■Contact Assignment
Description Select which relay output will be used for door release during call or monitoring.

Settings • Origination Station: Use origination station relay output for door release.
• Destination Station: Use destination station relay output for door release.

Default values Destination Station

Move row
Up to 50 station number rows can be 
displayed at a time. Switch the display as 
follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered 
row.

Move column
Up to 50 station number lines can be 
displayed at a time. Switch the display as 
follows.
[Previous]: Display the previous 50 
columns.
[Next]: Display the next 50 columns.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered 
column.

Destination station list
 (# / Number / Name / Station Type)



260

System Settings (Table View)

■Authentication Key
Description When "Destination Station" is selected in "Contact Assignment", set the Authentication Key for 

door release.
Authentication key must match with the destination station's authentication key, which is set in 
"Relay Output" - “Door Release Authorization (except IXW-MA) (→page 248)” to allow door 
release.

Settings • IX-MV7-*: 1-20 digits
• IX-MV: 1-4 digits

Default values Random characters (compatible with default value of "Relay Output" - "Door Release 
Authorization")

Note

• If “Create new system/import setting data (→page 123)” - "Automatically configure door release for all stations?" was set to 
"No," a default value for "Authentication Key" will not be set.

• The default values for the Door Release Authorization and Authentication Key vary depending on the station type set in 
“Create new system/import setting data (→page 123)” - "IX Support Tool Settings."

– System with IX-MV, IX-DA, or IX-BA: 20 digits

– System without IX-MV, IX-DA, or IX-BA: 4 digits

• If the destination station's Authentication Key is four characters or longer, the Door Release Key for IX-MV will release the door 
if the first four digits match.
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7.2 Network Camera Integration (for IX-MV7-* and IX-MV)

Configure network camera profile (video profile) and event related settings.
To configure the settings, register a network camera in the Address Book of the IX-MV7-* or IX-MV which will receive 
the event in "Address Book" - “Open Network Camera List (→page 212)”.

Important

• For network camera event registration, “Association Settings (→page 160)” must be configured for the IX-MV7-* or IX-MV. If 
the programming PC is not connected to the same network or cannot communicate with multicast transmission, it is not be 
possible to configure. (this is because network camera events are obtained over multicast via IX-MV7-* or IX-MV when 
registering network camera events).

Move row
Up to 50 station number rows can be displayed at 
a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.

If no network camera is registered, 
this will not be shown.

If no event is registered, this will not be 
shown.

Event NumberNetwork Camera Number

Jump to related item
Moves to the selected item within the same Settings screen.

Profile Setting
[<<]: Displays the first column for profile setting.
[>>]: Displays the last column for profile setting.
[Go]: Enter a network camera number and click [Go] to display the column for 
the entered network camera number.

Event Registration
[<<]: Displays the first column for event registration.
[>>]: Displays the last column for event registration.
[Go]: Enter an event number and click [Go] to display the column for the 
entered event number.

“How to configure network 
camera event setup 
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7.2.1 Profile Setting

Configure when changing the profile selected when a network camera is registered in "Address Book" - “Open 
Network Camera List (→page 212)”.

■Profile

7.2.2 Event Registration

Configure the network camera event to register in IX-MV7-* or IX-MV.
When the registered event is received, network camera monitoring will be performed and the notification tone will be 
played, or the outgoing call command will be sent to the destination station (for IX-MV7-*).

■Event

■Function (for IX-MV7-*)

Description Select the profile of the network camera.
On the first screen, the Profile that was selected when registering the network camera will be 
displayed. Refer to the manual of the network camera for the details.

Settings ̶

Default values ̶

Description Displays Event registered in “How to configure network camera event setup (→page 265)”.
To delete the registered event, click [Update] with "Event" set as blank. For details on topics, 
refer to the manual of the network camera.

Settings ̶

Default values ̶

Description Select the function when receive the topic from the network camera.

Settings • Monitor: Play the notification tone and begin network camera monitoring.
• Call: An outgoing call is placed from the station set in “Call Origination (for IX-MV7-*) 

(→page 264)”. Configure “ID (for IX-MV7-*) (→page 263)”, “Password (for IX-MV7-*) 
(→page 263)”, “Call Origination (for IX-MV7-*) (→page 264)”, “Call Destination (for IX-MV7-*) 
(→page 264)”, and “Priority (for IX-MV7-*) (→page 264)”.

Default values ̶
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■Event Tone (for IX-MV7-*)

■ ID (for IX-MV7-*)

■Password (for IX-MV7-*)

Description Select the tone to be played when receiving event from the network camera.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Call Pattern 3

Description If "Call" is set in “Function (for IX-MV7-*) (→page 262)”, configure the administrator ID of the 
station set in “Call Origination (for IX-MV7-*) (→page 264)”.

Settings 1-32 alphanumeric characters

Default values ̶

Description If "Call" is set in “Function (for IX-MV7-*) (→page 262)”, configure the administrator password of 
the station set in “Call Origination (for IX-MV7-*) (→page 264)”.

Settings 1-32 alphanumeric characters

Default values ̶

Note

• "Password" will be displayed as "****" in the Settings screen.
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■Call Origination (for IX-MV7-*)

■Call Destination (for IX-MV7-*)

■Priority (for IX-MV7-*)

■Event Tone (for IX-MV)

■Play count of Event Tone

Description If “Function (for IX-MV7-*) (→page 262)” is set to "Call," configure from which station to make the 
outgoing call.
Enter the station number or click [Open] to select a station.
The selected station must be set "Enable" in “CGI Functionality (→page 279)”.

Settings Select from the stations registered in “Address Book (for IX-MV7-* and IX-MV) (→page 208)”. 
IXW-MA cannot be selected.

Default values ̶

Description Configure the destination station number or group number when the station configured in “Call 
Origination (for IX-MV7-*) (→page 264)” makes an outgoing call.

Settings Station number: 3-32 digits
Group number: 01 - 99

Default values ̶

Description Select the call priority when the station configured in “Call Origination (for IX-MV7-*) 
(→page 264)” makes an outgoing call.

Settings • Normal
• Priority
• Urgent

Default values ̶

Description Select the tone to be played when receiving event from the network camera. The tone will be the 
same for all network cameras and events registered in the station.

Settings • Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Tone
• On Hold
• Operation Sound
• Error Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Call Pattern 3

Description Set the play count for Network Camera Event Tone when “Function (for IX-MV7-*) (→page 262)” 
is set to "Monitor." The ringtone count will be the same for all network cameras and events 
registered to the station. If "Call" is set, the ringtone count for the event notification tone will be 1 
only.

Settings • Infinite: Continues to sound while the event generated by the network camera is received.
• 1 - 20 times

Default values 1 time
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How to configure network camera event setup
The network camera event must be registered.
Click [Open Network Camera Event Registry]. The "Open Network Camera Event Registry" screen will be shown.

1. Select the station to register the network camera event from "Station List."

2. Select the network camera(s) to monitor events from "Network Camera List" (multiple selections 
allowed).
• Network cameras registered in the Address Book in "Address Book" - “Open Network Camera List 

(→page 212)” will be shown.

3. Click [Get Network Camera Events].
(Obtaining the events may take several minutes.)
• Once events are successfully obtained, they will be shown in "Event List."

1

2

3

4

5

If no event is obtained, this will not be shown.
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4. Select the events to monitor from "Event List." (Multiple selections allowed)
• For details on events, refer to the manual of the network camera.

5. Click [Register] to register the event.
• The network cameras and events registered in event registry will be shown.
• Click [Cancel] to back to the "Network Camera Integration" screen without registering the event.
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7.3 Paging Settings (except IX-MV7-*, IX-MV, and IXW-MA)

Configure incoming page settings.

7.3.1 Paging Pretone Setting

■Paging Pretone
Description Select the Paging Pretone.

Settings • None
• Call Pattern 1 (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 2 (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 3 (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 4 (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 5 (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 6 (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Tremolo Sound (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Busy Response Tone (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Operation Sound (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Error (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1 (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2
• Pre Tone 3 (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)” 

(except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*)).

Default values Pre Tone 2

Important

• Configure a tone with a shorter duration than the paging pretone on the paging origination station. Configuring a longer tone 
might prevent the station from receiving audio when paging begins.

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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7.4 Bathroom Call (for IXW-MA)

This function cannot be used outside Japan.
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7.5 Email

Configure this section when email notification of station operation is required.
Be sure to configure “DNS (→page 185)” for IX-MV, IX-DA, IX-DF(-*), IX-BA, or IX-SS(-*).

7.5.1 Server Settings

■SMTP Server

■SMTP Port♦

Description Set the SMTP server.
When choosing an IPv4 address, enter the IP address or the hostname.
When choosing an IPv6 address, configure the IP address (except IX-MV, IX-DA, IX-DF(-*), IX-
BA, and IX-SS(-*)) or the hostname. If a hostname is used, configure “DNS (→page 185)”.

Settings 1 - 255 alphanumeric characters

Default values ̶

Description Set the port number for SMTP.

Settings 1 - 65535

Default values 25

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

Select the event (sending trigger) to configure. The Settings screen is displayed.
“How to select event display (→page 275)”

Move to Related Settings
Moves to the selected item within the same Settings screen.
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■SMTP Encryption
Description Select the encryption type for SMTP.

Settings • OFF
• TLS
• STARTTLS

Default values OFF
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7.5.2 Authentication Settings

■SMTP Authentication

■Mode

■ ID

■Password

7.5.3 Email Addresses

■Destination 1

■Destination 2

Description Select ON / OFF for SMTP Authentication.

Settings • ON
• OFF

Default values OFF

Description Select the SMTP Authentication Mode.

Settings • LOGIN
• CRAM-MD5

Default values LOGIN

Description Set the ID for SMTP authentication.

Settings 1-64 alphanumeric characters

Default values -

Description Set the Password for SMTP authentication.

Settings 1-64 alphanumeric characters

Default values -

Note

• "Password" will be displayed as "*****" on the screen.

Description Set the destination email address.

Settings 1-64 alphanumeric characters

Default values -

Description Set the destination email address.

Settings 1-64 alphanumeric characters

Default values -
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■Destination 3

■Source Address

7.5.4 Email Event Trigger

Set the email event trigger which initiates the message sending process. Configure the email event trigger for each 
destination address.

■Outgoing Normal Call (except IXW-MA)

■ Incoming Normal Call (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

■Outgoing Priority Call (except IXW-MA)

■ Incoming Priority Call (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

■Outgoing Urgent Call (except IXW-MA)

Description Set the destination email address.

Settings 1-64 alphanumeric characters

Default values -

Description Set the source email address.

Settings 1-64 alphanumeric characters

Default values -

Description Send email when an outgoing call is placed at "Normal" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when an incoming call is received at "Normal" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when an outgoing call is placed at "Priority" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when an incoming call is received at "Priority" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when an outgoing call is placed at "Urgent" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■ Incoming Urgent Call (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

■Door Release Activated (for IX-MV7-*, IX-MV, and IX-RS-*)

■Call Failed (except IXW-MA)

■Latch Reset (for IX-RS-*, IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G)

■Error

■Station Restarted

■SD Card Error (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

Description Send email when an incoming call is received at "Urgent" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when Door Release is activated.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when outgoing call has failed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when reset latch relay output. ("Latch Output" is selected in "Relay Output" - 
“Function (→page 245)”.)

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when a communication error has occurred.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when the station has reset.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when a microSD access error is detected. If the error is detected continuously, mail 
will not be sent an additional time.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Recording Memory Full (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■Line Supervision (Passed) (for IX-MV7-*)

■Line Supervision (Failed) (for IX-MV7-*)

■Device Check (Passed) (for IX-MV7-*)

■Device Check (Failed) (for IX-MV7-*)

■Subject

Description Send email when a microSD card meets following criteria. If the error is detected continuously, 
mail will not be sent an additional time.
• When “Prevent Overwrite (→page 298)” is set to "Enable"

– Recorded recordings exceeds 950
– Storage capacity remaining 5% 

• When “Prevent Overwrite (→page 298)” is set to "Disable"
– Recorded recordings exceeds 999
– Storage capacity remaining 0%

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when Line Supervision is "Passed".

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when Line Supervision is "Failed".

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when Device Check is "Passed".

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when Device Check is "Failed".

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Set the Subject of email per Event Trigger. This will be used for all recipient addresses.

Settings 1-64 alphanumeric characters

Default values -

Important

• "UTF-8" encoding is used for "Subject." Depending on the email client, the characters may appear incorrectly. To avoid this, 
set the encoding method to "UTF-8."
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How to select event display
Select an event (Email Event Trigger) to display on the Settings screen. The selected sending trigger will be the only 
one displayed.
This will be used for all recipient addresses.
Click Event View Selection. The following screen will be shown.

1. Select the event(s) (Email Event Trigger) from "Event List" (multiple selections allowed).
• To select or unselect all events at once, click [Select] or [Unselect].
• By default, all events are displayed.

2. Click [OK].
• Click [Cancel] to exit the event display selection.

7.5.5 Periodic Log Transmission

Configure settings related to sending periodic logs. These can be configured for each recipient email address.

■Periodic Log Transmission

■Periodic Log Transmit Time

■Periodic Log Transmit Interval

Description Select Enable / Disable for send station log periodically.

Settings • Enable
• Disable

Default values Disable

Description Set the time to send the periodic log.

Settings 00:00 - 23:59

Default values 00:00

Description Select the interval to send the periodic log.

Settings 1 Day - 7 Day

Default values 1 Day

1

2
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■Periodic Log Transmission Subject
Description Set the email subject for Periodic Log Transmission. This is used for all destination addresses.

Settings 1 - 64 alphanumeric characters

Default values ̶

Important

• "UTF-8" encoding is used for "Periodic Log Transmission Subject." Depending on the email client, the characters may appear 
incorrectly. To avoid this, set the encoding method to "UTF-8."
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7.5.6 Send Test Email (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Send a test email to the address specified in “Email Addresses (→page 271)”.
Click [Send] of the station to send the test email to. The following email will be sent to the configured address.

Example of sending an email message:
When sending a test email from the station (Station Number: 001, Station Name: Intercom Station 1, Location: 
Office).

Important

• To send a test email, “Association Settings (→page 160)” must have been configured, and the programming PC must be able 
to communicate with the system.

From △△△△@△△△△△.com

Date and time 11/20/2018 15:22

To
CC

xxxx@xxxxx.com

Subject 001 Intercom Station 1 Test Email

Text Test Email sent at "20181120 15:22:46."

Station Number: "001"
Station Name: [Intercom Station 1]
Station location: [Office]

Important

• "UTF-8" encoding is used for "Subject," "Periodic Log Transmission Subject," and "Image Filename." Depending on the email 
client, the characters may appear incorrectly. To avoid this, set the encoding method to "UTF-8."
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7.5.7 Additional Settings (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■Attach Image

■ Image Filename

Description Select Enable / Disable to send an image with the email when "Outgoing Normal Call", "Outgoing 
Priority Call" and "Outgoing Urgent Call" is selected in “Email Event Trigger (→page 272)”.

Settings • Enable
• Disable

Default values Disable

Description Set the filename of a image file when "Attach Image" is enabled.

Settings 1-64 alphanumeric characters

Default values -

Important

• "UTF-8" encoding is used for "Image Filename." Depending on the email client, the characters may appear incorrectly. To 
avoid this, set the encoding method to "UTF-8."
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7.6 CGI

For the details of CGI functionality, contact the local Aiphone representative.

■CGI Functionality
Description Select Enable / Disable for CGI functionality.

Settings • Enable
• Disable

Default values Disable

Important

• CGI controls may fail when multiple CGI commands are received.

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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7.7 SIF

For the details of SIF functionality, contact the local Aiphone representative.

7.7.1 SIF Functionality

7.7.2 SIP URI Format (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Description Select Enable / Disable for SIF functionality.

Settings • Enable
• Disable

Default values Disable

Description Select Enable / Disable when SIP URI Format is used for station destination. If set to "Enable," 
TERMID cannot be used.

Settings • Enable
• Disable

Default values Disable

Move row
Up to 50 station number rows can be 
displayed at a time. Switch the display 
as follows.
[Previous]: Display the previous 50 
rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number 
and click [Display] to move the cursor 
to the entered row.

“Upload SIF File (→page 291)”

Display Settings
Displays setting content for the selected number or periodic transmission.

Select the event (SIF sending trigger) to configure. The Settings screen is 
displayed.
“How to select event display (→page 289)”

Move to Related Settings
Moves to the selected item within the same Settings screen.

“Download SIF File (→page 293)”
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7.7.3 SIF Settings (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))

Configure SIF recipient and communication settings. 16 SIF settings can be set for each station.
Select the number to configure from No.1 - No.16 in [Display Settings].

■Program Type

■ IPv4

■ IPv6

■Destination Port

■SSL

■Connection

Note

• There are two ways to configure SIF communication: manually configuring settings or uploading a "SIF Communication 
Settings (sif.ini)" file in “Upload SIF File (→page 291)”. The latest setting will take priority.

Description Set the Program Type for SIF.

Settings 0000-1111
If this is set to "0000," "0001," or "0011," the “Transmission Trigger (except IX-MV, IX-DA, IX-
DF(-*), IX-BA, IX-SS(-*)) (→page 282)” setting will be disabled.

Default values -

Description Set the SIF IPv4 destination address.
Go to “DNS (→page 185)” to set Hostname.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -

Description Set the SIF IPv6 destination address.
Go to “DNS (→page 185)”  to set Hostname.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -

Description Set the Port Number for destination.

Settings 1 - 65535

Default values -

Description Select Enable / Disable for SSL.

Settings • Disable
• Enable

Default values -

Description Select Socket / HTTP for connection.

Settings • Socket
• HTTP

Default values -
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7.7.4 Transmission Trigger (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))

Configure the SIF sending trigger when “Program Type (→page 281)” is set to "0010" or "0100-1111."
This can be configured for each recipient. Select the number to configure from No.1 - No.16 in [Display Settings].

■Begin Outgoing Call (except IXW-MA)

■Begin Communication (Source) (except IXW-MA)

■Door Release Indication (for IX-MV7-* and IX-RS-*)

■End Communication (except IXW-MA)

■Change contact

Description Send SIF command when outgoing call is placed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning communication.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when door release request is sent.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending communication.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when Option Input contact or Relay Output contact is changed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Unit error

■Begin broadcast (for IX-MV7-*)

■End broadcast (for IX-MV7-*)

■Begin Transfer (for IX-MV7-*)

■End Transfer (for IX-MV7-*)

■Periodical Transmission

■ Initialization Notice

Description Send SIF command when communication error has occurred.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when page, message page, or external input page is started.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when  page, message page, or external input page has ended.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when communication begins after transferring.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when communication ends after transferring.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Periodically send the station status using SIF command. The interval is set in “Periodical 
Transmission (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*)) (→page 290)”.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when the station is booted.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■End Outgoing Call (except IXW-MA)

■Begin Incoming Call (except IXW-MA)

■End Incoming Call (except IXW-MA)

■Latch Reset (except IX-MV7-* and IXW-MA)

■Change Call Destination (except IXW-MA)

■Call Failure (except IXW-MA)

■Begin Incoming Transfer Call (for IX-MV7-*)

Description Send SIF command when ending a outgoing call.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning a incoming call.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending a incoming call.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command by reset latch relay output. ("Latch Output" is selected in "Relay Output" - 
“Function (→page 245)”.)

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when changing call destination by delay time or schedule, or making an 
absent transfer, delay transfer or schedule transfer by the destination station.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when failed to place a call.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning Absent Transfer, Delay Transfer or Schedule Transfer.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Begin On Hold (for IX-MV7-*)

■End On Hold (for IX-MV7-*)

■Begin Incoming Page (except IXW-MA)

■End Incoming Page (except IXW-MA)

■Paging Failure (for IX-MV7-*)

■Begin Monitoring (for IX-MV7-*)

■End Monitoring (for IX-MV7-*)

Description Send SIF command when beginning a call on hold.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending a call on hold.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning a incoming page, message page, or external input page.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending a incoming page, message page, or external input page.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when failed to send a page,  message page, or external input page.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning monitoring.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending monitoring.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Monitoring Failure (for IX-MV7-*)

■Begin Monitored (except IX-MV7-* and IXW-MA)

■End Monitored (except IX-MV7-* and IXW-MA)

■Begin Communication (Destination) (except IXW-MA)

■Begin Privacy (for IX-MV7-*)

■End Privacy (for IX-MV7-*)

■Keypad Input (for IX-MV7-*)

Description Send SIF command when failed monitoring.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when the monitoring of this station begins.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when the monitoring of this station ends.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when communication begins.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when privacy mode begins.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when privacy mode ends.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when entering number using a keypad.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Speed Dial Input (for IX-MV7-*)

■Begin Record (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■End Record (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■Recording Memory Full (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■Passed Line Supervision (for IX-MV7-*)

■Failed Line Supervision (for IX-MV7-*)

Description Send SIF command when pressing a speed dial button.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning recording.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when recording ends.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when a microSD card meets following criteria. If the error is detected 
continuously, SIF command will not be sent an additional time.
• When “Prevent Overwrite (→page 298)” is set to "Enable"

– Recorded recordings exceeds 950
– Storage capacity remaining 5%

• When “Prevent Overwrite (→page 298)” is set to "Disable"
– Recorded recordings exceeds 999
– Storage capacity remaining 0%

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when the result of Line Supervision is "Passed".

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when the result of Line Supervision is "Failed".

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Passed Device Check (for IX-MV7-*)

■Failed Device Check (for IX-MV7-*)

■SD Card Error (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■SIP Registration Failure (except IXW-MA)

■Network Camera Event (for IX-MV7-*)

Description Send SIF command when the result of Device Check is "Passed".

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when the result of Device Check is "Failed".

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when a microSD access error is detected.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when REGISTER request for SIP server has a failure.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when receiving event from the network camera.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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How to select event display
Select an event (SIF sending trigger) to display on the Settings screen. Only the selected SIF sending trigger will be 
displayed.
This will be used for No.01 - No.16.
Click Event View Selection. The following screen will be shown.

1. Select the event(s) (SIF sending trigger) from "Event List" (multiple selections allowed).
• To select or unselect all events at once, click [Select] or [Unselect].
• By default, all events are displayed.

2. Click [OK].
• Click [Cancel] to exit the event display selection.

1

2
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7.7.5 Periodical Transmission (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))

Select periodic transmission in [Display Settings].

7.7.5.1 Periodical Transmission Interval

■Range

■ Interval♦

Description Set the interval to send the station status  periodically using SIF command in “Periodical 
Transmission (→page 283)”. This will be used for No.1 - No.16.

Settings • 1[sec]-59[sec]
• 0[min]-1440[min]

Default values 0[min]-1440[min]

Description Set the interval to send Periodical Transmission from selected "Range." This will be used for 
No.1 - No.16.

Settings The setting value as follows depends on "Range."
• If set to 1[sec]-59[sec]: Configure from 1 - 59 sec (by 1 sec).
• If set to 0[min]-1440[min]: Set from 0 (do not send) - 1440 min (by 1 min).

Default values 0 min (do not send)
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7.7.6 Upload SIF File

Upload the information in “SIF Settings (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 475)” using 
the file extension of "sif.ini," and upload the SIF parameter settings when “Program Type (→page 281)” is set to 
"0000," "0001," or "0011"  using the file extension of "sif_conf.ini."
If [Upload SIF File] is clicked, the following window will be shown.

How to upload SIF setting files

1. Select the type of SIF file being uploaded.

2. Click [Browse] and select the file to be uploaded.

3. Select the station to upload the SIF setting file from "Station List."
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].
• Stations in which “Association Settings (→page 160)” has not been performed cannot be selected.

4. Click [Start Upload].

Important

• To upload a SIF setting file, “Association Settings (→page 160)” must be preformed in the uploading station. And the 
programming PC and the station must be connected to the same network.

1

2

3

4
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5. Click [OK].
• Click [Cancel] to back to "Upload SIF File" window without uploading the file.

6. Click [OK].
• The results are displayed in "Status" in "Station List."

Success: Upload is completed.
Failed: Upload failed.
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7.7.7 Download SIF File

Download the content in “SIF Settings (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*)) (→page 281)” with "sif.ini" 
and download the uploaded "sif_conf.ini."
If [Download SIF File] is clicked, the following window will be shown.

How to download SIF setting files

1. Select the type of SIF file being downloaded.

2. Click [Browse] and select the folder to download.

3. Select the station to download the SIF setting file from "Station List."
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].
• Stations in which “Association Settings (→page 160)” has not been performed cannot be selected.

4. Click [Start Download].

Important

• To download a SIF setting file, “Association Settings (→page 160)” must be preformed in the downloading station. The 
programming PC and the station must be connected to the same network.

1

2

3

4
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5. Click [OK].
• Click [Cancel] to back to "Download SIF File" window without downloading.

6. Click [OK].
• The results are displayed in "Status" in "Station List."

Success: Download is completed.
Failed: Download failed.



295

System Settings (Table View)

7.8 Record (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

Configure settings related to video and audio recording. If there is no video, configure only audio recording. When 
recording audio during a call, audio will be recorded from both sides.
The following SD standards are required to record video and audio.

Standard Storage Capacity Format Speed class

microSDHC Max. 32 GB FAT32 SD speed class 10

microSDXC (for IX-MV7-*) Max. 128 GB exFAT SD speed class 10
UHS speed class 1

Important

• A microSD card is not included with this station.

• The device may not operate correctly depending on the microSD card.

• If the card contains data other than video/audio files, it may not have enough space to record video/audio.

• The network camera may not be able to record video, depending on the size of the video.

Note

• A maximum of 999 video/audio files can be saved. However, this may vary depending on the size of the video/audio files and 
the capacity of the microSD card.

• Line Supervision and Device Check results are also saved to the microSD card.

• Aiphone assumes no responsibility for  microSD cards. Please be aware of this in advance.

Move row
Up to 50 station number rows can be displayed at 
a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.

“Weekly Schedule (for IX-DV, IX-DVF(-*), IX-SSA(-*)) (→page 300)”

Move to Related Settings
Moves to the selected item within the same Settings screen.



296

System Settings (Table View)

7.8.1 Record Mode (for IX-DV, IX-DVF(-*), IX-SSA(-*))

Description Select the Record Mode.

Settings • No Recording
• Event Recording: Automatically record when the trigger set in "Record Event" has occurred.
• 24/7 Recording: Continuous recording while the station is operating normally.

Default values No Recording



297

System Settings (Table View)

7.8.2 Record Event

Configure the trigger in use to start recording video/audio automatically.
For stations other than IX-MV7-*, this is only the case when "Record Mode" is set to "Event Recording."

■ Incoming Call (for IX-MV7-*)

■Communication (Master) (for IX-MV7-*)

■Monitor (for IX-MV7-*)

■Outgoing Call (for IX-DV, IX-DVF(-*), IX-SSA(-*))

■Communication (Door) (for IX-DV, IX-DVF(-*), IX-SSA(-*))

■Monitored (for IX-DV, IX-DVF(-*), IX-SSA(-*))

Description Video Recording starts when station receives an incoming call. If a call is automatically 
answered, recording will start when communication starts.

Settings • Yes
• No

Default values No

Description Recording starts when communication begins.

Settings • Yes
• No

Default values No

Description Recording starts when monitoring begins. Recording is not possible during Scan Monitor.

Settings • Yes
• No

Default values No

Description IX-DV, IX-DVF(-*): Video recording will start when a call is placed. Audio recording will start once 
the outgoing call is answered.
IX-SSA(-*): Audio recording will start once the outgoing call is answered.

Settings • Yes
• No

Default values No

Description Recording starts when communication begins.

Settings • Yes
• No

Default values No

Description Recording starts when station is Monitored.
Recording is not possible during Scan Monitor.

Settings • Yes
• No

Default values No
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■Schedule (for IX-DV, IX-DVF(-*), IX-SSA(-*))

7.8.3 Recorded Device (for IX-MV7-*)

7.8.4 Prevent Overwrite

7.8.5 Video Recording File Length

Description Record during schedule set in “Weekly Schedule (for IX-DV, IX-DVF(-*), IX-SSA(-*)) 
(→page 300)”.

Settings • Yes
• No

Default values No

Important

• Video/audio recording will continue for the time set in “Weekly Schedule (for IX-DV, IX-DVF(-*), IX-SSA(-*)) (→page 300)”, 
regardless of what is configured for other triggers.

Description Set the Recorded Device when IX-MV7-* is displaying video from an IX Station and a Network 
Camera simultaneously.

Settings • IX Station: Record IX station video
• Network Camera: Record network camera video

Default values IX Station

Description Set prevent overwriting the old recorded file, when the number of saved video/audio files, the 
entire storage space of the microSD card, or the video/audio recording storage space of the 
microSD card is full.

Settings • Enable
• Disable

Default values Disable

Description Select the recording file length to split recording. Once recording has reached this time, a new 
recording file will be created automatically.

Settings • 5 min
• 10 min
• 20 min
• 40 min
• 60 min

Default values 10 min

Note

• If the Video Recording File Length is changed during recording  video/audio, the setting will not be applied until the recording 
is completed.
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7.8.6 Event Recording Timer (for IX-MV7-*)

7.8.7 Manual Recording (for IX-MV7-*)

7.8.8 Audio Recording (for IX-MV7-*, IX-DV, IX-DVF(-*))

Description Set the recording duration when the event trigger has occurred.

Settings • Disable: Does not stop until the operating status ends or the record button is tapped.
• 5 sec
• 10 sec
• 30 sec

Default values Disable

Description Select Enable / Disable for manual recording.

Settings • Enable
• Disable

Default values Enable

Description Select Enable / Disable for audio recording with video.

Settings • Enable
• Disable

Default values Enable
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7.8.9 Weekly Schedule (for IX-DV, IX-DVF(-*), IX-SSA(-*))

Configure this when "Record Event" - “Schedule (for IX-DV, IX-DVF(-*), IX-SSA(-*)) (→page 298)” is set to "Yes."
Configure the video and audio recording time for each day from Sunday to Saturday. Up to 12 schedules can be set 
for each day.

■Start Time

■End Time

Description Set the Start Time to begin recording.

Settings 00:00 - 23:59

Default values -

Description Set the End Time to stop recording. If this is set earlier than "Start Time," the end time will be for 
the following day.

Settings 00:00 - 23:59

Default values -

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

Weekly Schedule
Select the day and schedule range to configure. The Settings screen is displayed.
“How to configure schedule display (→page 301)”
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How to configure schedule display
Configure the day and schedule range shown on the Settings screen for the weekly schedule.
The display can be filtered to show only the day and schedule to configure.
Click Schedule View Adjustment. The following screen will be shown.

1. Select the day to display(s) from "Day" (multiple selections allowed).
• To select or unselect all days at once, click [Select] or [Unselect].
• By default, all days are shown.

2. Select the range of schedules to display (1 - 12) that can be configured for each day of the week.
• By default, the range of 1 - 3 is shown.

3. Click [OK].
• Click [Cancel] to set the schedule display.

1

2

3
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7.9 Communication Audio Messages (for IX-RS-*, IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G)

Configure the communication audio message.
Communication Audio Messages: Send messages to destination station when beginning communication or by 
keypad input from the other station (IX-MV7-*).

7.9.1 Start Communication

■Message
Description Select the message to be sent to destination station when beginning communication.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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7.9.2 Code Received

Configure the message to be sent when the code is received. Four patterns can be set for the received code and 
message.

■Code

■Message

Description Set the code to play message by keypad input from IX-MV7-*.

Settings 1-20 digits

Default values -

Note

• Enter " Door Release Authorization " using the keypad (if the Door Release Authorization is "0000" enter " 0000 ").

Description Set the code to play message by keypad input from IX-MV7-*.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None
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7.10 Chime (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

Configure the chime tone to be played from this station linked with the set schedule.

7.10.1 Weekly Schedule

Configure the start time and the chime tone for every day from Sunday through Saturday.
50 schedules can be set for each day.

■Start Time
Description Set the Time to ring Chime.

Settings 00:00 - 23:59

Default values -

Move row
Up to 50 station number rows can be displayed at 
a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.

Weekly Schedule
Select the day and schedule range to configure. The Settings screen will be 
shown.
“Weekly Schedule (→page 304)”

“Daily Schedule (→page 306)”

Move to Related Settings
Moves to the selected item within the 
same Settings screen.
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■Chime

How to configure schedule display
Configure the day and schedule range shown on the Settings screen for the weekly schedule.
The display can be filtered to show only the day and schedule to configure.
Click Schedule View Adjustment. The following screen will be shown.

1. Select the day(s) to display from "Day" (multiple selections allowed).
• To select or unselect all days at once, click [Select] or [Unselect].
• By default, all days are shown.

Description Set the sound for chime.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None

1

2

3
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2. Select the range of schedules to display (from 1 to 50) that can be configured for each day of the 
week.
• By default, the range of 1 - 3 is shown.

3. Click [OK].
• Click [Cancel] to set the schedule display.

7.10.2 Daily Schedule

Configure the start time and the chime tone in units of one day.
A schedule one year from the set day can be configured. 50 schedules can be set for each day.

Daily Schedule
Select the date and schedule range to configure. The Settings screen 
will be shown.

1. Select the date from the drop down menu.

2. Select the range of schedules to display (from 1 
to 50) that can be configured for each day.
• By default, the range of 1 - 3 is shown.

3. Click [Change to Daily Schedule Display].

Move row
Up to 50 station number rows can be displayed at a 
time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.
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■Start Time

■Chime

Description Set the Time to ring Chime.

Settings 00:00 - 23:59

Default values -

Description Set the sound for chime.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None
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7.11 CSR

Generate the signature request (CSR) submitted when a request is made to the Server Certificate Authority (CA)
Generate the signature request according to each station’s settings. “CSR (→page 495)”
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7.12 SSL Certificate

Upload the Server Certificate received from the Certificate Authority (CA) as well as the CA certificate.

How to register SSL certificates

1. Click [Browse] of the station to upload the server certificate and then select a file.

2. If required, click [Browse] of the station to upload the CA certificate and then select a file.

3. The reference destination of the file selected in "File" is displayed.

4. Click [Update].
• The name of the file registered in "Name" is displayed.
• Server certificate and CA certificate files are saved in "aiphone" - "AIPHONE_IX_SupportTool" - 

"SystemData" within the folder specified during installation for each station.

5. Click [OK].

6. Click [Upload SSL Certificate] to upload certificates to each station. Refer to “How to upload the 
SSL certificate to each station (→page 311)”.

Important

• To upload an SSL certificate, “Association Settings (→page 160)” must have been completed on the station, and the PC must 
be able to communicate with the system.

Important

• The server certificate must be uploaded when uploading a CA certificate.

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

“How to upload the SSL certificate to each station (→page 311)”
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How to delete a registered SSL certificate

1. Check the [Delete] box of the server certificate or CA certificate to delete.

2. Click [Update].
• The server certificate or CA certificate file will be deleted from the PC folder in which the file was saved in 

step 4 of "How to register SSL certificates."

3. Click [OK].



311

System Settings (Table View)

7.12.1 How to upload the SSL certificate to each station

Click [Upload SSL Certificate]. The following window will be shown.

How to upload an SSL certificate

1. Select the station(s) to upload a certificate from "Station List" (multiple selections allowed).
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].
• Stations in which “Association Settings (→page 160)” has not been performed cannot be selected.

2. Click [Upload].

Important

• When uploading the SSL certificate, restart the station. Restart may take up to 10 minutes in total. The station will not operate 
until restart is complete.

1

2
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3. Click [OK].
• The server certificate or CA certificate file is uploaded to the station, and the station is restarted.
• Click [Cancel] to return to the "Certification Update/Delete" screen without uploading.

4. Click [OK].
• The results are displayed in "Status" in "Station List."

In Process: Uploading the certificate.
Success: Upload is completed.
Failed: Upload failed.
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7.13 IEEE 802.1X (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Configure the settings for IEEE802.1X Authentication.

■ IEEE 802.1X

■EAP

Important

• Authentication may be impossible if there is a time difference between the authentication server and station.

• Upload the certificate prior to configuration.

• To Update/Delete an IEEE802.1X Certificate, “Association Settings (→page 160)” must have been performed on the station to 
upload/delete, and the PC must be able to communicate with the system.

• When changes to IEEE802.1X settings are updated on the station, or after uploading a certificate, restart the station. Restart 
may take up to 10 minutes in total. The station will not operate until restart is complete.

Description Select Enable / Disable for IEEE802.1X function.

Settings • Enable
• Disable

Default values Disable

Description Select the EAP method for IEEE802.1X authentication when “IEEE 802.1X (→page 313)” is set 
to "Enable".

Settings • TLS
• PEAP

Default values TLS

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

“How to upload/delete the IEEE802.1X Certificate to each station (→page 315)”
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■EAP User Name

■EAP Password

Description Set the EAP User Name.

Settings 1 - 32 alphanumeric characters

Default values -

Description Set the EAP Password when "EAP" is set to "PEAP".

Settings 1 - 32 alphanumeric characters

Default values -

Note

• "EAP Password" is shown as "*****" in the Settings screen.
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7.13.1 How to upload/delete the IEEE802.1X Certificate to each station

Click [IEEE802.1X Certificate Update/Delete]. The following window will be shown.

How to upload/delete IEEE802.1X certificates
To delete, start from Step 4.

1. Click [Browse] next to the Certificate Authority File to select a file.

2. If “EAP (→page 313)” was set to "TLS," click [Browse] next to the Client Certificate File to select a 
file.

3. If "EAP" was set to "TLS," click [Browse] next to the Client Private Key File to select a file.

4. Select the station(s) to upload/delete the file from "Station List" (multiple selections allowed).
• To select or unselect stations in a batch, choose the station type and click [Select] or [Unselect].
• Stations in which “Association Settings (→page 160)” has not been performed cannot be selected.

5. Click [Upload] or [Delete].

3

4

1

2

5



316

System Settings (Table View)

6. Click [OK].
• The file will be uploaded/deleted and the station will restart.
• Click [Cancel] to back to the "Certification Update/Delete" screen without uploading/deleting.

7. Click [OK].
• The results are displayed in "Status" in "Station List."

In Process: The file is being uploaded/deleted.
Success: Upload/delete is completed.
Failed: Upload/delete failed. Try uploading/deleting again.
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7.14 Display Mode (for IX-MV7-*)

Configure IX-MV7-* Master UI Mode, for both Standard and Receptionist modes.

7.14.1 Master UI Mode

Description Set the User Interface Mode.

Settings • Standard: All functions can be used.
• Receptionist: Only outgoing call can be used. Refer to “Receptionist Mode (→page 319)” for 

detail settings.

Default values Standard

Important

• When the "Master UI Mode" setting is applied to the station it will restart. This may take up to 10 minutes and the station 
cannot be used until it has finished restarting.

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

Jump to related item
Moves to the selected item within the same Settings screen.
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7.14.2 Standard Mode

■Home Screen
Description Select the layout of top image when “Master UI Mode (→page 317)” is set to "Standard."

Settings • Option 1:

• Option 2:

Default values Option 1
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7.14.3 Receptionist Mode

Configure Receptionist Mode screen if "Receptionist" was set in “Master UI Mode (→page 317)”.

Important

• During receptionist mode, operations are limited to the following.

– The outgoing call method is limited to the method configured in “Button Function (→page 325)”.

– Calls will be automatically answered even if “Auto Answer (→page 237)” is set to "OFF." However, the call will not be 
received if “Reject Incoming Call (→page 326)” is set to "Enable."

– For "Option Input" - “Function (→page 242)”, only "Call" and "Turn LCD On" are valid.

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

Move to Related Settings
Moves to the selected item within the same Settings screen.
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7.14.3.1 Color Scheme

Description Select the Color Scheme of Receptionist Mode.

Settings Example where "Layout 1" was set in “Screen Layout (→page 321)”
• Light:

• Dark:

Default values Light
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7.14.3.2 Screen Layout

Description Select the Screen Layout of top image for Receptionist Mode.

Settings Example where "Light" was set in “Color Scheme (→page 320)”
• Layout 1:

• Layout 2:

• Layout 3:

Default values Layout 1
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Customizing each screen layout

The layout of each screen's characters, images, and button displays can be customized.
The following spaces are customized by configuring “Company Information (→page 323)”, “Greeting Information (→page 323)”, 
“Images (→page 324)”, and “Button Function (→page 325)”.

Layout 1

Layout 2

Layout 3

“Company Information (→page 323)”

“Greeting Information (→page 323)”

“Button 1 
(→page 325)”

“Button 2 
(→page 325)”

“Button 3 
(→page 325)”

“Button 4 
(→page 326)”

“Company Image (→page 324)”
Recommended resolution (W×H): 
800×100

“Greeting Image (→page 324)”
Recommended resolution (W×H): 
400×240

“Receptionist Image (→page 325)”
Recommended resolution (W×H): 800×340

“Company Information (→page 323)”

“Greeting Information (→page 323)”

“Greeting Image (→page 324)”
Recommended resolution (W×H):

400×240

“Button 1 (→page 325)”

“Button 2 (→page 325)”

“Button 3 (→page 325)”

“Button 4 (→page 326)”

“Receptionist Image (→page 325)”
Recommended resolution (W×H): 460×480

“Company Image (→page 324)”
Recommended resolution (W×H): 460×80

“Company Information (→page 323)”
“Greeting Information (→page 323)”

“Button 1 (→page 325)”

“Button 2 (→page 325)”

“Button 3 (→page 325)”

“Receptionist Image (→page 325)”
Recommended resolution (W×H): 800×120

“Company Image (→page 324)”
Recommended resolution (W×H): 400×120
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7.14.3.3 Company Information

■Name

■Text Size♦

■Bold

■Text Color

7.14.3.4 Greeting Information

■Greeting

■Text Size♦

■Bold

Description Enter the Company Information.

Settings 0-40 alphanumeric characters

Default values -

Description Set the text size of Company Information.

Settings 12 - 24 pt (by 1pt)

Default values 12pt

Description Select ON / OFF for Bold text.

Settings • OFF
• ON

Default values OFF

Description Set the text color of Company Information.

Settings • Option 1
"Black" if "Light" was set in “Color Scheme (→page 320)”. "White" if "Dark" was set.

• Option 2
"Blue" if “Color Scheme (→page 320)” was set to "Light." "Orange" if "Dark" was set.

Default values Option 1

Description Enter Greeting text.

Settings 0-100 alphanumeric characters
(Up to 10 line breaks can be inserted. Insert a line break by pressing "Alt" + "Enter.")

Default values -

Description Set the text size of Greeting.

Settings 12 - 70 pt (by 1 pt)

Default values 12pt

Description Select ON / OFF for Bold text.

Settings • OFF
• ON

Default values OFF
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■Text Color

7.14.3.5 Images
Upload the image file to display on the reception screen. Upload an image file that suits the layout configured in 
“Screen Layout (→page 321)”. Refer to “Customizing each screen layout (→page 322)” for recommended image file 
resolutions for each screen layout.

■Company Image

■Greeting Image

Description Configure the character color displayed in Greeting Information.

Settings • Option 1
"Black" if "Light" was set in “Color Scheme (→page 320)”. "White" if "Dark" was set.

• Option 2
"Blue" if “Color Scheme (→page 320)” was set to "Light." "Orange" if "Dark" was set.

Default values Option 1

Description Update Company Image.
Supported file format
• File name: within 20 characters (excluding extension)
• File format: png
• Resolution

Width: 400 - 800 pixels
Height: 80 - 480 pixels

Settings Register: Click [Browse] to select a file.
Delete: Place a check in [Delete].

Default values -

Description Update Greeting Image.
Supported file format
• File name: within 20 characters (excluding extension)
• File format: png
• Resolution

Width: 400 - 800 pixels
Height: 80 - 480 pixels

Settings Register: Click [Browse] to select a file.
Delete: Place a check in [Delete].

Default values -
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■Receptionist Image

7.14.3.6 Button Function
Configure the buttons displayed on the reception screen and their functions. Refer to “Customizing each screen 
layout (→page 322)” while configuring.

■Button 1

■Button 2

■Button 3

Description Update Receptionist Image.
Supported file format
• File name: within 20 characters (excluding extension)
• File format: png
• Resolution

Width: 400 - 800 pixels
Height: 80 - 480 pixels

Settings Register: Click [Browse] to select a file.
Delete: Place a check in [Delete].

Default values -

Note

• Image file names can be deleted from the Settings screen by selecting “Upload Settings To Station (→page 145)” - "Image" to 
upload the setting file, and then deleting the image file from the statoin.

Description Set the function of Button 1.

Settings • Group Call: Call group number set by “Group Call Destination (→page 326)”.
• Select By Name: Select destination station by name.
• Select By List: Select destination station by list.
• Enter Number: Enter destination station number by keypad.
• Hide: Button is not displayed.

Default values Hide

Description Set the function of Button 2.

Settings • Group Call: Call group number set by “Group Call Destination (→page 326)”.
• Select By Name: Select destination station by name.
• Select By List: Select destination station by list.
• Enter Number: Enter destination station number by keypad.
• Hide: Button is not displayed.

Default values Hide

Description Set the function of Button 3.

Settings • Group Call: Call group number set by “Group Call Destination (→page 326)”.
• Select By Name: Select destination station by name.
• Select By List: Select destination station by list.
• Enter Number: Enter destination station number by keypad.
• Hide: Button is not displayed.

Default values Hide
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■Button 4

■Button Name for Group Call

■Button Name for Select By Name

■Button Name for Select By List

■Button Name for Enter Number

7.14.3.7 Group Call Destination

7.14.3.8 Reject Incoming Call

Description Set the function of Button 4.

Settings • Group Call: Call group number set by “Group Call Destination (→page 326)”.
• Select By Name: Select destination station by name.
• Select By List: Select destination station by list.
• Enter Number: Enter destination station number by keypad.
• Hide: Button is not displayed.

Default values Hide

Description Set the Button Name when Button 1 - 4 is assigned to "Group Call". If "Group Call" is set to 
multiple buttons, they will all share the same name.

Settings 1-24 alphanumeric characters

Default values -

Description Set the Button Name when Button 1 - 4 is assigned to "Select By Name". If "Select By Name" is 
set to multiple buttons, they will all share the same name.

Settings 1-24 alphanumeric characters

Default values -

Description Set the Button Name when Button 1 - 4 is assigned to "Select By List". If "Select By List" is set to 
multiple buttons, they will all share the same name.

Settings 1-24 alphanumeric characters

Default values -

Description Set the Button Name when Button 1 - 4 is assigned to "Enter Number". If "Enter Number" is set 
to multiple buttons, they will all share the same name.

Settings 1-24 alphanumeric characters

Default values -

Description Set the destination group when Button 1 - 4 is assigned to "Group Call". If "Group Call" is set for 
multiple buttons, they will all share the same call destination group.
Enter the group number directly, or click [Open] to select group.

Settings 01 - 99

Default values -

Description Select Enable / Disable for incoming calls in Receptionist Mode.

Settings • Enable: Do not receive incoming calls.
• Disable: Receive incoming calls.

Default values Disable
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7.15 Bathroom Link

This function cannot be used outside Japan.
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8. Transfer Settings

8.1 Absent Transfer (for IX-MV7-* and IX-MV)

Configure the settings for absent transfer.
Absent Transfer: If an incoming call is received during absent transfer, the incoming call will be automatically 
transferred to a transfer destination.

■Absent Transfer

■Transfer Destination List

Important

• When an incoming call is received from a VoIP Phone, the call will be received without transferring even when transfer is set. 
To transfer the call, configure transferring on the IP-PBX.

• Stations in which “IP Address (→page 180)” has not been configured cannot be configured as transfer destinations.

Description Select Enable / Disable for Absent Transfer. The setting can also be changed on the station.
If "Transfer Destination List" is not configured, this cannot be set to "Enable."

Settings • Enable: Set absent transfer
• Disable: Do not set absent transfer

Default values Disable

Description Configure the transfer destination station (Number) for absent transfer. Up to 10 transfer 
destination stations (IX-MV: one station only) can be configured. However, if the station making 
the outgoing call is IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*), the transfer will be made only 
to the station entered in "No.01."
Enter Number directly, or click [Open] to choose a station.
For IX-MV, a VoIP phone cannot be set as the transfer destination.

Settings IX-MV7-*: 3-32 digits
IX-MV: 3-5 digits

Default values -

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■Re-Transfer Destination (for IX-MV7-*)

Important

• Do not configure multiple VoIP Phone. If multiple VoIP Phone are configured, calls will be transferred to only one VoIP Phone.

Description Configure the transfer destination station (number) for absent re-transfer for a transferred call. 
Only a single station can be configured as the transfer destination. However, if the station 
making the outgoing call is IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*) the call will be received 
without transferring it again.
Enter the station number or click [Open] to choose one.

Settings 3-32 digits

Default values -
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8.2 Delay Transfer (for IX-MV7-* and IX-MV)

Configure the settings for delay transfer.
Delay Transfer: A call can be automatically transferred to another station after a certain period of time (delay time) 
elapses.

■Delay Transfer

■Delay Time [sec]♦

■Transfer Destination List

Important

• When an incoming call is received from a VoIP Phone, the call will be received without transferring even when transfer is set. 
To transfer the call, configure transferring on the IP-PBX.

• Stations in which “IP Address (→page 180)” has not been configured cannot be configured as transfer destinations.

Description Select Enable / Disable for Delay Transfer.
To enable Delay Transfer, set transfer or re-transfer destination.

Settings • Enable: Delay transfer enabled
• Disable: Delay transfer disabled

Default values Disable

Description Set the delay time between receiving and transferring a call.

Settings 1-300 sec (by 1 sec)

Default values 30 sec

Description Configure the transfer destination station (Number) for delay transfer. Up to 10 transfer 
destination stations (IX-MV: one station only) can be configured. However, if the station making 
the outgoing call is IX-MV, IX-DA, IX-DF(-*), IX-BA, or IX-SS(-*), the transfer will be made only to 
the station entered in "No.01."
Enter Number directly, or click [Open] to choose a station.
For IX-MV, a VoIP phone cannot be set as the transfer destination.

Settings IX-MV7-*: 3-32 digits
IX-MV: 3-5 digits

Default values -

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■Re-Transfer Destination (for IX-MV7-*)

Important

• Do not configure multiple VoIP Phone. If multiple VoIP Phone are configured, calls will be transferred to only one VoIP Phone.

Description Configure the transfer destination station (number) for delay re-transfer for a transferred call. 
Only a single station can be configured as the transfer destination. However, if the station 
making the outgoing call is IX-MV, IX-DA, IX-DF(-*), IX-BA, or IX-SS(-*), the call will be received 
without transferring it again.
Enter the station number or click [Open] to choose one.

Settings 3-32 digits

Default values -
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8.3 Schedule Transfer (for IX-MV7-* and IX-MV)

Configure the settings for Schedule Transfer.
Schedule Transfer: A call can be automatically transferred to another station when a call comes in during the time 
period set up in “Weekly Schedule (→page 333)” and “Daily Schedule (for IX-MV7-*) (→page 335)”.

■Schedule Transfer

Important

• When an incoming call is received from a VoIP Phone, the call will be received without transferring even when transfer is set. 
To transfer the call, configure transferring on the IP-PBX.

• Stations in which “IP Address (→page 180)” has not been configured cannot be configured as transfer destinations.

• Incoming calls will be transferred during the time period set in "Schedule Transfer," regardless of what was set in “Absent 
Transfer (for IX-MV7-* and IX-MV) (→page 328)” and “Delay Transfer (for IX-MV7-* and IX-MV) (→page 330)”.

Description Select Enable / Disable for Schedule Transfer.
To enable Schedule Transfer, configure “Weekly Schedule (→page 333)” or “Daily Schedule (for 
IX-MV7-*) (→page 335)”.

Settings • Enable: Schedule transfer enabled
• Disable: Schedule transfer disabled

Default values Disable

Move row
Up to 50 station number rows can be 
displayed at a time. Switch the display 
as follows.
[Previous]: Display the previous 50 
rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and 
click [Display] to move the cursor to the 
entered row.

Weekly Schedule
Select the day and schedule range to configure. The Settings screen is displayed.
“Weekly Schedule (→page 333)”

“Daily Schedule (for IX-MV7-*) 
(→page 335)”

Move to Related Settings
Moves to the selected item within 
the same Settings screen.
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8.3.1 Weekly Schedule

Configure the transfer destination and transfer time for every day from Sunday through Saturday.
For IX-MV7-*, up to 12 schedules can be set for each day, and for the IX-MV, one schedule can be set for each day.

■Transfer Destination List

■Re-Transfer Destination (for IX-MV7-*)

■Start Time

■End Time

Description Configure the transfer destination station (Number) for scheduled transfer.
• IX-MV7-*: Up to 10 transfer destination stations can be configured for each of the 12 

schedules , and for each day of the week. However, if the station making the outgoing call is 
IX-MV, IX-DA, IX-DF(-*), IX-BA, or IX-SS(-*), the transfer will only be made to the station 
entered in "No.01."

• IX-MV: Only a single transfer destination station can be set for each day of the week. Enter 
this in "No.01" for "Sun 01." A VoIP phone cannot be set as the transfer destination.

Enter Number manually, or click [Open] to choose a station.

Settings IX-MV7-*: 3-32 digits
IX-MV: 3-5 digits

Default values -

Important

• Do not configure multiple VoIP Phone. If multiple VoIP Phone are configured, calls will be transferred to only one VoIP Phone.

Description Configure the transfer destination station (Number) when performing a scheduled transfer again 
for a transferred call. Only a single station can be configured as the transfer destination for each 
of the 12 schedules on each day of the week. However, if the station making the outgoing call is 
IX-MV, IX-DA, IX-DF(-*), IX-BA, or IX-SS(-*), the call will be received without transferring it 
again.
Enter the station number or click [Open] to choose one.

Settings 3-32 digits

Default values -

Description Set the Start Time to enable schedule transfer.
For IX-MV, configure this as the first schedule of each day of the week. For example, configure 
Sunday in "Sun 01."

Settings 00:00 - 23:59

Default values -

Description Set the End Time to disable schedule transfer. If this is set earlier than "Start Time," the end time 
will be for the following day.
For IX-MV, configure this as the first schedule of each day of the week. For example, configure 
Sunday in "Sun 01."

Settings 00:00 - 23:59

Default values -
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How to configure schedule display
Configure the day and schedule range shown on the Settings screen for the weekly schedule.
The display can be filtered to show only the day and schedule to configure.
Click Schedule View Adjustment. The following screen will be shown.

1. Select the day(s) to display from "Day" (multiple selections allowed).
• To select or unselect all days at once, click [Select] or [Unselect].
• By default, all days are shown.

2. Select the range of schedules to display (1 - 12) that can be configured for each day of the week.
• By default, the range of 1 - 3 is shown.

3. Click [OK].
• Click [Cancel] to return to the schedule display.

1

2

3
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8.3.2 Daily Schedule (for IX-MV7-*)

Configure the transfer destination and time for each individual day.
A schedule one year from the set day can be configured. 12 schedules can be set for each day.

■Transfer Destination List
Description Configure the transfer destination station (Number) for scheduled transfer. Up to 10 transfer 

destination stations can be configured for each of the 12 schedules for each day of the week. 
However, if the station making the outgoing call is IX-MV, IX-DA, IX-DF(-*), IX-BA, or IX-SS(-*), 
the transfer will be made only to the station entered in "No.01."
Enter Number directly, or click [Open] to choose a station.

Settings 3-32 digits

Default values -

Important

• Do not configure multiple VoIP Phone. If multiple VoIP Phone are configured, calls will be transferred to only one VoIP Phone.

Daily Schedule
Select the date and schedule range to configure. The Settings 
screen is displayed.

1. Select the date from the drop down menu.

2. Select the range of schedules to display (1 
- 12) that can be configured for each day.
• By default, the range of 1 - 3 is displayed.

3. Click [Change to Daily Schedule 
Display].

Move row
Up to 50 station number rows can be displayed at a time. 
Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to 
move the cursor to the entered row.
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■Re-Transfer Destination

■Start Time

■End Time

Description Configure the transfer destination station (Number) when performing scheduled re-transfer for a 
transferred call. Only a single station can be configured as the transfer destination for each of the 
12 schedules on each day. However, if the station making the outgoing call is IX-MV, IX-DA, IX-
DF(-*), IX-BA, or IX-SS(-*), the call will be received without transferring it again.
Enter the station number or click [Open] to choose one.

Settings 3-32 digits

Default values -

Description Set the Start Time to enable schedule transfer.

Settings 00:00 - 23:59

Default values -

Description Set the End Time to disable schedule transfer. If this is set earlier than "Start Time," the end time 
will be for the following day.

Settings 00:00 - 23:59

Default values -
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8.4 Lock Transfer (for IX-MV7-*)

Description Select ON / OFF to Lock Transfer function. When set to "ON", transfer function cannot be 
changed by user account.

Settings • ON: Cannot be configured with user privileges.
• OFF: Can be configured with user privileges.

Default values OFF

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[ON]: Enter the station number and click [Display] to move the cursor to the row of the entered station number.
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9. Station Settings

9.1 Speed Dials / Favorites (for IX-MV7-* and IX-MV)

Configure the settings for Speed Dial buttons of IX-MV7-* and IX-MV.
Select the Speed Dial button number to configure in [Display Settings].

9.1.1 Advanced Speed Dial Button Settings

Select the functions to assign to each Speed Dial button.
Up to eight Speed Dial buttons can be set for IX-MV7-*, and six for IX-MV.

9.1.1.1 Speed Dial Name (for IX-MV7-*)

Description Set the Speed Dial Name.

Settings 1-24 alphanumeric characters
The entire name may not be shown on the station screen, depending on the number of 
characters.

Default values -

Display Settings
Settings for the selected Speed Dial button number are displayed.

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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9.1.1.2 Function

How to configure Individual Call
Configure this if "Individual Call" is set in “Function (→page 339)”.

■Number

■Priority

How to configure Group Call
Configure if "Group Call" is set in “Function (→page 339)”.

■Group Number

Important

• Enter button names in the language configure in “Language (→page 158)”. However, if the language (configured on the station 
main unit) displayed on the screen for IX-MV7-* differs from that set in "Language," the characters on the station screen may 
appear incorrectly. To avoid this, enter information in the setting data using alphabetical characters only.

Description Set the Speed Dial Function. The functions that can be selected differ between stations. Refer to 
“How to configure Individual Call (→page 339)” for how to configure detailed functions.

Settings • No Function
• Individual Call: Call individual station set in "Individual Call".
• Group Call: Call group set in "Group Call".
• Group Page: Page group set in "Group Page".
• All Page: Page all stations.
• Group Message Page (For IX-MV7-*): Page message to group set in "Group Message Page".
• All Message Page (For IX-MV7-*): Page message to all stations..
• Monitor (For IX-MV7-*): Monitor station set in "Monitor".
• Network Camera Monitor (For IX-MV7-*): Monitor network camera set in "Network Camera 

Monitor".
• Scan Monitor (For IX-MV7-*): Start scan monitor sequence set in "Station Settings - Monitor".
• Option Relay Control (For IX-MV7-*): Relay Control set in "Option Relay Control". Relay output 

will not be controlled for IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*).

Default values No Function

Description Set the destination station (Station Number).
Enter the Station Number or click [Open] to choose one. This cannot be configured for IXW-MA.

Settings 3-32 digits

Default values -

Important

• Stations in which “IP Address (→page 180)” has not been configured cannot be configured as destinations.

Description Set the Priority for the individual calls.

Settings • Normal
• Priority
• Urgent

Default values -

Description Set the destination group (group number).
Enter the group number or click [Open] to choose one.

Settings 01 - 99

Default values -
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■Priority

How to configure Group Page
Configure if "Group Page" is set in “Function (→page 339)”.

■Group Number

■Priority

How to configure All Page
Configure if "All Page" is set in “Function (→page 339)”.

■Priority

How to configure Group Message Page (for IX-MV7-*)
Configure if "Group Message Page" is set in “Function (→page 339)”.

■Group Number

Description Set the priority of Individual call.

Settings • Normal
• Priority
• Urgent

Default values -

Description Set the destination group (Group Number).
Enter the Group Number or click [Open] to choose one.

Settings 01 - 99

Default values -

Description Set the priority of group page.

Settings • Normal
• Urgent

Default values -

Description Set the priority of all page.

Settings • Normal
• Urgent

Default values -

Description Set the destination group (Group Number).
Enter the Group Number directly, or click [Open] to choose one.

Settings 01 - 99

Default values -
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■Message

■Priority

■Play Count [time(s)]

Description Select the message (audio file) to be send during group message paging.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None

Description Set the priority of group message page.

Settings • Normal
• Urgent

Default values -

Description Set the message play count of group message page.

Settings 1 - 20 times

Default values -
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How to configure All Message Page (for IX-MV7-*)
Configure if "All Message Page" is set in “Function (→page 339)”.

■Message

■Priority

■Play Count [time(s)]

How to configure Monitor (for IX-MV7-*)
Configure if "Monitor" is set in “Function (→page 339)”.

■Number

Description Select the message (audio file) to send during all message paging.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None

Description Set the priority of all message page.

Settings • Normal
• Urgent

Default values -

Description Set the message play count of all message page.

Settings 1 - 20 times

Default values -

Description Set the destination station (Station Number).
Enter the Station Number or click [Open] to choose one. This cannot be configured for IX-MV7-
*, IX-MV, IXW-MA, or VoIP phones.

Settings 3-32 digits

Default values -

Important

• Stations in which “IP Address (→page 180)” has not been configured cannot be configured to be monitored.
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How to configure Network Camera Monitor (for IX-MV7-*)
Configure if "Network Camera Monitor" is set in “Function (→page 339)”.

■Network Camera

How to configure Option Relay Control (for IX-MV7-*)
Configure if "Option Relay Control" is set in “Function (→page 339)”.

■Total

■Output Time Range

Description Set the destination Network Camera (#).
Enter the number of the network camera set in “Open Network Camera List (→page 212)” or 
click [Network camera selection] to choose one.

Settings 001 - 050

Default values -

Note

• When controlling relay output for multiple stations, processing may take some time and control may be delayed.

Description Configure the station to control relay output. This cannot be configured for IX-MV, IX-DA, IX-DF(-
*), IX-BA, IX-SS(-*).
Click [Open] to choose a station. Multiple stations (infinite) can be selected.

Settings The number of selected stations is displayed.

Default values 0

Important

• Stations that the "IP Address" has not been configured cannot be configured as stations to perform control.

Description Select the Output Time Range for relay output.

Settings • 0 (Momentary): Start Relay Output by pressing a Speed Dial button.
Stop Relay Output by pressing again the Speed Dial button.

• 200-2000 [msec]
• 3 - 600 [sec]

Default values 0 (Momentary)
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■Output Time♦

■TLS

■Option Relay Control Key

9.1.1.3 Lock (for IX-MV7-*)

Description Set the Output Time within the range selected in "Output Time Range."

Settings The setting value is as follows depends on "Output Time Range."
• If set to 0 (Momentary): Configuration unnecessary.
• If set to 200-2000 [msec]: Configure from 200 - 2000 msec (by 200 msec).
• If set to 3 - 600 [sec]: Configure from 3 - 600 sec (by 1 sec).

Default values 0

Description Select Enable / Disable for TLS.  When "Enable" is selected, set "Option Relay Control Key" and 
"Relay Output" - “Option Relay Control Authentication Key (except IX-MV, IX-DA, IX-DF(-*), IX-
BA and IX-SS(-*)) (→page 253)”.

Settings • Enable
• Disable

Default values Disable

Important

• If "TLS" is set to "Enable," this may take some time if there are multiple stations to control.

Description Set the Option Relay Control Key when"TLS" is set to "Enable." When matched with the Option 
Relay Control Authentication Key in "Relay Output" - “Option Relay Control Authentication Key 
(except IX-MV, IX-DA, IX-DF(-*), IX-BA and IX-SS(-*)) (→page 253)”, the relay output will 
activate.

Settings 1-20 digits

Default values -

Description Select ON / OFF to Lock Speed Dial setting. Once set to "ON", Speed Dial function cannot be 
changed by user account.

Settings • ON
• OFF

Default values OFF
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9.2 Privacy (for IX-MV7-* and IX-MV)

Configure to prevent the other station from hearing/viewing audio or camera images, when “Auto Answer 
(→page 237)” is set to "ON."

■Privacy
Description Select Enable / Disable for Privacy function. The setting can also be changed on the station.

Settings • Enable
• Disable

Default values Disable

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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9.3 Volume / Tone (except IXW-MA)

Configure the sound settings, such as volume and ringtone.

9.3.1 Volume

■Handset Transmit (for IX-MV7-*, IX-RS-*, and IX-MV)

■Handset Receive (for IX-MV7-*, IX-RS-*, and IX-MV)

■Hands-free Transmit (for IX-MV7-*, IX-RS-*, and IX-MV)

Description Set the transmit volume using handset while communicating and paging.

Settings 1 (Low) - 10 (High)

Default values 10

Description Set the receive volume using handset while communicating. Also sets ringback tone volume.

Settings 1 (Low) - 10 (High)

Default values 6

Description Set the hands-free transmit volume while communicating and paging.

Settings 1 (Low) - 10 (High)

Default values 10

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.

Move to Related Settings
Moves to the selected item within the same Settings screen.
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■Hands-free Receive (for IX-MV7-*, IX-RS-*, and IX-MV)

■Headset Jack Transmit (for IX-MV7-*)

■Headset Jack Receive (for IX-MV7-*)

■Transmit (except IX-MV7-*, IX-RS-*, and IX-MV)

■Receive (except IX-MV7-*, IX-RS-*, and IX-MV)

■External Input

■External Output (for IX-RS-*)

■VoIP Phone Volume Adjustment (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Description Set the hands-free receive volume while communicating and paging. Also sets ringback tone 
volume.

Settings 1 (Low) - 10 (High)

Default values • IX-MV7-*, IX-MV: 6
• IX-RS-*: 10

Description Set the transmit volume using headset jack.

Settings 1 (Low) - 10 (High)

Default values 10

Description Set the receive volume using headset jack.

Settings 1 (Low) - 10 (High)

Default values 6

Description Set the transmit volume while communicating and being  monitored.

Settings 1 (Low) - 10 (High)

Default values 10

Description Set the receive volume while communicating and paging (except IX-DV, IX-DVF(-*), IX-SSA(-*)). 
Also sets ringback tone. The receive volume for IX-DV, IX-DVF(-*), IX-SSA(-*) during page is 
configured in “Paging (for IX-DV, IX-DVF(-*), IX-SSA(-*)) (→page 348)”.

Settings 1 (Low) - 10 (High)

Default values IX-SS-2G, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*): 10
IX-DV, IX-DVF(-*), IX-SSA(-*): 6

Description Not used.

Description Set the transmit volume using external output.

Settings 1 (Low) - 10 (High)

Default values 6

Description Select the volume adjustment between VoIP Phone and IX stations.

Settings • -12dB from VoIP, +12dB to VoIP
• -6dB from VoIP, +6dB to VoIP
• No Adjustment
• +6dB from VoIP, -6dB to VoIP
• +12dB from VoIP, -12dB to VoIP

Default values No Adjustment
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■Ringtone

■Paging (for IX-DV, IX-DVF(-*), IX-SSA(-*))

■Button Feedback (for IX-MV7-* and IX-MV)

Description Select the volume for Ringtone and Paging Pretone.

Settings 0 (Off), 1 (Low) - 10 (High)

Default values • IX-MV7-*, IX-MV, IX-DV, IX-DVF(-*), IX-SSA(-*): 6
• IX-SS-2G, IX-RS-*, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*): 10

Description Set the volume while receiving page.

Settings 0 (Off), 1 (Low) - 10 (High)

Default values 6

Description Select Enable / Disable for Button Feedback tone.

Settings • Enable
• Disable

Default values • IX-MV7-*: Enable
• IX-MV: Disable
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9.3.2 Tone

■Communication Timeout Notification (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Description Select the tone to be played when an outgoing call times out.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Error



350

System Settings (Table View)

■Communication End Pretone (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

■Call Queue Notification (for IX-MV7-*)

Description Select the tone to be played 10 sec before communication, paging or monitoring ends.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Communication End Pretone

Description Select the tone to be played when receiving a call while communicating.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Call Queue Notification
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■Paging Pretone (for IX-MV7-* and IX-MV)

■Auto Answer Tone (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Description Select the sound to be played when placing or receiving a page.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Pre Tone 2

Important

• Configure the paging pretone with a longer duration than the paging pretone of the station receiving the page. Configuring a 
shorter tone might prevent audio from playing on the other station when paging starts. Configure the same tone as that of other 
IX-MV7-* andIX-MV stations in the system.

Description Select the tone to be played.
• Ringtone when receiving an individual call. “Auto Answer (→page 237)” must be set to  "ON".
• Ringback tone when placing an individual call. “Auto Answer (→page 237)” must be set to 

"ON" at the destination station. (for IX-MV7-*)

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Pre Tone 1
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■On Hold (for IX-MV7-*)

■Key Received (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))

Description Select the tone to be played while On-Hold.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values On Hold

Description Configure the tone to send to the destination station when the door release key entered using a 
keypad on the destination station (station performing a door release operation) matches the 
authentication key of this station (station connected to the electrical lock). The tone will be heard 
on the destination station.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None
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■Error (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

9.3.3 Mic Select

9.3.4 Headset Specification (for IX-MV7-*)

9.3.5 Audio Output (for Master) (for IX-MV7-*)

Description Select the tone to be played when error has occurred.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values Error

Description Not used.

Description Set the device to be connected to the headset jack.

Settings • Mic Device
• Headset Device

Default values Mic Device

Description Set using External speaker for Ringtone, Paging Pretone and Paging.

Settings • External speaker output for Ringtone, Built-in Speaker for Communication
• External speaker output  for Paging Pretone, Built-in Speaker for Paging
• External speaker output  for Ringtone, Paging Pretone and Paging, Built-in Speaker for 

Communication

Default values External speaker output for Ringtone, Built-in Speaker for Communication

Note

• The tone will play from the speaker of the station even if audio is heard from the external speaker.
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9.3.6 Audio Output (for Door) (except IX-MV7-*, IX-SS-2G, and IX-MV)

Description Set using Line Audio / External Speaker or Built-in Speaker while communicating and paging.

Settings • Built-in Speaker for Communication and Paging
• Line Audio Output for Communication and Paging (External speaker output for 

Communication and Paging for IX-RS-*)
• Built-in Speaker for Communication, Line Audio Output for Paging (External speaker output for 

Communication and Paging for IX-RS-*)

Default values Built-in Speaker for Communication and Paging
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9.4 Communication (except IXW-MA)

Configure the settings for a call.

■Talk Timeout [sec]♦
Description Set the communication timer when placing a call or answering a page. Communication timer 

when receiving a call is set at the destination station.

Settings • Infinite (Except IX-MV): No timeout.
• 30-600 sec: Configure between 30 to 600 sec (by 1 sec).

Default values 60 sec

Important

• During a communication with a VoIP Phone, this will be the shorter time of the time set for "Talk Timeout [sec]" and the call 
duration set on the VoIP Phone.

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■Communication Start Tone (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

■Force Touch-to-Talk (for IX-MV7-* and IX-MV)

Description Select the tone to be played when communication starts.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None

Description Select Enable / Disable for Force Touch-to-Talk (Or Press-to-Talk) when starting communication 
in hands-free mode.

Settings • Enable
• Disable

Default values Disable
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9.5 Monitor (except IXW-MA, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Configure monitoring-related settings.

9.5.1 Monitor Timeout [sec] (for IX-MV7-* and IX-MV) ♦

Important

• Monitoring cannot be performed for IX-MV7-*, IX-MV, or VoIP Phone.

Description Set the monitoring timer by station. Scan Monitor must be end manually.

Settings • Infinite (For IX-MV7-*): No timeout.
• 10-600sec: Set 10-600 sec by 1 sec.

Default values 60 sec

Move row
Up to 50 station number rows can be 
displayed at a time. Switch the display as 
follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered 
row.

Scan Monitor
Up to 50 monitoring number lines can be shown at a time. 
Switch the display as follows.
[Previous]: Display the previous 50 columns.
[Next]: Display the next 50 columns.
[Display]: Enter the monitoring number and click [Go] to 
display the column for the monitoring number.

Move to Related Settings
Moves to the selected item 
within the same Settings 
screen.

Monitoring number
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9.5.2 Scan Monitor (for IX-MV7-*)

Configure monitoring by automatically switching between several stations (except IX-MV7-* and IX-MV) and network 
cameras at set intervals. The scan will be performed in registration order.

■Type

■Number

■Camera Settings

■Dwell Time

9.5.3 Prevent Being Monitored (except IX-MV7-* and IX-MV) 

Description Select the Station Type.

Settings • IX Station
• Network Camera

Default values -

Description Set the Station Number.
Enter the Number or click [Open] to choose one. This cannot be selected for IX-MV7-*, IX-MV, 
IXW-MA or VoIP Phone.

Settings 3-5 digits

Default values -

Important

• Stations in which “IP Address (→page 180)” has not been configured cannot be configured to be monitored.

Description Set the Network Camera Number.
Enter the number of the network camera set in “Open Network Camera List (→page 212)” or 
click [Network camera selection] to choose one.

Settings Select from the network cameras registered in “Open Network Camera List (→page 212)”.

Default values -

Description Set the dwell time to change destination for scan monitor.

Settings • 5 sec
• 10 sec
• 30 sec

Default values 5 sec

Description Select ON / OFF to prevent being monitored.

Settings • ON
• OFF

Default values OFF



359

System Settings (Table View)

9.5.4 Monitored Notification (except IX-MV7-* and IX-MV) 

Description Select the tone to be played when monitored by another station.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 221)”.

Default values None
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9.5.5 Monitored LED Notification (except IX-MV7-* and IX-MV) 

Description Select ON / OFF for status LED notification (Blue flashing) while being monitored by another 
station.

Settings • ON
• OFF

Default values OFF
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9.6 Master Station Display (for IX-MV7-* and IX-MV)

Configure screen display-related settings.

■Brightness

■Primary Video Source (for IX-MV7-*)

■Aspect Ratio (for IX-MV7-*)

■Time Format: (for IX-MV)

Description Set the Brightness of Master station display.

Settings 1 (Dark) - 10 (Bright)

Default values 6

Description Select the primary video source when showing 2 video stream simultaneously.

Settings • IX Station
• Network Camera

Default values IX Station

Description Select the video aspect for primary video source.

Settings • 16:9
• 4:3

Default values 16:9

Description Select the Time format.

Settings • mm/dd/yyyy (12h)
• mm/dd/yyyy (24h)
• dd/mm/yyyy (12h)
• dd/mm/yyyy (24h)
• yyyy/mm/dd (12h)
• yyyy/mm/dd (24h)

Default values mm/dd/yyyy (12h)

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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■Standby LED State

■Keypad (for IX-MV7-*)

Description Select ON / OFF for stand by status LED.

Settings • ON
• OFF

Default values ON

Description Select ON / OFF  for whether to display the keypad used for door release and playing location 
messages.

Settings • ON
• OFF

Default values ON
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9.7 Camera (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

Configure camera settings.

9.7.1 Adjustment

■Backlight Compensation

■Low Light Sensitivity

Description During an outgoing call or monitoring, video with backlight compensation adjustment will be sent 
to the destination station.
The adjustment can be removed through operation by the destination station.

Settings • Enable
• Disable

Default values Disable

Description Send an image that low light sensitivity compensation was performed to the other station, when 
an outgoing call is made or the station is being monitored and the surrounding area is dark (such 
as at night). The compensation can be removed on the other station.

Settings • Enable
• Disable

Default values Disable

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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9.7.2 Color Settings (for IX-DA, IX-DF(-*))

■Brightness♦

■Contrast♦

■Color♦

9.7.3 White LED

■Call / Communication

■Monitored

Important

• If these settings are changed while video is displayed, the changes will not be reflected until the video is accessed again.

Description Set the Brightness for camera setting.

Settings 1 (Dark) to 100 (Bright)

Default values 50

Description Set the Contrast for camera setting.

Settings 1 (Weak) - 100 (Strong)

Default values 15

Description Set the Contrast for camera setting.

Settings 1 (Weak) to 100 (Strong)

Default values 50

Description Select Enable / Disable for white LED while calling or communicating in low light situation.

Settings • Enable
• Disable

Default values Enable

Description Select Enable / Disable for white LED while being monitored in low light situation.

Settings • Enable
• Disable

Default values Disable
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9.8 Door Release Assignment (for IX-RS-*)

Configure the connected station and door release key for door release during a call.
Configure each station for each group configured in “Called Stations (Door/Sub Stations) (except IX-MV7-*, IX-MV, 
and IXW-MA) (→page 225)”.
Select the group number to configure in [Display Settings].

■Contact Assignment

■Authentication Key

Description Select which relay output will be used for door release during call.

Settings • Originating Station: Use origination station relay output for door release.
• Destination Station: Use destination station relay output for door release.

Default values Destination Station

Description When "Destination Station" is selected in "Contact Assignment," set the Authentication Key for 
door release.
Authentication key must match with the destination station's authentication key, which is set in 
"Relay Output" - “Door Release Authorization (except IXW-MA) (→page 248)” to allow door 
release.

Settings 1-20 digits

Default values Random characters (compatible with default value of "Relay Output" - "Door Release 
Authorization")

Move row
Up to 50 station number rows can be displayed 
at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click 
[Display] to move the cursor to the entered row.

Display Settings
Displays the selected group number setting information.

Move to Related Settings
Moves to the selected item within the same Settings screen.
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■Door Release by IX-RS

Note

• If “Create new system/import setting data (→page 123)” - "Automatically configure door release for all stations?" was set to 
"No," the default value for "Authentication Key" will not be set.

• The default values for the Door Release Authorization and Authentication Key vary depending on the station type set in 
“Create new system/import setting data (→page 123)” - "IX Support Tool Settings."

– IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) not configured: 20 digits

– IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) configured: 4 digits

Description Select Enable / Disable for door release.

Settings • Enable
• Disable

Default values Disable
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9.9 Line Supervision (for IX-MV7-*)

Configure settings related to Line Supervision and Device Check performed by IX-MV7-*.
Monitor a station other than a VoIP Phone registered in “Station List (→page 209)”.

9.9.1 Line Supervision Interval

■Test Interval

■Weekly

■Line Supervision Schedule

Description Set the Line Supervision test interval.

Settings • OFF
• 15 sec
• 20 min
• 30 min
• 60 min
• Daily
• Weekly

Default values OFF

Description Set the day of the week when "Weekly" is selected in "Test Interval."

Settings Sun - Sat

Default values Sun

Description Set the time when automatic Line Supervision starts.
Set the time when "Daily" or "Weekly" is selected in "Test Interval."

Settings 00:00 - 23:59

Default values 00:00

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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9.9.2 Device Check Interval

■Test Interval

■Weekly

■Device Check Schedule

Description Set the Line Supervision test interval.

Settings • OFF
• 10 min
• 20 min
• 30 min
• 60 min
• Daily
• Weekly

Default values OFF

Description Set the day of the week when "Weekly" is selected in "Test Interval."

Settings Sun - Sat

Default values Sun

Description Set the time when Device Check starts.
Set the time when "Daily" or "Weekly" is selected in "Test Interval."

Settings 00:00 - 23:59

Default values 00:00
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10. Maintenance

10.1 Firmware Update

Access our website at "https://www.aiphone.net/" to download the latest version of the firmware.

Important

• To update the firmware, “Association Settings (→page 160)” must have been performed on the station to update, and the PC 
must be able to communicate with the system.

• If the firmware update is started while the station is operating (such as on a call), the operation will end and the firmware 
update will begin.

• If power is turned off while updating the firmware, the station may malfunction.

• The station will be inoperable while updating the firmware.

• When the firmware is updated, the station will be automatically restarted.

1

2

3

https://www.aiphone.net/
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How to update the firmware

1. Click [Browse] and select the firmware file to be downloaded for each station.

2. Select the station to update the firmware from "Station List" (multiple selections allowed).
• To select or unselect stations in a batch, choose the station type for a batch selection and click [Select] or 

[Unselect].
• Stations for which “Association Settings (→page 160)” has not been performed cannot be selected.

3. Click [Update].
• The firmware update may take approximately ten minutes per station.

4. Click [OK].
• Click [Cancel] to back to the "Update Firmware" screen without updating the firmware.

5. Click [OK].
• The result is displayed in "Station List" > "Status."

In Process: The firmware is being updated.
Success: Update successful.
Failed: Update failed. Try updating again.

10.2 Initialization

When initializing the station, all settings go back to the default values, and the system log and incoming/outgoing call 
history are erased.
Stations are also deleted from the settings in IX Support Tool.
To initialize a station, start from “Initialization (→page 547)” in the Settings (Station View).
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10.3 Settings File Backup

Download the setting file from the station and back it up.

How to download setting files

1. Select the station to download the setting file from "Station List" (multiple selections allowed).
• To select or unselect stations in a batch, choose the station type for a batch selection and click [Select] or 

[Unselect].
• Stations for which “Association Settings (→page 160)” has not been performed cannot be selected.

2. Download the file.
[Settings]: Download only the setting file.
[Sounds]: Download the setting file and audio file for a custom tone.
[Image] (for IX-MV7-*): Download the setting file and image file for the image on the reception screen.
[Schedule] (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA): Download schedule setting files 
(for transfer, etc.). Schedules for IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) are downloaded from [Settings].

Important

• Setting files are downloaded via “Association Settings (→page 160)” on the downloading station. Files cannot be downloaded 
unless the PC can communicate with the system.

• When first configuring settings using a web browser, or when changing the configuration using a web browser after configuring 
settings using IX Support Tool, it may not be possible to download the setting files. In this case, download the setting files 
using a browser.

1

2
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3. Click [OK].
• Click [Cancel] to return to the "Setting File Download" window without downloading.

4. Click [OK].
• The file download result is displayed in "Station List" - "Status."

In Process: The file is in the process of downloading.
Success: Download is completed.
Failed: Download failed.
Unavailable: This is displayed when a file that cannot be uploaded to a station is selected to download in 
Step 2.

• Downloaded files are saved as follows in "aiphone" - "AIPHONE_IX_SupportTool" - "SystemData" within the 
folder specified during installation.
– Setting file: "NewIXSystem(set system name).db"
– Sound file: Saved as a WAV file inside "(Set System Name)" - "Setting (Hidden Folder)" - "(Station 

Number)"
– Image file: Saved as a PNG file inside "(Set System Name)" - "Setting (Hidden Folder)" - "(Station 

Number)"
– Schedule file: Saved inside "(Set System Name)" - "Setting (Hidden Folder)" - "(Station Number)" as 

"SCHED_CHIME.txt," "SCHED_GROUP.txt," "SCHED_OUTPUT.txt," "SCHED_TRANSFER.txt," or 
"SCHED_REC.txt" (the saved content differs depending on the station).
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10.4 syslog (except  IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

■ IPv4 Address

■ IPv6 Address

■Port♦

Description Set the IPv4 address for syslog server.

Settings 1.0.0.1-223.255.255.254 or hostname(1-64 alphanumeric characters)

Default values -

Description Set the IPv6 address for syslog server.

Settings ::FF:0-FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname(1-64 alphanumeric 
characters)

Default values -

Description Set the port number of syslog server.

Settings 1-65535

Default values 514

Move row
Up to 50 station number rows can be displayed at a time. Switch the display as follows.
[Previous]: Display the previous 50 rows.
[Next]: Display the next 50 rows.
[Display]: Enter the station number and click [Display] to move the cursor to the entered row.
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Important

• Depending on the language settings of the station (IX-MV7-*or IX-MV), the content of the settings may differ from this manual.

• The symbols indicate the following:
♦: Indicates a required field. A value should be entered. Retain the default settings, unless a change is necessary.
♠:The content of the settings item can be copied to other stations. For how to copy, refer to “Copy settings (Settings (Station 
View)) (→page 83)” .
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1. Station Information

1.1 Identification

Configure the station number, station name, and location of the station to register in the system. Up to 500 stations 
can be registered.

■Number♦

■Name

■Location (except IXW-MA)

Important

• Always configure “Language (→page 158)” before setting "Identification."

• Enter the language configured in “Language (→page 158)”. However, if the language displayed on the screen for IX-MV7-* or 
IX-MV (configured on the station main unit) is different from that set in “Language (→page 158)”, the characters on the station 
screen may appear incorrectly. To avoid this, enter information in the setting data using alphabetical characters only.

• Results when searching by station will be listed in order of station number.

Description Set an unique number for each station. 
The station number will be displayed on the  screen of the destination during call, page, etc.
This is also used to search stations by station number for IX-MV7-* and IX-MV.

Settings 3-5 digits

Default values Start from 0001.

Description Set the station name.
The station name will be displayed on the  screen of the destination during call, page, etc. This is 
also used to search stations by station name for IX-MV7-* and IX-MV. 

Settings 1-24 alphanumeric characters

Default values IX-MV7-*, IX-MV: Master Station (Number); IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*): Video Station 
(Number); IX-SSA(-*), IX-SS-2G, IX-BA, IX-SS(-*): Audio Station (Number); IX-RS-*: Handset 
Sub Station (Number);IXW-MA: I/O Adaptor (Number)

Remarks If left blank, station name will be the same as station number.

Description Select the Location of the station.
The location will be displayed on the  screen of the destination during call, page, etc.

Settings Select one from the Location registered in “Location (for IX-MV7-* and IX-MV) (→page 406)”.

Default values -
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1.2 ID and Password

Set the ID and password for logging in via a web browser, and the ID and password for ONVIF/RTSP authentication.

■Administrator ID♦♠

■Administrator Password♦♠

■User ID♦♠

■User Password♦♠

■ONVIF ID (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))♦♠

Description Set the ID of the administrator account for logging in to the Web System Setting Server.
For IX-MV7-*, configure the administrator ID used to access the station's Settings screen.

Settings 1-32 alphanumeric characters

Default values admin

Description Set the Password of the administrator account for logging in to the Web System Setting Server.
For IX-MV7-*, configure the administrator password used to access the station's Settings screen.

Settings 1-32 alphanumeric characters

Default values admin

Description Set the ID of the user account for logging in to the Web System Setting Server.

Settings 1-32 alphanumeric characters

Default values user

Description Set the Password of the user account for logging in to the Web System Setting Server.

Settings 1-32 alphanumeric characters

Default values user

Description Set the ID to access this station from 3rd party products using ONVIF.
The settings of IX-DA, IX-DF(-*) cannot be changed from their default values. (They are not 
shown in the Settings screen.)

Settings 1-32 alphanumeric characters

Default values aiphone



377

System Settings (Station View)

■ONVIF Password (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))♦♠

■RTSP ID (for IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-*)♦♠

■RTSP Password  (for IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-*)♦♠

Description Set the Password to access this station from 3rd party products using ONVIF.
The settings of IX-DA, IX-DF(-*) cannot be changed from their default values. (They are not 
shown in the Settings screen.)

Settings 1-32 alphanumeric characters

Default values aiphone

Description Set the ID to access this station from 3rd party products using RTSP.

Settings 1-32 alphanumeric characters

Default values aiphone

Description Set the Password to access this station from 3rd party products using RTSP.

Settings 1-32 alphanumeric characters

Default values aiphone

Note

• The "Administrator ID" and "User ID" cannot be identical.

• The ONVIF port number is "10080" and the RTSP port number is "554."

• To view video from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) using a 3rd party product, refer to “Using a 3rd party product to monitor 
video/audio from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) (→page 397)”.

• The ONVIF ID and ONVIF Password of IX-DA, IX-DF(-*) can be changed on a 3rd party product. If changed on a 3rd party 
product, the Settings screen will not show the changed content.

• The "Administrator Password," "User Password," "ONVIF Password," and "RTSP Password " are displayed as "*****" on the 
screen.
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1.3 Time

Set the date and time for each station.

1.3.1 Time Zone

■Select time zone♠

1.3.2 Daylight Savings Time

■Enable automatic daylight savings time♠

1.3.3 Date and Time

Enter the time for each station. Time is used for incoming calls, outgoing calls, and the system log.

Description Set the Time Zone.

Settings Select from 99 regions

Default values When a new system is createdthe the following settings will be set to these defaults depending 
on the language selected.
Japanese: (GMT+09:00) Osaka, Sapporo, Tokyo
English: (GMT-08:00) Pacific Standard Time (US), Tijuana
French: (GMT+01:00) Brussels, Madrid, Copenhagen, Paris
Spanish: (GMT+01:00) Brussels, Madrid, Copenhagen, Paris
Dutch: (GMT+01:00) Amsterdam, Berlin, Bern, Rome, Stockholm
Traditional Chinese: (GMT+08:00) Taipei
Simplified Chinese: (GMT+08:00) Beijing, Chongqing, Hong Kong, Urumqi

Description The daylight saving time is set automatically according by region selected in "Select Time Zone".

Settings • Yes
• No

Default values No

Important

• The time cannot be set unless the “Association Settings (→page 160)” is performed and the PC is connected to the same 
network as the station.
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How to configure the date and time

1. Select "Year," "Month," "Day," "Hour," "Minute," and "Second."
• Click [Sync with PC] to synchronize with PC.

2. Click [Apply].
• If "Association Settings" has not been configured, the following screen will be shown.

Click [OK] and use “Association Settings (→page 160)”.

• If the PC cannot communicate with the system, the following screen will be shown.
Click [OK], and then ensure the PC can communicate with the system.

3. Click [OK].
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1.4 Expanded System

Description Not used.
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2. Network Settings

2.1 IP Address

Configure the hostname, IP address, subnet mask, and default gateway for each station.

■Hostname (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

■Static / DHCP♠

Important

• When a setting related to the IP address is updated on a station, it will restart. In some cases, it may take up to 10 minutes for 
the station to start up.

Description Set the Hostname for each station. Hostname can be viewed instead of IP address on “Address 
Book (for IX-MV7-* and IX-MV) (→page 406)” and “Called Stations (Door/Sub Stations) (except 
IX-MV7-*, IX-MV, and IXW-MA) (→page 419)”(Use Hostname to call another stations.).

Go to “DNS (→page 384)” to set Hostname.

Settings 1-64 alphanumeric characters

Default values -

Note

• Communication from IX Support Tool to the stations use the IP address.

Description Select Static or DHCP for the selected IP version.

Settings For IPv4
• Static
• DHCP

For IPv6
• Static
• Stateless
• DHCPv6

Default values • Static
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2.1.1 IPv4 Address

■ IP Address♦

■Subnet Mask♦♠

■Default Gateway♠

2.1.2 IPv6 Address

■ IP Address♦

Important

• IPv4 and IPv6 cannot be mixed in the same system.

• When selecting "DHCP" for IPv4, configure the system so that the DHCP server assigns a Static IP Address to each station.

• When selecting "Stateless" for IPv6, do not change the prefix of the device so that it can transmit RA.

• When selecting "DHCPv6" for IPv6, configure the system so that the DHCP server assigns a Static IP Address to each station. 
DUID of the station is "00030001 + MAC address."

• When setting up a product from another manufacturer, such as a DHCP server, refer to its manual.

Important

• If “Static / DHCP♠ (→page 381)” was set to "DHCP," settings will not be applied to the station if the "IP Address," "Subnet 
Mask," and "Default Gateway" are entered.

Description Set the IP Address.
The IP Address should be unique.

Settings 1.0.0.1 - 223.255.255.254

Default values -

Description Set the Subnet Mask.

Settings 128.0.0.0 - 255.255.255.255

Default values -

Description Set the Default Gateway.

Settings 1.0.0.1 - 223.255.255.254

Default values -

Important

• If “Static / DHCP♠ (→page 381)” is set to "Stateless" or "DHCPv6," settings will not be applied to the station even if the "IP 
Address" and "Default Gateway" settings are input.

Description Set the IP Address.
The IP Address should be unique.

Settings 2000::0 - 3FFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or FD00::0 - 
FDFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -
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■Default Gateway♠
Description Set the Default Gateway.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -
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2.2 DNS

When IPv4 or IPv6 is configured by Hostname for each item, or when using the email function configured in “Email 
(→page 463)” for IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*), a DNS server must be configured for name 
resolution.

2.2.1 Primary Server♠

■ IPv4

■ IPv6

2.2.2 Secondary Server♠

■ IPv4

■ IPv6

Description Set the IPv4 address for DNS Primary Server.

Settings 1.0.0.1 - 223.255.255.254

Default values -

Description Set the IPv6 address for DNS Primary Server.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -

Description Set the IPv4 address for DNS Secondary Server.

Settings 1.0.0.1 - 223.255.255.254

Default values -

Description Set the IPv6 address for DNS Secondary Server.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -
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2.3 SIP (except IXW-MA)

Configure SIP settings.

2.3.1 SIP Connections

■SIP Signaling Port♦♠

■User Agent (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

2.3.2 SIP Server (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Configure integration with 3rd party SIP based PBX systems. Please contact your local Aiphone distribution for more 
information.

Description Set the Port Number for SIP.
Set the same port number for each station to communicate.

Settings 1 - 65535

Default values 5060

Description Set the User Agent.

Settings 1-36 alphanumeric characters

Default values ̶
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2.3.2.1 Primary Server

■ ID♠

■Password♠

■ IPv4 Address♠

■ IPv6 Address♠

■Port♦♠

2.3.2.2 Secondary Server

■ ID♠

■Password♠

Description Configure the user ID for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Description Configure the user password for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Note

• The "Password" is displayed as "*****" in the Settings screen.

Description Set the IPv4 address for SIP Primary Server. Go to “DNS (→page 384)” to set Hostname.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -

Description Set the IPv6 address for SIP Primary Server. Go to “DNS (→page 384)” to set Hostname.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -

Description Set the Port Number for SIP Primary Server.

Settings 1 - 65535

Default values 5060

Description Configure the user ID for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Description Configure the user password for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -
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■ IPv4 Address♠

■ IPv6 Address♠

■Port♦♠

2.3.2.3 Tertiary Server

■ ID♠

■Password♠

■ IPv4 Address♠

■ IPv6 Address♠

Note

• The "Password" is displayed as "*****" in the Settings screen.

Description Set the IPv4 address for SIP Secondary Server. Go to “DNS (→page 384)” to set Hostname.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -

Description Set the IPv6 address for SIP Secondary Server. Go to “DNS (→page 384)” to set Hostname.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -

Description Set the Port Number for SIP Secondary Server.

Settings 1-65535

Default values 5060

Description Configure the user ID for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Description Configure the user password for digest authentication with SIP server.

Settings 1-24 alphanumeric characters

Default values -

Note

• The "Password" is displayed as "*****" in the Settings screen.

Description Set the IPv4 address for SIP Tertiary Server. Go to “DNS (→page 384)” to set Hostname.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -

Description Set the IPv6 address for SIP Tertiary Server. Go to “DNS (→page 384)” to set Hostname.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -
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■Port♦♠

2.3.3 Miscellaneous

■Register Transmission Interval [sec] (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-
SS(-*))♦ ♠

■DTMF digit interval timeout [sec] (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*)) 
♦ ♠

■Call health check timer♦♠

Description Set the Port Number for SIP Tertiary Server.

Settings 1-65535

Default values 5060

Description Set the Transmission Interval to send Regist to SIP server.

Settings 10 - 14400sec

Default values 3600 sec

Description Configure the time to timeout signal reception, when a DTMF signal is not received from the 
VoIP Phone for a continuous period of time.

Settings 1 - 10sec

Default values 5 sec

Important

• Configure the IP-PBX and VoIP Phone DTMF with outbound.

Description Set the timer to transmit re-INVITE while calling and monitoring.

Settings • Do not transmit re-INVITE: Do not detect communication errors.
• 80-3600 sec: Select to set between 80-3600 sec (by 1 sec).

Default values 90 sec
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2.4 Multicast Address (for IX-MV7-*, IX-MV, IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

This must be configured if multicast is enabled in “Group (for Master) (for IX-MV7-* and IX-MV) (→page 414)”, “All 

Page (for IX-MV7-* and IX-MV) (→page 452)”, and “Called Stations (Door/Sub Stations) (except IX-MV7-*, IX-MV, 
and IXW-MA) (→page 419)”.

for IX-MV7-* and IX-MV

for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)

■For Call / Paging (for IX-MV7-* and IX-MV)

■For Call (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

Note

• A multicast address must be configured to utilize All Page.

Description Set the IPv4 or IPv6 Multicast Address. The Multicast Address should be unique.

Settings [IPv4]: 224.0.0.0 - 239.255.255.255
[IPv6]: FF10::0 - FF1F:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -

Description Set the IPv4 or IPv6 Multicast Address. The Multicast Address should be unique.

Settings [IPv4]: 224.0.0.0 - 239.255.255.255
[IPv6]: FF10::0 - FF1F:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -
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2.5 Video (for IX-MV7-*, IX-MV, IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

Configure video settings.

2.5.1 Video Encoder 1

Configure video settings when placing a call between stations, during communication, or when calling a VoIP phone. 
Configure video settings for IX-MV7-* in “Master Station Video Setting (for IX-MV7-*) (→page 395)”.

■Video Codec (for IX-DA, IX-DF(-*))♠
Description Select Video Codec.

Settings • H.264 / AVC
• Motion-JPEG

Default values H.264 / AVC
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■Resolution (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♠

■Frame Rate [fps] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♠

■Select Profile [H.264 / AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■ I-picture interval [H.264/AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♦

■Bit rate [kbps] [H.264 / AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♠

Note

• For IX-DV, IX-DVF(-*), "Video Codec" is set to "H.264 / AVC" and cannot be changed.

Description Select the video resolution of Video Encoder 1.

Settings • 320×240 (QVGA)
• 640×480 (VGA)

Default values IX-DV, IX-DVF(-*): 640×480 (VGA)
IX-DA, IX-DF(-*): 320×240 (QVGA)

Description Set the Frame Rate [fps] of Video Encoder 1.

Settings 1, 2 (for IX-DV, IX-DVF(-*)), 3, 5, 7.5, 10, 15, 20, 30 fps
For IX-DA and IX-DF(-*), when the frame rate is set to 7.5, 10, 15, 20 or 30 fps, the frame Rate 
will be 5 fps after approx. 10 min of an outgoing call.

Default values 15 fps

Note

• The frame rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.

Description Select the H.264/AVC Profile of Video Encoder 1.

Settings • Baseline
• Main
• High

Default values Main

Description Set the interval to send H.264/AVC I-picture of Video Encoder 1.

Settings 1 - 100

Default values 15

Description Set the H.264/AVC Bit Rate of Video Encoder 1.

Settings 32 (for IX-DV, IX-DVF(-*)), 64, 128, 256, 384, 512, 768, 1024, 2048 kbps

Default values 1024 kbps

Note

• The bit rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.
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■Select Quality [Motion-JPEG] (for IX-DA, IX-DF(-*))♠

■RTP Start Port♦

■RTP End Port♦

Description Select the Quality of Motion-JPEG of Video Encoder 1.

Settings 1 (low) - 10 (high)

Default values 6

Description Set the range of port numbers to transmit and receive RTP for Video Encoder 1.
Set the difference to 90 or greater in the range of (RTP Start Port) - (RTP End Port).

Settings 1 - 65534

Default values 30000

Description Set the range of port numbers to transmit and receive RTP for Video Encoder 1.
Set the difference to 90 or greater in the range of (RTP Start Port) - (RTP End Port).

Settings 1 - 65535

Default values 31000
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2.5.2 Video Encoder 2

Set when transmitting video using ONVIF.
To view video from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) with a 3rd party product, refer to “Using a 3rd party product to 
monitor video/audio from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) (→page 397)”.

■Second Video Encoder (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♠

■Video Codec (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♠

■Resolution (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♠

■Frame Rate [fps] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♠

Important

• These settings may be changed by ONVIF-compliant 3rd party products, if utilized. Refer to the manual of the 3rd party 
product to be used.

Description Select Enable / Disable for Second Video Encoder.
Set to "Enable" to send the video using ONVIF.

Settings • Enable
• Disable

Default values Enable

Description Select the Video Codec of Video Encoder 2..

Settings • H.264 / AVC
• Motion-JPEG

Default values H.264 / AVC

Description Select the video resolution of Video Encoder 2.

Settings • 320x240(QVGA)
• 640x480(VGA)
• 800x480(WVGA) (For IX-DV, IX-DVF(-*))
• 1280x720(HD) (For IX-DV, IX-DVF(-*))
• 1280x960(SXVGA) (For IX-DV, IX-DVF(-*))

Default values IX-DV, IX-DVF(-*): 1280x720(HD)
IX-DA, IX-DF(-*): 320x240(QVGA)

Description Set the Frame Rate [fps] of Video Encoder 2.

Settings 1, 2 (for IX-DV, IX-DVF(-*)), 3, 5, 7.5, 10, 15, 20, 30 fps
For IX-DA and IX-DF(-*), when the frame rate is set to 7.5, 10, 15, 20 or 30 fps, the frame Rate 
will be 5 fps after approx. 10 min of an outgoing call.

Default values IX-DV, IX-DVF(-*): 10 fps
IX-DA, IX-DF(-*): 15 fps

Note

• The frame rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.
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■Select Profile [H.264 / AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■ I-picture interval [H.264/AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♦

■Bit rate [kbps] [H.264 / AVC] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♠

■Select Quality [Motion-JPEG] (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♠

■RTP Start Port♦

■RTP End Port♦

Description Select the H.264/AVC Profile of Video Encoder 2.

Settings • Baseline
• Main
• High

Default values Main

Description Set the interval to send H.264/AVC I-picture of Video Encoder 2.

Settings 1 - 100

Default values IX-DV, IX-DVF(-*): 10
IX-DA, IX-DF(-*): 15

Description Set the H.264/AVC Bit Rate of Video Encoder 2.

Settings 32 (for IX-DV, IX-DVF(-*)), 64, 128, 256, 384, 512, 768, 1024, 2048, 4096 (for IX-DV, IX-DVF(-
*)), 8192 (for IX-DV, IX-DVF(-*)) kbps

Default values IX-DV, IX-DVF(-*): 2048 kbps
IX-DA, IX-DF(-*): 1024 kbps

Note

• The bit rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.

Description Select the Quality of Motion-JPEG of Video Encoder 2.

Settings 1 (low) - 10 (high)

Default values 6

Description Set the range of port numbers to transmit and receive RTP for Video Encoder 2.
Set the difference to 10 or greater in the range of (RTP Start Port) - (RTP End Port).

Settings 1 - 65534

Default values 32000

Description Set the range of port numbers to transmit and receive RTP for Video Encoder 2.
Set the difference to 10 or greater in the range of (RTP Start Port) - (RTP End Port).

Settings 1 - 65535

Default values 33000
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2.5.3 Master Station Video Setting (for IX-MV7-*)

Configure video settings for the IX-MV7-* camera.

■Video Streaming

■Frame Rate [fps]♠

■Select Profile

■ I-picture interval♦

■Bit rate [kbps]♠

Important

• When sending video to an VoIP Phone, configure to the same video settings as the VoIP Phone.

• Video is not sent when making an outgoing call to a VoIP Phone.

Description Select Enable / Disable for Video Streaming of IX-MV7-*. Video cannot be distributed to 3rd 
party products not compatible with ONVIF or to IX-MV. The Video Codec is H.264 / AVC.

Settings • Enable
• Disable

Default values Enable

Description Set the Frame Rate [fps].

Settings 0.5, 1, 2, 3, 5, 7.5, 10, 15, 20, 30 fps

Default values 15 fps

Note

• The frame rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.

Description Set the profile for Video Streaming.

Settings • Baseline
• Main
• High

Default values Main

Description Select the interval to send I-picture for Video Streaming.

Settings 1 - 100

Default values 15

Description Select the bit rate [kbps].

Settings 32, 64, 128, 256, 384, 512, 768, 1024, 2048 kbps

Default values 1024 kbps
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Note

• The bit rate may be lower than the set value depending on the video being sent, the number of recipient stations, and the 
network environment.
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2.5.4 Using a 3rd party product to monitor video/audio from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)

IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) support ONVIF Profile S and RTSP.
Video and audio of IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) can be monitored on a 3rd party product.

Configuring IX-DV, IX-DVF(-*), and IX-DA so that video can be viewed on a 3rd party product.

1. Select "Enable" for “Second Video Encoder (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) ♠ 
(→page 393)”.

2. Configure video and audio settings.
• Configure video to “Video Encoder 2 (→page 393)”, and audio to “Audio 2 RTP Start Port♦ (→page 400)” 

and “Audio 2 RTP End Port♦ (→page 400)”.

3. Register IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) with a third party product. Enter the following as 
necessary.
• For IX-DV, IX-DVF(-*)

– ONVIF ID: Configure in “ONVIF Password (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))♦♠ (→page 377)”.
– ONVIF Password: Configure in “RTSP Password  (for IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-

*)♦♠ (→page 377)”.
– ONVIF communication port number: 10080
– RTSP ID: Configure in “RTSP ID (for IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-*)♦♠ (→page 377)”.
– RTSP Password : Configure in “RTSP Password  (for IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-*)♦♠ 

(→page 377)”.
– RTSP communication port number: 554

• For IX-DA, IX-DF(-*)
– ONVIF ID: aiphone
– ONVIF Password: aiphone
– ONVIF communication port number: 10080
– RTSP ID: aiphone
– RTSP Password : aiphone
– RTSP communication port number: 554

• For how to register, refer to the instruction manual of the product to be registered.

Important

• Video from IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*) camera cannot be viewed simultaneously by more than two 3rd party products.

• Audio will not be distributed if “Audio Codec♠ (→page 398)”is set to "G.722."

Important

• Configure “Video Encoder 2 (→page 393)” according to the specification of the product.

Important

• "ONVIF ID" and "ONVIF Password" can be changed on the third party product.

• If changed on a third party product, IX-DA, IX-DF(-*) will not show the changed content on IX Support Tool.
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2.6 Audio (except IXW-MA)

Configure the settings for audio.

■Audio Codec♠
Description Select the Audio Codec.

Settings • G.711 (μ-Law)
• G.711 (A-Law)
• G.722 (except IX-MV, IX-DA, IX-DF(-*), IX-BA and IX-SS(-*))

Default values G.711 (μ-Law)
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■Audio RTP Transmission Interval [msec]♠

Important

• When changing from "G.711" to "G.722" or from "G.722" to "G.711," the station will restart when the change is applied. In 
some cases, it may take around 10 minutes to restart the station.

• Stations with different audio codecs (G.711 and G.722) selected cannot ring, call, monitor, or page each other.

• When changing "G.711" to "G.722" and "G.722" to "G.711," change the custom tones used for the following subcategories to 
audio files with appropriate audio sample rates.“Custom Sound Registry (except IXW-MA) (→page 416)”

– "Call Origination" - “Ringback Tone (except IX-MV) ♠ (→page 423)”

– "Call Origination" - “Busy Tone (except IX-MV)♠ (→page 429)”

– "Call Origination" - “Error Tone (Call Failed) (except IX-MV7-* and IX-MV)♠ (→page 430)”

– "Incoming Call" - “Ringtone (except IX-MV7-*, IX-MV)♠ (→page 432)”

– "Incoming Call" - “Call Button (for IX-MV7-* and IX-MV) (→page 433)”

– "Incoming Call" - “Option Input (for IX-MV7-* and IX-MV) (→page 434)”

– "Relay Output" - “Door Release (→page 445)”

– "Relay Output" - “Relay Control (start) (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*)) (→page 445)”

– "Relay Output" - “Relay Control (end) (except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*)) (→page 446)”

– "Option Input Page" - “Message File Name (→page 454)”

– "Network Camera Integration" - “Event Tone (for IX-MV7-*) (→page 459)”

– "Network Camera Integration" - “Event Tone (for IX-MV)♠ (→page 460)”

– "Paging Settings" - “Paging Pretone (→page 461)”

– "Communication Audio Messages" - "Start Communication" - “Message (→page 489)”

– "Communication Audio Messages" - "Code Received" - “Message (→page 490)”

– "Chime" - "Weekly Schedule" - “Chime (→page 492)”

– "Chime" - "Daily Schedule" - “Chime (→page 494)”

– "Speed Dials / Favorites" - "How to configure group message paging" - “Message (→page 522)”

– "Speed Dials / Favorites" - "How to configure all message paging" - “Message (→page 523)”

– "Volume / Tone" - “Communication Timeout Notification (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠ 
(→page 529)”

– "Volume / Tone" - “Communication End Pretone (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠ (→page 530)”

– "Volume / Tone" - “Call Queue Notification (for IX-MV7-*)♠ (→page 530)”

– "Volume / Tone" - “Paging Pretone (for IX-MV7-* and IX-MV) ♠ (→page 531)”

– "Volume / Tone" - “Auto Answer Tone (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠ (→page 531)”

– "Volume / Tone" - “On Hold (for IX-MV7-*)♠ (→page 532)”

– "Volume / Tone" - “Key Received (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))♠ (→page 532)”

– "Volume / Tone" - “Error (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠ (→page 533)”

– "Communication" - “Communication Start Tone (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠ 
(→page 535)”

– "Monitor" - “Monitored Notification (except IX-MV7-* and IX-MV) ♠ (→page 537)”

Description Set the Audio RTP Transmission Interval. This setting is ignored when transmitting to multiple 
stations (paging, etc.)

Settings 20, 40, 60, 80, 100 msec

Default values 20 msec
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■RTP Idle Detection Time [sec]♦♠

■Audio 1 RTP Start Port♦

■Audio 1 RTP End Port♦

■Audio 2 RTP Start Port♦

■Audio 2 RTP End Port♦

Description Set the time to detect RTP idle state for Audio.
When Audio RTP is not received during communication, monitoring, or receiving a page, 
connection will be disconnected after the set time.

Settings 10 - 180 sec (by 1 sec)

Default values 10 sec

Description Set the range of port numbers to transmit and receive Audio RTP,  such as communication 
between IX systems.
Set the difference to 210 or greater in the range of (Audio 1 RTP Start Port) - (Audio 1 RTP End 
Port).

Settings 1 - 65534

Default values 20000

Description Set the range of port numbers to transmit and receive Audio RTP,  such as communication 
between IX systems.
Set the difference to 210 or greater in the range of (Audio 1 RTP Start Port) - (Audio 1 RTP End 
Port).

Settings 1 - 65535

Default values 21000

Description Set the range of port numbers to transmit and receive Audio RTP using ONVIF.
Set the difference to 10 or greater in the range of (Audio 2 RTP Start Port) - (Audio 2 RTP End 
Port).

Settings 1 - 65534

Default values 22000

Description Set the range of port numbers to transmit and receive Audio RTP using ONVIF.
Set the difference to 10 or greater in the range of (Audio 2 RTP Start Port) - (Audio 2 RTP End 
Port).

Settings 1 - 65535

Default values 23000
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2.6.1 Audio Buffer

■Packets Buffered at Audio Start♠

■Maximum Packets Buffered

Description Set the number of packets to accumulate before playing audio.

Settings 0 - 4

Default values 1

Description Set the maximum number of packets that can be accumulated.
If a packet is received beyond the set value, it is removed from the oldest packet.
It should be greater than the number of “Packets Buffered at Audio Start♠ (→page 401)”.

Settings 2 - 10

Default values 3
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2.7 Packet Priority

Configure the Packet Priority and VLAN for video, audio, and SIP packets.

■TOS Value (Audio) (except IXW-MA)♦ ♠

■TOS Value (Video) (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))♦ ♠

■TOS Value (SIP) (except IXW-MA)♦ ♠

■VLAN Setting♠

Important

• When a setting related to VLAN is updated at a station, it will restart. In some cases, it may take around 10 minutes for the 
station to start up.

Description Set the Packet Priority (TOS Value) for Audio.

Settings 0x00 - 0xFF

Default values 0x00

Description Set the Packet Priority (TOS Value) for Video.

Settings 0x00 - 0xFF

Default values 0x00

Description Set the Packet Priority (TOS Value) for SIP.

Settings 0x00 - 0xFF

Default values 0x00

Description Select Enable / Disable for tagged VLAN.

Settings • Disable
• Enable

Default values Disable

Important

• When "VLAN Setting" is set to "Enable" and the configuration is applied to the station, ensure that the station cannot 
communicate with switches, PCs, and stations not configured on the VLAN.
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■VLAN ID♦♠

■VLAN Priority♠

Description Set the VLAN ID.

Settings 1 - 4094

Default values 1

Description Set the VLAN priority.

Settings 0 (low) - 7 (high)

Default values 0
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2.8 NTP

2.8.1 Enable NTP♠

2.8.2 Synchronization Interval [hour]♦ ♠

2.8.3 Primary Server

2.8.3.1 Address♠

■ IPv4

Description Select Yes / No Use to synchronize the time with an NTP server. If this is set to "Yes," be sure to 
configure the other items in “NTP (→page 404)”.

Settings • Yes
• No Use

Default values No Use

Description Set the interval to synchronize with the NTP server.

Settings 1-255 hours (1 hour units)

Default values 24 hours

Description Set the IPv4 address for NTP Primary Server. Go to “DNS (→page 384)” to set  hostname.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -
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■ IPv6

2.8.3.2 Port♦ ♠

2.8.4 Secondary Server

2.8.4.1 Address♠

■ IPv4

■ IPv6

2.8.4.2 Port♦ ♠

Description Set the IPv6 address for NTP Primary Server. Go to “DNS (→page 384)” to set hostname.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -

Description Set the port number for NTP.

Settings 1 - 65535

Default values 123

Description Set the IPv4 address for NTP Secondary Server. Go to “DNS (→page 384)” to set hostname.

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -

Description Set the IPv6 address for NTP Secondary Server. Go to “DNS (→page 384)” to set hostname.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -

Description Set the port number for NTP.

Settings 1 - 65535

Default values 123
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3. System Information

3.1 Location (for IX-MV7-* and IX-MV)

Register a location.
For how to register a location, refer to “Register location (except IXW-MA) (→page 174)”.

3.2 Address Book (for IX-MV7-* and IX-MV)

Configure the IX-MV7-* and IX-MV Address Book.
Calling, paging, monitoring, line monitoring, and malfunction monitoring can be performed for any station registered in 
the Address Book. Network cameras can be monitored and outgoing calls can be made to VoIP phones.

3.2.1 Station List

Register the stations in the Address Book.

Important

• Always configure “Language (→page 158)” before setting "Address Book."

• Enter the language configured in “Language (→page 158)”. However, if the language displayed on the screen for IX-MV7-* or 
IX-MV is different from that set in “Language (→page 158)”, the characters on the station screen may appear incorrectly. To 
avoid this, enter information in the setting data using alphabetical characters only.

Details on VoIP phones registered in “VoIP Phone Registration (→page 408)” will be shown.

List of stations that can be registered to the Address Book

2

3

1VoIP Phone 
Registration(
→page 408)
Register the 
VoIP phone in 
the Address 
Book.
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How to create Station List

1. VoIP phones are registered in “VoIP Phone Registration (→page 421)”.

2. Identify the station to be registered in the Address Book using "List of stations that can be registered 
to the Address Book," and then configure "Select."
• Register stations in which "✔" has been selected to the Address Book. For IX stations, stations for which 

"SIP" was selected will be registered in the Address Book as VoIP phones.
By default, "✔ (register)" is set for all.

Click "Network Camera" (IX-MV7-* only) - [Network camera selection] to select the network camera to 
associate. Network cameras configured in “Network Camera List (→page 409)” can be selected. The number 
of the selected network camera will be displayed.
If a network camera is associated with a station, the video from the network camera will be displayed when 
placing a call, during a communication, or when monitoring.

3. When done, click [Update].

4. Click [OK].

Important

• Stations where “IP Address (→page 381)” is not configured cannot be registered to the Address Book.

• To access stations registered to the Address Book by hostname, configure "IP Address" - “Hostname (except IX-MV, IX-DA, 
IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 381)” and “DNS (→page 384)”.

• Results when searching by station will be listed in order of station number.
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3.2.1.1 VoIP Phone Registration

Register the VoIP phone to the Address Book. When registering a VoIP phone, be sure to also configure “SIP (except 
IXW-MA) (→page 385)”.
On the "Address Book" screen, click [VoIP Phone Registration]. The following window will be shown.

How to perform VoIP Phone Registration

1. In the "Station List," enter the "Number♦," "Name," and "Location."
• Number: 3-32 digits
• Name: 1-24 alphanumeric characters
• Location: Select a location registered in “Register location (except IXW-MA) (→page 174)”.

2. Click [Update].
• Click [Cancel] to close the "VoIP Phone Registration" screen without registering a VoIP Phone.
• The registered VoIP Phone is displayed on the Station List.

1

2

“Register location (except IXW-MA) (→page 174)”
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3.2.2 Network Camera List

IX-MV7-* and IX-MV support the ONVIF interface standard "ONVIF profile S."
Video and audio of 3rd party network camera can be monitored on the IX-MV7-*, IX-MV screen.
Register the network camera in the Address Book.
Up to 500 network cameras can be registered.
Configure “Network Camera Integration (for IX-MV7-* and IX-MV) (→page 456)” to configure event notification-
related settings for the network camera.

How to create Network Camera List

1. Register the network camera in “Network Camera Registry (→page 412)”.

2. Identify the network camera to be registered in the Address Book using "List of network cameras that 
can be registered to the Address Book." 

3. Click the cells ("Select," "PTZ Operation," and "Audio Monitoring) that correspond to Steps 2.
• Select: Register network cameras with "✔" selected to the Address Book.

All items are "blank (unregistered)" by default.

■Camera Name♦
Description Set the Network Camera Name.

Settings 1-24 alphanumeric characters

Default values -

“Network Camera Registry (→page 412)”

List of network cameras that can be registered to 
the Address Book

If no network camera is registered, this will not be 
shown.

Click [Delete]. The network camera will be deleted.



410

System Settings (Station View)

■Hostname

■ IP Address (IPv4)

■ IP Address (IPv6)

■ ID♦

■Password♦

■PTZ Operation

Description Set the hostname.
Go to “DNS (→page 384)” to set Hostname.

Settings 1-64 alphanumeric characters

Default values -

Description Set the IPv4 address for Network camera.

Settings 1.0.0.1 - 223.255.255.254

Default values -

Description Set the IPv6 address for Network camera.

Settings ::FF:0-FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

Default values -

Description Enter ID of the network camera.

Settings 1-32 alphanumeric characters

Default values -

Description Enter Password of the network camera.

Settings 1-32 alphanumeric characters

Default values -

Note

• "Password" is displayed as "*****" in the Settings screen.

Description Configure whether to allow network camera PTZ operation from the station.

Settings • Enable
• Disable

Default values • Enable
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■Audio Monitoring

4. When done, click [Update].

5. Click [OK].

Description Configure whether to allow monitoring of network camera audio from the station.

Settings • Enable
• Disable

Default values • Enable

Note

• "Allow PTZ" and "Audio Monitoring" are set to "Enable" for IX-MV and cannot be changed.
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3.2.2.1 Network Camera Registry

Registration cannot be performed if the PC is not connected to the same network as the network camera.
Click [Network Camera Selection] to search a network camera. (Searching may take several minutes.)
When searching is done, the network cameras connected in the network will be shown in the "Network Camera 
Search List."

Important

• Network camera registration is configured via “Association Settings (→page 160)” on at least one IX-MV7-* or IX-MV station, 
and cannot be configured if the PC cannot communicate with the system (this is because, when registering a network camera, 
the network camera is searched through IX-MV7-* or IX-MV).

Note

• When searching on the station, the numbers will be displayed in the order they were registered.

1

2

3

4

5

If the video profile cannot be obtained, nothing will be shown.
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How to register a new network camera

1. To search by specifying an IP address, select "Manual Network Camera Configuration," and enter 
the "IP Address (hostname) ♦," "ID♦," and "Password ♦" of the network camera.

2. To select from the Network Camera Search List, select "Select from Network Camera Search List." 
Select the network camera(s) to register from the "Network Camera Search List" and then enter the 
"Hostname," "ID♦," and "Password♦."
• When entering the Hostname, configure “DNS (→page 384)”.
• To search again, click [Search]. It is also possible change the search time.

3. Click [Get Network Camera Information].
(Obtaining the video profile may take several minutes.)
• When video profiles are successfully obtained, they will be shown in "Network Camera Information."

4. Choose the video profile(s) to be registered from the list.

5. Click [Register] to register a network camera.

6. When done, click [Update].

7. Click [OK].
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3.3 Group (for Master) (for IX-MV7-* and IX-MV)

Configure the group for group calls, group pages, and contact input calls.
Up to 50 groups per station (50 stations per group) can be registered.
Stations other than IXW-MA can be registered to groups.

How to configure groups

1. Enter the following information in "Group Information."
• Group Number: 01 - 99

Group numbers must be unique.
• Group Name: 1 - 24 alphanumeric characters

2. Identify the station to be registered from the "List of stations that can be registered to group."

3. Search for the group for registering the station in Step 2.

Important

• Always configure “Language (→page 158)” before setting "Group (for Master)."

• Enter using the language configured in “Language (→page 158)”. However, if the language displayed on the screen for IX-
MV7-* or IX-MV is different from that set in “Language (→page 158)”, the characters on the station screen may appear 
incorrectly. To avoid this, enter information using alphabetical characters only.

• Only a single VoIP Phone can be registered to each group.

• All pages, groups pages, message pages, and external input pages cannot be sent to VoIP Phone.

• Stations “IP Address (→page 381)” has not been configured and that have not been registered in “Address Book (for IX-MV7-
* and IX-MV) (→page 406)” cannot be registered to groups.

• Groups calls and calls by Option Input cannot be made to IX-DA, IX-DF(-*), IX-BA, IX-SS(-*).

• Groups calls and calls by Option Input cannot be made from IX-MV to IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, IX-RS-*.

• Results when searching by station will be listed in order of group number.

Group 
Information

List of stations that can be registered to group

1

2

3

4
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4. Click the cells that correspond to Steps 2 and 3. Select an audio protocol and video protocol setting 
value for each, and register to a group.
The number of registered stations will be shown in "Total."
Audio Protocol
• Blank: Select to not register to a group.
• U: Belongs to group. Paging audio is transmitted in unicast.
• M: Belongs to group. Paging audio is transmitted in multicast.

Video Protocol (only when IX-MV7-* is both the station to configure and register)
• Blank: Video will be transmitted as multicast.
• U: Video will be transmitted as unicast during group calls. Unicast can be used to send video to up to 

20stations.
• M: Video will be transmitted as multicast during group calls.

The video protocol pull-down menu is shown when the audio protocol setting is selected.
All items are blank by default.

5. When done, click [Update].

6. Click [OK].

Important

• If "M" is selected or "blank" is selected for the video protocol, be sure to configure “Multicast Address (for IX-MV7-*, IX-MV, IX-
DV, IX-DVF(-*), IX-DA, IX-DF(-*)) (→page 389)”.

• For VoIP phones or stations in which "SIP" was selected in “Station List (→page 406)” “Called Stations (Door/Sub Stations) 
(except IX-MV7-*, IX-MV, and IXW-MA) (→page 419)”, "M" cannot be selected.

Note

• When making a group call, the audio protocol will be set to "U" and cannot be changed.
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3.4 Custom Sound Registry (except IXW-MA)

Register audio files to be used for ringback tones, ringtones, message paging, etc.
The numbers of audio files that can be registered to each station are as follows.

Sound file format
• File Type: .wav
• Sample Size: 16 bits
• Sample Rate: 8 kHz (if “Audio Codec♠ (→page 398)” is "G.711 (μ-Law)" or "G.711 (A-Law)"), 16 kHz (if “Audio 

Codec♠ (→page 398)” is "G.722")
• Channel: 1 (monaural)
• File Name: 1-82 alphanumeric characters (without file extensions)

For IX-MV7-*, search for audio files used for message paging by file name by entering either a letter or number as 
the first character.

Station Type Information that can be saved to the station

IX-MV7-* Max. 100 files (with 200 seconds and 8 Mbytes per file)

IX-MV Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-DA, IX-DF(-*) Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-DV, IX-DVF(-*) Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-SSA(-*) Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-SS-2G Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-BA, IX-SS(-*) Max. 100 files (total length of within 200 seconds and 8 Mbytes)

IX-RS-* Max. 100 files (total length of within 200 seconds and 8 Mbytes)

Note

• If using a file for a ringback tone, ringtone, or network camera event tone, add a period of silence in the .wav file if the tone is 
to be intermittent.

• Sample files of custom tones are provided on our website (https://www.aiphone.net/product/) for download and use as audio 
sources.

https://www.aiphone.net/product/
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How to register an audio file

1. Click [Browse] at the end of the row for the station in which the file is to be registered.

2. Select the audio file to register, and click [Open].

3. Information on the selected audio file will be shown.
• Name: Shows the file name of the audio file. Up to 24 alphanumeric characters will be shown.

The name will be shown as the setting value when configuring the ringback tone etc.
If the file name of the audio file exceeds the character limit above, it will only partially be shown.

• Browse for .wav file: The audio file reference destination is shown.

4. When done, click [Update].

5. Click [OK].

How to delete a custom tone

1. Check the [Delete] box of the audio file to delete.

2. Click [Update].

3. Click [OK].

Note

• "Name" can be deleted from the Settings screen by selecting “Upload Settings To Station (→page 145)” - "Sounds" to upload 
the setting file, and then deleting the audio file from the station.
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4. Call Settings

4.1 Station Information (for IX-RS-*, IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G)

Configure the call button function.

■Call Button Function

4.2 Called Stations (Master Stations) (for IX-MV7-* or IX-MV)

A call destination does not have to be set up. Any intercom station registered in “Station List (→page 406)” can be 
called.

Description Select the Call button Function when call button is pressed (for IX-RS-*: Call/Talk button).

Settings • Call: Outgoing call
• Call, Cancel Call, End Communication: Out going call, Cancel outgoing call, End 

Communication
• Call, Answer Call, End Communication: Outgoing call, Answer call or page, End 

communication

Default values Call

Note

• Contact input calls and communication switched from a contact input call cannot be ended by pressing the Call button (IX-RS-
*: Call/Talk button).
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4.3 Called Stations (Door/Sub Stations) (except IX-MV7-*, IX-MV, and IXW-MA)

Configure the group to call when a call is made using the call button or via contact input.
• Stations other than IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*): Up to 20 stations can be configured in a single group, 

and up to 10 groups can be configured.
• IX-DA, IX-DF(-*), IX-BA,IX-SS(-*),(for placing a call button call): Up to 20 stations can be configured in a single 

group, and only a single group can be configured.
• IX-DA, IX-DF(-*), IX-BA, IX-SS(-*) (for placing a contact input call): Up to 20 stations can be configured in a single 

group, and up to nine groups can be configured.
Any station other than IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), IXW-MA can be registered as a call recipient.

How to configure destinations (Door/Sub Stations)

1. Select the group to configure from "Group Number."
The Settings screen for the selected group will be displayed.
• Use the following groups when configuring IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*) destinations.

– Group used to place a call by operating this device/pressing the call button: "Group 10"
– Groups used to place a call by Option Input: "Group 01 - 09"

Important

• An IX-RS, IX-DA, IX-DF(-*) or IX-BA, IX-SS(-*) must be registered under Called Stations (Door/Sub Stations) to use Door 
Release while in communication with IX-DA, IX-DF(-*) or IX-BA, IX-SS(-*). An IX-RS cannot place a call to IX-DA, IX-DF(-*) or 
IX-BA, IX-SS(-*) even IX-DA, IX-DF(-*) or IX-BA, IX-SS(-*) is under Called Stations (Door/Sub Stations.)

Important

• Stations in which “IP Address (→page 381)” is not configured cannot be registered as destinations.

• If the station registered to the call destination is anything other than IX-MV7-* or IX-MV, one of the following must be 
configured to receive incoming calls.

– Set to "Call, Answer Call, End Communication" in “Call Button Function (→page 418)”.

– Configure "Option Input" - “Function (→page 437)” to "Answer Call / Page."

• Do not register the same station to a group more than once.

• Only one VoIP Phone can be registered to each group.

Group Number

1

2

VoIP Phone Registration(→page 421)
Register the VoIP phone as a call recipient.

Click to delete 
the 
registration.
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2. Select the settings and register the station to the group.
• For group number 01 for stations other than IX-DA, IX-DF(-*) or IX-BA, IX-SS(-*) and for group number 10 for 

IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*), Stations number 1 - 20 are registered beforehand in IX-MV7-* and IX-
MV will be set to "U" ahead of time.

3. When done, click [Update].

4. Click [OK].

■Number

■Protocol (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))

How to delete a call destination.

1. Click [Delete] for the desired station.

2. Click [Update].

3. Click [OK].

Description Configure the stations to be registered as a call destination (Number).
Enter Number directly, or click [Open] to choose a station.

Settings 3-32 digits

Default values -

Description Configure the protocol used for outgoing calls.

Settings • U: The station will be registered in the call destination. An outgoing call is transmitted as 
unicast.

• M: Station will be registered in the call destination. Video is transmitted as multicast for an 
outgoing call. This can be configured if the originating station is IX-DV, IX-DVF(-*), IX-DA, IX-
DF(-*) and the destination station is IX-MV7-*, IX-MV.

• SIP: Select this to call an IX station as a VoIP phone.

Default values U

Important

• If "M" is selected, be sure to configure “Multicast Address (for IX-MV7-*, IX-MV, IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) 
(→page 389)”.
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4.3.1 VoIP Phone Registration

Register the VoIP Phone in Called Stations (Door/Sub Stations). When registering a VoIP Phone, be sure to configure 
“SIP (except IXW-MA) (→page 385)”.
On the "Called Stations (Door/Sub Stations)" screen, click [VoIP Phone Registration]. The following window will be 
shown.

VoIP Phone registration

1. In the "Station List," enter the "Number♦," "Name," and "Location."
• Number: 3-32 digits
• Name: 1-24 alphanumeric characters
• Location: Select a location registered in “Register location (except IXW-MA) (→page 174)”.

2. Click [Update].
• Click [Cancel] to close the "VoIP Phone Registration" screen without registering a VoIP phone.

“Register location (except IXW-MA) (→page 174)”

1

2
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4.4 Call Origination (except IXW-MA)

Configure outgoing call settings.

4.4.1 Call Origination Advanced Settings

How to configure call destination advanced settings

1. Select the call method to configure in "Call Button / Option Input #."
• "Call Button (except IX-MV)": Displays settings related to outgoing calls linked that placed by the call button.
• Option Input 1 - 6: Displays settings related to outgoing calls when "Call" is selected for Option Input" - 

“Function (→page 437)”.                                                                                          
Setting for the selected call method will be displayed.

2. Configure the setting of each item.

3. When done, click [Update].

4. Click [OK].

■Call Method (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Description Select the Call Method to change call destinations automatically by time delay or schedule.

Settings • Standard Destination: Do not change call destination automatically.
IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*) are fixed to "Standard Destination" and cannot be 
changed.

• Change Destination by Time Delay: Change destination group from “Destination by Time 
Delay Settings (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*)) 
(→page 424)” after “Destination Dwell Time[sec] (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), 
and IX-BA, IX-SS(-*))♦ (→page 425)”. Up to 8 groups can be used.

• Change Destination by Schedule: Change destination group by “Schedule Settings (except IX-
MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 426)”.

Default values Standard Destination
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■Ringback Tone (except IX-MV) ♠

■Call Timeout (except "Call Button" - IX-MV)

Description Select the sound to be played by the station when placing a call. For IX-MV7-*, this will also 
sound when monitoring.

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*) IX-BA, IX-SS(-*))
• Pre Tone 1 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Call Button
• IX-MV7-*: Call Pattern 4
• Except IX-MV7-*: Call Pattern 1

Option Input 1
• IX-MV7-*: Call Pattern 4
• Except for IX-MV7-*: Call Pattern 2

Option Input 2
• IX-MV7-*: Call Pattern 4
• IX-DV, IX-DVF(-*), IX-SSA(-*): Call Pattern 3

Option Input 3
• IX-MV7-*: Call Pattern 4
• IX-DV, IX-DVF(-*), IX-SSA(-*): Call Pattern 4

Option Input 4
• IX-MV7-*: Call Pattern 4
• IX-DV, IX-DVF(-*), IX-SSA(-*): Call Pattern 5

Option Input 5
• IX-DV, IX-DVF(-*), IX-SSA(-*): Call Pattern 6

Option Input 6
• IX-DV, IX-DVF(-*), IX-SSA(-*): Tremolo Sound

Description Set the Call Timeout for outgoing call.

Settings • 10-600sec: Select to set between 10-600 sec (by 1 sec).
• Infinite: Keep calling until call is answered.

Default values 60sec

Note

• For "Call Button", the outgoing call time for IX-MV is set on the station.



424

System Settings (Station View)

■Ringback Tone Count [time(s)] (except "Call Button" IX-MV) ♠

■Call Destination ("Option Input 1 - 4" - for IX-MV7-* and IX-MV)

■Standard Mode Settings (except IX-MV7-* and IX-MV)

■Destination by Time Delay Settings (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-
SS(-*))

Description Set the play count of ringback tone for outgoing call.

Settings • 1 - 20 times
• Infinite: The ring back tone continues to play for the amount of time set in “Call Timeout 

(except "Call Button" - IX-MV) (→page 423)”.

Default values Infinite

Note

• For "Call Button", the ringtone count for IX-MV is set on the station.

Description Configure the call destination group and call priority.
Enter the group number directly, or click [Open] to select a group.

Settings • Call Destination: 01 - 99. Select from groups registered in “Group (for Master) (for IX-MV7-* 
and IX-MV) (→page 414)”.

• Priority: Normal/Priority/Urgent

Default values • Call Destination: ―
• Priority: Normal

Description Select the destination group when "Standard Destination" is selected in "“Call Method (except 
IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 422)”.

Settings • Call Destination: 01 - 10. Select from groups registered in “Called Stations (Door/Sub Stations) 
(except IX-MV7-*, IX-MV, and IXW-MA) (→page 419)”.
The call group number for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*) is fixed to "10" and cannot be 
changed for "Call Button," or can be selected from "01 - 09" for "Option Input 1."

• Priority: Normal/Priority/Urgent

Default values Call Button
• Call Destination: 01 (IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*) are "10")
• Priority: Normal

Option Input 1 - 5
• Call Destination ― (01 for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Priority: Normal

Option Input 6
• Call Destination: 01
• Priority: Urgent

Description Configure the call priority for the call group to switch when “Call Method (except IX-MV7-*, IX-
MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 422)” is set to "Change Destination by Time 
Delay." Up to 8 groups can be configured, and it will switch between groups in order by the time 
configured in "Destination Dwell Time[sec]."

Settings • Call Destination: 01 - 10. Select from groups registered in “Called Stations (Door/Sub Stations) 
(except IX-MV7-*, IX-MV, and IXW-MA) (→page 419)”.

• Priority: Normal/Priority/Urgent

Default values • Call Destination: -
• Priority: Normal
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■Destination Dwell Time[sec] (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♦

Description Set the delay time to change the call destination when "Change Destination by Time Delay" is 
selected in “Call Method (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) 
(→page 422)”.

Settings 10-600sec / 1 sec step

Default values 30 sec
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4.4.1.1 Schedule Settings (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))
Configure when “Call Method (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 422)” is set 
to "Change Destination by Schedule."

How to configure the Weekly Schedule
Configure the switch time for the call destination, the call destination group, and the call priority each day from Sunday 
to Saturday. 12 schedules can be set for each day.

1. Configure "Start Time," "End Time," "Call Destination," and "Priority" for each day.

2. When done, click [Update].

3. Click [OK].

■Start Time

■End Time

■Call Destination

■Priority

Description Set the time to start changing the call destination.

Settings 00:00 - 23:59

Default values -

Description Set the time to stop changing the call destination. If this is set earlier than "Start Time," the end 
time will be for the following day.

Settings 00:00 - 23:59

Default values -

Description Set the call destination to change within the schedule.

Settings 01 - 10. Select from groups registered in “Called Stations (Door/Sub Stations) (except IX-MV7-*, 
IX-MV, and IXW-MA) (→page 419)”.

Default values -

Description Set the priority of calls.

Settings • Normal
• Priority
• Urgent

Default values -
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How to delete the Weekly Schedule

1. Return the settings to their default values and click [Update].

2. Click [OK].

How to configure Daily Schedule
Configure the switch time for the destination, the call group, and the call priority in units of one day. A schedule one 
year from the set day can be configured. 12 schedules can be set for each day.

1. Select the day to set a schedule from "Calendar."

2. Configure "Start Time," "End Time," "Call Destination," and "Priority," and click [Add].

3. When done, click [Update].

4. Click [OK].

■Start Time

■End Time

Description Set the time to start changing the call destination.

Settings 00:00 - 23:59

Default values -

Description Set the time to stop changing the call destination. If this is set earlier than "Start Time," the end 
time will be for the following day.

Settings 00:00 - 23:59

Default values -

Calendar

Set Schedule List
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■Call Destination

■Priority

How to delete Daily Schedule

1. Select the day for which to delete a schedule from "Calendar."

2. Schedules for the selected day are displayed in the "Set Schedule List."
• If a weekly schedule is configured for the selected day of the week, it will also be displayed.

3. Click [Delete] for the schedule to be deleted, and click [Update].
• Refer to “How to delete the Weekly Schedule (→page 427)” to delete a weekly schedule.

Description Set the call destination to change within the schedule.

Settings 01 - 10. Select from groups registered in “Called Stations (Door/Sub Stations) (except IX-MV7-*, 
IX-MV, and IXW-MA) (→page 419)”.

Default values -

Description Set the priority of calls.

Settings • Normal
• Priority
• Urgent

Default values -
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4.4.2 Tone Settings

Configure the busy tone and error tone when making an outgoing call.

■Busy Tone (except IX-MV)♠
Description Select the sound to be played when call destination station is busy.

Settings • None (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Pre Tone 1 (Except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Pre Tone 2 (Except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Pre Tone 3 (Except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Communication End Pretone (Except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Call Queue Notification (Except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Waiting Reply Tone (Except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
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■Error Tone (Call Failed) (except IX-MV7-* and IX-MV)♠

4.4.3 Call Restart Function

■Call Restart Function (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Description Select the sound to be played when outgoing call has failed.

Settings • None (except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*) are Busy Tone)
• On Hold
• Operation Sound
• Error (IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*) are Error Tone)
• Pre Tone 1 (except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Pre Tone 2 (except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Pre Tone 3 (except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Communication End Pretone (except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Call Queue Notification (except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Waiting Reply Tone (except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Error (IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*) are Error Tone)

Description Select Enable / Disable for Call Restart Function.
Call Restart Function: When the station is reset during an outgoing call, the outgoing call will be 
resumed automatically up to 2 times.

Settings • Enable
• Disable

Default values Disable
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4.5 Incoming Call (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

Configure incoming call settings.

4.5.1 Call Answer Settings

■Auto Answer♠
Description Select ON / OFF to automatically answer the individual call. 

Auto Answer: When receiving an individual call, answer automatically. When transferring a call, it 
must be answered manually.

Settings • ON: Auto Answer.
• OFF: No Auto Answer.

Default values • IX-MV7-*, IX-MV, IX-RS-*: OFF
• IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G: ON

Important

• For IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G, if Auto Answer is set to "OFF," be sure to configure one of the following. If not 
configured, calls will not be received.

– Set to "Call, Answer Call, End Communication" in “Call Button Function (→page 418)”.

– Configure "Option Input" - “Function (→page 437)” to "Answer Call / Page."

Note

• For IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*), Auto Answer is set to "ON" and cannot be changed.
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4.5.2 Ringtone

■Ringtone (except IX-MV7-*, IX-MV)♠
Description Select the ringtone to be played for incoming call.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Call Pattern 3
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■Ringback Tone Count [time(s)] (except IX-MV7-*)♠

■Call Button (for IX-MV7-* and IX-MV)

Description Set the play count of ringtone for incoming call.

Settings • Infinite: Keep ringing until the call is answered or canceled.
• 1 - 20 times

Default values Infinite

Description Select the ringtone for incoming call. Ringtone can be set per each source station.
IX-MV7-*: Ringtone can be set per priority.
IX-MV: Same for all priority. Set ringtone to "Normal" priority.

Settings • None (IX-MV7-* only)
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (IX-MV: Busy Tone)
• On Hold
• Operation Sound
• Error (IX-MV: Error Tone)
• Pre Tone 1 (IX-MV7-* only)
• Pre Tone 2 (IX-MV7-* only)
• Pre Tone 3 (IX-MV7-* only)
• Communication End Pretone (IX-MV7-* only)
• Call Queue Notification (IX-MV7-* only)
• Waiting Reply Tone (IX-MV7-* only)
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Call Pattern 1
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■Option Input (for IX-MV7-* and IX-MV)

■Call Button Ringtone Count [time(s)] (for IX-MV7-*)♠

■Option Input Ringtone Count [time(s)] (for IX-MV7-*)♠

Description Select the ringtone for incoming call by Option Input. The ringtone can be set per each source 
station.
IX-MV7-*: The ringtone can be set per priority.
IX-MV: Same for all priorities. Set the ringtone to "Normal" priority.

Settings • None (IX-MV7-* only)
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (IX-MV: Busy Tone)
• On Hold
• Operation Sound
• Error (IX-MV: Error Tone)
• Pre Tone 1 (IX-MV7-* only)
• Pre Tone 2 (IX-MV7-* only)
• Pre Tone 3 (IX-MV7-* only)
• Communication End Pretone (IX-MV7-* only)
• Call Queue Notification (IX-MV7-* only)
• Waiting Reply Tone (IX-MV7-* only)
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Call Pattern 2

Description Set the play count of ringback tone for incoming call from call button.

Settings • Infinite: Keep ringing until the call is answered or canceled.
• 1 - 20 times

Default values Infinite

Description Set the play count of ringback tone for incoming call from the option input.

Settings • Infinite: Keep ringing until the call is answered or canceled.
• 1 - 20 times

Default values Infinite
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4.5.3 VoIP Phone (except IX-MV)

■VoIP Phone Call Priority
Description Select the call priority from VoIP phones.

Settings • Normal
• Priority
• Urgent

Default values Normal
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5. Option Input/Relay Output Settings

5.1 Option Input

Configure the input terminal settings for each station. The number of input terminals varies by station.

5.1.1 Option Input Advanced Settings

Select the Option Input Number to configure for [Call Button / Option Input #]. The selected Option Input setting 
information will be displayed (for  IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*), and IXW-MA).

5.1.1.1 Name (except for IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

Description Set the Name of the Option Input. 

Settings 1-24 alphanumeric characters

Default values -
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5.1.1.2 Function

5.1.1.3 Type

5.1.1.4 Detection Time

■Detection Time Range

■Detection Time♦

Description Configure the contact input functions. The functions that can be selected differ depending on the 
station.

Settings • No Function
• Call (except IXW-MA): Call to destination. Be sure to also configure "Option Input 1 - 6" in “Call 

Origination (except IXW-MA) (→page 422)”.
• Answer Call / Page (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA): Answer 

incoming call or page.
• Paging (for IX-MV7-*): Page to destination. Be sure to also configure “Option Input Page (for 

IX-MV7-*) (→page 453)”.

• Message Page (for IX-MV7-*): Send message to destination. Be sure to also configure “Option 
Input Page (for IX-MV7-*) (→page 453)”.

• External Input Page (for IX-MV7-*): Page using an external sound source. Only one input 
terminal may be configured. Be sure to also configure “Option Input Page (for IX-MV7-*) 
(→page 453)”.

• Turn LCD On (for IX-MV7-*): Turn LCD backlight of IX-MV7-* on.
• Relay Latch Reset (for IX-RS-*, IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G): Reset latch relay 

output using the option input. "Relay Latch Reset" is selected in "Option Input" - "Function" 
and "Latch Output" is selected in "Relay Output" - “Function (→page 440)”.

• Bathroom Indicator Reset (for IXW-MA): Not used.
• API (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)): Send CGI command set by “API 1 

(→page 438)” and “API 2 (→page 438)”.

Default values No Function

Description Select the type of the option input.

Settings • Make
• Break

Default values Make

Description Select the Detection Time Range for Option Input.

Settings • 0 (Immediate): Detect at input less than 200 msec.
• 200 - 2000 [msec]
• 3 - 600 [sec]

Default values 0 (Immediate)

Note

• The Detection Time Range for IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*) is "200-2000 [msec]" and cannot be changed.

Description Configure the contact input search time within the range set in "Detection Time Range."

Settings The settings will be configured as follows according to the information set in "Detection Time 
Range."
• If set to 0 (Immediate): Configuration unnecessary.
• If set to 200 - 2000 [msec]: Configure from 200 - 2000 msec (by 100 msec).
• If set to 3 - 600 [sec]: Configure from 3 - 600 sec (by 1 sec).

Default values -
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5.1.1.5 API (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

■API 1

■API 2

Description Enter the CGI command sent when "API" is selected in “Function (→page 437)”.

Settings 1-128 alphanumeric characters

Default values -

Description Enter the CGI command sent when "API" is selected in “Function (→page 437)”.

Settings 1-128 alphanumeric characters

Default values -
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5.2 Relay Output

Configure the output terminal settings for each station. The number of output terminals varies by station.

5.2.1 Relay Output Advanced Settings

The relay output setting information selected in [Relay Output #] will be shown. (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-
SSA(-*), and IXW-MA)

Important

• The four relay output methods are shown below. Redundant configuration is possible for each output terminal. If multiple 
commands occur during a single relay output, the last command will take priority.

– Function selected in “Function (→page 440)”

– “Option Relay Control (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*)) (→page 442)”

– “Schedule Settings (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 447)”

– “CGI Integration (→page 473)”
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5.2.1.1 Name (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

5.2.1.2 Function

How to configure Status Output
If “Function (→page 440)” is set to "Status Output," select the operating state for when the relay output occurs. This 
can be selected for each operation priority (multiple selections allowed).
The operating states that can be selected vary by station type.

Description Set the name of the Relay Output.

Settings 1-24 alphanumeric characters

Default values -

Description Select the function of the Relay Output. Different function can be selected depending on the 
station type.

Settings • No Function
• Status Output (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA): Relay Output 

during the status.
The details setting can be set  in “How to configure Status Output (→page 440)”.

• External Audio Output (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*), IX-SSA(-*), IX-BA, IX-SS(-*)): 
Relay output during Line audio output. Contact continues to output while audio is playing. This 
operates when "Volume / Tone" - “Audio Output (for Door) (except IX-MV7-*, IX-SS-2G, and 
IX-MV) (→page 534)” is set to something other than "Built-in Speaker for Communication and 
Paging."

• Door Release (except for IXW-MA): Relay output when door release is activated or, entering 
the authentication key using keypad of the station or the VoIP Phone. Configure the output 
time in “Output Time (→page 524)”.

• Latch Output (for IX-RS-*, IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G): Latch relay output by 
event trigger. Continue to output until latch reset trigger input. Ignore set “Output Time [msec / 
sec]♦ (→page 443)”. Configuration can be set in “How to configure Latch Output 
(→page 441)”.

• Contact Input Call / Communication State (for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*)): Relay 
output during the contact input call and communication until reset. The contact will continue to 
output during operation.

• Bathroom Indicator (for IXW-MA): Not used.
• Contact Change SIF Event (for IXW-MA): Relay output when Contact Change SIF Event is 

received from another station. Output Time is the same as Option Input Detection Time or 
Relay Output Time of the SIF command originating station. Set in "SIF" - "Transmission 
Trigger" - “Change contact (→page 477)”.

Default values Relay Output 1
• Except IXW-MA: Door Release
• IXW-MA: No Function

Relay Output 2 - 10
• No Function

Note

• If "Automatically configure door release for all stations?" is set to "No" in “Create new system/import setting data 
(→page 123)”, the default value for "Relay Output 1 (except IXW-MA)" will be "No Function."
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How to configure Latch Output
If “Function (→page 440)” is set to "Latch Output," select the operating state for when the relay output occurs. This 
can be selected for each operation priority (multiple selections allowed).
Choose from two restoration methods for relay output.
• Option Input (default value): Reset Latch Output by the Option Input.
• End Communication: Reset Latch Output by ending communication or the option input.

All items are set to "Option Input" by default.
To reset by Option Input, be sure to configure "Relay Latch Reset" in "Option Input" - “Function (→page 437)”.

How to configure Contact Change SIF Event
If “Function (→page 440)” is set to "Contact Change SIF Event", select the station for interlocking with Contact 
Change SIF Event of Relay Output 1.

■Number

Note

• For "Outgoing Page" and "Incoming Page," relay output is performed even during message paging and external input paging.

• For "Monitored," relay output is performed even during scan monitoring.

Description Set SIF Origination Station Number. Enter the station number or select station from the list.

Settings 3-32 digits

Default values -
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5.2.1.3 Option Relay Control (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*))

Description Select Enable / Disable for Option Relay Control when using the speed dial of IX-MV7-* to 
control the output.
If set to "Enable," contact will be output according to the "Speed Dials / Favorites" - “How to 
configure Option Relay Control (for IX-MV7-*) (→page 524)” setting.
If "How to configure optional relay" - “TLS (→page 524)” was set to "Enable" for the station that 
be controlled, also configure “Option Relay Control Authentication Key (except IX-MV, IX-DA, IX-
DF(-*), and IX-BA, IX-SS(-*)) (→page 449)”.
For IXW-MA, this can be controlled as an optional relay if set to "Enable" only when “Function 
(→page 440)” is set to "No Function." The output time will be the output time configured on IX-
MV7-*.

Settings • Enable
• Disable

Default values Disable
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5.2.1.4 Output Time Range

■Output Time [msec / sec]♦

5.2.1.5 Door Release Authorization (except IXW-MA)

Description Select the Output Time Range for relay output if “Function (→page 440)” is set to "Door 
Release" or if the output terminal is controlled via “CGI Integration (→page 473)”.

Settings • 0 (Momentary) (for IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)): Outputs while an output 
command is received. However, this is set to 10 sec and cannot be changed if a relay output 
command is received via CGI.

• 200-2000 [msec]
• 3-600 sec (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))
• 3-300 sec (for IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*))

Default values 200-2000 [msec]

Important

• If set to "0 (Momentary)," the operation when the door on the other station is released will be as follows.
IX-MV7-* or IX-RS-*: When the Door Release button is pressed or Authentication Key is input by the keypad, a relay output 
command is sent and the output command ends immediately. The output command will not continue even if the Door Release 
button is held.
IX-MV: The relay output command continues while the Door Release button is pressed, and ends once it is released.

Description Set the Output Time within the range selected in “Output Time Range (→page 443)”.

Settings The settings will be configured as follows according to the information configured in “Output 
Time Range (→page 443)”.
• If set to 0 (Momentary): Configuration unnecessary.
• If set to 200-2000 [msec]: Configure from 200 - 2000 msec (by 200 msec).
• If set to 3-600 sec: Configure from 3 - 600 sec (by 1 sec).
• If set to 3-300 sec: Configure from 3 - 300 sec (by 1 sec).

Default values 400 [msec]

Description Set the Authentication Key when "Door Release"  is selected in “Function (→page 440)” for 
releasing the door that is connected to the station. When the "Authentication Key" is confirmed, 
the relay output will be activated. Configure "Door Release" - “Authentication Key (→page 455)”. 
This will also be the authentication key used to release the door using the numerical keypad on 
IX-MV7-* or a VoIP phone.

Settings • Except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*): 1-20 digits
• IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*): 1-4 digits

Default values This will vary depending on the setting value configured in “Create new system/import setting 
data (→page 123)” - "IX Support Tool Settings."
• IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) not configured: 20 random digits
• IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) configured: 4 random digits
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Important

• Configure the Authentication Key using 1 to 4 digits to release when using the IX-MV.

• Configure a different Authentication Key for each output terminal. (The same key cannot be used.)

• Configure an Authentication Key that is different from the Authentication Key configured in "Communication Audio Messages" 
- “Code (→page 490)” and “Option Relay Control Authentication Key (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) 
(→page 449)”. If the setting is the same, multiple functions might operate.

• To release the door using the numerical keypad, enter "**Authentication Key*" on the IX-MV7-* or VoIP Phone numerical 
keypad (if the Authentication Key is "0000" enter "**0000*").
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5.2.1.6 Sound Settings (except IX-MV and IXW-MA)

■Door Release

■Relay Control (start) (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))

Description Select the Door Release sounds to be played.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3 (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone (Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Operation Sound

Description Select the sound to be played when Option Relay is activated.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values None
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■Relay Control (end) (except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))

Description Select the sound to be played when Option Relay is deactivated.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values None
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5.2.1.7 Schedule Settings (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

How to Configure the Weekly Schedule
Configure the time to perform relay output for each day of the week from, Sunday to Saturday. 12 schedules can be 
set for each day.

1. Configure "Start Time" and "End Time" for each day.

2. After done, click [Update].

3. Click [OK].

■Start Time

■End Time

How to delete the Weekly Schedule

1. Return settings to their default values, and click [Update].

Important

• Regardless of the configuration in “Function (→page 440)”, the relay will continue to output during the time period set in the 
schedule. However, if a door release operation or other command occurs during the  relay output, the last command will be 
given priority, and the relay output will stop even if it is still within the time set in the schedule.

Description Set the time to start the relay output.

Settings 00:00 - 23:59

Default values -

Description Set the time to end the relay output. If this is set earlier than "Start Time," the end time will be for 
the following day.

Settings 00:00 - 23:59

Default values -
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How to configure Daily Schedule
Configure the time at which relay output will be performed, in units of one day. A schedule one year from the set day 
can be configured. 12 schedules can be set for each day.

1. Select the day to set a schedule from "Calendar."

2. Configure "Start Time" and "End Time," and click [Add].

3. When done, click [Update].

4. Click [OK].

Calendar

Set Schedule List
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■Start Time

■End Time

How to delete Daily Schedule

1. Select the day for which to delete a schedule from "Calendar."

2. Schedules for the selected day are displayed in the "Set Schedule List."
• If a weekly schedule is configured for the selected day of the week, it will also be displayed.

3. Click [Delete] for the schedule to be deleted, and click [Update].
• Refer to “How to delete the Weekly Schedule (→page 447)”  to delete a weekly schedule.

4. Click [OK].

5.2.2 Option Relay Control Authentication Key (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-
*))

Description Set the time to start the relay output.

Settings 00:00 - 23:59

Default values -

Description Set the time to end the relay output. If this is set earlier than "Start Time," the end time will be for 
the following day.

Settings 00:00 - 23:59

Default values -

Description If “Option Relay Control (except IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*)) (→page 442)” is 
set to "Enable" and "Speed Dials / Favorites" - “TLS (→page 524)” is set to "Enable" on the 
requesting station, configure the key used to decrypt encrypted communication.
If this matches the "Option Relay Control Key" of the station that performs the operation, the 
Relay Output may be controlled.
To use this, be sure to configure "Speed Dials / Favorites" - “Option Relay Control Key 
(→page 525)”.

Settings 1-20 digits

Default values -

Note

• Only one Option Relay Control Authentication Key can be set for each station. It will be shared with multiple Relay Output.
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6. Paging Settings

6.1 Paging Origination (for IX-MV7-* and IX-MV)

Configure settings related to outgoing paging.

■Paging Timeout [sec]♦ ♠

■Paging Wait Timer [sec] (for IX-MV7-*)♦ ♠

■Urgent Page Response (for IX-MV7-*)

Important

• All pages, groups pages, message pages, and external input pages cannot be sent to VoIP Phone.

Description Set the time for outgoing paging duration.

Settings 10-600sec / 1 sec step

Default values 30 sec

Description Set the time to wait for a response from all destination stations when outgoing paging is 
activated. Paging starts after this time without a response form all destination.

Settings 1-20sec (by 1 sec)

Default values 10 sec

Important

• A page may not be sent to a station if a response is received after "Paging Wait Timer [sec]" elapses. If multiple stations 
receive pages, configure a longer Paging Wait Timer.

Note

• The Paging Wait Timer for IX-MV is set to "10 sec" and cannot be changed.

Description Select Enable / Disable for the paging destination station can answer the urgent page.

Settings • Enable
• Disable

Default values Disable
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■Lock Paging (for IX-MV7-*)

Important

• If the station being called is IX-MV, end operations can be performed even if Urgent Page Response is set to "Enable."

Description Select Enable / Disable to lock paging function.

Settings • Enable: Page button will be hidden
• Disable

Default values Disable

Note

• Configure the pretone when a page is received in "Volume / Tone" - “Paging Pretone (for IX-MV7-* and IX-MV) ♠ 
(→page 531)”.
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6.2 All Page (for IX-MV7-* and IX-MV)

When paging all stations, the default setting is set to multicast. When unicast is required, configure the following 
settings.

How to configure All Page

1. Search for stations to transmit via unicast from "Station List."

2. Place a check in the cell corresponding to Step1.
• Unchecked: Multicast transmission
• Checked: Unicast transmission
• By default, all are set to "Unchecked" (multicast transmission).

3. After done complete, click [Update].

4. Click [OK].

Important

• Unicast can reach up to 50 stations. If you need to page more than 50 stations are to be paged at once, use multicast.

• When paging stations in multicast, configure “Multicast Address (for IX-MV7-*, IX-MV, IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*)) 
(→page 389)”.

Address Book Station List

21



453

System Settings (Station View)

6.3 Option Input Page (for IX-MV7-*)

Configure contact input paging.
Configure if "Paging," "Message Page," and "External Input Page" are selected in "Option Input" - “Function 
(→page 437)”.

■Destination

■Group Number

■Priority

Description Set the destination group for paging.

Settings • All Page: Page all stations that are registered in the address book. 
• Group: Page the group that is set in "Group Number."

Default values All Page

Description Set the destination group for paging.
Enter the group number, or click [Open] to select group.

Settings 01 - 99, or select from groups registered in “Group (for Master) (for IX-MV7-* and IX-MV) 
(→page 414)”.

Default values -

Description Set the priority for paging.

Settings • Normal
• Urgent

Default values Normal
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■Message File Name

■Play Count [time(s)]

Description Select the message to be sent for message paging. Available when "Message Page" is selected 
in "Option Input" - “Function (→page 437)”.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values None

Description Set the play count for message paging.

Settings 1 - 20 times

Default values 1 time
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7. Function Settings

7.1 Door Release (for IX-MV7-* and IX-MV)

7.1.1 Door Release Assignment

Configure the connected station and the authentication key to release the door during a call.
For IX-RS-* settings, refer to “Door Release Assignment (for IX-RS-*) (→page 543)”.

■Contact Assignment

■Authentication Key

Description Select which relay output will be used for door release during call or monitoring.

Settings • Originating Station: Use origination station relay output for door release.
• Destination Station: Use destination station relay output for door release.

Default values Destination Station

Description When "Destination Station" is selected in "Contact Assignment", set the Authentication Key for 
door release.
Authentication key must match with the destination station's authentication key, which is set in 
"Relay Output" - “Door Release Authorization (except IXW-MA) (→page 443)” to allow door 
release.

Settings • IX-MV7-*: 1-20 digits
• IX-MV: 1-4 digits

Default values Random characters (compatible with default value of "Relay Output" - "Authentication Key")

Note

• If "Automatically configure door release for all stations?" was set to "No" in “Create new system/import setting data 
(→page 123)”, a default value of "Authentication Key" will not be configured.

• The default values for the authentication key and door release key vary depending on the station type set in "IX Support Tool 
Settings" of “Create new system/import setting data (→page 123)”.

– System without IX-MV, IX-DA, or IX-BA: 20 digits.

– System with IX-MV, IX-DA, or IX-BA: 4 digits

• If the destination station's Authentication Key is four characters or longer, the Door Release Key for IX-MV will release the door 
if the first four digits match.
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7.2 Network Camera Integration (for IX-MV7-* and IX-MV)

Configure network camera profile (video profile) and event related settings.
To configure the settings, register a network camera in the Address Book of the IX-MV7-* or IX-MV which will receive 
the event in "Address Book" - “How to create Network Camera List (→page 409)”.

7.2.1 Profile Setting

Configure when changing the profile selected when a network camera is registered in "Address Book" - “How to 
create Network Camera List (→page 409)”.

■Profile

7.2.2 Event Registration

Configure the network camera event to register in IX-MV7-* or IX-MV.
When the registered event is received, network camera monitoring will be performed and the notification tone will be 
played, or the outgoing call command will be sent to the set Call Origination (for IX-MV7-*).

How to configure network camera event setup
The network camera event must be registered.
Click [Open Network Camera Event Registry]. The "Open Network Camera Event Registry" window will be shown.

Important

• For network camera event registration, “Association Settings (→page 160)” must be configured for the IX-MV7-* or IX-MV. If 
the programming PC is not connected to the same network or cannot communicate with multicast transmission, it is not be 
possible to configure. (this is because network camera events are obtained over multicast via IX-MV7-* or IX-MV when 
registering network camera events).

Description Select the profile of the network camera.
On the first screen, the profile that was selected when registering the network camera will be 
displayed. Refer to the manual of the network camera for the details.

Settings -

Default values -

If no network camera is registered, this will not be shown.
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1. Select the station to register the network camera event from "Station List."

2. Select the network camera(s) to monitor events from "Network Camera List" (multiple selections 
allowed).
• Network cameras registered in the Address Book in "Address Book" - “How to create Network Camera List 

(→page 409)” will be shown.

3. Click [Get Network Camera Events].
(Obtaining the events may take several minutes.)
• Once events are successfully obtained, they will be shown in "Event List."

4. Select the events to monitor from "Event List." (Multiple selections allowed)
• For details on events, refer to the manual of the network camera.

1

2

3

4

5

If no event is obtained, this will not be shown.
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5. Click [Register] to register the event.
• The network cameras and events registered in event registry will be shown.
• Click [Cancel] to back to the "Network Camera Integration" screen without registering the event.

■Event

■Function (for IX-MV7-*)

Description Displays topics (events) registered in “How to configure network camera event setup 
(→page 456)”.
To delete the registered event, click [Update] with "Event" set as blank.
For details of the Event, refer to the manual of the network camera.

Settings -

Default values -

Description Select the function when receive the topic from the network camera.

Settings • Monitor: Play the notification tone and begin network camera monitoring.
• Call: Place an outgoing call from the station configured in “Call Origination (for IX-MV7-*) 

(→page 459)”.
Configure “ID (for IX-MV7-*) (→page 459)”, “Password (for IX-MV7-*) (→page 459)”, and “Call 
Origination (for IX-MV7-*) (→page 459)” “Call Destination (for IX-MV7-*) (→page 460)” 
“Priority (for IX-MV7-*) (→page 460)”.

Default values -

If no event is registered, this will not be shown.
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■Event Tone (for IX-MV7-*)

■ ID (for IX-MV7-*)

■Password (for IX-MV7-*)

■Call Origination (for IX-MV7-*)

Description Select the tone to be played when receiving event from the network camera.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Call Pattern 3

Description If "Call" is set in “Function (for IX-MV7-*) (→page 458)”, configure the administrator ID of the 
station set in “Call Origination (for IX-MV7-*) (→page 459)”.

Settings 1-32 alphanumeric characters

Default values -

Description If "Call" is set in “Function (for IX-MV7-*) (→page 458)”, configure the administrator password of 
the station set in “Call Origination (for IX-MV7-*) (→page 459)”.

Settings 1-32 alphanumeric characters

Default values -

Note

• "Password" will be displayed as "****" in the Settings screen.

Description If "Call" is set in “Function (for IX-MV7-*) (→page 458)”, configure from which station to make the 
outgoing call.
Enter the station number directly, or click [Open] to select a station.
For the configured station, set “CGI Functionality (→page 473)” to "Enable."

Settings Select from the stations registered in “Address Book (for IX-MV7-* and IX-MV) (→page 406)”. 
IXW-MA cannot be selected.

Default values -
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■Call Destination (for IX-MV7-*)

■Priority (for IX-MV7-*)

■Event Tone (for IX-MV)♠

■Play count of Event Tone♠

Description Configure the destination station number or group number when the station configured in “Call 
Origination (for IX-MV7-*) (→page 459)” makes an outgoing call.

Settings Number: 3-5 digits
Group Number: 01 - 99

Default values -

Description Select the call priority when the station configured in “Call Origination (for IX-MV7-*) 
(→page 459)” makes an outgoing call.

Settings • Normal
• Priority
• Urgent

Default values -

Description Select the tone to be played when receiving event from the network camera. The tone will be the 
same for all network cameras and events registered in the station.

Settings • Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Tone
• On Hold
• Operation Sound
• Error Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Call Pattern 3

Description Set the play count for Network Camera Event Tone when “Function (for IX-MV7-*) (→page 458)” 
is set to "Monitor." The ringtone count will be the same for all network cameras and events 
registered to the station. If "Call" is set, the ringtone count for the event notification tone will be 1 
only.

Settings • Infinite: Play the ringtone while receiving an event that occurred on the network camera.
• 1 - 20 times

Default values 1 time
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7.3 Paging Settings (except for IX-MV7-*, IX-MV, or IXW-MA)

Configure incoming page settings.

7.3.1 Paging Pretone Setting

■Paging Pretone
Description Select the Paging Pretone.

Settings • None
• Call Pattern 1 (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Call Pattern 2 (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Call Pattern 3 (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Call Pattern 4 (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Call Pattern 5 (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Call Pattern 6 (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Tremolo Sound (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Busy Response Tone (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• On Hold (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Operation Sound (except  IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Error (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Pre Tone 1 (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Pre Tone 2
• Pre Tone 3 (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Communication End Pretone (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Call Queue Notification (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Waiting Reply Tone (except IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”. 

(Except for IX-DA, IX-DF(-*) and IX-BA, IX-SS(-*).)

Default values Pre Tone 2

Important

• Configure a tone with a shorter duration than the paging pretone on the paging origination station. Configuring a longer tone 
might prevent the station from receiving audio when paging begins.



462

System Settings (Station View)

7.4 Bathroom Call (for IXW-MA)

This function cannot be used outside Japan.



463

System Settings (Station View)

7.5 Email

Configure this section when email notification of station operation is required.
Be sure to configure “DNS (→page 384)” for IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*).

7.5.1 Server Settings

■SMTP Server♠

■SMTP Port♦♠

■SMTP Encryption♠

Description Set the SMTP server.
When choosing an IPv4 address, enter the IP address or the hostname.
For an IPv6 address, configure using the IP address (except IX-MV, IX-DA, IX-DF(-*), IX-BA, 
and IX-SS(-*)) or hostname. Configure this if connecting by hostname.
If a hostname is used, configure “DNS (→page 384)”.

Settings 1 - 255 alphanumeric characters

Default values -

Description Set the port number for SMTP.

Settings 1 - 65535

Default values 25

Description Select the encryption type for SMTP.

Settings • OFF
• TLS
• STARTTLS

Default values OFF
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7.5.2 Authentication Settings

■SMTP Authentication♠

■Mode♠

■ ID♠

■Password♠

Description Select ON / OFF for SMTP Authentication.

Settings • ON
• OFF

Default values OFF

Description Select the SMTP Authentication Mode.

Settings • LOGIN
• CRAM-MD5

Default values LOGIN

Description Set the ID for SMTP authentication.

Settings 1-64 alphanumeric characters

Default values -

Description Set the Password for SMTP authentication.

Settings 1-64 alphanumeric characters

Default values -

Note

• "Password" will be displayed as "*****" on the screen.
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7.5.3 Email Addresses

■Destination 1♠

■Destination 2♠

■Destination 3♠

■Source Address♠

Description Set the destination email address.

Settings 1-64 alphanumeric characters

Default values -

Description Set the destination email address.

Settings 1-64 alphanumeric characters

Default values -

Description Set the destination email address.

Settings 1-64 alphanumeric characters

Default values -

Description Set the source email address.

Settings 1-64 alphanumeric characters

Default values -
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7.5.4 Email Event Trigger

Set the email event trigger which initiates the message sending process. Configure the email event trigger for each 
destination address.

■Outgoing Normal Call (except IXW-MA)

■ Incoming Normal Call (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

Description Send email when an outgoing call is placed at "Normal" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when an incoming call is received at "Normal" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Outgoing Priority Call (except IXW-MA)

■ Incoming Priority Call (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

■Outgoing Urgent Call (except IXW-MA)

■ Incoming Urgent Call (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

■Door Release Activated (for IX-MV7-*, IX-MV, and IX-RS-*)

■Call Failed (except IXW-MA)

■Latch Reset (IX-RS-*, IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G only)

Description Send email when an outgoing call is placed at "Priority" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when an incoming call is received at "Priority" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when an outgoing call is placed at "Urgent" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when an incoming call is received at "Urgent" priority.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when Door Release is activated.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when outgoing call has failed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when reset latch relay output. ("Latch Output" is selected in "Relay Output"  - 
“Function (→page 440)”.)

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Error

■Station Restarted

■SD Card Error (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■Recording Memory Full (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■Line Supervision (Passed) (for IX-MV7-*)

■Line Supervision (Failed) (for IX-MV7-*)

Description Send email when a communication error has occurred.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when the station has reset.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when a microSD access error is detected. If the error is detected continuously, mail 
will not be sent an additional time.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when a microSD card meets following criteria. If the error is detected continuously, 
mail will not be sent an additional time.
• When “Prevent Overwrite♠ (→page 486)” is set to "Enable"

– Recorded recordings exceeds 950
– Storage capacity remaining 5% 

• When “Prevent Overwrite♠ (→page 486)” is set to "Disable"
– Recorded recordings exceeds 999
– Storage capacity remaining 0%

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when Line Supervision is passed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when Line Supervision is failed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send



469

System Settings (Station View)

■Device Check (Passed) (for IX-MV7-*)

■Device Check (Failed) (for IX-MV7-*)

■Subject♠

7.5.5 Periodic Log Transmission (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Configure settings related to sending periodic logs. These can be configured for each recipient email address.

■Periodic Log Transmission

■Periodic Log Transmit Time

Description Send email when Device Check is passed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send email when Device Check is failed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Set the Subject of email per Event Trigger. This will be used for all recipient addresses.

Settings 1-64 alphanumeric characters

Default values -

Important

• "UTF-8" encoding is used for "Subject." Depending on the email client, the characters may appear incorrectly. To avoid this, 
set the encoding method to "UTF-8."

Description Select Enable / Disable for send station log periodically.

Settings • Enable
• Disable

Default values Disable

Description Set the time to send the periodic log.

Settings 00:00 - 23:59

Default values 00:00
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■Periodic Log Transmit Interval

■Periodic Log Transmission Subject

Description Select the interval to send the periodic log.

Settings 1 Day - 7 Day

Default values Daily

Description Set the email subject for Periodic Log Transmission. This is used for all destination addresses.

Settings 1-64 alphanumeric characters

Default values -

Important

• "UTF-8" encoding is used for "Periodic Log Transmission Subject." Depending on the email client, the characters may appear 
incorrectly. To avoid this, set the encoding method to "UTF-8."
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7.5.6 Send Test Email (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Send a test email to the address specified in “Email Addresses (→page 465)”.
Click [Send] to send a test email to the configured address.

Example of sending an email message:
When sending a test email from the station (Station Number: 001, Station Name: Intercom Station 1, Location: 
Office).

Important

• To send a test email, “Association Settings (→page 160)” must have been configured, and the programming PC must be able 
to communicate with the system.

From △△△△@△△△△△.com

Date and time 11/20/2018 15:22

To
CC

xxxx@xxxxx.com

Subject 001 Intercom Station 1 Test Email

Text Test Email sent at "20181120 15:22:46."

Station Number: "001"
Station Name: [Intercom Station 1]
Station location: [Office]

Important

• "UTF-8" encoding is used for "Subject," "Periodic Log Transmission Subject," and "Image Filename." Depending on the email 
client, the characters may appear incorrectly. To avoid this, set the encoding method to "UTF-8."
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7.5.7 Additional Settings (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

■Attach Image♠

■ Image Filename♠

Description Select Enable / Disable to send an image with the email when "Outgoing Normal Call", "Outgoing 
Priority Call" and "Outgoing Urgent Call" is selected in “Email Event Trigger (→page 466)”.

Settings • Enable
• Disable

Default values Disable

Description Set the filename of a image file when "Attach Image" is enabled.

Settings 1-64 alphanumeric characters

Default values -

Important

• "UTF-8" encoding is used for "Image Filename." Depending on the email client, the characters may appear incorrectly. To 
avoid this, set the encoding method to "UTF-8."
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7.6 CGI Integration

For the details of CGI functionality, contact the local Aiphone representative.

■CGI Functionality
Description Select Enable / Disable for CGI functionality.

Settings • Enable
• Disable

Default values Disable

Important

• CGI controls may fail when multiple CGI commands are received.
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7.7 SIF Integration

For the details of SIF functionality, contact the local Aiphone representative.

7.7.1 SIF Functionality

7.7.2 SIP URI Format (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠

Description Select Enable / Disable for SIF functionality.

Settings • Enable
• Disable

Default values Disable

Description Select Enable / Disable when SIP URI Format is used for station destination. If set to "Enable," 
TERMID cannot be used.

Settings • Enable
• Disable

Default values Disable
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7.7.3 SIF Settings (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Configure SIF recipient and communication settings. 16 SIF settings can be set.

■Program Type♠

■ IPv4♠

■ IPv6♠

■Destination Port♠

Note

• There are two ways to configure SIF communication: manually configuring settings or uploading a file in “SIF Communication 
Settings (sif.ini) (→page 484)”. The latest setting will take priority.

Description Set the Program Type for SIF.

Settings 0000-1111
If this is set to "0000," "0001," or "0011," the “Transmission Trigger (except IX-MV, IX-DA, IX-
DF(-*), and IX-BA, IX-SS(-*)) (→page 477)” setting will be disabled.

Default values -

Description Set the SIF IPv4 destination address.
Go to “DNS (→page 384)” to set Hostname..

Settings 1.0.0.1 - 223.255.255.254 or hostname (1-64 alphanumeric characters)

Default values -

Description Set the SIF IPv6 destination address.
Go to “DNS (→page 384)” to set Hostname.

Settings ::FF:0 - FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname (1-64 alphanumeric 
characters)

Default values -

Description Set the Port Number for destination.

Settings 1-65535

Default values -
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■SSL♠

■Connection♠

Description Select  Enable / Disable for SSL.

Settings • Disable
• Enable

Default values -

Description Select Socket / HTTP for connection.

Settings • Socket
• HTTP

Default values -
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7.7.4 Transmission Trigger (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Configure the SIF sending trigger when “Program Type♠ (→page 475)” is set to “0010” and "0100 - 1111." This can 
be configured for each recipient.

■Begin Outgoing Call (except IXW-MA)

■Begin Communication (Source) (except IXW-MA)

■Door Release Indication (for IX-MV7-* and IX-RS-*)

■End Communication (except IXW-MA)

■Change contact

Description Send SIF command when outgoing call is placed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning communication.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when door release request is sent.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending communication.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when Option Input contact or Relay Output contact is changed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Unit error

■Begin broadcast (for IX-MV7-*)

■End broadcast (for IX-MV7-*)

■Begin Transfer (for IX-MV7-*)

■End Transfer (for IX-MV7-*)

■Periodical Transmission

■ Initialization Notice

Description Send SIF command when communication error has occurred.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when paging is started.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when paging has ended.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when communication begins after transferring.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when communication ends after transferring.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Periodically send the station status using SIF command. The interval is set in “Periodical 
Transmission (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) (→page 483)”.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when the station is booted.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■End Outgoing Call (except IXW-MA)

■Begin Incoming Call (except IXW-MA)

■End Incoming Call (except IXW-MA)

■Latch Reset (except IX-MV7-* and IXW-MA)

■Change Call Destination (except IXW-MA)

■Call Failure (except IXW-MA)

■Begin Incoming Transfer Call (for IX-MV7-*)

Description Send SIF command when ending a outgoing call.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning a incoming call.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending a incoming call.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command by reset latch relay output. ("Latch Output" is selected in "Relay Output" - 
“Function (→page 440)”.)

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when changing call destination by delay time or schedule, or making an 
absent transfer, delay transfer or schedule transfer by the destination station. 

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when failed to place a call.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning Absent Transfer, Delay Transfer or Schedule Transfer. 

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Begin On Hold (for IX-MV7-*)

■End On Hold (IX-MV7-* only)

■Begin Incoming Page (except IXW-MA)

■End Incoming Page (except IXW-MA)

■Paging Failure (for IX-MV7-*)

■Begin Monitoring (for IX-MV7-*)

■End Monitoring (for IX-MV7-*)

Description Send SIF command when beginning a call on hold.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending a call on hold.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning a incoming page.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending a incoming page.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when failed to send a page.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning monitoring.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending monitoring.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Monitoring Failure (for IX-MV7-*)

■Begin Monitored (except IX-MV7-* and IXW-MA)

■End Monitored (except IX-MV7-* and IXW-MA)

■Begin Communication (Destination) (except IXW-MA)

■Begin Privacy (for IX-MV7-*)

■End Privacy (for IX-MV7-*)

■Keypad Input (for IX-MV7-*)

Description Send SIF command when failed monitoring.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning being monitored.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending being monitored.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning a communication.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning privacy mode.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending privacy mode.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when entering number using a keypad.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Speed Dial Input (for IX-MV7-*)

■Begin Record (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■End Record (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■Recording Memory Full (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■Passed Line Supervision (for IX-MV7-*)

■Failed Line Supervision (for IX-MV7-*)

■Passed Device Check (for IX-MV7-*)

Description Send SIF command when pressing a speed dial button.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when beginning recording.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when ending recording.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when a microSD card meets following criteria. If the error is detected 
continuously, SIF command will not be sent an additional time.
• When “Prevent Overwrite♠ (→page 486)” is set to "Enable."

– Recorded recordings exceeds 950
– Storage capacity remaining 5%

• When “Prevent Overwrite♠ (→page 486)” is set to "Disable."
– Recorded recordings exceeds 999
– Storage capacity remaining 0%

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when the result of Line Supervision is passed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when the result of Line Supervision is failed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when the result of Device Check is passed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send
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■Failed Device Check (for IX-MV7-*)

■SD Card Error (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

■SIP Registration Failure (except IXW-MA)

■Network Camera Event (for IX-MV7-*)

7.7.5 Periodical Transmission (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

■Periodical Transmission Interval♦

Description Send SIF command when the result of Device Check is failed.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when a microSD access error is detected.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when REGISTER request for SIP server has a failure.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Send SIF command when receiving event from the network camera.

Settings • Checked: Send
• Unchecked: Do not send

Default values Unchecked: Do not send

Description Set the interval to send the station status  periodically using SIF command in “Periodical 
Transmission (→page 478)”.

Settings • If set to 1[sec]-59[sec]: Set from 1 - 59 sec (by 1 sec).
• If set to 0[min]-1440[min]: Set from 0 - 1440 min (by 1 min).

Default values 0 min (do not send)



484

System Settings (Station View)

7.7.6 SIF File Management

■SIF Communication Settings (sif.ini)

■SIF Parameter Settings (sif_conf.ini)

Important

• To upload a SIF setting file, “Association Settings (→page 160)” must be preformed in the uploading station. And the 
programming PC and the station must be connected to the same network.

Description Upload or download the content in “SIF Settings (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-
SS(-*)) (→page 475)” with "sif.ini."
Upload: Click [Browse], select a file, and click [Upload].
Download: Click [Download] to save the file.

Settings -

Default values -

Description Use "sif_conf.ini" to upload or download SIF details if “Program Type♠ (→page 475)” is set to 
"0000," "0001," or "0011."
Upload: Click [Browse] to select a file, and then click [Upload].
Download: Click [Download] to save a file.

Settings -

Default values -
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7.8 Record (for IX-MV7-*, IX-DV, IX-DVF(-*), IX-SSA(-*))

Configure settings related to video and audio recording. If there is no video, configure only audio recording. When 
recording audio during a call, audio will be recorded from both sides.
The following SD standards are required to record video and audio.

■Record Mode (for IX-DV, IX-DVF(-*), IX-SSA(-*)) ♠

Standards Memory Capacity Format Speed Class

microSDHC Max. 32 GB FAT32 SD speed class 10

microSDXC (for IX-MV7-*) Max. 128 GB exFAT SD speed class 10
UHS speed class 1

Important

• A microSD card is not included with this station.

• The device may not operate correctly depending on the microSD card.

• If the card contains data other than video/audio files, it may not have enough space to record video/audio.

• Depending on the size of the image, recording with the network camera may not be possible.

Note

• A maximum of 999 video/audio files can be saved. However, this may vary depending on the size of the video/audio files and 
the capacity of the microSD card.

• Line Supervision and Device Check results are also saved to the microSD card.

• Aiphone assumes no responsibility for  microSD cards. Please be aware of this in advance.

Description Select the Record Mode.

Settings • No Recording
• Event Recording: Automatically record when the trigger set in " Record Event" has occurred.
• 24/7 Recording: Keep recording 24/7 while station is operating normally.

Default values No Recording
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■Record Event

■Recorded Device (IX-MV7-* only)

■Prevent Overwrite♠

■Video Recording File Length♠

Description Configure the trigger in use to start recording video/audio automatically. 
For stations other than IX-MV7-*,"Record Mode" must be set to "Event Recording."

Settings Select from the following. (Multiple selections allowed)
• Not selected: Video/audio is not automatically recorded.
• Incoming Call (for IX-MV7-*): Record start when station receives Incoming Call. If a call is 

automatically answered, recording will start when communication starts.
• Communication (Master) (for IX-MV7-*): Recording starts when communication begins.
• Monitor (for IX-MV7-*): Recording starts when monitoring begins. Recording is not possible 

during Scan Monitor.
• Outgoing Call (for IX-DV, IX-DVF(-*), IX-SSA(-*)): Video recording will start when a call is 

placed. Audio recording will start once the outgoing call is answered. For IX-SSA(-*), audio 
recording will start once the outgoing call is answered.

• Communication (Door) (for IX-DV, IX-DVF(-*), IX-SSA(-*)): Recording starts when 
communication begins.

• Monitored (for IX-DV, IX-DVF(-*), IX-SSA(-*)): Recording starts when station is Monitored.  
Recording is not possible during Scan Monitor.

• Schedule (for IX-DV, IX-DVF(-*), IX-SSA(-*)): Record during schedule set in “Weekly 
Schedule (→page 488)”.

Default values Not selected

Important

• If "Schedule" is selected, video/audio recording will continue for the time configured in “Weekly Schedule (→page 488)”, 
regardless of what is configured for other triggers.

Description Set the Recorded Device when IX-MV7-* is displaying video from an IX Station and a Network 
Camera simultaneously.

Settings • IX Station: Record IX Station video and audio.
• Network Camera: Record Network Camera video and IX station audio.

Default values IX Station

Description Set prevent overwriting the old recorded file, when the number of saved video/audio files, the 
entire storage space of the microSD card, or the video/audio recording storage space of the 
microSD card is full.

Settings • Enable
• Disable

Default values Disable

Description Select the recording file length to split recording. Once recording has reached this time, a new 
recording file will be made automatically.

Settings • 5 min
• 10 min
• 20 min
• 40 min
• 60 min

Default values 10 min
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■Event Recording Timer (for IX-MV7-*)♠

■Manual Recording (for IX-MV7-*)♠

■Audio Recording (for IX-MV7-*, IX-DV, IX-DVF(-*)) ♠

Note

• If the Video Recording File Length is changed during recording  video/audio, the setting will not be applied until the recording 
is completed.

Description Set the recording duration when the event trigger has occurred.

Settings • Disable: Does not stop until the operating status ends or the record button is tapped.
• 5 sec
• 10 sec
• 30 sec

Default values Disable

Description Select Enable / Disable for manual recording.

Settings • Enable
• Disable

Default values Enable

Description Select Enable / Disable for audio recording with video.

Settings • Enable
• Disable

Default values Enable
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7.8.1 Schedule Settings (for IX-DV, IX-DVF(-*), IX-SSA(-*))

7.8.1.1 Weekly Schedule
Configure this when "Schedule" is selected in “Record Event (→page 486)”.
Configure the video and audio recording time for each day from Sunday to Saturday. Up to 12 schedules can be set 
for each day.

How to configure a Weekly Schedule

1. Configure "Start Time" and "End Time" for each day of week.

2. When done, click [Update].

3. Click [OK].

■Start Time

■End Time

How to delete a Weekly Schedule

1. Return the settings to their default values and click [Update].

2. Click [OK].

Description Set the Start Time to begin recording.

Settings 00:00 - 23:59

Default values -

Description Set the End Time to stop recording. If this is set earlier than "Start Time," the end time will be for 
the following day.

Settings 00:00 - 23:59

Default values -
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7.9 Communication Audio Messages (for IX-RS-*, IX-DV, IX-DVF(-*), IX-SSA(-*), IX-SS-2G)

Configure communication audio message.
Communication Audio Messages: Send messages to destination station when beginning communication or by 
keypad input from the other station (IX-MV7-*) .

7.9.1 Start Communication

■Message
Description Select the message to be sent to destination station when beginning communication.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values None
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7.9.2 Code Received

Configure the message to be sent when the code is received. Four patterns can be set for the received code and 
message.

■Code

■Message

Description Set the code to play message by keypad input from IX-MV7-*.

Settings 1-20 digits

Default values -

Note

• Enter " Authentication Key " on the numerical keypad (if the Authentication Key is "0000" enter " 0000 ").

Description Set the code to play message by keypad input from IX-MV7-*.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values None
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7.10 Chime (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA)

Configure the chime tone to be played from this station linked with the set schedule.

7.10.1 Weekly Schedule

Configure the start time and chime tone to play for each day of the week, from Sunday to Saturday. 50 schedules can 
be set for each day.

How to configure a Weekly Schedule

1. Configure "Start Time" and "Chime" for each day of week.

2. When done, click [Update].

3. Click [OK].

■Start Time
Description Set the Time to ring Chime.

Settings 00:00 - 23:59

Default values -
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■Chime

How to delete a Weekly Schedule

1. Return the settings to their default values and click [Update].

2. Click [OK].

Description Set the sound for chime.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values None
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7.10.2 Daily Schedule

Configure the start time and the chime tone in units of one day.
A schedule one year from the set day can be configured. 50 schedules can be set for each day.

How to configure Daily Schedule

1. Select the day to set a schedule from "Calendar."

2. Configure "Start Time" and "Chime," and click [Add].

3. When done, click [Update].

4. Click [OK].

Calendar

Chime Schedule List
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■Start Time

■Chime

How to delete Daily Schedule

1. Select the day for which to delete a schedule from "Calendar."

2. Schedules for the selected day are displayed in the Chime "Set Schedule List."
• If a weekly schedule is configured for the selected day of the week, it will also be shown.

3. Click [Delete] for the schedule that you want to delete, and click [Update].
• Refer to “How to delete a Weekly Schedule (→page 492)” to delete a weekly schedule.

4. Click [OK].

Description Set the Time to ring Chime.

Settings 00:00 - 23:59

Default values -

Description Set the sound for chime.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values None
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7.11 CSR

Generate the signature request (CSR) submitted when a request is made to the Server Certificate Authority (CA)

How to generate a CSR

1. Input each item.

2. Click [Create].

3. Click [OK].
• Click [Cancel] to back to the Settings screen without generating the CSR.

4. Specify the save location and store your created file in it.
• The default file name is "CSR." This file name must be changed.

5. Click [OK].

■Country

■State/County/Region

Important

• To generate a signature request, “Association Settings (→page 160)” must have been completed on the station to generate 
the request, and the PC must be able to communicate with the system.

Description Set the country name.

Settings The two-letter code

Default values -

Description Set the State/County/Region.

Settings 1-128 alphanumeric characters

Default values -
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■City/Locality

■Organization

■Organizational Unit

■Common Name

Description Set the City/Locality.

Settings 1-128 alphanumeric characters

Default values -

Description Set the organization name.

Settings 1-128 alphanumeric characters

Default values -

Description Set the department name.

Settings 1-64 alphanumeric characters

Default values -

Description Set the common name.

Settings 1-64 alphanumeric characters

Default values The station's IP address is listed.
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7.12 SSL Certificate

Upload the Server Certificate received from the Certificate Authority (CA) as well as the CA certificate.

How to upload SSL Certificates

1. Click [Browse] in the Server Certificate to select a file.

2. If required, click [Browse] in the CA Certificate to select a file.

3. Click [Upload].

4. Click [OK], and upload the Server Certificate and CA Certificate files.
• When uploading is completed, the station will restart.
• Click [Cancel] to back to the Settings screen without uploading the file.

5. Click [OK].

Important

• To upload an SSL certificate, “Association Settings (→page 160)” must have been completed on the station, and the PC must 
be able to communicate with the system.

• When uploading the SSL certificate, restart the station. This may take approx. 10 minutes in total. The station will not function 
until complete.

• The server certificate must be uploaded when uploading a CA certificate.
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7.13 IEEE 802.1X (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Configure the settings for IEEE802.1X Authentication.

■ IEEE 802.1X

■EAP♠

■EAP User Name♠

■EAP Password♠

Important

• Authentication may be impossible if there is a time difference between the authentication server and station.

• Upload the certificate prior to configuration.

• To upload/delete an IEEE802.1X certificate, “Association Settings (→page 160)” must have been completed on the station to 
upload/delete, and the PC must be able to communicate with the system.

• When changes to IEEE802.1X settings are updated on the station, or after uploading a certificate, restart the station. Restart 
may take up to 10 minutes in total. The station will not operate until restart is complete.

Description Select Enable / Disable for IEEE802.1X function.

Settings • Enable
• Disable

Default values Disable

Description Select the EAP method for IEEE802.1X authentication when “IEEE 802.1X (→page 498)” is set 
to "Enable".

Settings • TLS
• PEAP

Default values TLS

Description Set the EAP User Name.

Settings 1 - 32 alphanumeric characters

Default values -

Description Set the EAP Password when "EAP" is set to "PEAP".

Settings 1 - 32 alphanumeric characters

Default values -
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How to upload IEEE802.1X certificates

1. Click [Browse] next to the Certificate Authority to select a file.

2. If “EAP♠ (→page 498)” is set to "TLS," click [Browse] next to the Client Certificate to select a file.

3. If "“EAP♠ (→page 498)”" is set to "TLS," click [Browse] next to Client Private Key to select a file.

4. Click [Upload].

5. Click [OK] and upload each file.
• When uploading is completed, the station will restart.
• Click [Cancel] to back to the Settings screen without uploading the file.

6. Click [OK].

How to delete IEEE802.1X certificates

1. Click [Delete] to delete the uploaded file.

2. Click [OK].

Note

• "EAP Password" is shown as "*****" in the Settings screen.
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7.14 Display Mode (for IX-MV7-*)

Configure IX-MV7-* Master UI Mode, for both Standard and Receptionist modes.

7.14.1 Master UI Mode

Description Set the User Interface Mode.

Settings • Standard: All functions can be used.
• Receptionist: Only outgoing call can be used. Refer to “Receptionist Mode (→page 502)”  for 

detail settings.

Default values Standard

Important

• When the "Master UI Mode" setting is applied to the station it will restart. This may take up to 10 minutes and the station 
cannot be used until it has finished restarting.
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7.14.2 Standard Mode

■Home Screen
Description Select the layout of top image when “Master UI Mode (→page 500)” is set to "Standard."

Settings • Option 1:

• Option 2:

Default values Option 1



502

System Settings (Station View)

7.14.3 Receptionist Mode

Configure Receptionist Mode screen if “Master UI Mode (→page 500)” was set to "Receptionist."

7.14.3.1 Color Scheme

Important

• In receptionist mode, the following operations are limited.

– Calling can only be done in the method configured in “Button Function (→page 508)”.

– Auto Answer is enabled even if “Auto Answer♠ (→page 431)” was set to "OFF." However, the call will not be received if 
“Reject Incoming Call (→page 509)” was set to "Enable."

– For "Option Input" - “Function (→page 437)”, only "Call" and "Turn LCD On" are valid.

Description Select the Color Scheme of Receptionist Mode.

Settings Example where "Layout 1" was set in “Screen Layout (→page 503)”
• Light:

• Dark:

Default values Light
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7.14.3.2 Screen Layout

Description Select the Screen Layout of top image for Receptionist Mode.

Settings Example where "Light" was set in “Color Scheme (→page 502)”
• Layout 1:

• Layout 2:

• Layout 3:

Default values Layout 1
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Customizing each screen layout

The layout of each characters screen's, images, and button displays can be customized.
The following spaces are customized by configuring “Company Information (→page 505)”“Greeting Information 
(→page 506)”“Images (→page 507)”“Button Function (→page 508)”.

Layout 1

Layout 2

Layout 3

“Company Information (→page 505)”

“Greeting Information (→page 506)”

“Receptionist Image (→page 507)”
Recommended resolution (W x H): 800 x 340

“Button 1 
(→page 508)”

“Button 2 
(→page 508)”

“Button 3 
(→page 508)”

“Button 4 
(→page 508)”

“Company Image (→page 507)”
Recommended resolution (W x H): 
800 x 100

“Greeting Image (→page 507)”
Recommended resolution (W x H): 
400 x 240

“Company Image (→page 507)”
Recommended resolution (W x H): 
460 x 80

“Company Information (→page 505)”

“Greeting Information (→page 506)”

“Greeting Image (→page 507)”
Recommended resolution (W x H):

400 x 240

“Button 1 (→page 508)”

“Button 2 (→page 508)”

“Button 3 (→page 508)”

“Button 4 (→page 508)”

“Receptionist Image (→page 507)”
Recommended resolution (W x H): 460 x 480

“Receptionist Image (→page 507)”
Recommended resolution (W x H): 800 x 120

“Company Image (→page 507)”
Recommended resolution (W x H): 400 x 120

“Company Information 
(→page 505)”

“Greeting Information (→page 506)”

“Button 1 (→page 508)”

“Button 2 (→page 508)”

“Button 3 (→page 508)”
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7.14.3.3 Company Information

■Name

■Text Size♦

■Bold

■Text Color

Description Enter the Company Information.

Settings 0-40 alphanumeric characters

Default values ̶

Description Set the text size of Company Information.

Settings 12 - 24 pt (by 1pt)

Default values 12pt

Description Select ON / OFF for Bold text.

Settings • OFF
• ON

Default values OFF

Description Set the text color of Company Information.

Settings • Option 1
"Black" if "Light" was set in “Color Scheme (→page 502)”. "White" if "Dark" was set.

• Option 2
"Blue" if “Color Scheme (→page 502)” was set to "Light." "Orange" if "Dark" was set.

Default values Option 1
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7.14.3.4 Greeting Information

■Greeting

■Text Size♦

■Bold

■Text Color

Description Enter Greeting text.

Settings 0-100 alphanumeric characters
(Up to 10 line breaks can be inserted.)

Default values -

Description Set the text size of Greeting.

Settings 12 - 70 pt (by 1 pt)

Default values 12pt

Description Select ON / OFF for Bold text.

Settings • OFF
• ON

Default values OFF

Description Set the text color of Company Information.

Settings • Option 1
"Black" if "Light" was set in “Color Scheme (→page 502)”. "Blue" if "Dark" was set.

• Option 2
"Blue" if “Color Scheme (→page 502)” was set to "Light." "Orange" if "Dark" was set.

Default values Option 1
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7.14.3.5 Images
Upload the image file to be shown on the reception screen. Upload an image file that matches the layout set in 
“Screen Layout (→page 503)”. Refer to “Customizing each screen layout (→page 504)” for the recommended 
resolution of the image file for each screen's layout.

■Company Image

■Greeting Image

■Receptionist Image

Description Register an image file to be displayed in Image Space 1.
Supported file format
• Message File Name: within 20 characters (excluding extension).
• File format: png
• Resolution

Width: 400 - 800 pixels
Height: 80 - 480 pixels

Settings Register: Click [Browse] to select a file.
Supported file format: png
Delete: Place a check in [Delete].

Default values -

Description Register an image file to be displayed in Image Space 2.
Supported file format
• Message File Name: within 20 characters (excluding extension).
• File format: png
• Resolution

Width: 400 - 800 pixels
Height: 80 - 480 pixels

Settings Register: Click [Browse] to select a file.
Delete: Place a check in [Delete].

Default values -

Description Register an image file to be displayed in Variable Space.
Supported file format
• Message File Name: within 20 characters (excluding extension).
• File format: png
• Resolution

Width: 400 - 800 pixels
Height: 80 - 480 pixels

Settings Register: Click [Browse] to select a file.
Delete: Place a check in [Delete].

Default values -
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7.14.3.6 Button Function
Configure the buttons to be shown on the reception screen and their function. Refer to “Customizing each screen 
layout (→page 504)” for configuration.

■Button 1

■Button 2

■Button 3

■Button 4

Description Set the function of Button 1.

Settings • Group Call: Call group number set by “Group Call Destination (→page 509)”.
• Select By Name: Select destination station by name.
• Select By List: Select destination station by list.
• Enter Number: Enter destination station number by keypad.
• Hide: Button is not displayed.

Default values Hide

Description Configure the function of Button 2.

Settings • Group Call: Call group number set by “Group Call Destination (→page 509)”.
• Select By Name: Select destination station by name.
• Select By List: Select destination station by list.
• Enter Number: Enter destination station number by keypad.
• Hide: Button is not displayed.

Default values Hide

Description Configure the function of Button 3.

Settings • Group Call: Call group number set by “Group Call Destination (→page 509)”.
• Select By Name: Select destination station by name.
• Select By List: Select destination station by list.
• Enter Number: Enter destination station number by keypad.
• Hide: Button is not displayed.

Default values Hide

Description Configure the function of Button 4.

Settings • Group Call: Call group number set by “Group Call Destination (→page 509)”.
• Select By Name: Select destination station by name.
• Select By List: Select destination station by list.
• Enter Number: Enter destination station number by keypad.
• Hide: Button is not displayed.

Default values Hide
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■Button Name for Group Call

■Button Name for Select By Name

■Button Name for Select By List

■Button Name for Enter Number

7.14.3.7 Group Call Destination

7.14.3.8 Reject Incoming Call

Description Configure the name of the button when "Group Call" is selected for "Button 1" through "Button 4." 
If there is more than one "Group Call" set, they share the name.

Settings 1-24 alphanumeric characters

Default values -

Description Configure the name of the button when "Select By Name" is selected for "Button 1" through 
"Button 4." If there is more than one "Select By Name" set, they share the name.

Settings 1-24 alphanumeric characters

Default values -

Description Configure the name of the button when "Select By List" is selected for "Button 1" through "Button 
4." If there is more than one "Select By List" set, they share the name.

Settings 1-24 alphanumeric characters

Default values -

Description Configure the name of the button when "Enter Number" is selected for "Button 1" through "Button 
4." If there is more than one "Enter Number" set, they share the name.

Settings 1-24 alphanumeric characters

Default values -

Description Configure the call destination group number when a button is pressed, if "Group Call" was 
selected for "Button 1" through "Button 4." If "Group Call" is set for multiple buttons, they will all 
share the same call destination group.
Enter the group number directly, or click [Open Group List] to choose a group.

Settings 01 - 99

Default values -

Description Select Enable / Disable for incoming calls in Receptionist Mode.

Settings • Enable: Do not receive incoming calls.
• Disable: Receive incoming calls.

Default values Disable
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7.15 Bathroom Link

This function cannot be used outside Japan.
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8. Transfer Settings

8.1 Absent Transfer (for IX-MV7-* and IX-MV)

Configure the settings for absent transfer.
Absent Transfer: If an incoming call is received during absent transfer, the incoming call can be automatically 
transferred to a transfer destination.
For IX-MV7-*

For IX-MV

■Absent Transfer

Important

• When an incoming call is received from a VoIP Phone, the call will be received without transferring even when transfer is set. 
To transfer the call, configure transferring on the IP-PBX.

• Stations in which “IP Address (→page 381)” has not been configured cannot be configured as transfer destinations.

Description Select Enable / Disable for Absent Transfer. The setting can also be changed with the button on 
the station.
If "Transfer Destination List" ("Transfer Destination" for IX-MV) is not configured, this cannot be 
set to "Enable."

Settings • Enable: Set absent transfer.
• Disable: Do not set absent transfer.

Default values Disable
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■Transfer Destination List (for IX-MV7-*)

■Transfer Destination (for IX-MV)

■Re-Transfer Destination (for IX-MV7-*)

Description Configure the transfer destination station (Number) for absent transfer. Up to 10 transfer 
destination stations can be configured. However, if the station making the outgoing call is IX-MV, 
IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*), the transfer will be made only to the station entered in 
"No.01."
Click [Open] to choose a station.
For IX-MV, a VoIP phone cannot be set as the transfer destination.

Settings -

Default values -

Important

• Do not configure multiple VoIP Phone. If multiple VoIP Phone are configured, calls will be transferred to only one VoIP Phone.

Description Configure the transfer destination station (number) for absent transfer. Only one transfer 
destination station can be configured.
Enter Number directly, or click [Open] to choose a station.

Settings 3-5 digits

Default values -

Description Configure the transfer destination station (number) for absent re-transfer for a transferred call. 
Only a single station can be configured as the transfer destination. However, if the station 
making the outgoing call is IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*), the call will be 
received without transferring it again.
Enter Number directly, or click [Open] to choose a station.

Settings 3-32 digits

Default values -
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8.2 Delay Transfer (for IX-MV7-* and IX-MV)

Configure the settings for delay transfer.
Delay Transfer: A call can be automatically transferred to another station after a certain period of time (delay time) 
elapses.
For IX-MV7-*

For IX-MV

■Delay Transfer

Important

• When an incoming call is received from a VoIP Phone, the call will be received without transferring even when transfer is set. 
To transfer the call, configure transferring on the IP-PBX.

• Stations in which “IP Address (→page 381)” has not been configured cannot be configured as transfer destinations.

Description Select Enable / Disable for Delay Transfer.
To enable Delay Transfer, set transfer or re-transfer destination.
If "Transfer Destination List" ("Transfer Destination" for IX-MV) is not configured, this cannot be 
set to "Enable."

Settings • Enable: Delay transfer enabled.
• Disable: Delay transfer disabled.

Default values Disable
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■Delay Time [sec]♦

■Transfer Destination List (for IX-MV7-*)

■Transfer Destination (for IX-MV)

■Re-Transfer Destination (for IX-MV7-*)

Description Set the delay time between receiving and transferring a call.

Settings 1-300 sec (by 1 sec)

Default values 30 sec

Description Configure the transfer destination station (Number) for delay transfer. Up to 10 transfer 
destination stations can be configured. However, if the station making the outgoing call is IX-MV, 
IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*) the transfer will be made only to the station entered in 
"No.01."
Click [Open] to choose a station.
For IX-MV, a VoIP phone cannot be set as the transfer destination.

Settings -

Default values -

Important

• Do not configure multiple VoIP Phone. If multiple VoIP Phone are configured, calls will be transferred to only one VoIP Phone.

Description Configure the transfer destination station (number) for delay transfer. Only one transfer 
destination station can be configured.
Enter Number directly, or click [Open] to choose a station.

Settings 3-5 digits

Default values -

Description Configure the transfer destination station (number) for delay re-transfer for a transferred call. 
Only a single station can be configured as the transfer destination. However, if the station 
making the outgoing call is IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*), the call will be 
received without transferring it again.
Enter Number directly, or click [Open] to choose a station.

Settings 3-32 digits

Default values -
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8.3 Schedule Transfer (for IX-MV7-* and IX-MV)

Configure the settings for Schedule Transfer.
Schedule Transfer: A call can be automatically transferred to another station when a call comes in during the time 
period set up in “Weekly Schedule (→page 515)” and “Daily Schedule (for IX-MV7-*) (→page 517)”.

■Schedule Transfer

8.3.1 Weekly Schedule

Configure the transfer destination and transfer time for every day from Sunday through Saturday.
For IX-MV7-*, up to 12 schedules can be set for each day, and for the IX-MV, one schedule can be set for each day.
For IX-MV7-*

For IX-MV

How to configure the Weekly Schedule

1. IX-MV7-*: Configure the "Transfer Destination," "Re-Transfer Destination," "Start Time," and "End 
Time" for each day of the week.

Important

• When an incoming call is received from a VoIP Phone, the call will be received without transferring even when transfer is set. 
To transfer the call, configure transferring on the IP-PBX.

• Stations in which “IP Address (→page 381)” has not been configured cannot be configured as transfer destinations.

• Incoming calls will be transferred during the time period set in "Schedule Transfer," regardless of what was set in “Absent 
Transfer (for IX-MV7-* and IX-MV) (→page 511)” and “Delay Transfer (for IX-MV7-* and IX-MV) (→page 513)”.

Description Select Enable / Disable for Schedule Transfer.
To enable Schedule Transfer, set transfer or re-transfer destination.
If “Weekly Schedule (→page 515)” or “Daily Schedule (for IX-MV7-*) (→page 517)” is not 
configured, this cannot be set to "Enable."

Settings • Enable: Schedule transfer enabled.
• Disable: Schedule transfer disabled.

Default values Disable
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IX-MV: Configure "Transfer Destination," and "Start Time" and "End Time" for each day of week.

2. When done, click [Update].

3. Click [OK].

■Transfer Destination

■Re-Transfer Destination (for IX-MV7-*)

■Start Time

■End Time

How to delete the Weekly Schedule

1. Return the settings to their default values and click [Update].

2. Click [OK].

Description Configure the transfer destination station (Number) for a scheduled transfer.
• IX-MV7-*: Up to 10 transfer destination stations can be configured for each of the 12 

schedules, and for each day of the week. However, if the station making the outgoing call is an 
IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*), the transfer will only be made to the station 
entered in "No.01."

• IX-MV: Only a single transfer destination station can be set for each day of the week. A VoIP 
phone cannot be set as the transfer destination.

Enter Number manually, or click [Open] to choose a station.

Settings IX-MV7-*: 3-32 digits
IX-MV: 3-5 digits

Default values -

Important

• Do not configure multiple VoIP Phone. If multiple VoIP Phone are configured, calls will be transferred to only one VoIP Phone.

Description Configure the transfer destination when performing a schedule transfer again for a transferred 
call. Only a single station can be configured as the transfer destination for each of the 12 
schedules for each day of the week. However, if the station making the outgoing call is IX-MV, 
IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*), the call will be received without transferring it again.
Enter Number manually, or click [Open] to choose a station.

Settings 3-32 digits

Default values -

Description Set the Start Time to enable schedule transfer.

Settings 00:00 - 23:59

Default values -

Description Set the End Time to disable schedule transfer.

Settings 00:00 - 23:59

Default values -
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8.3.2 Daily Schedule (for IX-MV7-*)

Configure the transfer destination and time for each individual day.
A schedule one year from the set day can be configured. 12 schedules can be set for each day.

How to configure Daily Schedule

1. Select the day to configure a schedule from "Calendar."

2. Configure "Transfer Destination," "Re-Transfer Destination," "Start Time," and "End Time," and click 
[Add].

3. When done, click [Update].

4. Click [OK].

■Transfer Destination
Description Configure the transfer destination station (Number) for schedule transfer. Up to 10 transfer 

destination stations can be configured for each of the 12 schedules for each day of the week. 
However, if the station making the outgoing call is IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*), 
he transfer will be made only to the station entered in "No.01."
Click [Open] to choose a station.

Settings -

Default values -

Important

• Do not configure multiple VoIP Phone. If multiple VoIP Phone are configured, calls will be transferred to only one VoIP Phone.

Calendar

List of Configured Schedules
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■Re-Transfer Destination

■Start Time

■End Time

How to delete Daily Schedule

1. Select the day to delete a schedule from "Calendar."

2. Schedules for the selected day are displayed in the "Set Schedule List."
• If a weekly schedule is configured for the selected day of the week, it will also be shown.

3. Click [Delete] for the schedule to delete, and click [Update].
• Refer to “How to delete the Weekly Schedule (→page 516)” to delete a weekly schedule.

4. Click [OK].

8.4 Lock Transfer (for IX-MV7-*)

Description Configure the transfer destination station (Number) when performing schedule transfer again for 
a transferred call. Only a single station can be configured as the transfer destination for each of 
the 12 schedules on each day. However, if the station making the outgoing call is IX-MV, IX-DA, 
IX-DF(-*), IX-BA, and IX-SS(-*), the call will be received without transferring it again.
Enter Number directly, or click [Open] to choose a station.

Settings 3-32 digits

Default values -

Description Set the Start Time to enable schedule transfer.

Settings 00:00 - 23:59

Default values -

Description Set the End Time to disable schedule transfer. If this is set earlier than "Start Time," End Time 
will be for the following day.

Settings 00:00 - 23:59

Default values -

Description Select ON / OFF to Lock Transfer function. When set to "ON", transfer function cannot be 
changed by user account.

Settings • ON: Cannot be configured with user privileges.
• OFF: Can be configured with user privileges.

Default values OFF
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9. Station Settings

9.1 Speed Dials / Favorites (for IX-MV7-* and IX-MV)

Configure the Speed Dial button settings for IX-MV7-* and IX-MV.

9.1.1 Advanced Speed Dial Button Settings

Select the functions to assign to each Speed Dial button.
Up to eight Speed Dial buttons can be set for IX-MV7-*, and six for IX-MV.

How to configure the Speed Dial buttons

1. Select the Speed Dial button to configure in "Speed Dial #."
• The settings of the selected Speed Dial button are displayed.

2. Configure each item.

3. When done, click [Update].

4. Click [OK].
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9.1.1.1 Speed Dial Name (for IX-MV7-*)

9.1.1.2 Function

How to configure Individual Call
Configure this if "Individual Call" is set in “Function (→page 520)”.

■Number

■Priority

Description Set the Speed Dial Name.

Settings 1-24 alphanumeric characters
The entire name may not be shown on the station screen, depending on the number of 
characters.

Default values -

Important

• Enter button names in the language configure in “Language (→page 158)”. However, if the language displayed on the screen 
for IX-MV7-* differs from that set in "Language," characters on the station screen may appear incorrectly. To avoid this, enter 
information using alphabetical characters only.

Description Set the Speed Dial Function. Refer to “How to configure Individual Call (→page 520)” for how to 
configure detailed functions.

Settings • No Function
• Individual Call: Call individual station set in "Individual Call".
• Group Call: Call group set in "Group Call".
• Group Page: Page group set in "Group Page".
• All Page: Page all stations.
• Group Message Page (For IX-MV7-*): Page message to group set in "Group Message Page".
• All Message Page (For IX-MV7-*): Page message to all stations..
• Monitor (For IX-MV7-*): Monitor station set in "Monitor".
• Network Camera Monitor (For IX-MV7-*): Monitor network camera set in "Network Camera 

Monitor".
• Scan Monitor (For IX-MV7-*): Start scan monitor sequence set in "Station Settings - Monitor".
• Option Relay Control (For IX-MV7-*): Relay Control set in "Option Relay Control". Relay output 

will not be controlled for IX-MV, IX-DA, IX-DF(-*), IX-BA, and IX-SS(-*).

Default values No Function

Description Set the destination station.
Enter the Station Number or click [Open] to choose one. This cannot be configured for IXW-MA.

Settings 3-32 digits

Default values -

Important

• Stations in which the “IP Address (→page 381)” has not been configured cannot be configured as destinations.

Description Set the Priority for the individual calls.

Settings • Normal
• Priority
• Urgent

Default values -
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How to configure Group Call
Configure if "Group Call" is set in “Function (→page 520)”.

■Group Number

■Priority

How to configure Group Page
Configure if "Group Page" is set in “Function (→page 520)”.

■Group Number

■Priority

How to configure All Page
Configure if "All Page" is set in “Function (→page 520)”.

■Priority

How to configure Group Message Page (for IX-MV7-*)
Configure if "Group Message Page" is set in “Function (→page 520)”.

■Group Number

Description Set the destination group.
Enter the group number directly, or click [Open] to choose a group.

Settings 01 - 99

Default values -

Description Set the priority of Group call.

Settings • Normal
• Priority
• Urgent

Default values -

Description Set the destination group.
Enter the group number directly, or click [Open] to choose a group.

Settings 01 - 99

Default values -

Description Set the priority of group page.

Settings • Normal
• Urgent

Default values -

Description Set the priority of all page.

Settings • Normal
• Urgent

Default values -

Description Set the destination group.
Enter the group number directly, or click [Open] to choose a group.

Settings 01 - 99

Default values -
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■Message

■Priority

■Play Count [time(s)]

Description Select the message (audio file) to send during group message paging.

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))

Description Set the priority of group message page.

Settings • Normal
• Urgent

Default values -

Description Set the message play count of group message page.

Settings 1 - 20 times

Default values -



523

System Settings (Station View)

How to configure All Message Page (for IX-MV7-*)
Configure if "All Message Page" is set in “Function (→page 520)”.

■Message

■Priority

■Play Count [time(s)]

How to configure Monitor (for IX-MV7-*)
Configure if "Monitor" is set in “Function (→page 520)”.

■Number

Description Select the message (audio file) to send during all message paging.

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))

Description Set the priority of all message page.

Settings • Normal
• Urgent

Default values -

Description Set the message play count of all message page.

Settings 1 - 20 times

Default values -

Description Set the destination station.
Enter the Station Number or click [Open] to choose one. This cannot be configured for IX-MV7-
*, IX-MV, IXW-MA or VoIP Phone.

Settings 3-5 digits

Default values -

Important

• Stations in which “IP Address (→page 381)” has not been configured cannot be configured to be monitored.
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How to configure Network Camera Monitor (for IX-MV7-*)
Configure if "Network Camera Monitor" is set in “Function (→page 520)”.

■Network Camera

How to configure Option Relay Control (for IX-MV7-*)
Configure if "Option Relay Control" is set in “Function (→page 520)”.

■Station List

■Output Time

■TLS

Description Set the destination Network Camera.
Enter the number of the network camera set in “Network Camera List (→page 409)” or click 
[Network camera selection] to choose one.

Settings 001 - 050

Default values -

Note

• When controlling relay output on multiple stations, processing may take some time and control may be delayed.

Description Configure the station to control relay output. This cannot be configured for IX-MV, IX-DA, IX-DF(-
*), IX-BA, IX-SS(-*).
Click [Open] to choose a station. Multiple stations (infinite) can be selected.

Settings The selected station is displayed.

Default values -

Important

• Stations that the "IP Address" has not been configured cannot be configured as stations to perform control.

Description Select the Output Time Range for relay output, and set the Output Time within the range.

Settings • 0 (Momentary): Start Relay Output by pressing a Speed Dial button. Stop Relay Output by 
pressing again the Speed Dial button.
Pressing the Speed Dial button again will stop relay output.

• 200-2000 [msec]: Select this when configuring a value from 200 to 2000 msec (by 200 msec). 
Enter the time in "Output Time [msec / sec]♦."

• 3-600 sec: Select this when configuring a value from 3 to 600 sec (by 1 sec). Enter the time in 
"Output Time [msec / sec]♦."

Default values 0 (Momentary)

Description Select Enable / Disable for TLS. When "Enable" is selected, set "Option Relay Control Key" and 
Relay Output" - “Option Relay Control Authentication Key (except IX-MV, IX-DA, IX-DF(-*), and 
IX-BA, IX-SS(-*)) (→page 449)”.

Settings • Enable
• Disable

Default values Disable

Important

• If "TLS" is set to "Enable," this may take some time if there are multiple stations to control.
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■Option Relay Control Key

9.1.1.3 Lock (for IX-MV7-*)

Description Set the Option Relay Control Key.
When matched with the Option Relay Control Authentication Key in " Relay Output" - “Option 
Relay Control Authentication Key (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*)) 
(→page 449)” , the relay output will activate.

Settings 1-20 digits

Default values -

Description Select ON / OFF to Lock Speed Dial setting. Once set to "ON", Speed Dial function cannot be 
changed by user account.

Settings • ON
• OFF

Default values OFF
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9.2 Privacy (for IX-MV7-* and IX-MV)

Configure to prevent the other station from hearing/viewing audio or camera images, when “Auto Answer♠ 
(→page 431)” is set to "ON."

■Privacy♠
Description Select Enable / Disable for Privacy function. The setting can also be changed on the station.

Settings • Enable
• Disable

Default values Disable
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9.3 Volume / Tone (except IXW-MA)

Configure the sound settings, such as volume and ringtone.

9.3.1 Volume

■Handset Transmit (for IX-MV7-*, IX-RS-*, and IX-MV)

■Handset Receive (for IX-MV7-*, IX-RS-*, and IX-MV)

■Hands-free Transmit (for IX-MV7-*, IX-RS-*, and IX-MV)

■Hands-free Receive (for IX-MV7-*, IX-RS-*, and IX-MV)

■Headset Jack Transmit (for IX-MV7-*)

Description Set the transmit volume using handset while communicating and paging.

Settings 1 (Low) - 10 (High)

Default values 10

Description Set the receive volume using handset while communicating. Also sets ringback tone volume.

Settings 1 (Low) - 10 (High)

Default values 6

Description Set the hands-free transmit volume while communicating and paging.

Settings 1 (Low) - 10 (High)

Default values 10

Description Set the hands-free receive volume while communicating and paging. Also sets ringback tone 
volume.

Settings 1 (Low) - 10 (High)

Default values • IX-MV7-*, IX-MV: 6
• IX-RS-*: 10

Description Set the transmit volume using headset jack.

Settings 1 (Low) - 10 (High)

Default values 10
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■Headset Jack Receive (for IX-MV7-*)

■Transmit (except IX-MV7-*, IX-RS-*, and IX-MV)

■Receive (except IX-MV7-*, IX-RS-*, IX-MV, IX-DV, IX-DVF(-*), IX-SSA(-*))

■Receive (for IX-DV, IX-DVF(-*), IX-SSA(-*))

■External Input

■External Output (for IX-RS-*)

■VoIP Phone Volume Adjustment (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

■Ringtone

Description Set the receive volume using the headset jack.

Settings 1 (Low) - 10 (High)

Default values 6

Description Set the transmit volume while communicating and being monitored.

Settings 1 (Low) - 10 (High)

Default values 10

Description Set the receive volume while communicating and paging. This sets the Ringback Tone volume, 
as well.

Settings 1 (Low) - 10 (High)

Default values 10

Description Select the receive volume while communicating. Also sets ringback tone. The calling tone 
volume will be changed as well.

Settings 1 (Low) - 10 (High)

Default values 6

Description Not used.

Description Select the transmit volume when using the external output.

Settings 1 (Low) - 10 (High)

Default values 6

Description Select the volume adjustment between VoIP Phone and IX stations.

Settings • -12dB from VoIP, +12dB to VoIP
• -6dB from VoIP, +6dB to VoIP
• No Adjustment
• +6dB from VoIP, -6dB to VoIP
• +12dB from VoIP, -12dB to VoIP

Default values No Adjustment

Description Select the volume for Ringtone and Paging Pretone.

Settings 0 (Off), 1 (Low) - 10 (High)

Default values • IX-MV7-*, IX-MV, IX-DV, IX-DVF(-*), IX-SSA(-*): 6
• IX-SS-2G, IX-RS-*, IX-DA, IX-BA, IX-SS(-*): 10
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■Paging (for IX-DV, IX-DVF(-*), IX-SSA(-*))

■Button Feedback (for IX-MV7-* and IX-MV)

9.3.2 Tone

■Communication Timeout Notification (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠

Description Set the volume while receiving page.

Settings 0 (Off), 1 (Low) - 10 (High)

Default values 6

Description Select Enable / Disable for Button Feedback tone.

Settings • Enable
• Disable

Default values • IX-MV7-*: Enable
• IX-MV: Disable

Description Select the tone to be played when an outgoing call times out.

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Error
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■Communication End Pretone (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠

■Call Queue Notification (for IX-MV7-*)♠

Description Select the tone to be played 10 sec before communication, paging or monitoring ends.

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Communication End Pretone

Description Select the tone to be played when receiving a call while communicating.

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Call Queue Notification
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■Paging Pretone (for IX-MV7-* and IX-MV) ♠

■Auto Answer Tone (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠

Description Select the sound to be played when placing or receiving a page.

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Pre Tone 2

Important

• Configure the paging pretone with a longer duration than the paging pretone of the station receiving the page. Configuring a 
shorter tone might prevent audio from playing on the other station when paging starts. Configure the same tone as that of other 
IX-MV7-* andIX-MV stations in the system.

Description Select the tone to be played.
• Ringtone when receiving an individual call. “Auto Answer♠ (→page 431)” must be set to "ON".
• Ringback tone when placing an individual call. “Auto Answer♠ (→page 431)” must be set to 

"ON" at the destination station. (for IX-MV7-*)

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Pre Tone 1
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■On Hold (for IX-MV7-*)♠

■Key Received (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))♠

Description Select the tone to be played while On-Hold.

Settings • None (except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone (Busy Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• On Hold
• Operation Sound
• Error (Error Tone for IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 1(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 2(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Pre Tone 3(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Communication End Pretone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Call Queue Notification(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Waiting Reply Tone(Except IX-DA, IX-DF(-*), IX-BA, IX-SS(-*))
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values On Hold

Description Configure the tone to send to the destination station when the door release key entered using a 
keypad on the destination station (station performing a door release operation) matches the 
authentication key of this station (station connected to the electrical lock). The tone will be heard 
on the destination station.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values None



533

System Settings (Station View)

■Error (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠

■Mic Select

■Headset Specification (for IX-MV7-*)

■Audio Output (for Master) (for IX-MV7-*)

Description Select the tone to be played when error has occurred.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values Error

Description Not used.

Description Set the device to be connected to the headset jack.

Settings • Mic Device
• Headset Device

Default values Mic Device

Description Set using External speaker for Ringtone, Paging Pretone and Paging.

Settings • External speaker output for Ringtone, Built-in Speaker for Communication
• External speaker output for Page Pretone, Built-in Speaker for Paging
• External speaker output for Ringtone, Paging Pretone and Paging, Built-in Speaker for 

Communication

Default values External speaker output for Ringtone, Built-in Speaker for Communication

Note

• The tone will play from the speaker of the station even if audio is heard from the external speaker.
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■Audio Output (for Door) (except IX-MV7-*, IX-SS-2G, and IX-MV)

Description Set using Line Audio / External Speaker or Built-in Speaker while communicating and paging.

Settings • Built-in Speaker for Communication and Paging
• Line Audio Output for Communication and Paging (External speaker output for 

Communication and Paging for IX-RS-*)
• Built-in Speaker for Communication, Line Audio Output for Paging (External speaker output for 

Communication and Paging for IX-RS-*)

Default values Built-in Speaker for Communication and Paging
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9.4 Communication (except IXW-MA)

Configure the settings for a call.

■Talk Timeout [sec]♦♠

■Communication Start Tone (except IX-MV7-*, IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))♠

■Force Touch-to-Talk (for IX-MV7-* and IX-MV)

Description Set the communication timer when placing a call. Communication timer when receiving a call is 
set at the destination station.

Settings • 30-600 sec: Configure between 30 to 600 sec (by 1 sec).
• Infinite (Except IX-MV): No timeout.

Default values 60 sec

Important

• During a communication with a VoIP phone, this will be the shorter time of the time set for "Talk Timeout [sec]" and the call 
duration set on the VoIP phone.

Description Select the tone to be played when communication starts.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values None

Description Select Enable / Disable for Force Touch-to-Talk (Or Press-to-Talk) when starting communication 
in hands-free mode.

Settings • Enable
• Disable

Default values Disable
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9.5 Monitor (except IXW-MA, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

Configure the settings for the monitor function.

9.5.1 Monitor Timeout [sec] (for IX-MV7-* and IX-MV) ♦♠

9.5.2 Scan Monitor (for IX-MV7-*)

Configure monitoring by automatically switching between several stations (except IX-MV7-* and IX-MV) and network 
cameras at set intervals. The scan will be performed in registration order.

■Type

■Number

Important

• Monitoring cannot be performed for IX-MV7-*, IX-MV, or VoIP phones.

Description Set the monitoring timer by station. Scan Monitor must be end manually.

Settings • Infinite (For IX-MV7-*): No timeout.
• 10-600 sec: Set 10-600 sec by 1 sec.

Default values 60 sec

Description Select the Station Type.

Settings • IX Station
• Network Camera

Default values -

Description Set the Station Number.
Enter the Number or click [Open] to choose one. This cannot be selected for IX-MV7-*, IX-MV, 
IXW-MA or VoIP Phone.

Settings 3-5 digits

Default values -
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■Network Camera Number

■Dwell Time

9.5.3 Prevent Being Monitored (except IX-MV7-* and IX-MV) 

9.5.4 Monitored Notification (except IX-MV7-* and IX-MV) ♠

Important

• Stations in which “IP Address (→page 381)” has not been configured cannot be configured to be monitored.

Description Set the Network Camera Number.
Enter the number of the network camera set in “Network Camera List (→page 409)” or click 
[Network camera selection] to choose one.

Settings Select from the network cameras registered in “Network Camera List (→page 409)”.

Default values -

Description Set the dwell time to change destination for scan monitor.

Settings • 5 sec
• 10 sec
• 30 sec

Default values 5 sec

Description Select ON / OFF to prevent being monitored.

Settings • ON: Prevent being monitored.
• OFF: Allow monitoring

Default values OFF

Description Select the tone to be played when monitored by another station.

Settings • None
• Call Pattern 1
• Call Pattern 2
• Call Pattern 3
• Call Pattern 4
• Call Pattern 5
• Call Pattern 6
• Tremolo Sound
• Busy Response Tone
• On Hold
• Operation Sound
• Error
• Pre Tone 1
• Pre Tone 2
• Pre Tone 3
• Communication End Pretone
• Call Queue Notification
• Waiting Reply Tone
• Select a sound that is registered in “Custom Sound Registry (except IXW-MA) (→page 416)”.

Default values None



538

System Settings (Station View)

9.5.5 Monitored LED Notification (except IX-MV7-* and IX-MV) 

Description Select ON / OFF for status LED notification (Blue flashing) while being monitored by another 
station.

Settings • ON
• OFF

Default values OFF
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9.6 Master Station Display (for IX-MV7-* and IX-MV)

Configure screen display-related settings.

■Brightness

■Primary Video Source (for IX-MV7-*)

■Aspect Ratio (for IX-MV7-*)

■Time Format (for IX-MV)♠

■Standby LED State♠

Description Set the Brightness of Master station display.

Settings 1 (Dark) - 10 (Bright)

Default values 6

Description Select the primary video source when showing 2 video stream simultaneously.

Settings • IX Station
• Network Camera

Default values IX Station

Description Select the video aspect for primary video source.

Settings • 16:9
• 4:3

Default values 16:9

Description Select the Time format.

Settings • mm/dd/yyyy (12h)
• mm/dd/yyyy (24h)
• dd/mm/yyyy (12h)
• dd/mm/yyyy (24h)
• yyyy/mm/dd (12h)
• yyyy/mm/dd (24h)

Default values mm/dd/yyyy (12h)

Description Select ON / OFF for stand by status LED.

Settings • ON
• OFF

Default values ON
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■Keypad (for IX-MV7-*)

Description Select ON / OFF for display Keypad to use for door release or playing location message.

Settings • ON
• OFF

Default values ON
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9.7 Camera (for IX-DV, IX-DVF(-*), IX-DA, IX-DF(-*))

Configure camera settings.

9.7.1 Adjustment

■Backlight Compensation♠

■Low Light Sensitivity♠

9.7.2 Color Settings (for IX-DA, IX-DF(-*))

■Brightness♦

■Contrast♦

Description During an outgoing call or monitoring, video with backlight compensation adjustment will be sent 
to the destination station.
The adjustment can be removed through operation by the destination station.

Settings • Enable
• Disable

Default values Disable

Description Send an image that low light sensitivity compensation was performed to the other station, when 
an outgoing call is made or the station is being monitored and the surrounding area is dark (such 
as at night). The compensation can be removed on the other station.

Settings • Enable
• Disable

Default values Disable

Important

• If these settings are changed while video is displayed, the changes will not be reflected until the video is accessed again.

Description Set the Brightness for camera setting.

Settings 1 (Dark) to 100 (Bright)

Default values 50

Description Set the Contrast for camera setting.

Settings 1 (Weak) - 100 (Strong)

Default values 15
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■Color♦

9.7.3 White LED

■Call / Communication♠

■Monitored♠

Description Set the Contrast for camera setting.

Settings 1 (Weak) to 100 (Strong)

Default values 50

Description Select Enable / Disable for white LED while calling or communicating in low light situation.

Settings • Enable
• Disable

Default values Enable

Description Select Enable / Disable for white LED while being monitored in low light situation.

Settings • Enable
• Disable

Default values Disable
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9.8 Door Release Assignment (for IX-RS-*)

Configure the connected station and door release key for door release during a call.
Configure each station for each group configured in “Called Stations (Door/Sub Stations) (except IX-MV7-*, IX-MV, 
and IXW-MA) (→page 419)”.

How to configure Door Release Assignment

1. Select the group number to configure from "Number."
• Settings for the selected group number will be shown.

2. Configure each item.

3. When done, click [Update].

4. Click [OK].

■Contact Assignment

■Authentication Key

Description Select which relay output will be used for door release during call.

Settings • Originating Station: Use origination station relay output for door release.
• Destination Station: Use destination station relay output for door release.

Default values Destination Station

Description When "Destination Station" is selected in "Contact Assignment," set the Authentication Key for 
door release.
Authentication key must match with the destination station's authentication key, which is set in 
"Relay Output" - “Door Release Authorization (except IXW-MA) (→page 443)” to allow door 
release.

Settings 1-20 digits

Default values Random characters (compatible with default value of "Relay Output" - "Door Release 
Authorization")
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■Door Release by IX-RS

Note

• If “Create new system/import setting data (→page 123)” - "Automatically configure door release for all stations?" was set to 
"OFF," the default value for "Authentication Key" will not be set.

• The default values for the authentication key and door release key vary depending on the station type set in “Create new 
system/import setting data (→page 123)” - "IX Support Tool Settings."

– IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) not configured: 20 digits.

– IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) configured: 4 digits

Description Select Enable / Disable for door release by IX-RS.

Settings • Enable
• Disable

Default values Disable
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9.9 Line Supervision (for IX-MV7-*)

Configure settings related to Line Supervision and Device Check performed by IX-MV7-*.
Monitor a station other than a VoIP phone registered in “Station List (→page 406)”.

■Line Supervision Interval

■Line Supervision Schedule

■Device Check Interval

■Device Check Schedule

Description Set the Line Supervision test interval.

Settings • OFF
• 15sec
• 20 min
• 30 min
• 60 min
• Daily
• Weekly: Select from the day of week drop-down list

Default values OFF

Description Set the time when automatic line monitoring starts.
Set the time when is set to "Daily" or "Weekly" is selected in “Line Supervision Interval 
(→page 545)”.

Settings 00:00 - 23:59

Default values 00:00

Description Set the Line Supervision test interval.

Settings • OFF
• 10 min
• 20 min
• 30 min
• 60 min
• 1 day
• Weekly: Select from the day of week drop-down list

Default values OFF

Description Set the time when automatic failure monitoring starts.
Set the time when "1 day" or "Daily" is selected in “Device Check Interval (→page 545)”.

Settings 00:00 - 23:59

Default values 00:00
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10. Maintenance

10.1 Firmware Update

Access our website at "http://www.aiphone.net/" to download the latest version of the firmware.

How to update the firmware

1. Click [Browse] and select the firmware file to be downloaded.

2. Click [Firmware Update].

3. Click [OK].
• Click [Cancel] to back to the "Firmware Update" screen without updating the firmware.

4. Click [OK].

Important

• To update the firmware, “Association Settings (→page 160)” must have been performed on the station to update, and the PC 
must be able to communicate with the system.

• If the firmware update is started while the station is operating (such as on a call), the operation will end and the firmware 
update will begin.

• If power is turned off while updating the firmware, the station may malfunction.

• The station will be inoperable while updating the firmware.

• When the firmware is updated, the station will be automatically restarted.

Note

• If updating fails, repeat the procedure.

https://www.aiphone.net/product/
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10.2 Initialization

When initializing the station, all settings go back to the default values, and the system log and incoming/outgoing call 
history are erased.
Stations are also deleted from the settings in IX Support Tool.

How to initialize

1. Click [Initialization] or [Initialize User Settings].
• Initialization: All settings will revert to their default values. The system log, outgoing/incoming call history, and 

recorded video/audio data on the microSD card will be cleared.
• Initialize User Settings: Only the content of general user accounts are initialized.

2. Click [OK].
• Click [Cancel] to cancel the initialization.

3. Click [OK].

Important

• After selecting [Initialization], the station will restart. This may take approx. 10 minutes in total. The station will not operate 
until the restart is complete.

• If initialization fails, the message "Error: Station initialization failed." will appear. If this happens, perform initialization again.
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10.3 Settings File Backup

Download/upload setting files.

10.3.1 Setting File Download

Download the setting file from the station and back it up.

Click [Setting File Download]. The Setting File Download window will be shown.

How to download setting files

1. Select the station to download the setting file from "Station List" (multiple selections allowed).
• To select or unselect stations in a batch, choose the station type for a batch selection and click[Select] or 

[Unselect].
• Stations for which “Association Settings (→page 160)” has not been performed cannot be selected.

Important

• Setting files are downloaded via “Association Settings (→page 160)” on the downloading station. Files cannot be downloaded 
unless the PC can communicate with the system.

• When first configuring settings using a web browser, or when changing the configuration using a web browser after configuring 
settings using IX Support Tool, it may not be possible to download the setting files. In this case, download the setting files 
using a browser.

1

2
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2. Download the file.
[Settings]: Download only the setting file.
[Sounds]: Download the setting file and audio file for a custom tone.
[Image] (for IX-MV7-*): Download the setting file and image file for the image on the reception screen.
[Schedule] (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA): Download schedule setting files 
(for transfer, etc.). Schedules for IX-MV, IX-DA, IX-DF(-*), or IX-BA, IX-SS(-*) are downloaded from [Settings].

3. Click [OK].
• Click [Cancel] to return to the "Setting File Download" window without downloading.

4. Click [OK].
• The file download result is displayed in "Station List" - "Status."

In Process: The file is in the process of downloading.
Success: Download is completed.
Failed: Download failed. Try downloading again.
Unavailable: This is displayed when a file that cannot be uploaded to a station is selected to download in 
Step 2.

• Downloaded files are saved as follows in "aiphone" - "AIPHONE_IX_SupportTool" - "SystemData" within the 
folder specified during installation.
– Setting file: "NewIXSystem(Set System Name).db"
– Sound file: Saved as a WAV file inside "(Set System Name)" - "Setting (Hidden Folder)" - "(Station 

Number)"
– Image file: Saved as a PNG file inside "(Set System Name)" - "Setting (Hidden Folder)" - "(Station 

Number)"
– Schedule file: Saved inside "(Set System Name)" - "Setting (Hidden Folder)" - "(Station Number)" as 

"SCHED_CHIME.txt," "SCHED_GROUP.txt," "SCHED_OUTPUT.txt," "SCHED_TRANSFER.txt," or 
"SCHED_REC.txt" (the saved content differs depending on the station).
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10.3.2 Setting File Upload

Upload setting files to a station.

Click [Setting File Upload] and the Setting File Upload window will be shown.

How to upload setting files

1. Select the station(s) to upload the setting file to from the "Station List."
• To select or unselect stations in a batch, choose the station type and click[Select] or [Unselect].
• Stations that have not been associated cannot be selected. 

Important

• Setting files can only be uploaded to stations that have been associated “Association Settings (→page 160)”. They cannot be 
uploaded unless the PC can communicate with the system.

• If a custom tone/image was registered, be sure to upload each file to the station in "Sounds" - "Image."
The following will occur if only the setting file is uploaded.

– The default tone will play when the operation that the custom tone was set is performed.

– Images will not be displayed in receptionist mode.

– "Download Settings From Station" will fail.

– "Restore System Settings" will fail.

1

2
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2. Upload the file.
[Settings]: Upload only the setting file.
[Sounds]: Upload the setting file and audio file for a custom tone.
[Image] (for IX-MV7-*): Upload the setting file and image file for the image on the reception screen.
[Schedule] (except IX-MV, IX-DA, IX-DF(-*), IX-BA, IX-SS(-*), and IXW-MA): Upload the schedule setting files 
(transfer, etc.). Schedules for IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*) are uploaded from [Settings].

3. Click [OK].
• Click [Cancel] to back to "Setting File Upload" window without uploading the file.

4. Click [OK].
• The file upload result is displayed in "Station List" - "Status."

In Process: The file is in the process of uploading.
Success: Upload is completed.
Failed: Upload failed. Try uploading again.
Unavailable: This is displayed when a file that cannot be uploaded to a station is selected in Step 2.
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10.4 syslog (except IX-MV, IX-DA, IX-DF(-*), and IX-BA, IX-SS(-*))

■ IPv4 Address♠

■ IPv6 Address♠

■Port♦

Description Set the IPv4 address for syslog server.

Settings 1.0.0.1-223.255.255.254 or hostname(1-64 alphanumeric characters)

Default values -

Description Set the IPv6 address for syslog server.

Settings ::FF:0-FEFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF or hostname(1-64 alphanumeric 
characters)

Default values -

Description Set the port number of syslog server.

Settings 1-65535

Default values 514
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